
ActiveReports for .NET 3.0 is a fully integrated product which combines the features of the Visual Studio .NET 
programming languages with user-friendly controls to provide a powerful report designer.

In the ActiveReports for .NET 3.0 Documentation

Introducing ActiveReports for .NET 3.0
Find out what's new in ActiveReports for .NET 3.0, installation and setup information, and the features of the 
Standard and Professional Editions. This section also contains important architecture and concepts information as 
well as a guide to help you to get started. 

Licensing Reports
Use this guide to license your machine and to add licensing to projects created during your evaluation. 

Getting Assistance
Learn the location of the Readme file and how to obtain product support. 

Samples and Walkthroughs
Find out how to use various features of ActiveReports in the available samples and walkthroughs. 

Troubleshooting
Learn how to resolve some common issues with ActiveReports. 
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ActiveReports for .NET 3.0 is a fully integrated product which combines the features of the Visual Studio .NET 
programming languages with user-friendly controls to provide a powerful report designer.

In the ActiveReports for .NET 3.0 Documentation

Introducing ActiveReports for .NET 3.0
Find out what's new in ActiveReports for .NET 3.0, installation and setup information, and the features of 
the Standard and Professional Editions. This section also contains important architecture and concepts 
information as well as a guide to help you to get started. 

Licensing Reports
Use this guide to license your machine and to add licensing to projects created during your evaluation. 

Getting Assistance
Learn the location of the Readme file and how to obtain product support. 

Samples and Walkthroughs
Find out how to use various features of ActiveReports in the available samples and walkthroughs. 

Troubleshooting
Learn how to resolve some common issues with ActiveReports. 

ActiveReports leverages the latest technologies including XML, scripting and CSS along with open architecture 
to provide you with a fully-integrated and user-friendly report designer. This version now supports Visual 
Studio 2005, as well as Visual Studio 2003.

This section contains information about:

ActiveReports Editions
Find out about the different features of the Standard and Professional Editions. 

Data Dynamics Copyright Notice
Explains Data Dynamics copyright information. 

ActiveReports License Agreement
Understand the terms of the ActiveReports License Agreement and Limited Warranty. 

Frequently Asked Questions
Find the answers to Frequently Asked Questions. 

Installation and Setup
Explains the details of ActiveReports installation and setup. 

Upgrading Reports
Learn to upgrade reports in previous versions of ActiveReports and other report programs. 

Architecture and Concepts
Find out about the structure and concepts of report design. 

Getting Started
Learn the basics of using ActiveReports for .NET 3.0. 

What's New
Learn about the new features added to ActiveReports for .NET 3.0.

Standard Edition Features
Find out about the features of ActiveReports for .NET 3.0 Standard Edition. 

ActiveReports for .NET 3.0 User Guide

Introducing ActiveReports for .NET 3.0

ActiveReports Editions
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Professional Edition Features
Find out about the features of ActiveReports for .NET 3.0 Professional Edition. 

ActiveReports for .NET 3.0 is an enhancement of the popular ActiveReports for .NET engine and report 
viewer.  It includes the same power and flexibility of ActiveReports for .NET and the same integration with 
the Visual Studio® .NET 2003 Environment, and adds several new features including integration with the 
Visual Studio .NET 2005 Environment. ActiveReports for .NET 3.0 Standard Edition supports the following 
features: 

Designer
l Full integration with the .NET environment 

l Familiar user interface 

l C# and VB.NET support 

l The ability to compile reports into the application for speed and security or to keep them separate for 
ease of updating 

l Designer hosting of .NET and user controls 

Report Controls
l Label 

l Textbox 

l Checkbox 

l Picture 

l Line 

l Shape 

l RichText with new HTML tag support 

l New! Report Info 

l Subreport 

l Pagebreak 

l Barcode with standard styles plus QRCode, Code49, JapanesePostal, and Pdf417 

l OleObject 

l Chart control with separate data source

Reporting Engine
l Managed code 

l Binding to ADO.NET, XML, iList, and custom data sources 

l Easy deployment with the report processing engine as a single assembly DLL 

l All of the features of ActiveReports 2.0

Report Viewer
l Managed C# code 

l Very small deployment assembly, suitable for use on the Internet 

l Table of Contents/Bookmarks 

l Thumbnail View 

l Hyperlinking 

l New! Tabbed Viewing

Export Filters

Standard Edition Features
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ActiveReports includes export filters to generate output into Rich Text Format (RTF) for word-processing, 
Portable Document Format (PDF) for printing, Microsoft® Excel® worksheets, HTML and DHTML for 
publishing your reports to the internet, TIFF for optical archiving and faxing and delimited text for 
spreadsheets and databases.

ActiveReports for .NET 3.0 is an enhancement of the popular ActiveReports for .NET engine and report 
viewer. It includes the same power and flexibility of ActiveReports for .NET and the same integration with the 
Visual Studio® .NET 2003 Environment and adds integration with the Visual Studio .NET 2005 Environment. 
ActiveReports for .NET 3.0 Professional Edition includes all of the features of the Standard Edition and 
supports the following additional features: 

End-User Report Designer
The control is a run-time designer that may be distributed royalty-free. It allows the ActiveReports designer 
to be hosted in an application and provides end-user report editing capabilities. The control's methods and 
properties provide easy access for saving and loading report layouts, monitoring and controlling the design 
environment, and customizing the look and feel to the needs of end users.

ASP.NET Integration
l The Web server control provides convenience for running and exporting reports in ASP.NET. 

l HTTP Handler extensions allow report files (RPX) or compiled assemblies containing reports to be dropped 
on the server and hyperlinked. 

Web Viewer Control
l The Web Viewer control allows quick viewing of ActiveReports on the web as well as printing capability 

with the ActiveXViewer and AcrobatReader ViewerType enumerations. 

HTTP Handlers
l The RPX HTTPHandler allows the developer to hyperlink ActiveReports on a web page to return HTML 

format or PDF format reports for viewing and/or printing. 

l The Compiled Report HTTPHandler allows the developer to hyperlink ActiveReports compiled in an 
assembly on a web page to return HTML format or PDF format reports for viewing and/or printing. 

Information in this document, including URL and other Internet Web site references, is subject to change 
without notice. Unless otherwise noted, the example companies, organizations, products, domain names, e-
mail addresses, logos, people, places and events depicted herein are fictitious, and no association with any 
real company, organization, product, domain name, e-mail address, logo, person, place or event is intended 
or should be inferred. Complying with all applicable copyright laws is the responsibility of the user. No part of 
this document may be reproduced, stored in or introduced into a retrieval system, or transmitted in any form 
or by any means (electronic, mechanical, photo copying, recording, or otherwise), or for any purpose, 
without the express written permission of Data Dynamics, Ltd.

 

ActiveReports and the ActiveReports logo are registered trademarks of Data Dynamics, Ltd.  

All other trademarks are the property of their respective owners.

License Agreement and Limited Warranty
Please read carefully before installing this software package. Your installation of the package indicates your 

Professional Edition Features

Data Dynamics Copyright Notice

ActiveReports for .NET 3.0 License Agreement and Limited Warranty
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acceptance of the terms and conditions of this license agreement. Contact Data Dynamics if you have any 
questions about this license.

The Product (libraries and object code) is proprietary to Data Dynamics, Ltd. and is protected by Federal 
Copyright Law. Data Dynamics retains the title to and ownership of the Product. You are licensed to use this 
Product on the following terms and conditions:

LICENSE:

The Product is licensed per software application developer (“developer”). Licensee is defined as the person or 
entity that pays consideration for the license to use the Product. Data Dynamics hereby grants the Licensee a 
nonexclusive License authorizing one, and only one, developer at a time to use the Product for development 
purposes. The Licensee is also permitted to distribute applications containing the files designated below on a 
royalty free basis. The use of this License does not create any kind of partnership or joint ownership interest 
in the Licensee’s proprietary applications. Please contact Data Dynamics if you require additional Licenses. 
Licensee may incorporate the sample code into Licensee’s applications. Use of this product by more than one 
developer at a time terminates, without notification, this License and the right to use this product.

LICENSEE MAY NOT:

Distribute, rent, sub-license or otherwise make available to others the software or documentation or copies 
thereof, except as expressly permitted in this License without prior written consent from Data Dynamics. In 
the case of an authorized transfer, the transferee must agree to be bound by the terms and conditions of this 
License Agreement.

RESTRICTIONS:

Licensee may use this Product in Licensee's business application for sale or distribution as long as:

1. The product that Licensee produces and/or distributes is NOT a software development product; a product 
that is sold primarily to software developers or system integrators or a development environment of any 
kind. Please contact Data Dynamics, Ltd. for special commercial licensing provisions in these 
circumstances. 

2. The software serial number and Licensee must be registered with Data Dynamics in order to receive 
support or distribution rights. 

3. Licensee may not remove any proprietary notices, labels, or trademarks on the software or 
documentation. 

4. Licensee may not modify, de-compile, disassemble, reverse engineer or translate the software.

FILES THAT MAY BE DISTRIBUTED WITH YOUR APPLICATION:

Standard Edition License:
ACTIVEREPORTS3.DLL, ACTIVEREPORTS.CHART.DLL, ACTIVEREPORTS.VIEWER3.DLL, 
ACTIVEREPORTS.INTEROP.DLL, ACTIVEREPORTS.XLSEXPORT.DLL, ACTIVEREPORTS.HTMLEXPORT.DLL, 
ACTIVEREPORTS.PDFEXPORT.DLL, ACTIVEREPORTS.RTFEXPORT.DLL, ACTIVEREPORTS.TEXTEXPORT.DLL, 
ACTIVEREPORTS.TIFFEXPORT.DLL

Professional Edition License:
ACTIVEREPORTS.DESIGN3.DLL and ACTIVEREPORTS.WEB.DLL in addition to the Standard Edition files.

US GOVERNMENT RESTRICTED RIGHTS:

Use, duplication or disclosure by the United States Government is subject to restrictions as set forth under 
DFARS 252.227-7013 or in FARS 52.227-19 Commercial Computer Software - Restricted Rights.

TERM:

Licensee may terminate its License and this Agreement at any time by destroying all copies of the Product 
and Product Documentation. They will also terminate automatically if Licensee fails to comply with any term 
or condition in this Agreement.

LIMITED WARRANTY

This software and documentation are sold "as is" without any warranty as to their performance, 
merchantability or fitness for any particular purpose. Licensee assumes the entire risk as to the quality and 
performance of the software. Data Dynamics warrants that the media on which the Program is furnished will 
be free from any defects in materials. Exclusive remedy in the event of a defect is expressly limited to the 
replacement of media. In no event shall Data Dynamics or anyone else who has been involved in the 
creation, development, production, or delivery of this software be liable for any direct, incidental or 
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consequential damages, such as, but not limited to, loss of anticipated profits, benefits, use, or data resulting 
from the use of this software, or arising out of any breach of warranty.

Is ActiveReports 100% managed?

ActiveReports includes the following distributable assemblies:

Managed assemblies: 

l ActiveReports3.DLL - This is the reporting engine. Managed and written in C#. 

l ActiveReports.Chart.DLL - This is the chart control.  Managed and written in C#. 

l ActiveReports.Design3.DLL - This is the run-time end user report designer. Managed and written in C#. 

l ActiveReports.Viewer3.DLL - This is the Windows Forms viewer. Managed and written in C#. 

l ActiveReports.Web.DLL - This is the Web Forms viewer and RPX handler. Managed and written in C#. 

l ActiveReports.PdfExport.DLL - This is the PDF export filter. Managed and written in C#. 

l ActiveReports.HtmlExport.DLL - This is the HTML export filter. Managed and written in C#. 

l ActiveReports.XlsExport.DLL - This is the Microsoft® Excel® export filter. Managed and written in C#. 

l ActiveReports.RtfExport.DLL - This is the RTF export filter. Managed and written in C#. 

l ActiveReports.TextExport.DLL - This is the Text export filter. Managed and written in C#. 

l ActiveReports.TiffExport.DLL - This is the TIFF export filter. Managed and written in C#. 

 

Unmanaged assemblies: 

l ActiveReports.Interop.DLL - This is the auxiliary COM interop DLL. Unsafe C# code used for OLE object 
hosting and other COM functions. The above are the only distributable DLLs. The core components are all 
managed and use all of what the .NET framework has to offer. 

l riched20.dll - This is version 4.0 of the Microsoft® RichEdit control. This only needs to be distributed if 
you have the End User Report Designer in your project, and want to ensure that tables will display 
correctly in edit mode of the RichTextBox control.

 

ActiveReports also includes the following non-distributable DLLs:

l ActiveReportsWizards.AccessImport.DLL - This is the design-time Report Wizard. Managed C#. 

l ARTaskPane.DLL - This is the design-time wizards container. Managed C#. 

l ARVSPackage.DLL - This is the VS Integration package. Unmanaged VC++ (Since integration with VS 
requires COM, this cannot be done any other way). 

 

How do I display the Report Explorer?  

When you create your first ActiveReport with ActiveReports for .NET 3.0, the Report Explorer by default does 
not display. To display the Report Explorer, complete the following steps. 

1. Right-click on the Visual Studio toolbar. 

2. Select ActiveReports for .NET 3.0 from the shortcut menu to display the designer toolbar. 

3. On the designer toolbar, click the View Report Explorer button.

Alternatively, you can display the Report Explorer by opening the View menu, pointing to Other Windows, 
and clicking Report Explorer.

Note: Once the Report Explorer has been added to the IDE, it will appear when a new 
Windows Application is created. If you do not wish to see the Report Explorer you can close it 

Frequently Asked Questions
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by selecting the window and closing it. 

Where is the Script Editor Icon?  

The Script Editor has become the Script View of the report in the same way that there is an HTML View of 
an .ASPX form. To access the Script View, click the Script View tab located below the report design surface. 
To go back to the Design View, click the Design View tab just to the right of the Script View tab. 

 

Why is the viewer icon grayed out?  

The icon may be grayed out for two reasons: 

1. The control selected in the components list was for the wrong viewer control. ActiveReports has two 
separate viewer controls. One is DataDynamics.ActiveReports.WebViewer, which is a viewer control that 
only works on Web Forms, and the other is DataDynamics.ActiveReports.Viewer, which is a viewer control 
that works only on Windows Forms.    

NOTE: The WebViewer control is only licensed for use with the Professional Edition. An evaluation 
message is displayed if the control is used with a Standard license.

2. The correct form is not selected. If a Windows Form or Web Form is not selected in the project, the 
viewer icon may be grayed out. Verify the correct viewer component is selected for the project: 

For the Windows Form Viewer - DataDynamics.ActiveReports.Viewer - ActiveReports.Viewer(x.x.x.xxxx)

For the WebForm Viewer - DataDynamics.ActiveReports.Web - ActiveReports.WebViewer(x.x.x.xxx)

 

Why am I getting an ambiguous reference error?  

This error occurs if the report's class file has "Imports System.Windows.Form" or "using 
System.Windows.Form." The reason for the error is that the Windows.Forms namespace and the 
ActiveReports namespace both have definitions for Textbox, Label etc. In order to prevent the error, the code 
needs to use the full System.Windows.Form namespace when referencing Windows.Form objects. 

 

Why are my empty controls not moving up? 

Stacked controls will not move up under the following conditions: 

1. The controls overlap: If the controls are overlapping they are prevented from moving up when the empty 
controls shrink. 

2. The controls intersect with another control: if the stacked controls have another control to the left or right 
that does not line up, it will stop the controls from moving up. 

The best solution is to use the Remove Vertical Spacing icon on the .NET layout toolbar. After you place the 
controls on the report, leaving a little space between each control, select all of the controls in the stack and 
click the icon to remove the white space between them. 

 

How do I distribute the assemblies for ActiveReports for .NET 3.0?

There are two ways the ActiveReports assemblies can be deployed. The decision on which one to use depends 
on your installation method. 

1. If you are copying your project from the development machine to your server, you should set the 
ActiveReports references in your project references to CopyLocal = True. This way the ActiveReports 
DLLs are in the bin folder of the compiled project. 

2. If you are making an installer for your software, you will need to include the ActiveReportsDistrib.MSM 
file included with the installation of ActiveReports for .NET 3.0. For example, it may be installed in the 
C:\Program Files\Data Dynamics\ActiveReports for .NET 3.0\Deployment folder. 

There is a third way to accomplish this that is not generally recommended. There is a command line utility 
that you can use to install each DLL in the GAC. The format is 'C:\Program Files\Microsoft Visual 
Studio .NET\FrameworkSDK\Bin>gacutil -i assembly'. 
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Why is my copy button not showing up on my viewer? 

You need to include references to the RtfExport and TextExport DLLs in order to enable the copy feature.  

This topic will help you find out what is necessary to install ActiveReports and direct you to appropriate help 
for the installation process.

 

Requirements
Learn the hardware and software required to install ActiveReports for .NET 3.0. 

Installed Files
Find out what files are installed with ActiveReports for .NET 3.0. 

Troubleshooting Installation
Find out how to troubleshoot installation issues. 

Verifying Package Installation
Find out how to verify successful installation. 

Tip: Close Visual Studio® .NET before running the installation program to allow the help files to be 
integrated into the common help collection in Visual Studio®.

This topic details hardware and software requirements for installing and using ActiveReports for .NET 3.0. 

Hardware requirements (minimum)
l Minimum processor: Pentium® II-class processor 450 MHz 

¡ Recommended processor: Pentium® III-class processor 600 MHz 

l Minimum RAM: 160 MB (192 MB for Windows® 2000 Server operating system) 

¡ Recommended RAM: 200 MB 

l Minimum hard drive space: 46 MB available 

¡ Recommended hard drive space: 50 MB available

Software requirements
l Operating System: Windows® 2000, Windows® XP or Windows® NT 4.0 

l Microsoft® .NET Framework Version 1.1 SP1 or 2.0 

l Microsoft Visual Studio® .NET 2003 or Microsoft Visual Studio® .NET 2005 

Note: The Express Editions of Visual Studio .NET 2005 will not work with ActiveReports, as they do 
not support packages.

l For Web deployment: IIS 5.1 or 6.0 and ASP.NET (version to match the .NET Framework version)

Installation and Setup

Hardware and Software Requirements

Installed Files

Folder/Files Description

<Common Files>\Data Dynamics\ActiveReports for .NET 3.0

ActiveReports3.dll Run-time engine assembly file 

ActiveReports.Chart.dll Chart control assembly file 
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ActiveReports.CodeDomSerializer.dll Helper file for Visual Studio .NET 
integration

ActiveReports.Design3.dll Designer assembly file 

ActiveReports.HtmlExport.dll HTML Export assembly file 

ActiveReports.Interop.dll Native functions assembly file 

ActiveReports.ItemWizard.VS200*.dll Access import and new item wizard files

ActiveReports.PdfExport.dll PDF Export assembly file 

ActiveReports.RtfExport.dll RTF Export assembly file 

ActiveReports.TextExport.dll Text Export assembly file 

ActiveReports.TiffExport.dll TIFF Export assembly file 

ActiveReports.Viewer3.dll Viewer assembly file 

ActiveReports.Web.Design.dll Web designer assembly file 

ActiveReports.Web.dll Web assembly file 

ActiveReports.XlsExport.dll Microsoft® Excel® Export assembly file 

AR3Col*.* (2 files) ActiveReports Help Integration Collection 

ARVSPackage.dll Visual Studio® .NET Integration Package 

COL_ActiveReports3*.* (5 files) ActiveReports Help Integration Collection 

CustomInstaller.dll Managed installation helper file

CustomInstaller.InstallState Managed installation helper file

ddARNET3.HxS ActiveReports Help File

H2Reg*.* (3 files) Files used to register the ActiveReports 
help collection with the combined help 
collection of Visual Studio .NET

License.rtf Data Dynamics ActiveReports License 
Agreement and Limited Warranty 

Microsoft.VisualStudio.Designer.Interfaces.dll Helper file for Visual Studio .NET 
integration

Microsoft.VisualStudio.DLL Helper file for Visual Studio .NET 
integration

Microsoft.VisualStudio.OLE.Interop.dll Helper file for Visual Studio .NET 
integration

Microsoft.VisualStudio.Shell.Interop.dll Helper file for Visual Studio .NET 
integration

Microsoft.VisualStudio.TextManager.Interop.dll Helper file for Visual Studio .NET 
integration

Microsoft.VisualStudio.VSIP.Helper.DLL Helper file for Visual Studio .NET 
integration

riched20.dll Version 4.0 of the Microsoft® RichEdit 
control, used to support rtf tables in edit 
mode of the ActiveReports RichTextBox 
control

<Common Files>\Data Dynamics\ActiveReports for .NET 3.0\1033

ARVSPackageUI.DLL Visual Studio .NET integration localized UI 
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assembly file for US English

<Common Files>\Data Dynamics\ActiveReports for .NET 3.0\1041

ARVSPackageUI.DLL Visual Studio .NET integration localized UI 
assembly file for Japanese

<Common Files>\Data Dynamics\ActiveReports for .NET 3.0\Wizards

WebKey.exe Web.config key generator 

<Application Folder>

File.ico Image file for the Report icon

<Application Folder>\Data

NWIND.mdb Samples database file 

<Application Folder>\Deployment

ActiveReportsDistrib.msm ActiveReports merge module file 

arview2.cab ActiveX® viewer cab file 

<Application Folder>\Introduction

*.gif and *.ico (8 files) Readme image files

readme.hta ActiveReports Readme file 

<Application Folder>\Localization

ARDesigner.zip Files used for localizing the End User 
Report Designer control 

AREngine.zip Files used for localizing the report engine 

ARVSPackage.zip Files used for localizing Visual Studio 
integration

Chart.zip Files used for localizing the chart

ExcelExport.zip Files used for localizing the Excel export

HtmlExport.zip Files used for localizing the HTML export

ItemWizard2003.zip Files used for localizing the Access import 
and new item wizards

ItemWizard2005.zip Files used for localizing the Access import 
and new item wizards

PdfExport.zip Files used for localizing the PDF export

publickey.snk Strong name key file used in localizing the 
Report Engine, End User Report Designer, 
and Viewer 

RtfExport.zip Files used for localizing the RTF export

Satellite.chm Help file for the Satellite Assembly utility

SatelliteAssembly.exe Utility which creates satellite assemblies 
for localizing the Report Engine, End User 
Report Designer, and Viewer 

TextExport.zip Files used for localizing the Text export

TiffExport.zip Files used for localizing the TIFF export

Viewer.zip Files used for localizing the Viewer control 
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Why can't other users access or use ActiveReports on my machine?

The installation for ActiveReports for .NET 3.0 gives the user the option to install the program for everyone or 
the current user. If it is installed only for the current user, other users on the same machine will not be able 
to access it or use it. 

I just installed ActiveReports for .NET 3.0. Why can't I see the help files?

If the installation was run while Visual Studio® was open, the help files will not be integrated until the user 
exits Visual Studio® and reopens it.

Why do I get, "The installer was interrupted before Data Dynamics ActiveReports for .NET 3.0 
could be installed. You need to restart the installer to try again" when I run the ActiveReports 
Setup?

The most likely cause for this error is a permissions issue. Either the folder the setup is pointing to or the 
folder containing the setup files does not have the correct permissions. The user needs to verify that the 
system account for the local machine has permissions to the folder containing the setup and verify that the 
user installing the program has the appropriate permissions.

To verify package installation

1. Open Visual Studio® .NET. 

2. You should see the ActiveReports logo on the splash screen. 

3. Open the Help > About dialog and verify the "Data Dynamics ActiveReports" entry in the installed 
products list. 

ActiveReports allows you to upgrade your reports from other versions of ActiveReports and other reporting 
programs. 

Changes Between ActiveReports 2.0 and ActiveReports for .NET
Find out about changes between ActiveReports 2.0 and ActiveReports for .NET. 

Converting Microsoft® Access® Reports
Find out about converting Microsoft® Access® reports to ActiveReports. 

Migrating from ActiveReports 2.0
Find out how to migrate reports from ActiveReports 2.0. 

Upgrading Reports Created with Previous Versions of ActiveReports for .NET
Find out how to upgrade reports created with ActiveReports for .NET 1.0 and ActiveReports 2.0 to 

ActiveReports for .NET 3.0. 

Web.zip Files used for localizing the Web Viewer 
control 

WebDesign.zip Files used for localizing the Web Viewer 
control designer for use in Visual Studio

<Application Folder>\Samples

CSharp\*.* Visual C#® sample projects 

VB\*.* Visual Basic® sample projects 

Troubleshooting Installation

Verifying Package Installation

Upgrading Reports
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Report Classes

Data Dynamics attempted to keep to a minimum the number of changes to the report object model from 
ActiveReports 2.0.  Most of the changes are due to class refactoring and renaming of objects and members to 
closely match the .NET Framework naming conventions.  Listed below are the significant changes in the 
object model.

1. ActiveReport.Show removed: ActiveReports class is no longer a Window class. This requires using the 
viewer control to preview the output of a report. 

2. Strong-typed Section classes:  ActiveReports for .NET includes classes for each of the section types with 
their own unique properties.  The old Section object is still available and the SectionCollection class holds 
items of the Section type.  The new section classes are Detail, GroupHeader, GroupFooter, PageHeader, 
PageFooter, ReportHeader and ReportFooter. 

3. New Stylesheet class:  Provides access to the styles defined in the report and allows you to change the 
individual style item properties. 

4. Image control renamed to Picture. 

5. Field control renamed to Textbox. 

6. Supported justified text alignment option for textboxes and labels. 

7. Indirect support of ActiveX® controls through .NET wrappers and the new CustomControl class. 

8. Three added data source classes which replace the data controls:  OleDbDataSource, XmlDataSource and 
SqlClientDataSource. 

9. Split Pages collection:  the Pages class from ActiveReports 2.0 is refactored into a PagesCollection class 
and a Document class.  The new Document class contains all the members to save or load RDF files and 
streams. 

10. Changed measurements from twips to inches.

11. Frame control has been removed. 

Printing

1. Added PrintController and PrintControllerWithStatus classes to make the printing model similar to 
the .NET Framework. 

2. Use of the .NET Framework Printer and PrinterSettings classes by the viewer control.  An optional � 
unsafe� printer class is also included for advanced printing and print job control similar to the 
ActiveReports 2.0 class. 

3. Calling Document.Print will no longer run the report.  The report must be run before attempting to print 
the document.

Viewer

1. A rewritten report viewer control to take full advantage of the .NET Framework classes. 

2. Complete revision of the Toolbar and Tools classes. 

3. Separation of the Table of Contents tree control from the TOC collection (renamed to 
BookmarksCollection). 

4. No binding of the viewer control to an ActiveReport object. Instead, it binds to a Document object. 

Microsoft® Access® reports can be easily converted into ActiveReports format by running the ActiveReports 
Microsoft Access Import Wizard. Due to differences between products, the extent to which your reports will 
be converted will depend on your specific report layout. However, since Data Dynamics provides source code, 
you can modify the resulting ActiveReport to achieve the results you desire.

To convert a Microsoft® Access® report into an ActiveReport 

Changes Between ActiveReports 2.0 and ActiveReports for .NET

Converting Microsoft Access Reports
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1. Open a project in Visual Studio®. 

2. From the Project menu, select Add New Item.

3. Select "ActiveReports Access Wizard" from the Templates pane of the "Add New Item" dialog and click 
Open. 

 

4. Click the ellipsis button button to browse for the Access Database that contains the report or reports you 
want to convert. 
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5. Once you have selected the database file click Open. 
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6. If you receive a security warning, click Open to proceed. 

7. Select the reports from the database that you want to import and click Next.  

 

8. Click Next to begin the conversion process. 
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9. Click Open to proceed through any security warnings. 

10. Click Finish when the conversion process has finished. 
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The converted reports now appear in the Solution Explorer.

ActiveReports for .NET 3.0 can use existing ActiveReports 2.0 report layout files (RPX) after some 
modifications to the scripting code.  ActiveReports 2.0 designer files (DSR/DSX) must be saved as RPX files in 
the ActiveReports 2.0 Designer before they can be imported into ActiveReports. Since ActiveReports does not 
import any Visual Basic® or scripting code into .NET, the code will need to be rewritten using the appropriate 
language in the new .NET environment.

Because ActiveReports for .NET 3.0 writes its report layout files in C# or Visual Basic for .NET and the 
nomenclature of the ActiveReports, ActiveReports.Viewer, and ActiveReports.Design DLLs have changed 
to ActiveReports3, ActiveReports.Viewer3, and ActiveReports.Design3 respectively, reports that were built 
with ActiveReports for .NET 1.0 and ActiveReports for .NET 2.0 will need to be converted to run in the new 
environment. ActiveReports for .NET 3.0 includes a converter that makes this an easy process. 

To convert an ActiveReports for .NET 1.0 or 2.0 project into an ActiveReports for .NET 3.0 project

Note: Always back up your projects before beginning the conversion process.

1. Open an existing ActiveReports for .NET 1.0 or 2.0 project in Visual Studio®. The report appears in the 
Solution Explorer as an RPX file. If you open the file in the IDE, you will see the XML that makes up the 
report's layout, but will not be able to view the designer or run the project. 

2. Click on Tools > Convert ActiveReports to open the ActiveReports for .NET Report Converter. 
The converter displays a list of all RPX files in your project.  

Migrating from ActiveReports 2.0

Upgrading Reports Created with Previous Versions of ActiveReports 
for .NET
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3. To convert the files click OK. The reports now appear in the Solution Explorer as C# or Visual Basic 
for .NET files and all references to earlier versions of ActiveReports for .NET DLLs have been updated.  

Note: The naming convention for controls has changed from previous editions of ActiveReports 
for .NET. Previously controls could be similarly named, as in "Test" and "test," but ActiveReports 
for .NET 3.0 requires control names to be unique. Thus when loading an RPX that has two controls with 
the same names but different cases, the report will not load and an error will be raised. In order to 
avoid this, give each control a unique name. 

This topic introduces you to the basic structure and concepts of ActiveReports for .NET 3.0 to enable efficient 
report creation.

 

Charts  
Learn about the available chart types, data, and customizing the appearance of charts. 

Events
Learn how section events work in ActiveReports. 

Raising Sequence of Events
Learn how processing events work in ActiveReports. 

Hyperlinks
Learn how hyperlinks can be used in ActiveReports. 

Inheritance
Learn how to create a base class from an ActiveReport to set up a template report from which other 
reports can inherit. 

Layout Files
Learn about layout files. 

Localization

Architecture and Concepts
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Learn how to localize the viewer control. 

OutputFormat Strings
Learn about OutputFormat strings. 

Parameters
Learn how parameters function for simple reports and subreports. 

Report and Page Settings
Learn how to access report and page settings in ActiveReports. 

Report Execution
Learn about report execution in ActiveReports. 

Report Structure
Learn about the structure of ActiveReports. 

RichText
Learn about the new RichText features, and which HTML tags are supported in the control. 

Scripting
Learn how to use scripting with ActiveReports. 

Follow the links below for information about concepts essential to the use of the Chart control.

Chart Types
Shows examples of Common Charts, 3D Charts, XY Charts, and Financial Charts. 

Chart Data
Discusses ways of connecting a chart to data. 

Chart Appearance
Covers Chart Effects, Chart Control Items, and Chart Axes and Walls. 

Chart-Specific Properties
Explains the use of properties specific to each Chart Type.

These topics introduce you to the different Chart Types you can create with the Chart control. 

Common Charts 
Area, Bar2D, Bezier, Doughnut/Pie, Line, Scatter, StackedArea, StackedBar, StackedArea100Pct, and 
StackedBar100Pct 

3D Charts 
Area3D, Bar3D, ClusteredBar, Line3D, Doughnut3D/Pie, StackedBar3D, and StackedBar3D100Pct 

XY Charts 
Bubble, BubbleXY, LineXY, and PlotXY 

Financial Charts 
Candle, HiLo, and HiLoOpenClose 

These topics take you through some of the common chart types that you can create with the Chart control.

Area Charts
Learn about the features of an Area Chart. 

Bar2D Charts

Charts

Chart Types

Common Charts
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Learn about the features of a Bar2D Chart. 

Bezier Charts
Learn about the features of a Bezier Chart. 

Doughnut/Pie Charts
Learn about the features of a Doughnut or Pie Chart. 

HorizontalBar Charts
Learn about the features of a HorizontalBar Chart. 

Line Charts
Learn about the features of a Line Chart. 

Scatter Charts
Learn about the features of a Scatter Chart. 

StackedArea Charts
Learn about the features of a StackedArea Chart. 

StackedBar Charts
Learn about the features of a StackedBar Chart. 

StackedArea100Pct Charts
Learn about the features of a StackedArea100Pct Chart. 

StackedBar100Pct Charts
Learn about the features of a StackedBar100Pct Chart. 

Use an area chart to compare trends over a period of time or in specific categories.

 

Area Charts

Graph Information

# of Y values/data point 1 

# of Series 1 or more 

Marker Support Series or Data Point 

Custom Properties None 
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Use a bar chart to compare values of items across categories.

 

 

Below is an example of setting the custom chart properties at run time for a bar chart.

' Visual Basic
Me.ChartControl1.Series(0).Properties("Gap") = 50.0F

// C#
this.ChartControl1.Series[0].Properties["Gap"] = 50f;

Use a Bezier or spline chart to compare trends over a period of time or in certain categories. It is a line chart 
that plots curves through the data points in a series.

Bar 2D Charts

Chart Information

# of Y values/data point 1 

# of Series 1 or more 

Marker Support Series or Data Point 

Custom Properties
Gap gets or sets the space between the bars of each
X axis value 

Bezier Charts
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A doughnut chart shows how the percentage of each data item contributes to the total.

Chart Information

# of Y values/data point 1 

# of Series 1 or more 

Marker Support Series or Data Point 

Custom Properties None 

Doughnut and Pie Charts
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In order to show each section of the pie in a different color, the Background property for each data point 
must be set. Below is an example of setting custom chart properties at run time for a doughnut chart.

' Visual Basic
Me.ChartControl1.Series(0).Properties("ExplodeFactor") = 0.0F
Me.ChartControl1.Series(0).Properties("HoleSize") = 0.25F
Me.ChartControl1.Series(0).Properties("OutsideLabels") = False
Me.ChartControl1.Series(0).Properties("StartAngle") = 0.0F

 
// C#
this.ChartControl1.Series[0].Properties["ExplodeFactor"] = 0f;
this.ChartControl1.Series[0].Properties["HoleSize"] = 0.25f;
this.ChartControl1.Series[0].Properties["OutsideLabels"] = false;
this.ChartControl1.Series[0].Properties["StartAngle"] = 0f;
 

Chart Information

# of Y values/data 
point

1 

# of Series 1 

Marker Support Series or Data Point 

Custom Properties

ExplodeFactor gets or sets the amount of separation between data 
point values.
HoleSize gets or sets the inner radius of the chart.
OutsideLabels gets or sets a value indicating whether the data 
point labels appear outside the chart.
StartAngle gets or sets the horizontal start angle for the series. 

Gantt Charts
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The Gantt chart is a project management tool used to chart the progress of individual project tasks. The 
chart compares project task completion to the task schedule.

 

Below is an example of setting the custom chart properties at run time for a Gantt chart.

'Visual Basic
Me.ChartControl1.Series(0).Properties("Gap") = 50.0F

//C#
this.ChartControl1.Series[0].Properties["Gap"] = 50f;
 

Note: In a Gantt chart the X and Y axes are reversed. AxisX is vertical and AxisY is horizontal.

Use a horizontal bar chart to compare values of items across categories with the axes reversed.

Chart Information

# of Y values/data 
point

2 

# of Series 1 or more

Marker Support Series or Data Point

Custom Properties
Gap gets or sets the space between the bars of each X axis 
value.

Horizontal Bar Charts
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Below is an example of setting the custom chart properties at run time for a horizontal bar chart as shown 
above.

' Visual Basic
Me.ChartControl1.Series(0).Properties("Gap") = 65.0F

// C#
this.ChartControl1.Series[0].Properties["Gap"] = 65f;

Use a line chart to compare trends over a period of time or in certain categories.

Chart Information

# of Y values/data 
point

1 

# of Series 1 or more 

Marker Support Series or Data Point 

Custom Properties
Gap gets or sets the space between the bars of each X axis 
value.

Line Charts
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Use a scatter chart to compare values across certain categories.

Chart Information

# of Y values/data point 1 

# of Series 1 or more 

Marker Support Series or Data Point 

Custom Properties None 

Scatter Charts

 

ActiveReports for .NET 3 User Guide | 36



 

 

A stacked area chart is an area chart with two or more data series stacked one on top of the other. Use this 
chart to show how each value contributes to a total.

Chart Information

# of Y values/data point 1 

# of Series 1 or more 

Marker Support Series or Data Point 

Custom Properties None 

StackedArea Charts
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A stacked bar chart is a bar chart with two or more data series stacked one on top of the other. Use this 
chart to show how each value contributes to a total.

Chart Information

# of Y values/data point 1 

# of Series 1 or more 

Marker Support Series or Data Point 

Custom Properties None 

StackedBar Charts
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Below is an example of setting the custom chart properties at run time for a StackedBar chart.

' Visual Basic
Me.ChartControl1.Series(0).Properties("Gap") = 100.0F

// C#
this.ChartControl1.Series[0].Properties["Gap"] = 100f;
 

A stacked area 100% chart is an area chart with two or more data series stacked one on top of the other to 
sum up to 100%. Use this chart to show how each value contributes to a total with the relative size of each 
series representing its contribution to the total. 

Chart Information

# of Y values/data 
point

1 

# of Series 1 or more 

Marker Support Series or Data Point 

Custom Properties
Gap gets or sets the space between the bars of each X axis 
value 

StackedArea100Pct Charts
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A StackedBar100Pct chart is a bar chart with two or more data series stacked one on top of the other to sum 
up to 100%. Use this chart to show how each value contributes to a total with the relative size of each 
series representing its contribution to the total. 

Chart Information

# of Y values/data point 1 

# of Series 1 or more 

Marker Support Series or Data Point 

Custom Properties None 

StackedBar100Pct Charts
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Below is an example of setting the custom chart properties at run time for a StackedBar100Pct chart.

' Visual Basic
Me.ChartControl1.Series(0).Properties("Gap") = 100.0F

// C#
this.ChartControl1.Series[0].Properties["Gap"] = 100f;

These topics take you through some of the three dimensional chart types that you can create with the Chart 
control. 

Note: To see a chart in three dimensions, open the ChartArea Collection dialog, and in the Projection 
section, change the ProjectionType from Identical to Orthogonal. 

Area3D Charts
Learn about the features of an Area3D Chart. 

Bar3D Charts
Learn about the features of a Bar3D Chart. 

ClusteredBar Charts

Chart Information

# of Y values/data 
point

1 

# of Series 1 or more 

Marker Support Series or Data Point 

Custom Properties
Gap gets or sets the space between the bars of each X axis 
value 

3D Charts
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Learn about the features of a ClusteredBar Chart. 

HorizontalBar3D Charts
Learn about the features of a HorizontalBar3D Chart. 

Line3D Charts
Learn about the features of a Line3D Chart. 

Doughnut3D/Pie Charts
Learn about the features of a Doughnut3D Chart. 

StackedBar3D Charts
Learn about the features of a StackedBar3D Chart. 

StackedBar3D100Pct Charts
Learn about the features of a StackedBar3D100Pct Chart. 

Use a 3D area chart to compare trends in two or more data series over a period of time or in specific 
categories, allowing the data to be viewed side by side.

 

Note: To see a chart in three dimensions, the ProjectionType must be Orthogonal. The ProjectionType 
is found in the ChartArea Collection dialog in the Projection section.

 

Area3D Charts

Chart Information

# of Y values/data point 1 

# of Series 1 or more 

Marker Support Series or Data Point 

LineBackdrop gets or sets the backdrop information
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Below is an example of setting the custom chart properties at run time for a 3D area chart as shown for the 
first series in the image above.

' Visual Basic
Me.ChartControl1.Series(0).Properties("LineBackdrop") = New Backdrop(Color.Red, CType(150, _

Byte))
Me.ChartControl1.Series(0).Properties("Thickness") = 5.0F
Me.ChartControl1.Series(0).Properties("Width") = 30.0F

// C#
this.ChartControl1.Series[0].Properties["LineBackdrop"] = new Backdrop(Color.Red, ((System. _

Byte)(150)));
this.ChartControl1.Series[0].Properties["Thickness"] = 5f;
this.ChartControl1.Series[0].Properties["Width"] = 30f;

Use a 3D bar chart to compare values of items across categories, allowing the data to be viewed conveniently 
in a 3D format.

 

Note: To see a chart in three dimensions, the ProjectionType must be Orthogonal. The ProjectionType 
is found in the ChartArea Collection dialog in the Projection section.

 

Custom Properties

for the 3D line.
Thickness gets or sets the thickness of
the 3D line.
Width gets or sets the width of the 3D line. 

Bar3D Charts

Chart Information

# of Y values/data 1 

 

ActiveReports for .NET 3 User Guide | 43



 

Below is an example of setting the custom chart properties at run time for a 3D bar chart as shown above.

' Visual Basic
Me.ChartControl1.Series(0).Properties("BarTopPercent") = 80.0F
Me.ChartControl1.Series(0).Properties("BarType") = BarType.Custom
Me.ChartControl1.Series(0).Properties("Gap") = 65.0F
Me.ChartControl1.Series(0).Properties("RotationAngle") = 0.0F
Me.ChartControl1.Series(0).Properties("VertexNumber") = 6

// C#
this.ChartControl1.Series[0].Properties["BarTopPercent"] = 80f;
this.ChartControl1.Series[0].Properties["BarType"] = BarType.Custom;
this.ChartControl1.Series[0].Properties["Gap"] = 65f;
this.ChartControl1.Series[0].Properties["RotationAngle"] = 0f;
this.ChartControl1.Series[0].Properties["VertexNumber"] = 6;

Use a 3D clustered bar chart to compare values of items across categories, allowing the data to be viewed 
conveniently in a 3D format.

point

# of Series 1 or more 

Marker Support Series or Data Point 

Custom Properties

BarTopPercent gets or sets the percentage of the top
of the bar that is shown for Cone or Custom BarTypes.
BarType gets or sets the type of bars that is displayed.
Gap gets or sets the space between the bars of each X axis 
value.
RotationAngle gets or sets the starting horizontal angle for
custom 3D bar shapes. Can only be used with the Custom 
BarType.
VertexNumber gets or sets the number of vertices for the data
point, used to create custom 3D bar shapes. Can only be used 
with the Custom
BarType. Bars must contain 3 or more vertices. 

ClusteredBar Charts
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Note: To see a chart in three dimensions, the ProjectionType must be Orthogonal. The ProjectionType 
is found in the ChartArea Collection dialog in the Projection section.

 

 

Below is an example of setting the custom chart properties at run time for a 3D clustered bar chart as shown 
above.

' Visual Basic
' set the custom properties for series 1
Me.ChartControl1.Series(0).Properties("BarTopPercent") = 50.0F
Me.ChartControl1.Series(0).Properties("BarType") = BarType.Custom
Me.ChartControl1.Series(0).Properties("Gap") = 300.0F
Me.ChartControl1.Series(0).Properties("RotationAngle") = 0.0F
Me.ChartControl1.Series(0).Properties("VertexNumber") = 6

Chart Information

# of Y 
values/data 
point

1 

# of Series 1 or more 

Marker Support Series or Data Point 

Custom 
Properties

BarTopPercent gets or sets the percentage of the top of the bar that is 
shown for Cone or Custom BarTypes.
BarType gets or sets the type of bars that are displayed.
Gap gets or sets the space between the bars of each X axis value.
RotationAngle gets or sets the starting horizontal angle for custom 3D 
bar shapes. Can only be used with the Custom BarType.
VertexNumber gets or sets the number of vertices for the data point, 
used to create custom 3D bar shapes. Can only be used with the 
Custom BarType. Bars must contain 3 or more vertices. 
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' set the custom properties for series 2
Me.ChartControl1.Series(1).Properties("BarTopPercent") = 20.0F
Me.ChartControl1.Series(1).Properties("BarType") = BarType.Custom
Me.ChartControl1.Series(1).Properties("Gap") = 300.0F
Me.ChartControl1.Series(1).Properties("RotationAngle") = 90.0F
Me.ChartControl1.Series(1).Properties("VertexNumber") = 3

// C#
// set the custom properties for series 1
this.ChartControl1.Series[0].Properties["BarTopPercent"] = 50f;
this.ChartControl1.Series[0].Properties["BarType"] = BarType.Custom;
this.ChartControl1.Series[0].Properties["Gap"] = 300f;
this.ChartControl1.Series[0].Properties["RotationAngle"] = 0f;
this.ChartControl1.Series[0].Properties["VertexNumber"] = 6;

// set the custom properties for series 2
this.ChartControl1.Series[1].Properties["BarTopPercent"] = 20f;
this.ChartControl1.Series[1].Properties["BarType"] = BarType.Custom;
this.ChartControl1.Series[1].Properties["Gap"] = 300f;
this.ChartControl1.Series[1].Properties["RotationAngle"] = 90f;
this.ChartControl1.Series[1].Properties["VertexNumber"] = 3;

A 3D doughnut chart shows how the percentage of each data item contributes to a total percentage, allowing 
the data to be viewed in a 3D format.

 

Note: To see a chart in three dimensions, the ProjectionType must be Orthogonal. The ProjectionType 
is found in the ChartArea Collection dialog in the Projection section. 

 

Doughnut3D Pie Charts

Chart Information

# of Y 
values/data 
point

1 

# of Series 1 

Marker 
Support

Series or Data Point 
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Below is an example of setting the custom chart properties at run time for a 3D doughnut chart as shown in 
the image above.

' Visual Basic
Me.ChartControl1.Series(0).Properties("ExplodeFactor") = 0.0F
Me.ChartControl1.Series(0).Properties("HoleSize") = 0.33F
Me.ChartControl1.Series(0).Properties("OutsideLabels") = False
Me.ChartControl1.Series(0).Properties("StartAngle") = 50.0F

// C#
this.ChartControl1.Series[0].Properties["ExplodeFactor"] = 0f;
this.ChartControl1.Series[0].Properties["HoleSize"] = .33f;
this.ChartControl1.Series[0].Properties["OutsideLabels"] = false;
this.ChartControl1.Series[0].Properties["StartAngle"] = 50f;

A 3D funnel chart shows how the percentage of each data item contributes to the whole, allowing the data to 
be viewed in a three dimensional format.

Custom 
Properties

ExplodeFactor gets or sets the amount of separation between data 
point values. The value must be less than or equal to 1. To explode one 
section of the doughnut chart, set ExplodeFactor on the data point 
instead of on the series.
HoleSize gets or sets the inner radius of the chart. If set to 0, the chart 
will look like a pie chart. The value must be less than or equal to 1.
OutsideLabels gets or sets a value indicating whether the data point 
labels appear outside of the graph.
StartAngle gets or sets the horizontal start angle for the series data 
points. 

Funnel 3D Charts
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Below is an example of setting the custom chart properties at run time for a 3D funnel chart.

'Visual Basic
Imports DataDynamics.ActiveReports.Chart
Imports DataDynamics.ActiveReports.Chart.Graphics

With Me.ChartControl1.Series(0)
.Properties("BaseStyle") = BaseStyle.SquareBase
.Properties("CalloutLine") = New Line(Color.Black, 2, LineStyle.Dot)
.Properties("FunnelStyle") = FunnelStyle.YIsWidth
.Properties("MinPointHeight") = 10.0F
.Properties("NeckWidth") = 20.0F
.Properties("NeckHeight") = 5.0F
.Properties("OutsideLabels") = True
.Properties("OutsideLabelsPlacement") = LabelsPlacement.Right
.Properties("PointGapPct") = 3.0F
.Properties("RotationAngle") = 3.0F

End With

//C#
using DataDynamics.ActiveReports.Chart;
using DataDynamics.ActiveReports.Chart.Graphics;

this.ChartControl1.Series[0].Properties["BaseStyle"] = BaseStyle.SquareBase;
this.ChartControl1.Series[0].Properties["CalloutLine"] = new Line(Color.Black, 2, LineStyle.Dot);

Chart Information

# of Y 
values/data 
points

1 

# of Series 1

Marker 
Support

Series or Data Point

Custom 
Properties

BaseStyle Gets or sets a circular or square base drawing style for the 
3D funnel chart. 
CalloutLine Gets or sets the style for a line connecting the marker label 
to its corresponding funnel section. The default value is a black one-point 
line.
FunnelStyle Gets or sets the Y value for the series points to the width 
or height of the funnel. The default value is YIsHeight.
MinPointHeight Gets or sets the minimum height allowed for a data 
point in the funnel chart. The height is measured in relative coordinates.
NeckHeight Gets or sets the neck height for the funnel chart. This 
property can only be used with the FunnelStyle property set to 
YIsHeight. The default value is 5.
NeckWidth Gets or sets the neck width for the funnel chart. This 
property can only be used with the FunnelStyle property set to 
YIsHeight. The default value is 5.
OutsideLabels Gets or sets a value indicating whether the labels are 
placed outside of the funnel chart. The default value is True.
OutsideLabelsPlacement Gets or sets a value indicating whether the 
data point labels appear on the left or right side of the funnel. This 
property can only be used with the OutsideLabels property set to True.
PointGapPct Gets or sets the amount of space between the data points 
of the funnel chart. The PointGapPct is measured in relative coordinates. 
The default value is 0, and valid values range from 0 to 100.
RotationAngle Gets or sets the left-to-right rotation angle of the funnel. 
The valid values range from -180 to 180 degrees. This property is only 
effective with the Projection property set to Orthogonal and the 
BaseStyle property set to SquareBase.
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this.ChartControl1.Series[0].Properties["FunnelStyle"] = FunnelStyle.YIsWidth;
this.ChartControl1.Series[0].Properties["MinPointHeight"] = 10f;
this.ChartControl1.Series[0].Properties["NeckWidth"] = 20f;
this.ChartControl1.Series[0].Properties["NeckHeight"] = 5f;
this.ChartControl1.Series[0].Properties["OutsideLabels"] = true;
this.ChartControl1.Series[0].Properties["OutsideLabelsPlacement"] = LabelsPlacement.Right; 
this.ChartControl1.Series[0].Properties["PointGapPct"] = 3f;
this.ChartControl1.Series[0].Properties["RotationAngle"] = 3f;

Use a horizontal 3D bar chart to compare values of items across categories, allowing the data to be viewed 
conveniently in a 3D format with the axes reversed.

Note: To see a chart in three dimensions, the ProjectionType must be Orthogonal. The ProjectionType 
is found in the ChartArea Collection dialog in the Projection section.

 

 

Horizontal Bar 3D Charts

Chart Information

# of Y values/data 
point

1 

# of Series 1 or more 

Marker Support Series or Data Point 

Custom Properties

Gap gets or sets the space between the bars of each X axis 
value.
PointBarDepth Gets or sets the thickness of the 3D bar.

 

ActiveReports for .NET 3 User Guide | 49



Below is an example of setting the custom chart properties at run time for a 3D bar chart as shown above.

' Visual Basic
Me.ChartControl1.Series(0).Properties("Gap") = 65.0F
Me.ChartControl1.Series(0).Properties("PointBarDepth") = 100 
// C#
this.ChartControl1.Series[0].Properties["Gap"] = 65f;
this.ChartControl1.Series[0].Properties["PointBarDepth"] = 100;

Use a 3D line chart to compare trends over a period of time or in certain categories in a 3D format.

 

Note: To see a chart in three dimensions, the ProjectionType must be Orthogonal. The ProjectionType 
is found in the ChartArea Collection dialog in the Projection section. 

 

 

Below is an example of setting the custom chart properties at run time for a 3D line chart as shown for the 
first series in the image above.

Line3D Charts

Chart Information

# of Y values/data 
point

1 

# of Series 1 or more 

Marker Support Series or Data Point 

Custom Properties

LineBackdrop gets or sets the backdrop information for the 3D 
line.
Thickness gets or sets the thickness of the 3D line.
Width gets or sets the width of the 3D line. 

 

ActiveReports for .NET 3 User Guide | 50



' Visual Basic
Me.ChartControl1.Series(0).Properties("LineBackdrop") = New Backdrop(Color.GreenYellow)
Me.ChartControl1.Series(0).Properties("Thickness") = 8.0F
Me.ChartControl1.Series(0).Properties("Width") = 40.0F

// C#
this.ChartControl1.Series[0].Properties["LineBackdrop"] = new Backdrop(Color.GreenYellow);
this.ChartControl1.Series[0].Properties["Thickness"] = 8f;
this.ChartControl1.Series[0].Properties["Width"] = 40f;

A 3D Pyramid chart shows how the percentage of each data item contributes to the whole, allowing the data 
to be viewed in a three dimensional format.

Pyramid Charts

Chart Information

# of Y 
values/data 
point

1

# of Series 1

Marker 
Support

Series or Data Points

BaseStyle Gets or sets a circular or square base drawing style for the 3D 
pyramid chart. CalloutLine Gets or sets the style for a line connecting 
the marker label to its corresponding pyramid section. The default value 
is a black one-point line.
MinPointHeight Gets or sets the minimum height allowed for a data 
point in the pyramid chart. The height is measured in relative 
coordinates.
OutsideLabels Gets or sets a value indicating whether the labels are 
placed outside of the pyramid chart. The default value is True.
OutsideLabelsPlacement Gets or sets a value indicating whether the 
data point labels appear on the left or right side of the pyramid. This 
property can only be used with the OutsideLabels property set to True.
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Below is an example of setting the custom chart properties at run time for a Pyramid chart.

'Visual Basic
Imports DataDynamics.ActiveReports.Chart
Imports DataDynamics.ActiveReports.Chart.Graphics

With Me.ChartControl1.Series(0)
.Properties("BaseStyle") = BaseStyle.SquareBase
.Properties("MinPointHeight") = 10.0F
.Properties("OutsideLabels") = True
.Properties("OutsideLabelsPlacement") = LabelsPlacement.Right
.Properties("PointGapPct") = 3.0F
.Properties("RotationAngle") = 3.0F

End With

//C#
using DataDynamics.ActiveReports.Chart;
using DataDynamics.ActiveReports.Chart.Graphics;

this.ChartControl1.Series[0].Properties["BaseStyle"] = BaseStyle.SquareBase;
this.ChartControl1.Series[0].Properties["MinPointHeight"] = 10f;
this.ChartControl1.Series[0].Properties["OutsideLabels"] = true;
this.ChartControl1.Series[0].Properties["OutsideLabelsPlacement"] = LabelsPlacement.Right; 
this.ChartControl1.Series[0].Properties["PointGapPct"] = 3f;
this.ChartControl1.Series[0].Properties["RotationAngle"] = 3f;

Use a 3D bar graph to compare values of items across categories, allowing the data to be viewed 
conveniently in a 3D format. A stacked bar graph is a bar graph with two or more data series stacked on top 
of each other. Use this graph to show how each value contributes to a total.

Custom 
Properties

PointGapPct Gets or sets the amount of space between the data points 
of the pyramid chart. The PointGapPct is measured in relative 
coordinates. The default value is 0, and valid values range from 0 to 100.
RotationAngle Gets or sets the left-to-right rotation angle of the 
pyramid. The valid values range from -180 to 180 degrees. This property 
is only effective with the Projection property set to Orthogonal and the 
BaseStyle property set to SquareBase.

StackedBar3D Charts
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Note: To see a chart in three dimensions, the ProjectionType must be Orthogonal. The ProjectionType 
is found in the ChartArea Collection dialog in the Projection section.

 

 

Below is an example of setting the custom chart properties at run time for a StackedBar3D chart.

' Visual Basic
Me.ChartControl1.Series(0).Properties("Gap") = 100.0F

// C#
this.ChartControl1.Series[0].Properties["Gap"] = 100f;

A StackedBar3D100Pct chart is a bar chart with two or more data series stacked one on top the other three 
dimensionally to sum up to 100%. Use this chart to show how each value contributes to a total with the 
relative size of each series representing its contribution to the total. 

Chart Information

# of Y values/data 
point

1 

# of Series 1 or more 

Marker Support Series or Data Point 

Custom Properties
Gap gets or sets the space between the bars of each X axis 
value 

StackedBar3D100Pct Charts
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Note: To see a chart in three dimensions, the ProjectionType must be Orthogonal. The ProjectionType is 
found in the ChartArea Collection dialog in the Projection section. 

 

 

Below is an example of setting the custom chart properties at run time for a StackedBar3D100Pct chart.

' Visual Basic
Me.ChartControl1.Series(0).Properties("Gap") = 100.0F

// C#
this.ChartControl1.Series[0].Properties["Gap"] = 100f;

These topics take you through some of the XY chart types that you can create with the Chart control.

Bubble Charts
Learn about the features of a Bubble Chart. 

BubbleXY Charts
Learn about the features of a BubbleXY Chart. 

Chart Information

# of Y values/data 
point

1 

# of Series 1 or more 

Marker Support Series or Data Point 

Custom Properties
Gap gets or sets the space between the bars of each X axis 
value 

XY Charts
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LineXY Charts
Learn about the features of a LineXY Chart. 

PlotXY Charts
Learn about the features of a PlotXY Chart. 

The Bubble chart is an XY chart in which bubbles represent data points. The first Y value is used to plot the 
bubble along the Y axis, and the second Y value is used to set the size of the bubble. The bubble shape can 
be changed using the series Shape property.

 

 

Below is an example of setting the custom chart properties at run time for a bubble chart as shown in the 
image above.

Bubble Charts

Chart Information

# of Y 
values/data point

2 

# of Series 1 or more 

Marker Support
Series or Data Point. Marker labels use the second Y value as the 
default value. 

Custom 
Properties

MaxSizeFactor gets or sets the maximum size of the bubble radius. 
Values must be less than or equal to 1. Default is .25.
MaxValue gets or sets the bubble size that is used as the maximum.
MinValue gets or sets the bubble size that is used as the minimum.
Shape gets or sets the shape of the bubbles. Uses or returns a valid 
MarkerStyle enumeration value. 
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' Visual Basic
Me.ChartControl1.Series(0).Properties("MaxSizeFactor") = 0.25F
Me.ChartControl1.Series(0).Properties("MaxValue") = 55.0R
Me.ChartControl1.Series(0).Properties("MinValue") = 5.0R
Me.ChartControl1.Series(0).Properties("Shape") = MarkerStyle.Circle

// C#
this.ChartControl1.Series[0].Properties["MaxSizeFactor"] = .25f;
this.ChartControl1.Series[0].Properties["MaxValue"] = 55D;
this.ChartControl1.Series[0].Properties["MinValue"] = 5D;
this.ChartControl1.Series[0].Properties["Shape"] = MarkerStyle.Circle;
 

The BubbleXY chart is an XY chart in which bubbles represent data points. The BubbleXY uses a numerical X 
axis and plots the x values and first set of Y values on the chart. The second Y value is used to set the size of 
the bubble.

 

BubbleXY Charts

Chart Information

# of Y 
values/data point

2 

# of Series 1 or more 

Marker Support
Series or Data Point. Marker labels use the second Y value as the 
default value. 

Custom 

MaxSizeFactor gets or sets the maximum size of the bubble radius. 
Values must be less than or equal to 1. Default is .25.
MaxValue gets or sets the bubble size that is used as the maximum.
MinValue gets or sets the bubble size that is used as the minimum.
Shape gets or sets the shape of the bubbles. Uses or returns a valid 
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Below is an example of setting the custom chart properties at run time for a bubble XY chart as shown in the 
image above.

' Visual Basic
Me.ChartControl1.Series(0).Properties("MaxSizeFactor") = 0.25F
Me.ChartControl1.Series(0).Properties("MaxValue") = 50.0R
Me.ChartControl1.Series(0).Properties("MinValue") = 0.0R
Me.ChartControl1.Series(0).Properties("Shape") = MarkerStyle.InvTriangle

// C#
this.ChartControl1.Series[0].Properties["MaxSizeFactor"] = .25f;
this.ChartControl1.Series[0].Properties["MinValue"] = 0D;
this.ChartControl1.Series[0].Properties["MaxValue"] = 50D;
this.ChartControl1.Series[0].Properties["Shape"] = MarkerStyle.InvTriangle;
 

A line XY chart plots points on the X and Y axes as one series and uses a line to connect points to each other.

 

 

Properties MarkerStyle enumeration value. 

LineXY Charts

Chart Information

# of Y values/data point 1 

# of Series 1 or more 

Marker Support Series or Data Point 

Custom Properties None 
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A plot XY chart shows the relationships between numeric values in two or more series sets of XY values.

 

 

These topics take you through some of the financial chart types that you can create with the Chart control.

Candle Charts
Learn about the features of a Candle Chart. 

HiLo Charts
Learn about the features of a HiLo Chart. 

HiLoOpenClose Charts
Learn about the features of a HiLoOpenClose Chart. 

PlotXY Charts

Chart Information

# of Y values/data point 1 

# of Series 1 or more 

Marker Support Series or Data Point 

Custom Properties None 

Financial Charts

Candle Charts
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A candle chart displays stock information using High, Low, Open and Close values. The size of the wick line is 
determined by the High and Low values, while the size of the bar is determined by the Open and Close 
values. The bar is displayed using different colors, depending on whether the price of the stock has gone up 
or down.

 

 

Below is an example of setting the custom chart properties at run time for a candle chart as shown in the 
image above.

' Visual Basic
Me.ChartControl1.Series(0).Properties("BodyDownswingBackdrop") = New Backdrop(Color.FromArgb _

(CType(101, Byte), CType(43, Byte), CType(87, Byte)), CType(200, Byte))
Me.ChartControl1.Series(0).Properties("BodyUpswingBackdrop") = New Backdrop(Color.FromArgb _

(CType(121, Byte), CType(113, Byte), CType(60, Byte)), CType(200, Byte))

Chart Information

# of Y 
values/data 
point

4 (The first value is the high figure, the second is the low figure, the 
third is the opening figure, and the fourth is the closing figure.)

# of Series 1 or more 

Marker Support
Series or Data Point. Marker labels use the first Y value as the default 
value. 

Custom 
Properties

BodyDownswingBackdrop gets or sets the backdrop information used 
to fill the rectangle for data points in which the closing figure is lower 
than the opening figure.
BodyUpswingBackdrop gets or sets the backdrop information used to 
fill the rectangle for data points in which the closing figure is higher than 
the opening figure.
BodyWidth gets or sets the width of the rectangle used to show 
upswing or downswing.
Wickline gets or sets the line information for the wick line. 
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Me.ChartControl1.Series(0).Properties("WickLine") = New Line(Color.FromArgb(CType(145, Byte), _
CType(141, Byte), CType(127, Byte)))

Me.ChartControl1.Series(0).Properties("BodyWidth") = 10.0F

// C#
this.ChartControl1.Series[0].Properties["BodyDownswingBackdrop"]= new Backdrop(Color.FromArgb

(((System.Byte)(101)), ((System.Byte)(43)), ((System.Byte)(87))), 
((System.Byte)(200)));

this.ChartControl1.Series[0].Properties["BodyUpswingBackdrop"] = new Backdrop(Color.FromArgb
(((System.Byte)(121)), ((System.Byte)(113)), ((System.Byte)(60))), 
((System.Byte)(200)));

this.ChartControl1.Series[0].Properties["WickLine"] = new Line(Color.FromArgb(((System.Byte)
(145)), ((System.Byte)(141)), ((System.Byte)(127))));

this.ChartControl1.Series[0].Properties["BodyWidth"] = 10f;
 

A HiLo chart displays stock information using High and Low or Open and Close values. The length of the HiLo 
line is determined by the High and Low values or the Open and Close values.

 

 

HiLo Charts

Chart Information

# of Y values/data 
point

2 

# of Series 1 or more 

Marker Support
Series or Data Point. Marker labels use the first Y value as the 
default value. 

Custom Properties HiLoLine gets or sets the line information for the HiLo line. 
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Below is an example of setting the custom chart properties at run time for a HiLo chart as shown in the 
image above.

' Visual Basic
Me.ChartControl1.Series(0).Properties("HiLoLine") = New Line(Color.Teal, 4)

// C#
this.ChartControl1.Series[0].Properties["HiLoLine"] = new Line(Color.Teal, 4);
 

A HiLo OpenClose chart displays stock information using High, Low, Open and Close values. Opening values 
are displayed using lines to the left, while lines to the right indicate closing values.

 

 

Below is an example of setting the custom chart properties at run time for a HiLoOpenClose chart as shown in 
the image above.

HiLoOpenClose Charts

Chart Information

# of Y values/data 
point

4 

# of Series 1 or more 

Marker Support
Series or Data Point. Marker labels use the first Y value as the 
default value. 

Custom Properties

HiLoLine gets or sets the line information for the HiLo line.
CloseLine gets or sets the line information for the close line.
OpenLine gets or sets the line information for the open line.
TickLen gets or sets the length of the tick for the open and close 
lines. 
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' Visual Basic
Me.ChartControl1.Series(0).Properties("CloseLine") = New Line(Color.FromArgb(CType _

(38, Byte), CType(110, Byte), CType(0, Byte)), 6)
Me.ChartControl1.Series(0).Properties("HiloLine") = New Line(Color.FromArgb(CType _

(255, Byte), CType(226, Byte), CType(233, Byte)))
Me.ChartControl1.Series(0).Properties("OpenLine") = New Line(Color.FromArgb(CType _

(187, Byte), CType(16, Byte), CType(82, Byte)), 6)
Me.ChartControl1.Series(0).Properties("TickLen") = 10.0F

// C#
this.ChartControl1.Series[0].Properties["CloseLine"] = new Line(Color.FromArgb(((System.Byte)

(38)), ((System.Byte)(110)), ((System.Byte)(0))), 6);
this.ChartControl1.Series[0].Properties["HiloLine"] = new Line(Color.FromArgb(((System.Byte)

(255)), ((System.Byte)(226)), ((System.Byte)(233))));
this.ChartControl1.Series[0].Properties["OpenLine"] = new Line(Color.FromArgb(((System.Byte)

(187)), ((System.Byte)(16)), ((System.Byte)(82))), 6);
this.ChartControl1.Series[0].Properties["TickLen"] = 10f;
 

A Kagi chart displays supply and demand trends using a sequence of linked vertical lines. The thickness and 
direction of the lines vary depending on the price movement. If closing prices go in the direction of the 
previous Kagi line, then that Kagi line is extended. However, if the closing price reverses by the preset 
reversal amount, a new Kagi line is charted in the next column in the opposite direction. Thin lines indicate 
that the price breaks the previous low (supply) while thick lines indicate that the price breaks the previous 
high (demand).

Kagi Charts

Chart Information

# of Y 
values/data 
point

1
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Below is an example of setting the custom chart properties at run time for a Kagi chart.

'Visual Basic
Imports DataDynamics.ActiveReports.Chart.Graphics

With Me.ChartControl1.Series(0)
.Properties("BodyDownswingBackdrop") = New Backdrop(Color.Red)
.Properties("BodyUpswingBackdrop") = New Backdrop(Color.Blue)
.Properties("DownswingLine") = New Chart.Graphics.Line(Color.DarkRed)
.Properties("ReversalAmount") = "25"
.Properties("UpswingLine") = New Chart.Graphics.Line(Color.DarkBlue)
.Properties("Width") = 50.0F

End With

//C#
using DataDynamics.ActiveReports.Chart.Graphics;

this.ChartControl1.Series[0].Properties["BodyDownswingBackdrop"] = new Backdrop(Color.Red);
this.ChartControl1.Series[0].Properties["BodyUpswingBackdrop"] = new Backdrop(Color.Blue);
this.ChartControl1.Series[0].Properties["DownswingLine"] = new Chart.Graphics.Line(Color.DarkRed);
this.ChartControl1.Series[0].Properties["ReversalAmount"] = "25"; 
this.ChartControl1.Series[0].Properties["UpswingLine"] = new Chart.Graphics.Line(Color.DarkBlue);
this.ChartControl1.Series[0].Properties["Width"] = 50f;

The point and figure chart uses stacked columns of Xs to indicate that demand exceeds supply and columns 
of Os to indicate that supply exceeds demand to define pricing trends. A new X or O is added to the chart if 
the price moves higher or lower than the BoxSize value you set. A new column is added when the price 
reverses to the level of the BoxSize value multiplied by the ReversalAmount you set. The use of these values 
in the point and figure chart to calculate pricing trends makes this chart best suited for long term financial 
analysis.

# of Series 1

Marker 
Support

Series or Data Points

Custom 
Properties

BodyDownswingBackdrop Gets or sets the style and color settings for 
the three-dimensional side view of downswing Kagi lines. This property is 
only available with the Kagi 3D chart type, and is only effective when the 
Width property is set to a value higher than 25.
BodyUpswingBackdrop Gets or sets the style and color settings for the 
three-dimensional side view of upswing Kagi lines. This property is only 
available with the Kagi 3D chart type, and is only effective when the 
Width property is set to a value higher than 25.
DownswingLine Gets or sets the style and color settings to use for a 
Kagi line which charts a price decrease.
ReversalAmount Gets or sets the amount that a price must shift in 
order for the Kagi line to change direction.
UpswingLine Gets or sets the style and color settings to use for a Kagi 
line which charts a price increase.
Width Gets or sets the width of the three-dimensional side view of the 
Kagi lines.This property is only available with the Kagi 3D chart type, and 
must be set higher than its default value of 1 in order to display body 
downswing and upswing backdrops. 

Point And Figure Charts
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Below is an example of setting the custom chart properties at run time for a Point and Figure chart.

'Visual Basic
Imports DataDynamics.ActiveReports.Chart.Graphics

With Me.ChartControl1.Series(0)
.Properties("DownswingLine") = New Chart.Graphics.Line(Color.Red)
.Properties("UpswingLine") = New Chart.Graphics.Line(Color.Blue)
.Properties("BoxSize") = 3.0F

End With

//C#
using DataDynamics.ActiveReports.Chart.Graphics;

this.ChartControl1.Series[0].Properties["DownswingLine"] = new Chart.Graphics.Line(Color.Red);
this.ChartControl1.Series[0].Properties["UpswingLine"] = new Chart.Graphics.Line(Color.Blue);
this.ChartControl1.Series[0].Properties["BoxSize"] = 3f;

Chart Information

# of Y values/data 
point

2

# of Series 1

Marker Support Series or Data Points

Custom Properties

BoxSize Gets or sets the amount a price must change in order to 
create another X or O.
DownswingLine Gets or sets the style and color settings for the 
downswing Os.
ReversalAmount Gets or sets the amount that a price must shift in 
order for a new column to be added.
UpswingLine Gets or sets the style and color settings for the 
upswing Xs. 
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The Renko chart uses bricks of uniform size to chart price movement. When a price moves to a greater or 
lesser value than the preset BoxSize value required to draw a new brick, a new brick is drawn in the 
succeeding column. The change in box color and direction signifies a trend reversal.

 

Below is an example of setting the custom chart properties at run time for a Renko chart.

'Visual Basic
Imports DataDynamics.ActiveReports.Chart.Graphics

With Me.ChartControl1.Series(0)
.Properties("BodyDownswingBackdrop") = New Backdrop(Color.Red)
.Properties("BodyUpswingBackdrop") = New Backdrop(Color.Blue)
.Properties("BoxSize") = 3.0F

Renko Charts

Chart Information

# of Y values/data 
point

2

# of Series 1

Marker Support Series or Data Points

Custom Properties

BodyDownswingBackdrop Gets or sets the style and color 
settings for the downswing bricks.
BodyUpswingBackdrop Gets or sets the style and color settings 
for the upswing bricks.
BoxSize Gets or sets the amount a price must change in order to 
create another brick. 
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End With

//C#
using DataDynamics.ActiveReports.Chart.Graphics;

this.ChartControl1.Series[0].Properties["BodyDownswingBackdrop"] = new Backdrop(Color.Red);
this.ChartControl1.Series[0].Properties["BodyUpswingBackdrop"] = new Backdrop(Color.Blue);
this.ChartControl1.Series[0].Properties["BoxSize"] = 3f;

A three line break chart uses vertical boxes or lines to illustrate price changes of an asset or market. The 
price in a three line break graph must break the prior high or low set in the NewLineBreak property in order 
to reverse the direction of the graph.

 

Three Line Break Charts

Chart Information

# of Y 
values/data 
point

1

# of Series 1

Marker Support Series or Data Points

Custom 
Properties

BodyDownswingBackdrop Gets or sets the style and color settings 
for the downswing boxes.
BodyUpswingBackdrop Gets or sets the style and color settings for 
the upswing boxes.
NewLineBreak Gets or sets the amount that a price must shift in 
order for the direction to change. The default value is 3. 
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Below is an example of setting the custom chart properties at run time for a Three Line Break chart.

'Visual Basic
Imports DataDynamics.ActiveReports.Chart.Graphics

With Me.ChartControl2.Series(0)
.Properties("BodyDownswingBackdrop") = New Backdrop(Color.Red)
.Properties("BodyUpswingBackdrop") = New Backdrop(Color.Blue)
.Properties("NewLineBreak") = 5

End With

//C#
using DataDynamics.ActiveReports.Chart.Graphics;

this.ChartControl1.Series[0].Properties["BodyDownswingBackdrop"] = new Backdrop(Color.Red);
this.ChartControl1.Series[0].Properties["BodyUpswingBackdrop"] = new Backdrop(Color.Blue);
this.ChartControl1.Series[0].Properties["NewLineBreak"] = 5;

These topics will introduce you to some basic information about manipulating the appearance of Charts.

Chart Effects 
Learn about the visual effects possible with the Chart control. 

Chart Control Items 
Learn about Chart control items that can be used to customize your chart. 

Chart Axes and Walls
Learn some basic information about Chart axes and walls. 

Chart Wizard 
Learn what you can accomplish with the Chart Wizard. 

Chart-Specific Properties 
Learn which properties apply to each of the Chart Types.

These topics will introduce you to the different visual effects you can create with the Chart control.

Colors
Learn about colors and gradients. 

3D Effects
Find out about 3D effects. 

Lighting
Find out about directional light ratio, light type, and light source. 

Alpha Blending
Find out about Alpha blending. 

In the Chart control, colors can be used in different ways to enhance the chart's appearance, distinguish 
different series, point out or draw attention to data information such as averages, and more. 

Color Palettes
The Chart control includes several pre-defined color palettes that can be used to automatically set the colors 
for data values in a series. The pre-defined palettes are as follows:

Chart Appearance

Chart Effects

Colors
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l Cascade (default) A cascade of eight cool colors ranging from deep teal down through pale orchid. 

l Confetti A sprinkling of bright and pastel colors. 

l Iceberg A range of the soft blues and greys found in an iceberg. 

l Springtime The colors of spring, in deep green, two vivid colors and five pastels. 

l None All data is drawn using the same teal color. 

These enumerated values are accessed through the Series class with code like the following.

' Visual Basic
Me.ChartControl1.Series(0).ColorPalette = Chart.ColorPalette.Iceburg
 

// C#
this.ChartControl1.Series[0].ColorPalette = DataDynamics.ActiveReports.Chart.

ColorPalette.Iceburg;

Gradients
Gradients can be used in object backdrops to enhance the visual appearance of various chart items. 
Gradients can be used in the following chart sections:

l Chart backdrop 

l Chart area backdrops 

l Wall backdrops 

l Title backdrops 

l Legend backdrops 

l Legend item backdrops (for custom legend items) 

l WallRange backdrops 

l Series backdrops 

l Data point backdrops 

l Marker backdrops 

l Marker label backdrops 

l Annotation TextBar backdrops 

You can set gradients for a backdrop at run time by creating a BackdropItem, setting its Style property to 
Gradient, setting the GradientType, and setting the two colors to use for the gradient as shown in the 
following example.

' Visual Basic
Dim bItem As New DataDynamics.ActiveReports.Chart.BackdropItem
bItem.Style = Chart.Graphics.BackdropStyle.Gradient
bItem.Gradient = Chart.Graphics.GradientType.Vertical
bItem.Color = Color.Purple
bItem.Color2 = Color.White
Me.ChartControl1.Backdrop = bItem
 

// C#
DataDynamics.ActiveReports.Chart.BackdropItem bItem = new DataDynamics.ActiveReports.

Chart.BackdropItem();
bItem.Style = Chart.Graphics.BackdropStyle.Gradient;
bItem.Gradient = GradientType.Vertical;
bItem.Color = Color.Purple;
bItem.Color2 = Color.White;
this.ChartControl1.Backdrop = bItem;

Using the projection and viewpoint settings, you have the ability to display your 3D chart at or from any 

3D Effects
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angle needed to provide the desired view or call attention to a specific chart section. 

Projection
Determine the projection for a 3D chart using three factors: the ZDepth ratio, the projection type, and the 
projection DX and DY values. 

l ZDepth ratio The Z depth ratio is the level of depth the Z axis has in the chart. Values range from 0 (for 
a 2D chart) to 1.0. 

l ProjectionType The type of projection used for the chart. In order to show charts three dimensionally, 
the ProjectionType in the ChartArea Collection editor must be set to Orthogonal. To access this dialog 
box, click the ellipsis button next to the ChartAreas (Collection) property in the Properties Window. 

l ProjectionDX The origin position of the Z axis in relation to the X axis. This property is valid only when 
the ProjectionType is Orthogonal. 

l ProjectionDY The origin position of the Z axis in relation to the Y axis. This property is valid only when 
the ProjectionType is Orthogonal. 

l HorizontalRotation The HorizontalRotation property allows you to set the degree (-90° to 90°) 
of horizontal rotation from which the chart is seen. 

l VerticalRotation The VerticalRotation property allows you to set the degree (-90° to 90°) of vertical 
rotation from which the chart is seen.

The Backdrop class in the Chart control has an Alpha property which employs GDI+, and is used to set the 
transparency level of each object's backdrop. GDI+ uses 32 bits overall and 8 bits per alpha, red, green, and 
blue channels respectively to indicate the transparency and color of an object. Like a color channel's levels of 
color, the alpha channel represents 256 levels of transparency. 

Alpha Blending
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The default value of the Alpha property is 255, which represents a fully opaque color. For a fully transparent 
color, set this value to 0. To blend the color of the object's backdrop with the background color, use a setting 
between 0 and 255.

In the Chart control, you can use the Color.FromArgb method to set the alpha and color levels for a 
particular chart element. The following example shows how you can use the method to set the alpha and 
color values for the chart backdrop.

' Visual Basic
Me.ChartControl1.Backdrop = New DataDynamics.ActiveReports.Chart.BackdropItem _

(Color.FromArgb(100, 0, 11, 220))

// C#
this.ChartControl1.Backdrop = new DataDynamics.ActiveReports.Chart.

BackdropItem(Color.FromArgb(100, 0, 11, 220));
Changing the alpha level of a chart element reveals other items that are beneath the object. Because you can 
set the alpha level for any chart element that supports color, you can create custom effects for any chart. For 
example, you can use alpha blending to combine background images with a semi-transparent chart backdrop 
to create a watermark look. 

The Chart control provides the ability to completely customize lighting options for 3D charts. 

Directional Light Ratio
Using the DirectionalLightRatio property, you can control the directional or ambient intensity ratio. 

Light Type
By setting the Type property to one of the enumerated LightType values, you can control the type of lighting 

Lighting
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used in the chart. The settings are as follows:

l Ambient An ambient light source is used. It is equal to DirectionalLightRatio = 0. 

l InfiniteDirectional An infinite directional light source (like the sun) is used. 

l FiniteDirectional A point light source is used.   

Light Source
You can also set the Source property to a Point3d object, which controls the location of the light source.

These topics will introduce you to the Chart control items that can be used to customize your chart.

 

Annotations
Find out how annotations can be added to a chart. 

Titles and Footers
Find out how custom titles and footers can be added to a chart. 

Legends
Find out how to add a legend to a chart. 

Markers
Find out how to create custom markers to show data values. 

Constant Lines and Stripes
Find out how to use constant lines and stripes in a chart. 

The Chart control offers a built-in annotation tool to allow you to include floating text bars or images in your 
charts or call attention to specific items or values in your charts using the line and text bar controls included 
in the Annotation Collection Editor. 

Chart Control Items

Annotations
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The following properties are important when setting up annotations for your chart: 

l Start Point: sets the starting point (X and Y axis values) for an annotation line. 

l End Point: sets the end point (X and Y axis values) for an annotation line. 

l Anchor Placement: sets the position of the anchor point for the text bar on the chart surface. 

l Anchor Point: sets the point (X and Y axis values) where the text bar will be anchored based on the 
anchor placement selected. 

 

The following code demonstrates creating annotation lines and text bars, setting their properties, and adding 
them to the series annotations collection at run time. The results are shown in the screenshot above.  

' Visual Basic

' create the annotation lines and text bars
Dim aLine1 As New DataDynamics.ActiveReports.Chart.Annotations.AnnotationLine
Dim aLine2 As New DataDynamics.ActiveReports.Chart.Annotations.AnnotationLine
Dim aText1 As New DataDynamics.ActiveReports.Chart.Annotations.AnnotationTextBar
Dim aText2 As New DataDynamics.ActiveReports.Chart.Annotations.AnnotationTextBar

' set the properties for each line and text bar
With aLine1

.EndPoint = New DataDynamics.ActiveReports.Chart.Graphics.Point2d(1.5F, 30.0F)

.Line = New DataDynamics.ActiveReports.Chart.Graphics.Line(System.Drawing.Color _
 .Red, 2)
.StartPoint = New DataDynamics.ActiveReports.Chart.Graphics.Point2d(1.5F, 15.0F)

End With
With aLine2

.EndPoint = New DataDynamics.ActiveReports.Chart.Graphics.Point2d(4.6F, 47.0F)

.Line = New DataDynamics.ActiveReports.Chart.Graphics.Line(System.Drawing.Color _
 .Red, 2)
.StartPoint = New DataDynamics.ActiveReports.Chart.Graphics.Point2d(3.6F, 45.0F)
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End With
With aText1

.AnchorPlacement = DataDynamics.ActiveReports.Chart.Annotations _
 .AnchorPlacementType.Bottom
.AnchorPoint = New DataDynamics.ActiveReports.Chart.Graphics.Point2d(1.5F, 31.0F)
.Height = 25.0F
.Line = New DataDynamics.ActiveReports.Chart.Graphics.Line(System.Drawing.Color _

 .Red, 2)
.Text = "Min Value"
.Width = 100.0F

End With
With aText2

.AnchorPlacement = DataDynamics.ActiveReports.Chart.Annotations _
 .AnchorPlacementType.Left
.AnchorPoint = New DataDynamics.ActiveReports.Chart.Graphics.Point2d(4.7F, 47.0F)
.Height = 25.0F
.Line = New DataDynamics.ActiveReports.Chart.Graphics.Line(System.Drawing.Color _

 .Red, 2)
.Text = "Max Value"
.Width = 100.0F

End With

' add the annotation lines and text bars to the annotations collection for the series
Me.ChartControl1.Series(0).Annotations.AddRange(New DataDynamics.ActiveReports.Chart _

.Annotations.Annotation() {aLine1, aLine2, aText1, aText2})
 

// C#

// create the annotation lines and text bars
DataDynamics.ActiveReports.Chart.Annotations.AnnotationLine aLine1 = new 

DataDynamics.SharpGraph.Windows.Annotations.AnnotationLine();
DataDynamics.ActiveReports.Chart.Annotations.AnnotationLine aLine2 = new 

DataDynamics.SharpGraph.Windows.Annotations.AnnotationLine();
DataDynamics.ActiveReports.Chart.Annotations.AnnotationTextBar aText1 = new 

DataDynamics.SharpGraph.Windows.Annotations.AnnotationTextBar();
DataDynamics.ActiveReports.Chart.Annotations.AnnotationTextBar aText2 = new 

DataDynamics.SharpGraph.Windows.Annotations.AnnotationTextBar();

// set the properties for each line and text bar
aLine1.EndPoint = new DataDynamics.ActiveReports.Chart.Graphics.Point2d(1.5F, 30F);
aLine1.Line = new DataDynamics.ActiveReports.Chart.Graphics.Line(System.Drawing.Color.Red, 

2);
aLine1.StartPoint = new DataDynamics.ActiveReports.Chart.Graphics.Point2d(1.5F, 15F);
aLine2.EndPoint = new DataDynamics.ActiveReports.Chart.Graphics.Point2d(4.6F, 47F);
aLine2.Line = new DataDynamics.ActiveReports.Chart.Graphics.Line(System.Drawing.Color.Red, 

2);
aLine2.StartPoint = new DataDynamics.ActiveReports.Chart.Graphics.Point2d(3.6F, 45F);
aText1.AnchorPlacement = DataDynamics.ActiveReports.Chart.Annotations.AnchorPlacementType

.Bottom;
aText1.AnchorPoint = new DataDynamics.ActiveReports.Chart.Graphics.Point2d(1.5F, 31F);
aText1.Height = 25F;
aText1.Line = new DataDynamics.ActiveReports.Chart.Graphics.Line(System.Drawing.Color.Red, 

2);
aText1.Text = "Min Value";
aText1.Width = 100F;
aText2.AnchorPlacement = DataDynamics.ActiveReports.Chart.Annotations.AnchorPlacementType

.Left;
aText2.AnchorPoint = new DataDynamics.ActiveReports.Chart.Graphics.Point2d(4.7F, 47F);
aText2.Height = 25F;
aText2.Line = new DataDynamics.ActiveReports.Chart.Graphics.Line(System.Drawing.Color.Red, 

2);
aText2.Text = "Max Value";
aText2.Width = 100F;

// add the annotation lines and text bars to the annotations collection for the series
this.ChartControl1.Series[0].Annotations.AddRange(new DataDynamics.ActiveReports.Chart

.Annotations.Annotation[] {aLine1, aLine2, aText1, aText2});
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The Chart control allows you to add custom titles to your charts. The Titles collection is accessible from the 
SharpGraph object. With the ability to add as many titles as needed, dock them to any side of a chart area, 
change all of the font properties, add borders and shadows, make the background look the way you want it, 
and change the location of the text, you can easily make your titles look the way you want them to look. 

 

The following code demonstrates creating header and footer titles, setting their properties, and adding them 
to the titles collection at run time.

' Visual Basic

' create the header and footer titles
Dim tHeader As New DataDynamics.ActiveReports.Chart.Title
Dim tFooter As New DataDynamics.ActiveReports.Chart.Title

' set the properties for the header
tHeader.Alignment = Chart.Alignment.Center
tHeader.Backdrop = New DataDynamics.ActiveReports.Chart.Graphics.Backdrop(System.Drawing _

.Color.Thistle)
tHeader.Border = New DataDynamics.ActiveReports.Chart.Border(New DataDynamics.ActiveReports _

.Chart.Graphics.Line(System.Drawing.Color.DimGray), 3)
tHeader.DockArea = Me.ChartControl1.ChartAreas(0)
tHeader.Docking = Chart.DockType.Top
tHeader.Font = New DataDynamics.ActiveReports.Chart.FontInfo(System.Drawing.Color.White, _

New System.Drawing.Font("Arial", 25.0F))
tHeader.Text = "Chart Title"
tHeader.Visible = True

' set the properties for the footer
tFooter.Alignment = Chart.Alignment.Center
tFooter.Backdrop = New DataDynamics.ActiveReports.Chart.Graphics.Backdrop(System.Drawing _

.Color.Thistle)
tFooter.Border = New DataDynamics.ActiveReports.Chart.Border(New DataDynamics.ActiveReports _
.Chart.Graphics.Line(System.Drawing.Color.Indigo), 0, System.Drawing.Color.Black)
tFooter.DockArea = Me.ChartControl1.ChartAreas(0)
tFooter.Docking = Chart.DockType.Bottom
tFooter.Font = New DataDynamics.ActiveReports.Chart.FontInfo(System.Drawing.Color.DimGray, _

New System.Drawing.Font("Arial", 12.0F, System.Drawing.FontStyle.Bold))

Titles and Footers
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tFooter.Text = "Chart Footer"
tFooter.Visible = True

' add the header and footer titles to the titles collection
Me.ChartControl1.Titles.AddRange(New DataDynamics.ActiveReports.Chart.Title() {tHeader, _

tFooter})
 

// C#

// create the header and footer titles
DataDynamics.ActiveReports.Chart.Title tHeader = new DataDynamics.ActiveReports.Chart

.Title();
DataDynamics.ActiveReports.Chart.Title tFooter = new DataDynamics.ActiveReports.Chart

.Title();

// set the properties for the header
tHeader.Alignment = Chart.Alignment.Center;
tHeader.Backdrop = new DataDynamics.ActiveReports.Chart.Graphics.Backdrop(System.Drawing

.Color.Thistle);
tHeader.Border = new DataDynamics.ActiveReports.Chart.Border(new DataDynamics.ActiveReports

.Chart.Graphics.Line(System.Drawing.Color.DimGray), 3);
tHeader.DockArea = this.ChartControl1.ChartAreas[0];
tHeader.Docking = Chart.DockType.Top;
tHeader.Font = new DataDynamics.ActiveReports.Chart.FontInfo(System.Drawing.Color.White, 

new System.Drawing.Font("Arial", 25F));
tHeader.Text = "Chart Title";
tHeader.Visible = true;

// set the properties for the footer
tFooter.Alignment = Chart.Alignment.Center;
tFooter.Backdrop = new DataDynamics.ActiveReports.Chart.Graphics.Backdrop(System.Drawing

.Color.Thistle);
tFooter.Border = new DataDynamics.ActiveReports.Chart.Border(new DataDynamics.ActiveReports

.Chart.Graphics.Line(System.Drawing.Color.Indigo), 0, System.Drawing.Color.Black);
tFooter.DockArea = this.ChartControl1.ChartAreas[0];
tFooter.Docking = Chart.DockType.Bottom;
tFooter.Font = new DataDynamics.ActiveReports.Chart.FontInfo(System.Drawing.Color.DimGray, 

new System.Drawing.Font("Arial", 12F, System.Drawing.FontStyle.Bold));
tFooter.Text = "Chart Footer";
tFooter.Visible = true;

// add the header and footer titles to the titles collection
this.ChartControl1.Titles.AddRange(new DataDynamics.ActiveReports.Chart.Title[] {tHeader,

tFooter});
 

The Chart control automatically creates a legend item for each series added to a chart at design time and 
sets the Legend property for each series by default. However, the legend's Visible property must be set 
to True for the legend to show with the chart. The text for each default legend entry is taken from the 
Name property on the series. 

Legends
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The following code demonstrates how to create a legend at run time, add it to the legends collection for the 
Chart object and set the legend property of the series to the new legend, resulting in the legend shown 
above.

Note: Each Series to be shown in the Legend must have a Name. If the Name property is not set, the 
Series does not show up in the Legend.

' Visual Basic
' create the legend and title for the legend
Dim legend1 As New DataDynamics.ActiveReports.Chart.Legend
Dim lHeader As New DataDynamics.ActiveReports.Chart.Title
' set the properties for the legend title
lHeader.Backdrop = New DataDynamics.ActiveReports.Chart.Graphics.Backdrop(Chart.Graphics _

.BackdropStyle.Transparent, Color.White, Color.White, Chart.Graphics.GradientType _

.Vertical, Drawing2D.HatchStyle.DottedGrid, Nothing, Chart.Graphics.PicturePutStyle _

.Stretched)
lHeader.Border = New DataDynamics.ActiveReports.Chart.Border(New Chart.Graphics.Line(Color _

.White, 2, Chart.Graphics.LineStyle.None), 0, Color.Black)
lHeader.Font = New DataDynamics.ActiveReports.Chart.FontInfo(Color.White, New _

System.Drawing.Font("Arial", 10.0F, FontStyle.Bold))
lHeader.Text = "Series:"
' set the properties for the legend and add it to the legends collection
legend1.Alignment = DataDynamics.ActiveReports.Chart.Alignment.TopRight
legend1.Backdrop = New DataDynamics.ActiveReports.Chart.BackdropItem(Chart.Graphics _

.BackdropStyle.Transparent, Color.Gray, Color.White, Chart.Graphics.GradientType _

.Vertical, Drawing2D.HatchStyle.DottedGrid, Nothing, Chart.Graphics.PicturePutStyle _

.Stretched)
legend1.Border = New DataDynamics.ActiveReports.Chart.Border(New Chart.Graphics.Line(Color _

.Navy, 2), 0, Color.Black)
legend1.DockArea = Me.ChartControl1.ChartAreas(0)
legend1.LabelsFont = New DataDynamics.ActiveReports.Chart.FontInfo(Color.White, New System _

.Drawing.Font("Arial", 9.0F))
legend1.Header = lHeader
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legend1.MarginX = 5
legend1.MarginY = 5
Me.ChartControl1.Legends.Add(legend1)
' set the legend property of the series to the legend you created
Me.ChartControl1.Series(0).Legend = legend1
Me.ChartControl1.Series(1).Legend = legend1
Me.ChartControl1.Series(2).Legend = legend1
 

// C#
// create the legend and title for the legend
DataDynamics.ActiveReports.Chart.Legend legend1 = new DataDynamics.ActiveReports.Chart

.Legend();
DataDynamics.ActiveReports.Chart.Title lHeader = new DataDynamics.ActiveReports.Chart

.Title();
// set the properties for the legend title
lHeader.Backdrop = new DataDynamics.ActiveReports.Chart.Graphics.Backdrop(Chart.Graphics

.BackdropStyle.Transparent, Color.White, Color.White, Chart.Graphics.GradientType

.Vertical, System.Drawing.Drawing2D.HatchStyle.DottedGrid, null, Chart.Graphics

.PicturePutStyle.Stretched);
lHeader.Border = new DataDynamics.ActiveReports.Chart.Border(new Chart.Graphics.Line(Color

.White, 2, Chart.Graphics.LineStyle.None), 0, Color.Black);
lHeader.Font = new DataDynamics.ActiveReports.Chart.FontInfo(Color.White, new Font("Arial", 

10F, FontStyle.Bold));       
lHeader.Text = "Series:";
// set the properties for the legend and add it to the legends collection
legend1.Alignment = DataDynamics.ActiveReports.Chart.Alignment.TopRight;
legend1.Backdrop = new DataDynamics.ActiveReports.Chart.BackdropItem(Chart.Graphics

.BackdropStyle.Transparent, Color.Gray, Color.White, Chart.Graphics.GradientType

.Vertical, System.Drawing.Drawing2D.HatchStyle.DottedGrid, null, Chart.Graphics

.PicturePutStyle.Stretched);
legend1.Border = new DataDynamics.ActiveReports.Chart.Border(new Chart.Graphics.Line(Color

.Navy, 2), 0, Color.Black);
legend1.DockArea = this.sharpGraph1.ChartAreas[0];
legend1.LabelsFont = new DataDynamics.ActiveReports.Chart.FontInfo(Color.White, new Font

("Arial", 9F));
legend1.Header = lHeader;
legend1.MarginX = 5;
legend1.MarginY = 5;
this.ChartControl1.Legends.Add(legend1);

 
// set the legend property of the series to the legend you created
this.ChartControl1.Series[0].Legend = legend1;
this.ChartControl1.Series[1].Legend = legend1;
this.ChartControl1.Series[2].Legend = legend1;

Markers are used to show specific data series values in a chart. 

Markers
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The following code demonstrates how to create a marker object at run time and assign it to the Marker 
property of the series. The results are shown in the image above. 

' Visual Basic
' create the marker object
Dim marker1 As New DataDynamics.ActiveReports.Chart.Marker

' set the marker properties
marker1.Backdrop = New Chart.Graphics.Backdrop(Chart.Graphics.GradientType.Horizontal, _

Color.Navy, Color.Black)
marker1.Line = New Chart.Graphics.Line(Color.White)
marker1.Label = New Chart.LabelInfo(New Chart.Graphics.Line(Color.Transparent, 0, Chart _

.Graphics.LineStyle.None), New Chart.Graphics.Backdrop(Chart.Graphics.BackdropStyle _

.Transparent, Color.White, Color.White, Chart.Graphics.GradientType.Vertical, System _

.Drawing.Drawing2D.HatchStyle.DottedGrid, Nothing, Chart.Graphics.PicturePutStyle _

.Stretched), New Chart.FontInfo(Color.White, New Font("Arial", 8.0F)), "{Value}", _
Chart.Alignment.Center)

marker1.Size = 24
marker1.Style = Chart.MarkerStyle.Diamond

' assign the marker to the series Marker property
Me.ChartControl1.Series(0).Marker = marker1
 

// C#
// create the marker object
DataDynamics.ActiveReports.Chart.Marker marker1 = new DataDynamics.ActiveReports.Chart

.Marker();

// set the marker properties
marker1.Backdrop = new Chart.Graphics.Backdrop(Chart.Graphics.GradientType.Horizontal, 

Color.Navy, Color.Black);
marker1.Line = new Chart.Graphics.Line(Color.White);
marker1.Label = new Chart.LabelInfo(new Chart.Graphics.Line(Color.Transparent, 0, Chart
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.Graphics.LineStyle.None), new Chart.Graphics.Backdrop(Chart.Graphics.BackdropStyle

.Transparent, Color.White, Color.White, Chart.Graphics.GradientType.Vertical, System

.Drawing.Drawing2D.HatchStyle.DottedGrid, null, Chart.Graphics.PicturePutStyle

.Stretched), new Chart.FontInfo(Color.White, new Font("Arial", 8F)), "{Value}", Chart

.Alignment.Center);
marker1.Size = 24;
marker1.Style = Chart.MarkerStyle.Diamond;

// assign the marker to the series Marker property
this.ChartControl1.Series[0].Marker = marker1;

The Chart control supports constant lines and stripes through the use of the WallRanges collection. It allows 
you to display horizontal or vertical lines or stripes in a chart to highlight certain areas. For example, you 
could draw a stripe in a chart to draw attention to a high level in the data or draw a line to show the average 
value of the data presented. 

Important properties
l EndValue--Sets the end value on the primary axis for the wall range.  

l StartValue --Sets the start value on the primary axis for the wall range. 

l PrimaryAxis--Sets the axis on which the wall range should appear.  

 

The following code demonstrates how to create wall ranges, set their properties, and assign them to a chart 
area at run time. The results are shown in the image above. 

' Visual Basic
' create the wall range objects
Dim wallRange1 As New DataDynamics.ActiveReports.Chart.WallRange

Constant Lines and Stripes
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Dim wallRange2 As New DataDynamics.ActiveReports.Chart.WallRange
Dim wallRange3 As New DataDynamics.ActiveReports.Chart.WallRange

' set the wall range properties
With wallRange1

.Backdrop = New DataDynamics.ActiveReports.Chart.Graphics.Backdrop(Color.White)

.Border = New DataDynamics.ActiveReports.Chart.Border(New DataDynamics.ActiveReports _
 .Chart.Graphics.Line(Color.Transparent, 0, DataDynamics.ActiveReports.Chart _
 .Graphics.LineStyle.None), 0, Color.Black)
.EndValue = 40
.PrimaryAxis = ((CType(Me.ChartControl1.ChartAreas(0).Axes("AxisY"), DataDynamics _

 .ActiveReports.Chart.Axis)))
.StartValue = 30

End With
With wallRange2

.Backdrop = New DataDynamics.ActiveReports.Chart.Graphics.Backdrop(Color.Lime)

.Border = New DataDynamics.ActiveReports.Chart.Border(New DataDynamics.ActiveReports _
 .Chart.Graphics.Line(Color.Transparent, 0, DataDynamics.ActiveReports.Chart _
 .Graphics.LineStyle.None), 0, Color.Black)
.EndValue = 34
.PrimaryAxis = ((CType(Me.ChartControl1.ChartAreas(0).Axes("AxisY"), DataDynamics _

 .ActiveReports.Chart.Axis)))
.StartValue = 33

End With
With wallRange3

.Backdrop = New DataDynamics.ActiveReports.Chart.Graphics.Backdrop(Color.DarkGreen, _
 CType(150, Byte))
.Border = New DataDynamics.ActiveReports.Chart.Border(New DataDynamics.ActiveReports _

 .Chart.Graphics.Line(Color.Transparent, 0, DataDynamics.ActiveReports.Chart _
 .Graphics.LineStyle.None), 0, Color.Black)
.EndValue = 40
.PrimaryAxis = ((CType(Me.ChartControl1.ChartAreas(0).Axes("AxisZ"), DataDynamics _

 .ActiveReports.Chart.Axis)))
.StartValue = 20

End With

' add the wall ranges to the chart area and set wall and Z axis properties to show lines
With ChartControl1.ChartAreas(0)

.WallRanges.AddRange(New DataDynamics.ActiveReports.Chart.WallRange() {wallRange1, _
 wallRange2, wallRange3})
.WallXY.Backdrop.Alpha = 100
.WallXZ.Backdrop.Alpha = 100
.WallYZ.Backdrop.Alpha = 100
.Axes(4).MajorTick.Step = 20
.Axes(4).Max = 60
.Axes(4).Min = 0
.Axes(4).Visible = True

End With
// C#
// create the wall range objects
DataDynamics.ActiveReports.Chart.WallRange wallRange1 = new DataDynamics.ActiveReports

.Chart.WallRange();
DataDynamics.ActiveReports.Chart.WallRange wallRange2 = new DataDynamics.ActiveReports

.Chart.WallRange();
DataDynamics.ActiveReports.Chart.WallRange wallRange3 = new DataDynamics.ActiveReports

.Chart.WallRange();

// set the wall range properties
wallRange1.Backdrop = new DataDynamics.ActiveReports.Chart.Graphics.Backdrop(System.Drawing

.Color.White);
wallRange1.Border = new DataDynamics.ActiveReports.Chart.Border(new DataDynamics

.ActiveReports.Chart.Graphics.Line(System.Drawing.Color.Transparent, 0, DataDynamics

.ActiveReports.Chart.Graphics.LineStyle.None), 0, System.Drawing.Color.Black);
wallRange1.EndValue = 40;
wallRange1.PrimaryAxis = (DataDynamics.ActiveReports.Chart.Axis)this.ChartControl1

.ChartAreas[0].Axes["AxisY"];
wallRange1.StartValue = 30;
wallRange2.Backdrop = new DataDynamics.ActiveReports.Chart.Graphics.Backdrop(System.Drawing
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.Color.Lime);
wallRange2.Border = new DataDynamics.ActiveReports.Chart.Border(new DataDynamics

.ActiveReports.Chart.Graphics.Line(System.Drawing.Color.Transparent, 0, DataDynamics

.ActiveReports.Chart.Graphics.LineStyle.None), 0, System.Drawing.Color.Black);
wallRange2.EndValue = 34;
wallRange2.PrimaryAxis = (DataDynamics.ActiveReports.Chart.Axis)this.ChartControl1

.ChartAreas[0].Axes["AxisY"];
wallRange2.StartValue = 33;
wallRange3.Backdrop = new DataDynamics.ActiveReports.Chart.Graphics.Backdrop(System.Drawing

.Color.DarkGreen);
wallRange3.Border = new DataDynamics.ActiveReports.Chart.Border(new DataDynamics

.ActiveReports.Chart.Graphics.Line(System.Drawing.Color.Transparent, 0, DataDynamics

.ActiveReports.Chart.Graphics.LineStyle.None), 0, System.Drawing.Color.Black);
wallRange3.EndValue = 40;
wallRange3.PrimaryAxis = (DataDynamics.ActiveReports.Chart.Axis)this.ChartControl1

.ChartAreas[0].Axes["AxisZ"];
wallRange3.StartValue = 20;

// add the wall ranges to the chart area  and set wall and Z axis properties to show lines
this.ChartControl1.ChartAreas[0].WallRanges.AddRange(new DataDynamics.ActiveReports.Chart

.WallRange[] {wallRange1,wallRange2,wallRange3});
this.ChartControl1.ChartAreas[0].WallXY.Backdrop.Alpha = 100;
this.ChartControl1.ChartAreas[0].WallXZ.Backdrop.Alpha = 100;
this.ChartControl1.ChartAreas[0].WallYZ.Backdrop.Alpha = 100;
this.ChartControl1.ChartAreas[0].Axes[4].MajorTick.Step = 20;
this.ChartControl1.ChartAreas[0].Axes[4].Max = 60;
this.ChartControl1.ChartAreas[0].Axes[4].Min = 0;
this.ChartControl1.ChartAreas[0].Axes[4].Visible = true;
 

These topics will introduce you to some basic information about Chart axes and walls.

 

Standard Axes
Learn about the properties and characteristics of standard axes. 

Custom Axes
Learn about how to create custom axes. 

Gridlines and Tick Marks
Learn about using gridlines and tick marks. 

The Chart control provides the means to change axis settings at design time or run time. Chart axes make it 
possible to view and understand the data plotted in a graph.

Chart Axes and Walls

Standard Axes
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Axis Types
Most 2D charts contain a numerical axis (AxisY) and a categorical axis (AxisX). 3D charts include another 
numerical axis (AxisZ). These axes are accessible at run time from the ChartArea object and allow you to 
control the settings for each, including scaling, labels, and various formatting properties. For any of the 
scaling or labeling properties you set to show up at run time, you will need to set the Visible property of the 
axis to True.

Changing Axis Settings
Axis settings can be changed at design time by clicking on a Chart control and using the Properties Window 
or at run time in code from the chart's ChartArea object.

Scaling
For normal linear scaling on a numeric axis, you will need to set the Max and Min properties for the axis, 
which correspond to the numerical values in the chart's data series. You will also need to set the Step 
property of the MajorTick to show the major numerical unit values. The Step property controls where labels 
and/or tick marks are shown on the numerical axis.

' Visual Basic
With Me.ChartControl1.ChartAreas(0).Axes("AxisY")

.Max = 100

.Min = 0

.MajorTick.Step = 10
End With

// C#
this.ChartControl1.ChartAreas[0].Axes["AxisY"].Max = 100;
this.ChartControl1.ChartAreas[0].Axes["AxisY"].Min = 0;
this.ChartControl1.ChartAreas[0].Axes["AxisY"].MajorTick.Step = 10;
The Chart control also supports logarithmic scaling which allows you to show the vertical spacing between 
two points that corresponds to the percentage of change between those numbers. You can set your numeric 
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axis to scale logarithmically by setting the IsLogarithmic property on the axis to True and setting the Max and 
Min properties of the axis. 

Labeling
To show labels on an axis, you will need to specify the value for the LabelsGap property, set your LabelsFont 
properties, and set LabelsVisible to True. These properties can be set in the AxisBase Collection editor, which 
is accessed at design time by clicking the ellipsis button next to the ChartAreas (Collection) property, then 
the Axes (Collection) property of the ChartArea. 

NOTE: Labels render first, and then the chart fills in the remaining area, so be sure to make the 
chart large enough if you use angled labels.

You can specify strings to be used for the labels instead of numerical values on an axis by using the Labels 
collection property at design time or assigning a string array to the Labels property at run time. You can also 
specify whether you want your axis labels to appear on the outside or inside of the axis line using the 
LabelsInside property. By default, labels appear outside the axis line.

Secondary Axes
By default, a Chart object includes secondary X and Y axes (AxisX2 and AxisY2). At design time or run time, 
you can specify a secondary axis to plot data against by setting all of the appropriate properties for AxisX2 or 
AxisY2, including the Visible property. 

If you want to use two axes to show the same data as it appears on two different scales, you can set 
the primary axis to show the actual data value scale, for example, and set the secondary axis to show a 
logarithmic scale.

' Visual Basic
' set properties for AxisY (primary axis)
With Me.ChartControl1.ChartAreas(0).Axes("AxisY")

.Max = 25

.Min = 0

.MajorTick.Step = 5
End With

' set properties for AxisY2 (secondary Y axis)
With Me.ChartControl1.ChartAreas(0).Axes("AxisY2")

.Max = 1000

.Min = 0

.MajorTick.Step = 200
' set the scaling for the secondary axis to logarithmic
.AxisType = DataDynamics.ActiveReports.Chart.AxisType.Logarithmic
.Visible = True

End With

// C#
// set properties for AxisY (primary axis)
this.ChartControl1.ChartAreas[0].Axes["AxisY"].Max = 25;
this.ChartControl1.ChartAreas[0].Axes["AxisY"].Min = 0;
this.ChartControl1.ChartAreas[0].Axes["AxisY"].MajorTick.Step = 5;

// set properties for AxisY2 (secondary Y axis)
this.ChartControl1.ChartAreas[0].Axes["AxisY2"].Max = 1000;
this.ChartControl1.ChartAreas[0].Axes["AxisY2"].Min = 0;
this.ChartControl1.ChartAreas[0].Axes["AxisY2"].MajorTick.Step = 200;
// set the axis type for the secondary axis to logarithmic
this.ChartControl1.ChartAreas[0].Axes["AxisY2"].AxisType = DataDynamics.ActiveReports.Chart

.AxisType.Logarithmic;
this.ChartControl1.ChartAreas[0].Axes["AxisY2"].Visible = true;

The Chart control supports the creation of additional custom axes through the use of the chart's CustomAxes 
collection.  Once a custom axis has been added to the collection, in addition to setting the normal axis 
properties, you will need to set the following properties: 

l Parent - The Parent property allows you to choose the primary or secondary axis on which your custom 

Custom Axes
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axis resides. 

l PlacementLength - The PlacementLength property allows you to set the length of the custom axis in 
proportion to the Min and Max property values you have already set for the parent axis. 

l PlacementLocation - The PlacementLocation property allows you to set the starting location value for the 
custom axis to appear in relation to the parent axis. 

The following code sample demonstrates creating a custom axis, adding it to the Axes collection for the 
ChartArea, and setting its properties.

' Visual Basic 
' create the custom axis and add it to the ChartArea's Axes collection
Dim customAxisY As New DataDynamics.ActiveReports.Chart.CustomAxis
Me.ChartControl1.ChartAreas(0).Axes.Add(customAxisY)

' set the basic axis properties for customAxisY
customAxisY.LabelFont = New DataDynamics.ActiveReports.Chart.FontInfo(Color.Red, New Font _

("Arial", 7.0!))
customAxisY.LabelsGap = 1
customAxisY.LabelsVisible = True
customAxisY.Line = New DataDynamics.ActiveReports.Chart.Graphics.Line(Color.Red)
customAxisY.MajorTick = New DataDynamics.ActiveReports.Chart.Tick(New DataDynamics _

.ActiveReports.Chart.Graphics.Line(Color.Red, 1), New DataDynamics.ActiveReports.Chart _

.Graphics.Line(Color.Red, 1), 1, 2.0F, True)
customAxisY.MajorTick.GridLine = New DataDynamics.ActiveReports.Chart.Graphics.Line(Color _

.Red, 1, LineStyle.Solid)
customAxisY.MajorTick.Visible = True
customAxisY.Max = 5
customAxisY.MaxDerived = False
customAxisY.Min = 0
customAxisY.Visible = True

' set the special custom axis properties
customAxisY.Parent = ((CType(Me.ChartControl1.ChartAreas(0).Axes("AxisY"), DataDynamics _

.ActiveReports.Chart.Axis)))
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customAxisY.PlacementLength = 20
customAxisY.PlacementLocation = 30

// C#
// create the custom axis and add it to the ChartArea's Axes collection
DataDynamics.ActiveReports.Chart.CustomAxis customAxisY = new DataDynamics.ActiveReports

.Chart.CustomAxis();
this.ChartControl1.ChartAreas[0].Axes.Add(customAxisY);

// set the basic axis properties for customAxisY
customAxisY.LabelFont = new DataDynamics.ActiveReports.Chart.FontInfo(Color.Red, new Font

("Arial", 7F, FontStyle.Regular, GraphicsUnit.Point, ((System.Byte)(0))));
customAxisY.LabelsGap = 1;
customAxisY.LabelsVisible = true;
customAxisY.Line = new DataDynamics.ActiveReports.Chart.Graphics.Line(Color.Red);
customAxisY.MajorTick = new DataDynamics.ActiveReports.Chart.Tick(new DataDynamics

.ActiveReports.Chart.Graphics.Line(Color.Red, 1), new DataDynamics.ActiveReports.Chart

.Graphics.Line(Color.Red, 1), 1, 2F, true);
customAxisY.MajorTick.GridLine = new DataDynamics.ActiveReports.Chart.Graphics.Line(Color

.Red, 1, LineStyle.Solid);
customAxisY.MajorTick.Visible = true;
customAxisY.Max = 5;
customAxisY.MaxDerived = false;
customAxisY.Min = 0;
customAxisY.Visible = true;

// set the special custom axis properties
customAxisY.Parent = (DataDynamics.ActiveReports.Chart.Axis)this.ChartControl1.ChartAreas[0]

.Axes["AxisY"];
customAxisY.PlacementLength = 20;
customAxisY.PlacementLocation = 30;
 

Gridlines and tick marks are generally used to help increase the readability of a chart. 

Grid lines and Tick Marks
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Types
There are two kinds of gridlines and tick marks in the Chart control: major and minor. The properties for the 
major gridlines and tick marks are set on the MajorTick object of the particular axis and the properties for 
minor gridlines and ticks are set on the MinorTick object of the axis. The location for any labels shown for the 
axis are determined by the Step property of the MajorTick object.

Step and TickLength
For either the MajorTick or MinorTick objects, you can define where the tick marks and gridlines will appear 
by setting the Step property. The TickLength property allows you to set how far outside of the axis line the 
tick mark will extend. 

Visible
To make any defined major or minor tick marks to show up at design time or run time, the Visible property of 
the MajorTick or MinorTick object must be set to True. To show major or minor gridlines at design time or run 
time, the Visible property of the WallXY object as well as that of the MajorTick or MinorTick object must be 
set to True.

 

These topics introduce you to some basic information about bound and unbound data support in the Chart 
control.

 

Bound Data
Learn about data binding with the Chart control. 

Chart Data
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Unbound Data
Learn how to use unbound data. 

Calculated and Sequence Series
Learn about using calculated and sequence series in the Chart control. 

NOTE: The Chart control has its own data source which is distinct from the report data source.  To 
access the chart's data source, click the Data Source. hyperlink which appears below the Properties 
window when the chart is selected on the report.

The Chart control provides several ways to bind your charts to data at design time.

Adding Data with the Wizard
To open the Chart Wizard, click the Wizard verb below the Properties window. In the Chart Wizard, once you 
have added a series, you can create a data adapter to contain the data for your chart, if needed. When a 
data source is available, the Value X and Y values can be set for the series in the chart wizard from the 
expressions and/or data columns retrieved from the data source.

Adding Data with the Chart Designer
Once a data source is set up, you can easily bind data to a series using the Chart Designer. To open the 
Chart Designer, click the Customize verb below the Properties window. Choose the Series section on the left, 
and on the General tab, after a series has been added to the chart, set the ValueY property by selecting the 
name of the data expression you wish to assign to the series.

Data Bound Charts
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Adding Data through the Chart Data Source Dialog
To set the data source for the chart through the Chart Data Source dialog, click the DataSource verb below 
the Properties Window.
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After the DataSource for the chart is set, add a series to the chart. To do this, open the Series Collection 
Editor dialog by clicking the ellipsis button which appears when you click next to the Series property in the 
Properties Window, then click the "Add" button. To bind the series to an expression or dataset column 
returned by your data source, set the ValueMembersY or ValueMembersX property of the series by selecting 
it from the drop-down list.
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The Chart control makes it easy to set the data source for a chart control, series, or data points collection at 
run time.

Below is a list of objects that can be used as data sources.

l dataset 

l dataset Column 

l Data Table 

l SqlCommand/OleDbCommand 

l SqlDataAdapter/OleDbDataAdapter 

l Array 

 

Below are some examples of binding to different data sources at run time.

dataset
The Chart control's DataSource property can be set to a dataset at run time. The following code 
demonstrates setting up a dataset, setting the DataSource property to the dataset, creating a series, and 
setting the ValueMembersY property to the dataset expression at run time.

' Visual Basic
' create the series
Dim s As New DataDynamics.ActiveReports.Chart.Series
Dim m_cnnString As String = "Provider=Microsoft.Jet.OLEDB.4.0;Data Source=C:/Northwind.mdb; _

Persist Security Info=False"

Unbound Charts
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Dim m_cnn As New System.Data.OleDb.OleDbConnection(m_cnnString)
Dim oDBAdapter As System.Data.OleDb.OleDbDataAdapter

' create the dataset
Dim oDS As DataSet
oDBAdapter = New System.Data.OleDb.OleDbDataAdapter("SELECT ShipCountry, SUM(Freight) AS _

Expr1 FROM Orders GROUP BY ShipCountry", m_cnnString)
oDS = New DataSet
oDBAdapter.Fill(oDS, "Expr1")

' set the DataSource and ValueMembersY properties
Me.ChartControl1.DataSource = oDS
s.ValueMembersY = "Expr1"

Me.ChartControl1.Series.Add(s)
 

// C#
// create the series
DataDynamics.ActiveReports.Chart.Series s = new DataDynamics.ActiveReports.Chart.Series();
string m_cnnString = "Provider=Microsoft.Jet.OLEDB.4.0;Data Source=C:/Northwind.mdb;Persist 

Security Info=False";   
System.Data.OleDb.OleDbConnection m_cnn = new System.Data.OleDb.OleDbConnection(m_cnnString);       
System.Data.OleDb.OleDbDataAdapter oDBAdapter;

// create the dataset
System.Data.DataSet oDS;
oDBAdapter = new System.Data.OleDb.OleDbDataAdapter("SELECT ShipCountry, SUM(Freight) AS 

Expr1 FROM Orders GROUP BY ShipCountry", m_cnnString);
oDS = new System.Data.DataSet();
oDBAdapter.Fill(oDS, "Expr1");

// set the DataSource and ValueMembersY properties
this.ChartControl1.DataSource = oDS;
s.ValueMembersY = "Expr1";

this.ChartControl1.Series.Add(s);

dataset Column
In the Chart control, the ValueMembersX and ValueMembersY properties of a series can be set to a dataset 
column. The following code demonstrates creating a series, setting up a dataset, setting the DataSource 
property to the dataset, and setting the ValueMembersY and ValueMembersX properties to dataset columns 
at run time.

' Visual Basic
' create the series
Dim s As New DataDynamics.ActiveReports.Chart.Series
Dim m_cnnString As String = "Provider=Microsoft.Jet.OLEDB.4.0;Data Source=C:/Northwind.mdb; _

Persist Security Info=False"
Dim m_cnn As New System.Data.OleDb.OleDbConnection(m_cnnString)
Dim oDBAdapter As System.Data.OleDb.OleDbDataAdapter

' create the dataset
Dim oDS As DataSet
oDBAdapter = New System.Data.OleDb.OleDbDataAdapter("SELECT * from Orders WHERE OrderDate _

< #08/17/1994#", m_cnnString)
oDS = New DataSet
oDBAdapter.Fill(oDS, "Orders")

' set the DataSource, ValueMembersY, and ValueMembersX properties
Me.ChartControl1.DataSource = oDS
Me.ChartControl1.Series.Add(s)
Me.ChartControl1.Series(0).ValueMembersY = oDS.Tables("Orders").Columns(7).ColumnName
Me.ChartControl1.Series(0).ValueMemberX = oDS.Tables("Orders").Columns(8).ColumnName
 

// C#
// create the series
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DataDynamics.ActiveReports.Chart.Series s = new DataDynamics.ActiveReports.Chart.Series();
string m_cnnString = "Provider=Microsoft.Jet.OLEDB.4.0;Data Source=C:/Northwind.mdb;Persist 

Security Info=False";   
System.Data.OleDb.OleDbConnection m_cnn = new System.Data.OleDb.OleDbConnection(m_cnnString);       
System.Data.OleDb.OleDbDataAdapter oDBAdapter;

// create the dataset
System.Data.DataSet oDS;
oDBAdapter = new System.Data.OleDb.OleDbDataAdapter("SELECT * from Orders WHERE OrderDate 

< #08/17/1994#", m_cnnString);
oDS = new System.Data.DataSet();
oDBAdapter.Fill(oDS, "Orders");

// set the DataSource, ValueMembersY, and ValueMembersX properties
this.ChartControl1.DataSource = oDS;
this.ChartControl1.Series.Add(s);
this.ChartControl1.Series[0].ValueMembersY = oDS.Tables["Orders"].Columns[7].ColumnName;
this.ChartControl1.Series[0].ValueMemberX = oDS.Tables["Orders"].Columns[8].ColumnName;

Data Command
A chart's data source can be set to a SqlCommand or OleDbCommand. The following code demonstrates 
creating a series, creating an OleDbCommand, setting the DataSource property to the data command, and 
setting the ValueMembersY property for the series at run time.

' Visual Basic        
' create the series
Dim s As New DataDynamics.ActiveReports.Chart.Series
Dim m_cnnString As String = "Provider=Microsoft.Jet.OLEDB.4.0;Data Source=C:/Northwind.mdb; _

Persist Security Info=False"
Dim m_cnn As New System.Data.Oledb.OleDbConnection(m_cnnString)
Dim query As String = "SELECT ShipCountry, SUM(Freight) AS Expr1 FROM Orders GROUP BY _

ShipCountry"

' create the OleDbCommand and open the connection
Dim command As New System.Data.Oledb.OleDbCommand(query, m_cnn)
command.Connection.Open()

' set the DataSource and ValueMembersY properties
Me.ChartControl1.DataSource = command
Me.ChartControl1.Series.Add(s)
Me.ChartControl1.Series(0).ValueMembersY = "Expr1"

' close the connection
m_cnn.Close()

// C#
// create the series
DataDynamics.ActiveReports.Chart.Series s = new DataDynamics.ActiveReports.Chart.Series();
string m_cnnString = "Provider=Microsoft.Jet.OLEDB.4.0;Data Source=C:/Northwind.mdb;Persist 

Security Info=False";   
System.Data.Oledb.OleDbConnection m_cnn = new System.Data.Oledb.OleDbConnection(m_cnnString);       
string query = "SELECT ShipCountry, SUM(Freight) AS Expr1 FROM Orders GROUP BY ShipCountry";

// create the OleDbCommand and opent the connection
System.Data.Oledb.OleDbCommand command = new System.Data.Oledb.OleDbCommand(query, m_cnn);
command.Connection.Open();

// set the DataSource and ValueMembersY properties
this.ChartControl1.DataSource = command;
this.ChartControl1.Series.Add(s);
this.ChartControl1.Series[0].ValueMembersY = "Expr1";

// close the connection         
m_cnn.Close();

Array
The Chart control allows the data source for the data points collection to be set to an array. The following 
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code demonstrates creating a series, creating an array, and using the DataBindY method to set the data 
source for the data points collection at run time.

' Visual Basic
' create the series
Dim s As New DataDynamics.ActiveReports.Chart.Series

' create the array
Dim a As Double() = {1, 4, 2, 6, 3, 3, 4, 7}

' set the data source for the data points collection
Me.ChartControl1.Series.Add(s)
Me.ChartControl1.Series(0).Points.DataBindY(a)
 

// C#
// create the series
DataDynamics.ActiveReports.Chart.Series s = new DataDynamics.ActiveReports.Chart.Series();

// create the array
double [] a = {1,4,2,6,3,3,4,7};

// set the data source for the data points collection
this.ChartControl1.Series.Add(s);
this.ChartControl1.Series[0].Points.DataBindY(a);
 

The Chart control allows you to bind a formula to the ValueMembersY property of a series to create a 
calculated or sequence series for your chart.

Calculated Series
You can easily create a calculated series based on the values of one or more series by setting the 
ValueMembersY property of a series to a formula. To reference a series in the formula, use the name of the 
series. The following code demonstrates creating two series, one bound to a data array and the other bound 
to a formula based on the Y values of the first series.

' Visual Basic
Dim s As New DataDynamics.ActiveReports.Chart.Series
Dim cS As New DataDynamics.ActiveReports.Chart.Series
Dim a As Double() = {1, 4, 2, 6, 3, 3, 4, 7}

Me.ChartControl1.Series.AddRange(New DataDynamics.ActiveReports.Chart.Series() {s, cS})
Me.ChartControl1.Series(0).Points.DataBindY(a)
Me.ChartControl1.Series(0).Name = "Series1"
Me.ChartControl1.Series(1).ValueMembersY = "Series1.Y[0]+10"
 

// C#
DataDynamics.ActiveReports.Chart.Series s = new DataDynamics.ActiveReports.Chart.Series();
DataDynamics.ActiveReports.Chart.Series cS = new DataDynamics.ActiveReports.Chart.Series();
double [] a = { 1,4,2,6,3,3,4,7};
 
this.ChartControl1.Series.AddRange(new DataDynamics.SharpGraph.Windows.Series[] {s, cS});
this.ChartControl1.Series[0].Name = "Series1";
this.ChartControl1.Series[0].Points.DataBindY(a);
this.ChartControl1.Series[1].ValueMembersY = "Series1.Y[0]+10";

Sequence Series
Set a sequence series by specifying the minimum value, maximum value, and step for the series. The 
following code shows how to set the ValueMembersY property at run time to create a sequence series.

' Visual Basic
Dim s As New DataDynamics.ActiveReports.Chart.Series

Calculated and Sequence Series Charts
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Me.ChartControl1.Series.Add(s)
Me.ChartControl1.Series(0).ValueMembersY = "sequence(12,48,4)"
 

// C#
DataDynamics.ActiveReports.Chart.Series s = new DataDynamics.ActiveReports.Chart.Series();
this.ChartControl1.Series.Add(s);
this.ChartControl1.Series[0].ValueMembersY = "sequence(12,48,4)";

Each chart type in the ActiveReports Chart control contains specific properties that apply to it. Set the chart 
type and chart-specific properties in the Series Collection Editor dialog box accessed through the Series 
property in the property grid and in the DataPoint Collection dialog box accessed through the Points property 
in the Series dialog box.

Chart-Specific Properties
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When a specific property is set on the Series object, it is applied to all data points objects in the series unless 
a different value for the property has been set on a specific data point. In that case, the data point property 
setting overrides the series property setting for that particular data point. Note that for charts bound to a 
data source, you do not have access to the DataPoint collection in the dialog.

Setting chart-specific properties at design time
To set custom properties for a chart at design time, set the Properties attribute of the series or data points 
object from the Visual Studio .NET Properties Window by clicking on the Series (Collection) property and 
opening the Series Collection Editor dialog. 

Note: If you specify the value for any of the custom properties, this value is not cleared when 
you change the ChartType. Although this will show properties that do not apply to certain ChartTypes, 
it has the advantage of keeping your settings in case you accidentally change the ChartType.

Setting chart-specific properties at run time
To set custom properties for a chart at run time on the series, reference the series by name or index and use 
the string Properties attribute name you wish to set. 

' Visual Basic
' Sets the shape for bubbles on a bubble chart to diamond
Me.ChartControl1.Series(0).Properties("Shape") = Chart.MarkerStyle.Diamond
// C#
// Sets the shape for bubbles on a bubble chart to diamond
this.ChartControl1.Series[0].Properties["Shape"] = DataDynamics.ActiveReports.Chart 

.MarkerStyle.Diamond;
To set custom properties for a chart at run time on the data points object, reference the series by name or 
index, reference the data point by index and use the string Properties attribute name you wish to set. 

' Visual Basic
' Sets the explode factor on a doughnut chart for the second point in the series
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Me.ChartControl1.Series(0).Points(1).Properties("ExplodeFactor") = 0.5F
// C#
// Sets the explode factor on a doughnut chart for the second point in the series
this.ChartControl1.Series[0].Points[1].Properties["ExplodeFactor"] = .5f; 

Chart Standard Properties
l Backdrop: Gets or sets the backdrop information for the series. Does not apply to Bezier, Line, LineXY, 

Line3D, PlotXY, or Scatter charts. 

l BorderLine: Gets or sets the line information used to draw the border of the series. Does not apply to 
Bezier, Line, LineXY, PlotXY, or Scatter charts. 

l Line: Gets or sets the line information for the series. Only applies to Bezier, Line, and LineXY charts. 

l Marker: Gets or sets the ToolTip settings for the series. 

l ToolTip: Gets or sets the ToolTip information for the series. 
 

Charts and Custom Properties
l Area (none)   

l Area3D

¡ LineBackdrop Gets or sets the backdrop information for the 3D line. 

¡ Thickness Gets or sets the thickness of the 3D line. 

¡ Width Gets or sets the width of the 3D line. 

l Bar2D

¡ Gap Gets or sets the space between the bars of each X axis value. 

l Bar3D

¡ BarTopPercent Gets or sets the percentage of the top of the bar that is shown for Cone or Custom 
BarTypes. 

¡ BarType Gets or sets the type of bars that are displayed. Values are Bar, Cylinder, Cone, Pyramid, 
and Custom. 

¡ Gap Gets or sets the space between the bars of each X axis value. 

¡ PointBarDepth Gets or sets the thickness of the 3D bar. 

¡ RotationAngle Gets or sets the starting horizontal angle for custom 3D bar shapes. Can only be 
used with the Custom BarType. 

¡ VertexNumber Gets or sets the number of vertices for the data point, used to create custom 3D bar 
shapes. Can only be used with the Custom BarType. Bars must contain 3 or more vertices. 

l Bezier (none) 

l Bubble

¡ MaxSizeFactor Gets or sets the maximum size of the bubble radius. Values must be less than or 
equal to 1. Default is .25. 

¡ MaxValue Gets or sets the bubble size that is used as the maximum. 

¡ MinValue Gets or sets the bubble size that is used as the minimum. 

¡ Shape Gets or sets the shape of the bubbles. Uses or returns a valid MarkerStyle enumeration value. 

l BubbleXY

¡ MaxSizeFactor Gets or sets the maximum size of the bubble radius. Values must be less than or 
equal to 1. Default is .25. 

¡ MaxValue Gets or sets the bubble size that is used as the maximum. 

¡ MinValue Gets or sets the bubble size that is used as the minimum. 

¡ Shape Gets or sets the shape of the bubbles. Uses or returns a valid MarkerStyle enumeration value. 

l Candle

¡ BodyDownswingBackdrop Gets or sets the backdrop information used to fill the downswing 
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rectangle. 

¡ BodyUpswingBackdrop Gets or sets the backdrop information used to fill the upswing rectangle. 

¡ BodyWidth Gets or sets the width of the rectangle used to show upswing or downswing. 

¡ Wickline Gets or sets the line information for the wick line.

l ClusteredBar

¡ BarTopPercent Gets or sets the percentage of the top of the bar that is shown for Cone or Custom 
BarTypes. 

¡ BarType Gets or sets the type of bars that are displayed. Values are Bar, Cylinder, Cone, Pyramid, 
and Custom. 

¡ Gap Gets or sets the space between the bars of each X axis value. 

¡ PointBarDepth Gets or sets the thickness of the 3D bar. 

¡ RotationAngle Gets or sets the starting horizontal angle for custom 3D bar shapes. Can only be 
used with the Custom BarType. 

¡ VertexNumber Gets or sets the number of vertices for the data point, used to create custom 3D bar 
shapes. Can only be used with the Custom BarType. Bars must contain 3 or more vertices. 

l Doughnut 

¡ ExplodeFactor Gets or sets the amount of separation between data point values. The value must be 
less than or equal to 1. To explode one section of the doughnut chart, set ExplodeFactor on the data 
point instead of on the series. 

¡ HoleSize Gets or sets the inner radius of the chart. If set to 0, the chart looks like a pie chart. The 
value must be less than or equal to 1. 

¡ OutsideLabels Gets or sets a value indicating whether the data point labels appear outside the 
chart.

¡ StartAngle Gets or sets the horizontal start angle for the series.

l Doughnut3D 

¡ ExplodeFactor Gets or sets the amount of separation between data point values. The value must be 
less than or equal to 1. To explode one section of the doughnut chart, set ExplodeFactor on the data 
point instead of on the series. 

¡ HoleSize Gets or sets the inner radius of the chart. If set to 0, the chart looks like a pie chart. The 
value must be less than or equal to 1. 

¡ OutsideLabels Gets or sets a value indicating whether the data point labels appear outside the 
chart. 

¡ StartAngle Gets or sets the horizontal start angle for the series data points. 

l Funnel

¡ BaseStyle Gets or sets a circular or square base drawing style for the 3D funnel chart. This property 
can only be with the Projection property set to Orthogonal. 

¡ CalloutLine Gets or sets the style for a line connecting the marker label to its corresponding funnel 
section. The default value is a black one-point line. 

¡ FunnelStyle Gets or sets the Y value for the series points to the width or height of the funnel. The 
default value is YIsHeight. 

¡ MinPointHeight Gets or sets the minimum height allowed for a data point in the funnel chart. The 
height is measured in relative coordinates. 

¡ NeckHeight Gets or sets the neck height for the funnel chart. This property can only be used with 
the FunnelStyle property set to YIsHeight. The default value is 5. 

¡ NeckWidth Gets or sets the neck width for the funnel chart. This property can only be used with the 
FunnelStyle property set to YIsHeight. The default value is 5. 

¡ OutsideLabels Gets or sets a value indicating whether the labels are placed outside of the funnel 
chart. The default value is True. 

¡ OutsideLabelsPlacement Gets or sets a value indicating whether the data point labels appear on 
the left or right side of the funnel. This property can only be used with the OutsideLabels property set 
to True. 

ActiveReports for .NET 3 User Guide | 98



¡ PointGapPct Gets or sets the amount of space between the data points of the funnel chart. The 
PointGapPct is measured in relative coordinates. The default value is 0, and valid values range from 0 
to 100. 

¡ RotationAngle Gets or sets the left-to-right rotation angle of the funnel. The valid values range from 
-180 to 180 degrees. This property is only effective with the Projection property set to Orthogonal 
and the BaseStyle property set to SquareBase.

l Gantt

¡ Gap Gets or sets the space between the bars of each X axis value. 

l HiLo

¡ HiLoLine Gets or sets the line information for the hi-lo line. 

l HiLoOpenClose

¡ HiLoLine Gets or sets the line information for the hi-lo line. 

¡ CloseLine Gets or sets the line information for the close line. 

¡ OpenLine Gets or sets the line information for the open line. 

¡ TickLen Gets or sets the length of the tick for the open and close lines.

l HorizontalBar

¡ Gap Gets or sets the space between the bars of each X axis value.

l HorizontalBar3D

¡ BarTopPercent Gets or sets the percentage of the top of the bar that is shown for Cone or Custom 
BarTypes. 

¡ BarType Gets or sets the type of bars that are displayed. Values are Bar, Cylinder, Cone, Pyramid, 
and Custom. 

¡ Gap Gets or sets the space between the bars of each X axis value. 

¡ PointBarDepth Gets or sets the thickness of the 3D bar.

l Kagi

¡ BodyDownswingBackdrop Gets or sets the style and color settings for the three-dimensional side 
view of downswing Kagi lines. This property is only available with the Kagi 3D chart type, and is only 
effective when the Width property is set to a value higher than 25. 

¡ BodyUpswingBackdrop Gets or sets the style and color settings for the three-dimensional side view 
of upswing Kagi lines. This property is only available with the Kagi 3D chart type, and is only effective 
when the Width property is set to a value higher than 25. 

¡ DownswingLine Gets or sets the style and color settings to use for a Kagi line which charts a price 
decrease. 

¡ ReversalAmount Gets or sets the amount that a price must shift in order for the Kagi line to change 
direction. 

¡ UpswingLine Gets or sets the style and color settings to use for a Kagi line which charts a price 
increase. 

¡ Width Gets or sets the width of the three-dimensional side view of the Kagi lines.This property is 
only available with the Kagi 3D chart type, and must be set higher than its default value of 1 in order 
to display body downswing and upswing backdrops.

l Line (none) 

l Line3D

¡ LineBackdrop Gets or sets the backdrop information for the 3D line. 

¡ Thickness Gets or sets the thickness of the 3D line. 

¡ Width Gets or sets the width of the 3D line. 

l LineXY (none) 

l PlotXY (none) 

l Point and Figure

¡ BoxSize Gets or sets the amount a price must change in order to create another X or O. 
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¡ DownswingLine Gets or sets the style and color settings for the downswing Os. 

¡ ReversalAmount Gets or sets the amount that a price must shift in order for a new column to be 
added. 

¡ UpswingLine Gets or sets the style and color settings for the upswing Xs.

l Pyramid

¡ BaseStyle Gets or sets a circular or square base drawing style for the 3D pyramid chart. This 
property can only be with the Projection property set to Orthogonal. 

¡ MinPointHeight Gets or sets the minimum height allowed for a data point in the pyramid chart. The 
height is measured in relative coordinates. 

¡ OutsideLabels Gets or sets a value indicating whether the labels are placed outside of the pyramid 
chart. The default value is True. 

¡ OutsideLabelsPlacement Gets or sets a value indicating whether the data point labels appear on 
the left or right side of the pyramid. This property can only be used with the OutsideLabels property 
set to True. 

¡ PointGapPct Gets or sets the amount of space between the data points of the pyramid chart. The 
PointGapPct is measured in relative coordinates. The default value is 0, and valid values range from 0 
to 100. 

¡ RotationAngle Gets or sets the left-to-right rotation angle of the pyramid. The valid values range 
from -180 to 180 degrees. This property is only effective with the Projection property set to 
Orthogonal and the BaseStyle property set to SquareBase.

l Renko

¡ BodyDownswingBackdrop Gets or sets the style and color settings for the downswing bricks. 

¡ BodyUpswingBackdrop Gets or sets the style and color settings for the upswing bricks. 

¡ BoxSize Gets or sets the amount a price must change in order to create another brick. 

l Scatter (none) 

l StackedArea (none) 

l StackedBar

¡ Gap Gets or sets the space between the bars of each X axis value. 

l StackedBar3D

¡ BarTopPercent Gets or sets the percentage of the top of the bar that is shown for Cone or Custom 
BarTypes. 

¡ BarType Gets or sets the type of bars that are displayed. Values are Bar, Cylinder, Cone, Pyramid, 
and Custom. 

¡ Gap Gets or sets the space between the bars of each X axis value. 

¡ VertexNumber Gets or sets the number of vertices for the data point, used to create custom 3D bar 
shapes. Can only be used with the Custom BarType. Bars must contain 3 or more vertices. 

l StackedArea100Pct (none) 

l StackedBar100Pct

¡ Gap Gets or sets the space between the bars of each X axis value.

l StackedBar3D100Pct

¡ BarTopPercent Gets or sets the percentage of the top of the bar that is shown for Cone or Custom 
BarTypes. 

¡ BarType Gets or sets the type of bars that are displayed. Values are Bar, Cylinder, Cone, Pyramid, 
and Custom. 

¡ Gap Gets or sets the space between the bars of each X axis value. 

¡ VertexNumber Gets or sets the number of vertices for the data point, used to create custom 3D bar 
shapes. Can only be used with the Custom BarType. Bars must contain 3 or more vertices. 

l Three Line Break

¡ BodyDownswingBackdrop Gets or sets the style and color settings for the downswing boxes. 
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¡ BodyUpswingBackdrop Gets or sets the style and color settings for the upswing boxes. 

¡ NewLineBreak Gets or sets the amount that a price must shift in order for the direction to change. 
The default value is 3. 

The chart control features an easy-to-use wizard. The chart wizard automatically runs when you first add a 
chart control to a report. If you prefer not to have the wizard run automatically, uncheck the Auto Run 
Wizard checkbox at the bottom of the wizard. You can also access the wizard through the Wizard verb  that 
appears below the Properties window when the chart is selected on the report.

ActiveReports Section Events
In a report, regardless of the type or content of the various sections, there are three events for each section: 
Format, BeforePrint and AfterPrint. 

Because there are many possible report designs, the event-raising sequence must be dynamic in order to 
accommodate individual report demands. 

Out of the three events, the Format event generally is used the most often, followed by the BeforePrint event 
and, in rare circumstances, the AfterPrint event. 

Note: You should never reference the report's Fields collection in these section events. The 
DataInitialize and FetchData events are the only events in which the Fields collection should ever be 
referenced.

Format event
This event is raised after the data is loaded and bound to the controls contained in a section, but before the 
section is rendered to a page.

Chart Wizard

Section Events
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The Format event is the only event where the section's height may be changed. This section may be used to 
set or change the properties of any controls or load subreport controls with subreports.

If the CanGrow or CanShrink property of any control contained within a section, or the section itself, is set to 
True, all of the growing and shrinking of controls contained in this section, and the section itself, takes place 
in the Format event. Because of this, information about a control or a section's height cannot be obtained in 
this event.

BeforePrint event
This event is raised before the section is rendered to the page. 

The growing and shrinking of the section and all controls contained in a section have already taken place by 
the time this event is raised. Use this section to resize any controls if needed.

Since all controls and section growth have already taken place by the time this event is raised, the event may 
be used to get an accurate height of the section, or, if needed, any controls contained in it. Any controls in 
the BeforePrint event may be resized but not the height of the section itself.

AfterPrint event
This event is raised after the section is rendered to the page.

Although AfterPrint was an important event prior to ActiveReports Version 1 Service Pack 3, it is rarely used 
in any of the newer builds of ActiveReports. When you place code in the section events, you likely will place 
your code in either the Format event or the BeforePrint event. This event is still useful for drawing on the 
page after text has already been rendered to the page.

ActiveReports Events

Events that are Raised Only Once
The following events are all of the events that are raised only once during a report's processing. These 
events are raised at the beginning and at the end of the report processing cycle. 

ReportStart 
This event is raised before the DataInitialize event. Use this event to initialize any objects or variables needed 
while running a report. Also use this event to set any Subreport control objects to a new instance of the 
report assigned to the Subreport control. Do not add items dynamically to a report once this event has 
finished. 

DataInitialize 
This event is raised after ReportStart. Use it to add custom fields to the report's Fields collection. Custom 
fields can be added to a bound report (one that uses a Data Control to connect and retrieve records) or an 
unbound report (one that does not depend on a data control to get its records). In a bound report the dataset 
is opened and the dataset fields are added to the custom fields collection, then the DataInitialize event 
is raised so new custom fields can be added. The DataInitialize event can also be used to make adjustments 
to the DataSource or to set up database connectivity. 

ReportEnd 
This event is raised after the report finishes processing. Use this event to close or free any objects that you 
were using while running a report in unbound mode, or to display information or messages to the end user. 
This event can also be used to export reports. 

Events that are Raised Multiple Times
The following ActiveReports events are raised multiple times during a report's processing. 

FetchData 
This event is raised every time a new record is processed. The FetchData has an EOF parameter indicating 
whether the FetchData event should be raised. This parameter is not the same as the Recordset's EOF 
property and is defaulted to True. When working with bound reports (reports using a DataControl), the EOF 

Sequence of Events
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parameter is automatically set by the report; however, when working with unbound reports this parameter 
needs to be controlled manually. 

Use the FetchData event with unbound reports to set the values of custom fields that were added in the 
DataInitialize event or with bound reports to perform special functions, such as combining fields together or 
performing calculations. The FetchData event should not have any references to controls on the report. 

If you need to use a value from a Dataset with a control in the Detail section, set a variable in the FetchData 
event and use the variable in the section's Format event to set the value for the control. Please note that this 
method of setting a variable in the FetchData event and using it to set a control's value is only supported in 
the Detail_Format event.

Also use the FetchData event to increment counters when working with arrays or collections. 

PageStart 
This event fires before a page is rendered. Use this event to initialize any variables needed for each page 
when running an unbound report. 

PageEnd 
This event is raised after each page in the report is rendered. Use this event to update any variables needed 
for each page when running an unbound report. 

Section Events
There are three events that are raised for each section, regardless of its type or content. The sequence of 
these events depends on the summary objects and their section dependencies. The only guaranteed 
sequence is that a section's Format event is raised before the BeforePrint event, which in turn occurs before 
the AfterPrint event but not necessarily all together. Reports should not be designed to rely on these 
events being raised in immediate succession. Never access a report's Fields collection in any of these section 
events, but rather in the DataInitialize and FetchData events.

Format 
This event is raised after data is loaded and bound to the fields but before the section is laid out for printing. 
Use this event to modify the layout of a section or any of the controls in the section. This is the only event in 
which a section's height can be changed. Also use the Format event to pass information, such as an SQL 
String, to a Subreport. Because a section's height is unknown until the Format event finishes, it is possible 
for a section's Format event to be raised while the report is on a page to which the section is not rendered. 
For example, the Detail_Format event is raised but the section is too large to fit on the page. This causes the 
PageFooter event and the PageEnd event to be raised on the current page, and the PageStart, any other 
Header events, and possibly the FetchData event to be raised before the section is rendered to the canvas on 
the next page. 

BeforePrint 
This event is raised before the section is rendered to the page. You can use this event to modify the values of 
the controls before they are printed. Any changes made here will not affect the height of the section. We 
recommend that you do NOT access any fields in a DataSource's dataset in this event. Also use this event to 
do page specific formatting since the report knows which page the section will be rendered to when this event 
is raised. Once this event has finished, the section cannot be changed in any way because the section is 
rendered to the canvas immediately after this event is raised. 

AfterPrint 
This event is raised after the section is rendered to the canvas object. You can use this event to draw directly 
to the canvas. Do not use the AfterPrint event to make any changes to the section since the section has 
already been rendered to the canvas at this point.

When Bound and Unbound Data Values are Set
1. The Fields collection is populated from the dataset that is bound to the report after the DataInitialize 

event is raised. (In an unbound report, the Fields collection values are not set to anything at this point.) 

2. The FetchData event is raised, giving the user a chance to modify the Fields collection. 

3. Any fields that are bound have the values transferred over. 

4. The Format event is raised.
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Using Hyperlinks in ActiveReports
ActiveReports for .NET 3.0 allows you to add hyperlinks to reports to perform a variety of functions. You can 
set the HyperLink property to any HTML-style link, items in the Bookmarks collection (TOC), or use it to 
simulate drill-down reporting. By using the HyperLink property, reports can have "clickable" controls that can 
be used for many purposes, including the ability to run and display other reports. When a control that has its 
HyperLink property set to an item in the Bookmarks collection or a Web link is clicked, ActiveReports will 
display the link as a new tab within the Viewer object. When a link that is not TOC or Web related, such as an 
e-mail link, the Viewer will shell the link out to the operating system. Thus, e-mail links will not open as a 
new tab within the Viewer but as a separate window. 

To add a hyperlink to a report at design time, click on the appropriate control within the 
ActiveReport designer and set the HyperLink property for it at the Properties grid.

 

The following code snippets demonstrate how to set the HyperLink property of a TextBox control to point to 
available links.

To point to a TOC entry

txtEntry.HyperLink = "toc://" + BookmarksCollection(iEntry - 1).Label

To point to a Web link

txtWebsite.HyperLink = "www.datadynamics.com"

To point to a e-mail link

txtMail.HyperLink = "mailto:support@companyname.com"

Hyperlinks

Inheritance
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ActiveReports can be used to create a base class as a template from which other reports can inherit. A very 
simple example of how this functionality may be used is the creation of a company letterhead template.  To 
do this, create a LetterHead class with code like the following.

 

[C#]
using DataDynamics.ActiveReports;
using DataDynamics.ActiveReports.Document;
namespace InheritanceCS
{

/// <summary>
/// Summary description for LetterHead.
/// The LetterHead class is to be used with reports having only a Detail section.
/// </summary>
public class LetterHead : ActiveReport //Tell the letterhead class to inherit from AR
{

public LetterHead()
{

//
// TODO: Add constructor logic here
//

}
protected void InitializeLetterhead()
{

//create sections and controls for the letterhead
PageHeader ph = new PageHeader();
PageFooter pf = new PageFooter();
Picture p = new Picture();
Label l = new Label();
Label l2 = new Label();
//set properties on sections and controls
ph.BackColor = System.Drawing.Color.Gainsboro;
ph.Height = 1F;
pf.BackColor = System.Drawing.Color.Gainsboro;
pf.Height = 1F;
p.Name = "Logo";
p.Image = System.Drawing.Image.FromFile(@"c:\logo.gif");
p.Left = 0F;
p.Width = 2.5F;
l.Name = "CompanyName";
l.Text = "Data Dynamics Ltd.";
l.Left = 2.5F;
l.Width = 4F;
l.Height = 1F;
l.Font = new System.Drawing.Font("Times New Roman", 20);
l2.Name = "WebsiteAddress";
l2.Text = "http://www.datadynamics.com";
l2.Left = 0F;
l2.Width = 6.5F;
l2.Alignment = TextAlignment.Center;
//add the sections created above to the report
this.Sections.Insert(0,ph);
this.Sections.Insert(2,pf);
//add the controls created above to the sections
ph.Controls.Add(p);
ph.Controls.Add(l);
pf.Controls.Add(l2);

}
protected void rptLetter_ReportStart(object sender, System.EventArgs eArgs)
{

//add the code in InitializeLetterhead to the ReportStart event 
//of the report
InitializeLetterhead();

}
}

}
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[Visual Basic]
Imports System
Imports DataDynamics.ActiveReports
Imports DataDynamics.ActiveReports.Document
Namespace InheritanceVB

Public Class Letterhead
Inherits ActiveReport 'Tell the letterhead class to inherit from AR
Protected Sub InitializeLetterhead()

'The Letterhead class is for use with reports containing only a Detail section.
'create sections and controls for the letterhead
Dim ph As PageHeader = New PageHeader
Dim pf As PageFooter = New PageFooter
Dim p As Picture = New Picture
Dim l As Label = New Label
Dim l2 As Label = New Label
'set properties on sections and controls
With ph

.BackColor = System.Drawing.Color.Gainsboro

.Height = 1.0F
End With
With pf

.BackColor = System.Drawing.Color.Gainsboro

.Height = 1.0F
End With
With p

.Name = "Logo"

.Image = System.Drawing.Image.FromFile("c:\logo.gif")

.Left = 0.0F

.Width = 2.5F
End With
With l

.Name = "CompanyName"

.Text = "Data Dynamics Ltd."

.Left = 2.5F

.Width = 4.0F

.Height = 1.0F

.Font = New System.Drawing.Font("Times New Roman", 20)
End With
With l2

.Name = "WebsiteAddress"

.Text = "http://www.datadynamics.com"

.Left = 0.0F

.Width = 6.5F

.Alignment = TextAlignment.Center
End With
'add the sections created above to the report
Me.Sections.Insert(0, ph)
Me.Sections.Insert(2, pf)
'add the controls created above to the sections
ph.Controls.Add(p)
ph.Controls.Add(l)
pf.Controls.Add(l2)

End Sub
Protected Sub rptLetter_ReportStart(ByVal sender As Object, ByVal eArgs As System _

 .EventArgs)
'add the code in InitializeLetterhead to the ReportStart event of the report
InitializeLetterhead()

End Sub
End Class

End Namespace
Then in the code behind any report that is to inherit from this class, change the inheritance in the 
automatically generated code from "ActiveReport" to your class name, in this case "LetterHead." To use the 
code in the ReportStart event you created in the class above, create an event handler just after 
InitializeReport() with code like the following.

[C#]
this.ReportStart += new EventHandler(base.rptLetter_ReportStart);
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[Visual Basic]
AddHandler Me.ReportStart, AddressOf rptLetter_ReportStart

Report layouts in ActiveReports for .NET 3.0 are automatically saved as C# or Visual Basic for .NET files 
within the confines of the project in which they are created. In this way, layout information models the 
behavior of Windows Forms in the .NET framework. However, report layouts can be saved as stand-alone RPX 
files—the XML-formatted file on which previous editions of ActiveReports for .NET were based. This 
functionality makes ActiveReports for .NET 3.0 truly backward compatible. Older layout files can easily be 
brought into the newest applications while new layout files can be saved to an older format.

Note: When saving a layout which contains a dataset to the Arnet3 Format, the data adapter and 
data connection are saved, but the dataset itself is lost. When the saved layout is loaded into another 
report, you must generate the dataset again, as there is no convenient way to reconnect the old 
dataset.

The .NET Framework makes it easy for developers to localize their applications and controls. The 
ActiveReports for .NET 3.0 Viewer Control uses the Hub and Spoke model for localizing resources. The hub is 
the main executing assembly. In our case the application hosts the Viewer Control. The spokes are satellite 
DLLs that contain localized resources for the application. 

Place the satellite DLLs in subdirectories under the main executing assembly. When the main executing 
assembly needs a resource, use a ResourceManager object to load the required resource. The 
ResourceManager uses the thread's CurrentUICulture Property. The common language runtime sets this 
property or you can set it in code to force a certain UI Culture. 

Forcing a certain locale is helpful when you want to test whether your satellite DLL is loading properly. The 
ResourceManager class uses the CurrentUICulture Property to locate subdirectories that should contain a 
satellite DLL for the current culture. If no subdirectory exists the ResourceManager uses the resource that is 
embedded in the assembly. 

The Viewer Control is built using the default culture of US English. This is the fallback culture for the Viewer 
Control. For more detailed information about how the Framework locates satellite DLLs, please refer to the 
help system in Visual Studio® .NET or the book Developing International Software, 2nd edition by MS Press 
that contains information on localizing applications using the .NET Framework. 

ActiveReports allows you to set formatting strings for date, time, currency, and other numeric values using 
the OutputFormat property on the TextBox control. The OutputFormat dialog also allows you to 
select international currency values and select from various built-in string expressions. In addition to the 
built-in string expressions, you may use any .NET standard formatting strings.  You can find information 
about these strings (Numerics (http://msdn.microsoft.com/library/default.asp?url=/library/en-
us/cpguide/html/cpconstandardnumericformatstrings.asp)and Date/Time 
(http://msdn.microsoft.com/library/default.asp?url=/library/en-
us/cpguide/html/cpconstandarddatetimeformatstrings.asp)formats) on MSDN. 

The OutputFormat property of the TextBox control includes four sections delimited by a semicolon.  Each 
section contains the format specifications for a different type of number:

l The first section provides the format for positive numbers. 

l The second section provides the format for negative numbers. 

l The third section provides the format for Zero values. 

l The fourth section provides the format for Null or System.DBNull values.

 

Layout Files

Localization

OutputFormat Strings
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Times:
l hh:mm tt = 09:00 AM 

l HH:mm = 21:00 (twenty-four hour clock) 

l HH = hours in 24 hour clock 

l hh = hours in 12 hour clock 

l mm = minutes 

l ss = seconds 

l tt = AM or PM 

Dates:
l dddd, MMMM d, yyyy = Saturday, December 25, 2004 

l dd/MM/yyyy = 25/12/2004 

l d or dd = day in number format 

l ddd = day in short string format (i.e. Sat for Saturday) 

l dddd = day in string format (i.e. Saturday) 

l MM = month in number format 

l MMM = month in short string format (i.e. Dec for December) 

l MMMM = month in string format (i.e. December) 

l y or yy = year in two digit format (i.e. 04 for 2004) 

l yyyy or yyyy = year in four digit format (i.e. 2004) 

Currency and numbers:
l $0.00 = $6.25 

l $#,#00.00 = $06.25 

l 0 = digit or zero 

l # = digit or nothing 

l % = percent-multiplies the string expression by 100 

Parameters and Simple Reports
In ActiveReports for .NET 3.0, you can allow users to filter the amount of information exposed in a report 
through the use of parameters. Adding parameters to the report results in a Parameters dialog that the user 
can manipulate against the database to return pertinent data. 

For example, the SQL statement "SELECT * FROM products INNER JOIN categories ON products.categoryid = 
categories.categoryid WHERE products.supplierID =<%SupplierID|Enter supplierID|1000%> and 
OrderDate=#<%Date|Order date:|1/1/2001|D%># and Discount=<%bool| Is this checked ?|true|B%>;" 
contains unique syntax that ActiveReports for .NET uses to generate the following dialog. 

Parameters
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Breaking down the SQL statement, the syntactical elements <%SupplierID|Enter supplierID|1000%>, <%
Date|Order date:|1/1/2001|D%>,  and <%bool| Is this checked ?|true|B%> comprise the report 
parameters. The user can accept these or input other values to further define report data. Each of these 
parameters follow the syntactical pattern <%FieldName | PromptString | DefaultValue | Type%
> where: 

l FieldName is the name of the field you wish to request (e.g. CustomerID or LastName). This is the only 
part of the syntax which is required, so you can use <%FieldName%> if you do not wish to use the 
other values. 

l PromptString is an optional string value which sets the text that appears in the dialog next to the 
control (e.g. "Enter Customer ID: "). 

l DefaultValue sets a default value for the parameter. For example, if you have a date parameter, you 
can set the DefaultValue for the field to the current date so users can just hit ENTER unless they want to 
generate a report based on a new date. 

l Type indicates the type of the data requested. The possible values are nothing (which defaults to string), 
S for string, D for date, and B for Boolean. A string type provides a textbox for input, a date type 
provides a calendar drop-down control for input, and a Boolean type provides a check box for input. 

Note: For Strings, if you specify a default value that is enclosed in apostrophes or quotation 
marks, ActiveReports sends the same marks to SQL. For Boolean parameters, if you specify true/false 
for the DefaultValue it generates true/false for SQL output. If you specify 0,1, it generates 0 or 1.

Note: Although FieldName is the only required parameter, please note that if you do not specify a 
default value for the other parameters the field list is not populated at design time and you will see a 
SQL error message. Setting a default value for all parameters allows you to see fields in the Report 
Explorer instead of an error message.

You can use stored procedures in the same way as parameters in ActiveReports. The SQL statement has the 
stored procedure call and placeholders for the parameters: "CustOrderHist <%ID|Enter Customer 
ID:|AFLKI%>". ActiveReports replaces the parameter text "<% %>" with whatever the user types into the 
dialog to create a call like this: CustOrderHist 'AFLKI'.

To add parameters in SQL statements as in the above example, you will need to add them to the query via 
the Datasource dialog that is accessed by clicking the datasource icon in the ActiveReports designer.

Adding Parameters Via the Report Explorer
In addition to adding parameters in SQL statements, ActiveReports for .NET 3.0 provides for the addition of 
parameters via the Report Explorer. To do so, right-click the Parameters node in the Report Explorer and click 
"Add" from the shortcut menu. This will add a child to the Parameters node.
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Once a parameter is added to the , you can set its properties from the Properties grid.  

Adding Parameters at Run time
Custom parameters can be added, edited, and deleted at run time. The following demonstrates how to add a 
parameter to the Report_Start event and assign its value to an ActiveReports textbox.

'Visual Basic
Private Sub rptParam_ReportStart(ByVal sender As System.Object, ByVal e As System.EventArgs)_ 

Handles MyBase.ReportStart

Dim myParam1 As New Parameter()
myParam1.Key = "myParam1"
myParam1.Type = Parameter.DataType.String
myParam1.PromptUser = True 'set to False if you do not want input from user
myParam1.Prompt = "Enter last name:"
myParam1.DefaultValue = "This is myParam1 default value"
Me.Parameters.Add(myParam1)
 
'Set textbox text equal to the value of the parameter
Me.txtParam1.Text = Me.Parameters("myParam").Value

End Sub

//C#
private void NewActiveReport1_ReportStart(object sender, System.EventArgs e)

{
Parameter myParam1 = new Parameter();
myParam.Key = "myParam1";
myParam.Type = Parameter.DataType.String;
myParam.PromptUser = true; //set to false if you do not want input from user
myParam.Prompt = "Enter last name:";
this.Parameters.Add(myParam1);

 
//Set textbox text equal to the value of the parameter
this.txtParam1.Text = this.Parameters["myParam"].Value

}

Parameters and Subreports
You can use parameters with subreports to connect the subreport to the parent report. If you set a 
parameter for the field that links the parent report to the child subreport, the parent report passes the 
information to the child through the parameters. Keep the following in mind when working with subreports 
and parameters: 

l Set the subreport's ShowParametersUI property to False. 

l Set the subreport's SQL query to use the parameter syntax = <%fieldname%>. 

Note: Both report queries must contain the same field (so the main report must have a categoryID 
field and the subreport also must have a categoryID field. 
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The Report Settings Dialog
With ActiveReports, you can modify facets of your report, such as the page setup, printer settings, styles, 
and global settings of your report at design time, as well as at run time. To make changes at design time, 
access the Report Settings dialog by selecting Report > Settings from the toolbar menu. 

 

Alternatively, you can right-click the "Settings" node located within the Report Explorer and select "Show."

 

The Page Setup Pane
By clicking the Page Setup button, you can make changes to the report margins (left, right, top, and 
bottom), specify a gutter, and select the Mirror margins option within the Page Setup pane.

By setting a gutter and selecting Mirror margins, you can easily set up reports for publishing purposes. When 
you select Mirror margins, the inner margins in the report are set for opposite pages to be the same width 
and the outside margins for opposite pages to be the same width. Specifying a gutter gives extra space 
between the edge of the page and the margins. This allows reports to be bound.

Report and Page Settings
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The Printer Settings Pane
By clicking the Printer Settings button, you can make changes to the printer paper size and orientation within 
the Printer Settings pane. You can set a custom paper size by selecting "Custom Size" from the options listed 
in the "Paper Size" combo box. Once you have selected this option, you can set a specific height and width.

The Printer Settings dialog also lets the user choose the type of collation to use, whether or not the report 
should be printed in duplex, and the location of the paper source.
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The Styles Pane
By clicking the Styles button, changes can be made to the appearance of text associated with controls within 
the Styles pane, either by applying an existing style sheet, creating and applying a new style sheet, or by 
modifying and applying an existing style.
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The Global Settings Pane
By clicking the Global Settings button, changes can be made to the design surface within the Global Settings 
pane, including showing or hiding the grid, setting the controls to align to the grid, setting the number of 
columns or rows on the grid, and changing the ruler units to inches or centimeters. 

In addition, you can set the number of Pages that will display within the Preview Tab of the ActiveReports 
Designer. The minimum value is "1" and the maximum value is "10000."
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ActiveReports report execution begins by raising the ReportStart event. At this point, accessing data source 
properties might raise the DataInitialize event. The report validates any changes made to the report structure 
in ReportStart.

Printer settings are applied next.

At this point the DataInitialize event will be raised and the data source will be opened if the event was not 
raised during the ReportStart event. If the data source contains parameters with unset values and the 
ShowParameterUI property is set to True, ActiveReports displays a parameters dialog and raises 
the ParameterUIClosed event when the dialog is closed. If the report is a subreport that requires parameters, 
ActiveReports binds the subreport parameters to any fields in the parent report.

Next, the FetchData event is raised; if there is no data, the NoData event is raised.

Note: The DataInitialize and FetchData events are the only events in which the Fields collection should 
ever be referenced.

Group sections are bound and sections begin rendering on pages.

Events are then raised for processing the report header, followed by page header, groups, detail, and page 
footer for each page in the report. The cancel flag is checked after each event.

The speed in processing and output generation of ActiveReports is attributed to its intelligent, multi-threaded, 
single-pass processing. ActiveReports will process and render each page as soon as the page is ready. If 
ActiveReports is not able to fully render a page because of unknown data elements or because the layout is 
not final, it places the page in cache until the data is available.

Summary fields and KeepTogether constraints are two reasons why a page might not be rendered 
completely. The summary field is not complete until all the data needed for calculation is read from the data 
source. When a summary field such as a grand total is placed ahead of its completion level, such as in the 
report header, the report header and all following sections will be delayed until all of the data is read.

The KeepTogether property determines whether a section should print in its entirety on the same page. When 
this property is set to True, the section will print on the same page without any page breaks. A False setting 
allows the section to be split across two or more pages. If the KeepTogether property is set to True, but the 

Report Execution
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section is too large for the current page or needs to fit fully on the next page, the KeepTogether property will 
be ignored.

The GroupKeepTogether property determines whether group header and footer sections will print as a single 
block on the same page. The property defaults to None, which allows the group block to be split across 
pages. When you set this property to All, ActiveReports attempts to print the complete block on the same 
page without any page breaks. When a complete block does not fit on a single page, it will be split across two 
or more pages. The third option, FirstDetail, prevents any widowed group header sections. The group header 
will always print with at least one Detail section.

A report section contains a group of controls that are processed and printed at the same time as a single 
unit. ActiveReports defines the following section types: 

Report Header
A report can have one report header section that prints at the beginning of the report. This section generally 
is used to print a report title, a summary table, a chart or any information that needs only to appear once at 
the report's start.

Report Footer
A report can have one report footer section that prints at the end of the report. This section is used to print a 
summary of the report, grand totals, or any information that needs to print once at the report's end.

Page Header
A report can have one page header section that prints at the top of each page. Unless the page contains a 
report header section, the page header will be the first section that prints on the page. The page header 
section is used to print column headers, page numbers, a page title, or any information that needs to appear 
at the top of each page in the report.

Note: Bound controls in the PageHeader or PageFooter are not supported.  The data in such controls 
may not be in synch with the data displayed in other sections on the page. 

Page Footer
A report can have one page footer section that prints at the bottom of each page. It is used to print page 
totals, page numbers, or any other information that needs to appear at the bottom of each page.

Group Header/Footer
A report can consist of single or multiple nested groups, with each group having its own header and footer 
sections. The header section is inserted and printed immediately before the Detail section. The footer section 
is inserted and printed immediately after the Detail section.

Detail
A report has one Detail section. The detail section is the body of the report and one instance of the section is 
created for each record in the report.

The RichText control offers the user an enormous amount of control over the appearance of text in the 
report. Unlike the TextBox control which applies formatting to the entire contents of the control, the RichText 
control allows you to apply selective formatting to various areas of text within the control. For example, the 
Find method allows the developer to find specific words or characters in the control, while the various 
selection properties allow the results of this method to be used to select text and change its formatting in a 
dozen ways.

The control's text can be set directly using the Text, Html, or RTF properties, or it can be loaded from a plain 
text, RTF or HTML file or stream using the Load method. 

Note: In order to show special characters in an html file loaded into the control, use the character 

Report Structure

RichText
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entity reference (i.e. &egrave; for è).

Note: To load a file at design time, be sure that you are not in edit mode. 

The InsertField and ReplaceField methods enable field merging reports, such as the mail merge report 
demonstrated in the "Rich Text and Field Merging" walkthrough. The RichTextBox now automatically binds 
inserted fields to the report's fields collection.

 

The following is a list of all of the HTML tags that can be used with the RichText control. Unsupported 
tags will be ignored. Please note that W3C conventions are strictly observed.

Supported Html Tags In the RichText Control

Tag Comment Attributes 

<B> Bold none 

<I> Italic none 

<P> Paragraph align, style 

<STRONG> Strong (looks like bold) none 

<BIG> Big none 

<SMALL> Small none 

<PRE> Preformatted none 

<FONT> Font  face, size, color, style (see notes for style 
attributes) 

<BODY> The body tag background, text, leftmargin 

<H1> -
<H6> 

Heading levels one 
through six 

none 

<BR> Line break none 

<EM> Emphasized (looks like 
Italics) 

none 

<U> Underlined none 

<IMG> Image align, height, src, width 

<SUP> Superscript none 

<SUB> Subscript none 

<CENTER> Center alignment none 

<TABLE> Table align, border, cellpadding, cellspacing, height, 
style, width 

<TR> Table row align 

<TH> Table head none 

<TD> Table datum align, border, colspan, rowspan, width 

<LI> List item none (nesting levels yield disc, circle, square 
bullets) 

<OL> Ordered list type 

<UL> Unordered list type, value 

<STRIKE> Strike through none 
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NOTE: The style attributes of <FONT>, <P>, and <TABLE> support the following properties: 

ActiveReports allows you to use scripting to provide VB.NET or C#  functionality to reports without needing to 
use actual .vb or .cs files. This permits reports saved to an RPX (report xml) file to contain code that when 
saved as an RPX file creates a stand-alone report. By including scripting when the report is saved as an RPX 
file, it can later be loaded, run, and displayed directly to the viewer control without using the designer. In 
conjunction with RPX files, scripting allows distributed reports to be updated without recompiling.

Note: ActiveReports for NET 3.0 loads RPX files, including any scripting in the InitializeComponent() 
method. 

Scripting can be used by adding C# or VB.NET code to the script editor at design time or by using the 
rpt.Script property at run time. The script is then saved to the RPX file.

Note: Since the RPX file can be read with any text editor, the AddCode or AddNamedItem method 
should be used to add secure information, such as a connection string, to a project.

Tips for Using Scripting 
l Make sure the report class is public. If the report class is not set to public, the script will not be able 

to recognize the items in your report. The report class is public by default. 

l Make sure the control being referenced in the script has its Modifiers property set to Public. If 
the control's Modifiers property is not set to Public, the control cannot be referenced in script and an error 
will be raised when the report is run. The Modifiers property has a default value of Private, so you must 
set this property in the designer. 

l Use "rpt." The script must use rpt to reference the report instead of this (as in C# code-behind) or Me
(as in VB code-behind).  

l Use error handling. When working with scripting, use error handling around the .Run() call. When 
errors are raised, the returned error should point to the section of script causing the error. 

l Use ((ControlType)rpt.Sections[SectionName].Controls[ControlName]) to type cast a control 
and access its properties.

l Create classes inside the script to call methods. 

l Use the AddScriptReference method to gain access to .NET (or other) namespaces.

l Use the AddNamedItem method to access class files in a project.

l Use AddCode to inject code into the script. 

l border-bottom 

l border-bottom-width 

l border-color 

l border-left 

l border-left-width 

l border-right 

l border-right-width 

l border-style 

l border-top 

l border-top-width 

l border-width 

l font-family 

l font-size 

l height 

l line-height 

l margin-bottom 

l margin-left 

l margin-right 

l margin-top 

l padding-bottom 

l padding-left 

l padding-right 

l padding-top 

l table-layout 

l text-align 

l text-indent 

l width 

Scripting

To access the script editor, click the script tab below 
the report design surface. 

Access Controls In Script
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Use ((ControlType)rpt.Sections[SectionName].Controls[ControlName]) to type cast a control and 
access its properties. 

If the project loads an RPX file into a new ActiveReport object, the script must refer to each control by using 
((ControlType)rpt.Sections[SectionName].Controls[ControlName]). The reason for doing this is that a new 
ActiveReport object is not aware of the objects contained inside the RPX file. If you are using script in a 
report contained in a project and just creating a new instance of the report class you can use "rpt". 

'Visual Basic
Private Sub Form1_Load(ByVal sender As System.Object, ByVal e As System.EventArgs) Handles _

MyBase.Load
Dim rpt as new ActiveReport() 
Rpt.LoadLayout("ActiveReport1.rpx")
rpt.Run()
Me.Viewer1.Document = rpt.Document 

End Sub 

//C#
private void Form1_Load(object sender, System.EventArgs e) 
{ 

ActiveReport rpt = new ActiveReport(); 
rpt.LoadLayout("ActiveReport1.rpx"); 
rpt.Run(); 
this.viewer1.Document = rpt.Document; 

}

'VB.NET Script
Public Sub Detail_Format()

CType(rpt.Sections("Detail").Controls("TextBox1"), TextBox).Text = "Hello"
End Sub

//C# Script
public void Detail_Format() 
{ 

((TextBox)rpt.Sections["Detail"].Controls["TextBox1"]).Text = "Hello"; 
}

Create classes inside the script to call methods.

If the script requires method calls, a class can be constructed inside the script. 

'VB.NET Script
Public Class MyFuncs

Public  Sub New()
End Sub
Public Function ShowMyString() As String

Return "This is my string"
End Function

End Class

Public  Sub Detail_Format() 
Dim f As MyFuncs =  New MyFuncs() 
(CType(rpt.Sections("Detail").Controls("TextBox1"), TextBox)).Text = f.ShowMyString()

End Sub

 
//C# Script
public class MyFuncs
{

public MyFuncs()
{
}
public string ShowMyString()
{

Script Class
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return "This is my string";
}

}

public void Detail_Format()
{ 

MyFuncs f = new MyFuncs();
((TextBox)rpt.Sections["Detail"].Controls["TextBox1"]).Text = f.ShowMyString();

}

Use the AddScriptReference method to gain access to .NET (or other) namespaces. 

Use AddScriptReference() in the project's code to add references to the script that might be needed. 
AddScriptReference() would only need to be used if there is a reference needed inside the script that does 
not get initialized in the project before the script runs, such as the System.Data.dll. 

//C#
private void runReport() 
{ 

ActiveReport1 rpt = new ActiveReport1(); 
rpt.AddScriptReference("System.Data.dll"); 
rpt.Run(); 
this.viewer1.Document = rpt.Document; 

} 
'Visual Basic
Private Sub runReport() 

Dim rpt as new ActiveReport1() 
rpt.AddScriptReference("System.Data.dll") 
rpt.Run() 
Me.Viewer1.Document = rpt.Document 

End Sub 

Use the AddNamedItem method to access class files in a project. 

The AddNamedItem method is used to allow the script to gain access to functions in a class file contained 
within a project. This can be useful for allowing secure information such as a database connection string or 
a SQL query string to be used in the script without having to save it into the RPX file.

'Visual Basic
Public Class clsMyItem 

Public Function getMyItem() As String 
getMyItem = "Hello" 

End Function 
End Class 

//C#
public class clsMyItem 
{ 

public clsMyItem() 
{ 
} 
public string getMyItem() 
{ 

return "Hello"; 
} 

}

'Visual Basic
Private Sub rptAddNamedItem_ReportStart(ByVal sender As Object, ByVal e As System.EventArgs) _

Handles MyBase.ReportStart 
me.AddNamedItem("myItem", new clsMyItem()) 

Add Script Reference

Add Named Item
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End Sub 

//C#
private void rptAddNamedItem_ReportStart(object sender, System.EventArgs eArgs) 
{ 

this.AddNamedItem("myItem", new clsMyItem()); 
}

'VB.NET Script
Public Sub Detail_Format() 

rpt.Label1.Text = myItem.getMyItem()
End Sub

//C# Script
public void Detail_Format() 
{ 

rpt.Label1.Text = myItem.getMyItem(); 
}

Use the AddCode method to inject code into the script.

The AddCode method allows actual code segments to be added to the script at run time. This is useful for 
allowing secure information, such as a database connection string or SQL query string, to be used inside the 
script without having to save it into the RPX file. 

//C#
public string AddThisCode() 
{ 

string sCode = "public string ShowACMessage()"; 
sCode += "{"; 
sCode += "return \"my Added Code\";"; 
sCode +="}"; 
return sCode; 

} 
private void rptAddCode_ReportStart(object sender, System.EventArgs eArgs) 
{ 

this.AddCode(addThisCode()); 
}

'Visual Basic
Public Function addThisCode() As String 

Dim sCode as String 
sCode = "public string ShowACMessage(){return ""my Added Code"";}" 
addThisCode = sCode 

End Function 

Private Sub rptAddCode_ReportStart(ByVal sender As Object, ByVal e As System.EventArgs) Handles MyBase.ReportStart 
this.AddCode(addThisCode()) 

End Sub 

//C# Script
public void Detail_Format() 
{ 

rpt.TextBox1.Text = ShowACMessage(); 
} 

'VB.NET Script
Public Sub Detail_Format()

rpt.TextBox1.Text = ShowACMessage()
End Sub

Add Code

Getting Started
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This topic will show you how to begin using ActiveReports by explaining different aspects of ActiveReports 
and showing you how to include it in your Visual Studio .NET IDE (Integrated Development Environment).

 

ActiveReports and the Web

Learn about using ActiveReports with the Web. 

Adding ActiveReports Controls to the Visual Studio Toolbox

Learn how to add ActiveReports controls to the toolbox in Visual Studio. 

Adding an ActiveReport to a Visual Studio .NET Project

Learn how to add an ActiveReport to a Visual Studio project. 

ActiveReports Designer

Learn how to use the ActiveReports designer. 

Viewing ActiveReports
Learn how to preview a report at design time as well as use the WinForm Viewer to view a report at run 
time. 

Adding Field Expressions

Learn how to add field expressions to a text box data field. 

Binding Reports to a Data Source

Learn how to bind reports to various data sources. 

Grouping Data

Learn how to use the GroupHeader to group data in a report. 

Saving and Loading RPX-based Report Layouts

Learn how to save and load RPX-based report layouts in ActiveReports for .NET 3.0. 

Localizing the Viewer Control

Learn how to localize settings for the ActiveReports Viewer control. 

Metric Units

Learn how to use metric units with ActiveReports for .NET 3.0. 

Optimizing ActiveReports

Learn how to optimize very large reports. 

Saving and Loading RDF Files

Learn how to save and load reports as RDF files at run time. 

Saving and Loading RPX Files

Learn how to save and load reports as RPX files at run time. 

Limitations in Export Formats

Learn about some of the limitations of the various ActiveReports export filters. 

Using Charts

Learn about using the new Chart control. 

Using Annotations

Learn how to use the Annotations with your reports. 

Related Sections

Samples
ActiveReports includes many samples which demonstrate applications the developers created for 
ActiveReports. These samples show the use of a combination of controls and code to produce various 
reports. 
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Walkthroughs
Learn how to create various types of applications in C# and Visual Basic .NET--one step at a time. 

Technical Support
Technical support is available for ActiveReports for .NET 3.0 in a variety of media. 

ActiveX Viewer Control

Learn about the properties, methods, and events for the ActiveX Viewer Control. 

Manually Configuring Web Samples

Learn how to manually configure ActiveReports Web Samples. 

Properties

ActiveReports and the Web

ActiveX Viewer Control

Property Data Type Description 

AllowSplitter Boolean Sets or returns whether or not the 
viewer can be split into two windows. 

BackColor OLE_COLOR Sets or returns the background color of 
the viewer. 

BorderStyle BorderStyle Sets or returns the border style. 

DataPath String Report file (RDF) URL for asynchronous 
downloads. 

Object Object Returns an object in a collection 

Pages Pages collection Returns a reference to the current pages 
collection displayed in the viewer. 

PaperColor OLE_COLOR Sets or returns the paper background 
color. 

Printer Printer Returns a reference to the viewer's 
printer object. 

ReportSource Object Sets or returns a reference to the linked 
subreport. 

RulerVisible Boolean Sets or returns whether or not the 
viewer's top and side rulers are shown at 
run-time. 

Status ViewerStatus Returns the status of loading pages into 
the viewer cache. 

TOC TOC Returns a reference to the table of 
contents object. 

TOCEnabled Boolean Disables or enables the TOC tree. 

TOCVisible Boolean Determines whether the table of 
contents tree is visible. 

TOCWidth Single Sets or returns the width of the TOC tree 
when displayed. 
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Methods

Events

Toolbar DDToolbar Returns a reference to the built-in 
toolbar object. The toolbar object allows 
you modify the toolbar's icons and tools. 

ToolbarVisible Boolean Determines whether the built-in toolbar 
is visible. 

UseSourcePrinter Boolean Sets/return whether the viewer or 
ReportSource printer is used to print the 
report. 

Zoom Integer Sets or returns the zoom level of the 
current page view. 

Method Description

CopyPageToClipboard Copies the indicated page to the clipboard. 

Sub CopyPageToClipboard([Page])

Find Searches a report for a specified string. 

Sub Find(View As SplitViewTypes, SearchText As String, 
Direction As SearchDirectionTypes, MatchCase As 
Boolean, MatchWord As Boolean)

Localize Allows modification of the caption of the string used in the 
preview window. 

Localize(index As Integer, str As String)

MultiplePage Switches the viewer settings so multiple pages can be displayed 
at one time. 

Sub MultiplePage(View As SplitViewTypes, rows As 
Integer, cols As Integer)

PrintReport Prints the viewer pages collection to the selected device. 

Sub PrintReport(bDisplayDialog As Boolean)

Refresh Refreshes the viewer control. 

Sub Refresh()

SinglePage Switches the viewer back to displaying a single page. 

Sub SinglePage(View As SplitViewTypes)

Event Description 

DblClick Fired when the user double clicks the mouse in the viewer. 

Sub DblClick() 

Error Occurs when an error fires. 

Sub Error(Number As Integer, ByVal Description As 
String,ByVal SCode As Long, ByVal Source As String, 
ByVal HelpFile As String, ByValHelpContext As Long, 
CancelDisplay As Boolean)

FindProgress This event fires when a search is performed on a report 
loaded into the viewer. When a search reaches a report's end 
or beginning, the event will fire. 

Event FindProgress(ByVal Result As 
DDActiveReortsViewer2Ctl.FindResults)
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HyperLink This event fires when a hyperlink is clicked. The event can be 
used to redirect the hyperlink or prevent the link from 
activating. 

Sub Hyperlink(ByVal Button As Integer, Link As 
String)

KeyDown Fired when a key is pressed down while the viewer has focus. 

Sub KeyDown(KeyCode As Integer, Shift As Integer)

KeyPress Fired When a key is pressed and released while the viewer 
has focus. 

Sub KeyPress(KeyAscii As Integer)

KeyUp Fired when a key is released while the viewer has focus. 

Sub KeyUp(KeyCode As Integer, Shift As Integer)

LoadCompleted Fired when all the pages in the report source have been 
loaded into the viewer. 

Sub LoadCompleted()

MouseDown Fired when a mouse button is pressed down. 

Sub MouseDown(Button As Integer, Shift As Integer, 
X As Single,Y As Single)

MouseMove Fired as the mouse moves over the viewer area. 

Sub MouseMove(Button As Integer, Shift As Integer, 
X As Single, Y As Single)

MouseOver This event fires when the mouse moves over a report page. 
If the mouse moves over a control with a hyperlink, then the 
link will be returned. 

Sub MouseOver(ByVal PageX As Long, ByVal PageY As 
Long, ByVal Hyperlink As String)

MouseUp Fired when a mouse button is released. 

Sub MouseUp(Button As Integer, Shift As Integer, X
As Single, Y As Single)

PageModeChanged Fired when the viewer switches between displaying a single 
page and multiple pages. 

Sub PageModeChanged(ByVal MultiplePage As Boolean)

PrintAborted Called in the PrintReport Method when the user cancels a 
print job before it finishes. 

Sub PrintAborted()

TOCClick Fired on a mouse click in the TOC treeview window. 

Sub TOCClick(ByVal Button As Integer, ByVal As 
Long, ByVal Flags As Long)

TOCSelChange Fired when the TOC selection changes. 

Sub TOCSelChange (ByVal ItemIndex As Long)

ToolbarClick Fired when the user clicks on a tool in the viewer toolbar. 

Sub ToolbarClick(ByVal Tool As DDTool)

ZoomChanged Fired when the viewer's zoom percentage changes. 

Sub ZoomChanged()

Manually Configuring Web Samples
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Installing the Sample Web Application

To install the sample web application  

1. In the Control Panel, double-click "Administrative Tools." Double-click "Internet Information Services 
(Internet Services Manager for Windows 2000)" to open its dialog window. 

2. Right-click on "Default Web Site" then click New > Virtual Directory.

3. Click Next when you see the "Virtual Directory Creation Wizard." 

4. In the Alias field, enter one of the following folder names, depending on which web sample you need to 
configure: 

¡ ArWebSampleStdCs 

¡ ArWebSampleStdVb 

¡ ArWebSampleProCs 

¡ ArWebSampleProVb 

5. Click Next to continue. 

6. Click Browse to find the folder in which ActiveReports is installed. Find and select the appropriate folder. 

7. Click OK to continue and then click Next. 

8. Make sure the "Read" and "Run Scripts" permissions are checked and click Next. 

9. The ActiveReports Web sample is now installed. 

 

Note If you are only configuring Standard Edition Web Samples, you do not need to complete the 
following steps. 

Configuring the ActiveReports HTTPHandlers

To configure the HTTPHandler  

1. In the Control Panel, double-click "Administrative Tools." Double-click "Internet Information Services" to 
open its dialog window. 

2. Right-click on the Web site that you need to configure the HTTPHandlers for, then click Properties. 

3. Click on the "Home Directory" tab of the "Default Web Site Properties" dialog. 
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4. Click on the Configuration button. 

5. In the "Application Mappings" window of the Application Configuration dialog, select the list item 
with .aspx in the extension column and click Edit. Note that if your machine does not have the ASP.NET 
server components installed, the .aspx handler will not show up in the Application Mappings list. 
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6. Select and copy all of the text in the "Executable" field. Click Cancel to return to the Application 
Configuration dialog. 

7. Click Add in the Application Configuration dialog to add a new Application Mapping. 

8. In the Executable field, paste the value copied from Step 6 and enter ".rpx"in the Extension field. 

9. Click OK to add the mapping and return to the Application Configuration dialog. 

 

To configure the compiled report handler (continuing from Step 9 in "To Configure the HTTPHandler) 

1. In the Application Configuration dialog, click Add to add a new Application Mapping. 
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2. In the Executable field, paste the value copied from Step 6 above. 

3. Enter .ActiveReport in the Extension field. 

4. Make sure the "Check that file exists" permission is unchecked. 

5. Click OK to add the mapping and return to the Application Configuration dialog. 

 

To configure the WebCacheAccessHandler (continuing from Step 9 in "To Configure the HTTPHandler)   

1. In the Application Configuration dialog, click Add to add a new Application Mapping. 

2. In the Executable field, paste the value copied from Step 6 above. 

3. Enter .ArCacheItem in the Extension field. 

4. Make sure the "Check that file exists" permission is unchecked. 

5. Click OK to add the mapping and return to the Application Configuration dialog. 

6. Click OK on the remaining open dialogs to exit the IIS Administrative tool. 

Adding the ActiveReports Controls

To add the controls  

Adding ActiveReports Controls to the Visual Studio Toolbox
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1. Right-click on the toolbox tab where you want to add ActiveReports controls. 

2. In Visual Studio .NET  2003 select Add/Remove Items; in Visual Studio 2005 select Choose Items.

3. Select the Designer, ReportExplorer, HtmlExport, PdfExport, Viewer and WebViewer controls in the 
DataDynamics.ActiveReports namespace in the components list view. (Hint: Sort by Namespace to see all 
of the DataDynamics assemblies together.) 

4. Click OK to add the controls to your selected toolbox. 

Creating the Project
The first step is creating a new Visual Studio Project.

To create the project

1. From the File menu, click on New and choose Project.

2. Select Project, then Add New Item.

3. Select ActiveReports 3.0 File and name your new report. 

Adding an ActiveReport to a Visual Studio .NET Project
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4. Click Open to add the report to your project.

With its various tools and qualities, ActiveReports for .NET 3.0 offers great flexibility in constructing report 
projects. In this section, you will learn how to use the different features of the ActiveReports Designer.

ActiveReports Designer
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Design Surface
Learn more about the features of the design surface. 

Designer Tabs
Learn more about the designer tabs. 

Report Explorer
Learn about the features and functionality of the Report Explorer. 

Report Menu
Learn about the different aspects of the report menu. 

Toolbars
Learn how to use the ActiveReports toolbars. 

Toolbox
Learn about the functions of the controls on the ActiveReports toolbox. 

The ActiveReports design surface leverages your current knowledge of Visual Studio .NET's designer interface 
and provides full integration within the Visual Studio environment.

Design Surface
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To access the ActiveReports design surface

1. Open a Visual Studio project. 

2. Add an ActiveReport to your project. 

3. Once the report is added, you will see the report design surface. 

 

The default ActiveReports design surface is made up of the following base components:

l PageHeader section--This section can be used to print column headers, page numbers, page titles, or any 
information that needs to be printed once at the top of each page. Bound controls in the PageHeader or 
PageFooter are not supported.  The data in such controls may not be in synch with the data displayed in 
other sections on the page. 

l Detail section--This section is the body of the report that prints once for each record in the data source. 

l DataSource icon--This control can be used to connect the report's data source settings to an existing data 
source 

l PageFooter section--This section can be used to print page totals, page numbers or any other information 
that needs to be printed once at the bottom of each page. 

l Designer/Script/Preview tabs--The Designer and Script tabs can be clicked to toggle between design and 
script views, while the Preview tab allows for a fully functional design-time preview of how a report will 
look and behave at run time.   

The designer tabs located at the bottom of the ActiveReports for .NET 3.0 design surface allow you to quickly 
access various aspects of ActiveReports. The ActiveReports designer is equipped with three tabs, the 

Designer Tabs
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Designer tab, the Script tab, and the Preview tab. 

l Designer Tab: By default, when you create or open an ActiveReport the designer tab is selected. While 
in this tab of the ActiveReport, you can perform all design-time and run-time functions associated with 
your report, such as creating a layout, binding to data sources, creating event-handling methods, and 
more. 

 

l Script Tab: By selecting the Script tab, you open the script editor, which gives you the ability to easily 
and quickly add scripting to your report. The script editor contains two comboboxes that allow you to 
select any section of the ActiveReport and all events associated with that section. When you select a 
section and an event, the script editor generates a method stub for the event. 
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l Preview Tab: The Preview tab allows you to quickly view what your report looks like at run time without 
needing to actually run your project. This makes it easy to quickly see the run-time impact of changes 
you make in the designer or the code-behind. To gain a report preview, toggle from the Designer or 
Script tab to the Preview tab.  
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In ActiveReports for .NET 3.0 the Report Explorer serves as the information focal point for your report. From 
it, you can gain a quick overview of the elements that comprise the report, remove individual controls, add 
parameters and calculated fields, change report settings, bind data fields to textbox controls, and 
modify properties and report behavior via the Properties grid.

If you do not see the Report Explorer within the Visual Studio IDE, do the following:

1. Right-click on the Visual Studio toolbar. 

2. Select ActiveReports for .NET 3.0 from the shortcut menu to display the designer toolbar. 

3. On the designer toolbar, click the View Report Explorer button.

Alternatively, you can display the Report Explorer by opening the View menu, pointing to Other Windows, 
and clicking Report Explorer.

Note: Once the Report Explorer has been added to the IDE, it will appear when a new 
Windows Application is created. If you do not wish to see the Report Explorer you can close it 
by selecting the window and closing it. 

The Report Explorer lays out in one place the sum total of the elements contained in your report.

Report Explorer
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The following demonstrates how you can quickly modify a report using the Report Explorer. 

To remove individual controls  

1. In the Report Explorer, expand the tree that contains the the control you wish to remove. For example, if 
you want to remove a ReportInfo control from a group header, expand the group header that contains 
the control.  

2. Right-click on the control and select Delete from the shortcut menu. 

3. Click Yes in the Report Explorer dialog to confirm your decision. 

To add parameters

1. In the Report Explorer, right-click on the Parameters node. 

2. Select Add from the shortcut menu. 

3. Set any desired properties or events for the parameter in the Properties grid. 
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4. Drag the parameter from the Report Explorer onto the design surface of your report. This will create a 
textbox object that is bound to the parameter.

To add calculated fields

1. In the Report Explorer, expand the Fields tree. 

2. Right-click on the Calculated node. 

3. Select Add from the shortcut menu. 

4. Set any desired properties or events for the field in the Properties grid. 

5. Drag the field from the Report Explorer onto the design surface of your report. This will create a textbox 
object that is bound to the field.

 

To change report settings

1. In the Report Explorer, right-click on the Settings node. 

2. Select Show from the shortcut menu to open the Report Settings dialog. 

3. Make any desired changes and click OK . 
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To bind data fields to textbox controls

1. In the Report Explorer, select the data field you want to bind to a textbox control.  

2. Drag the field onto the design surface of the report. A textbox control is created and bound to the field, 
which is reflected in the textbox's DataField and Name properties. For example, if you dragged a field 
named "EmployeeID," the DataField property of the textbox is set to EmployeeID and the textbox is 
named "txtEmployeeID1." 

To modify properties and report behavior

1. In the Report Explorer, select the report element you want to modify. The Properties grid displays all 
available properties and events for the element.  

2. In the Properties grid, change any properties or events to implement the changes.

The report menu allows access to save the current report layout, load existing report layouts, modify the 
report data source or modify report settings. 

To access the report menu

1. Open a new or existing ActiveReport. 

2. Click on any section in the report to select it. 

3. Click on Report from the main toolbar. 

Report Menu
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The Report Menu allows the following options:

l Save Layout 

The Save Layout option allows for the existing report layout to be saved as an rpx file.

l Load Layout 

The Load Layout option allows access to load an existing report layout into the open ActiveReport.

l Data Source 

The Data Source option allows access to add Data Source parameters or modify existing Data Source 
settings.

l Settings 

The Settings option allows access to change printer or page settings, stylesheets, or global settings.

The toolbars in ActiveReports can be easily customized. ActiveReports' toolbars allow developers to rearrange 
buttons and menu options, as well as hide, display, dock or float toolbars. 

To access a toolbar's shortcut menu

l Right-click anywhere in the toolbar area 

The shortcut menu allows you to show or hide toolbars by selecting the toolbar name from the menu. In 
addition, you can customize the toolbars or create a new toolbar from the customize option on the menu.

 

The ActiveReports toolbar is made up of the following components: 

l Report Explorer--Shows or hides the report explorer tree and the Fields list

l Style Sheets--Sets the style sheet for a control 

l Font--Sets the typeface of the selected label, checkbox, or textbox control 

l Size--Sets the font size of the selected label, checkbox, or textbox control 

l View Grid--Turns the grid display on or off 

l Reorder Groups--Displays the groups order dialog 

l New! Zoom Out--Incrementally reduces the magnification level of the design surface 

l New! Zoom In--Incrementally increases the magnification level of the design surface 

l Bold--Sets the bold typeface on or off 

l Italic--Sets the italic typeface on or off 

l Underline--Sets the underline typeface on or off 

l Align Left--Aligns the text left in the control area 

l Align Center--Aligns the text centered in the control area 

Toolbars
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l Align Right--Aligns the text right in the control area 

l Justify--Justifies the text in the control area 

l Bullets--Adds bullets to the text in the RichText control area 

l Decrease Indent--Decreases the indent of the text in the RichText control area 

l Increase Indent--Increases the indent of the text in the RichText control area 

The ActiveReports toolbox displays a variety of controls available for use in ActiveReports. The items 
available from the toolbox change depending on the designer currently in use.

To access the ActiveReports toolbox

1. Open a Visual Studio project. 

2. Add an ActiveReport to the project. 

3. Click on View > Toolbox. 

4. Click on the ActiveReports 3.0 tab. 

 

The ActiveReports toolbox is made up of the following components: 

l Pointer--Allows you to select controls or sections of the report 

l Barcode--Allows you to insert an ActiveReports Barcode control 

l ChartControl--Allows you to insert a chart in any of a variety of styles 

l Checkbox--Allows you to insert a checkbox, bound to a database field or unbound 

l Label--Allows you to insert a new static label control 

l Line--Allows you to insert a line control 

l OleObject--Allows you to insert an OLE object, bound to a database field or unbound 

l PageBreak--Allows you to insert a page break within a selection 

l Picture--Allows you to insert an image loaded from a file 

l New! ReportInfo--Allows you to display report info in a number of format strings such as {PageNumber} 
of {PageCount} 

l Textbox--Allows you to insert a textbox, bound to a database field or unbound 

Toolbox
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l Shape--Allows you to insert a rectangle, circle or square shape  

l Subreport--Allows you to insert a Subreport control to link to another report 

l RichTextBox--Allows you to insert an ActiveReports RichTextBox control 

 

To access the ActiveReports components

See the topic "Adding ActiveReports Controls to the Visual Studio Toolbox."

 

ActiveReports components that can be used on forms or web forms include:

l Designer--Allows you to insert an ActiveReports Designer control 

l ReportExplorer--Allows you to insert an ActiveReports ReportExplorer control 

l HtmlExport--Allows you to add HTML exporting capability to an ActiveReports project 

l PdfExport--Allows you to add PDF exporting capability to an ActiveReports project 

l RtfExport--Allows you to add RTF exporting capability to an ActiveReports project 

l TextExport--Allows you to add text exporting capability to an ActiveReports project 

l TiffExport--Allows you to add TIFF exporting capability to an ActiveReports project 

l New!Toolbox--Allows you to add a toolbox control to use in creating 

l XlsExport--Allows you to add Excel exporting capability to an ActiveReports project 

l Viewer--Allows you to insert an ActiveReports Viewer control 

l WebViewer--Allows you to insert a control to view an ActiveReport on the web 

In ActiveReports, C# expressions can be used in the DataField property to specify textbox output in a report, 
such as date/time, mathematical calculations or conditional values. Any field expression should begin with 
the equals (=) sign.

Adding Field Expressions
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Using Field Expressions

To use a mathematical expression

Change the DataField property for the text box to the mathematical calculation desired. 

Examples: =UnitPrice+5 

=Quantity-5

=Quantity*UnitPrice

=UnitPrice/QuantityPerUnit

To use a substring

Change the DataField property for the text box to the substring needed. If setting up grouping, change the 
GroupHeader's DataField property to the same substring. 

Example: =ProductName.Substring(0, 1)

To use date/time

Change the DataField property for the text box to the following. 

Example: =System.DateTime.Now.ToString()

To create a conditional value

Change the DataField property for the text box to the conditional statement desired. 

Example: =(UnitsInStock > 0)?"In Stock":"Backorder"

To concatenate fields

Change the DataField property for the text box to the following. 

Examples: ="There are " + UnitsInStock + " units of " + ProductName + " in stock."

=TitleOfCourtesy + " " + FirstName + " " + LastName

NOTE: ActiveReports for .NET 3.0 automatically handles null values, replacing them with an empty 
string.

To round a calculation
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Change the DataField Property for the text box to the following. 

Example: =(double)System.Math.Round(UnitPrice*UnitsOnOrder,2)

To use modular division

Change the DataField Property for the text box to the following to get the remainder (2 in this case). 

Example: =22%(5)

To replace a null value

Change the DataField Property for the text box to the following to replace nulls with your own value. 

=(Region == System.DBNull.Value) ? "No region specified" : Region

ActiveReports allows much flexibility in binding reports to various kinds of data sources. In this section, you 
will learn how to use different methods to bind reports to data sources.

Note DAO and RDO data controls are no longer supported in ActiveReports for .NET. The ADO data 
control is converted to an ADO.NET data source. Data controls are removed and replaced with a report 
data source dialog accessible from the data source icon on the Detail section of the report. The XML 
Data control is converted into an XML data source.

dataset
Learn how to bind a report to a data source using a dataset. 

Data View
Learn how to bind a report to a data source using a data view. 

Data Source Icon
Learn how to bind a report to a data source using the DataSource icon in the ActiveReports Designer. 

ActiveReports makes it easy to bind your report to a data source by using the gray DataSource icon located 
in the Detail section of the report design surface or by accessing the DataSource dialog from the Report 
Settings menu.

To use the DataSource icon

1. Open a Visual Studio project. 

2. Add an ActiveReport to your project. 

3. Once the report is added, you will see the report design surface. 

4. Click on the gray DataSource icon in the Detail section of the report to open the Datasource dialog. 

5. You will then be prompted to select your data source, connection string, and query. 

Binding Reports to a Data Source

Using the DataSource Icon
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To connect to Microsoft Access using Jet 4.0

1. Click on the gray report DataSource icon in the Detail section to open the Datasource dialog. 

2. Select the OLE DB tab. 

3. Click on Build.

4. Select "Microsoft Jet 4.0 OLE DB Provider" and click Next.

5. Enter a database name or Click the ellipsis button to browse for the access path to a database. 

6. Click Open once you have entered a database name or selected the appropriate access path. 

7. Click OK to continue. 

8. Enter a SQL statement in the Query box (e.g. "Select * from products"). 

9. Click OK to return to the report design surface. 

To connect to SQL Server 

1. Click on the gray report DataSource icon in the Detail section to open the Datasource dialog. 

2. Select the SQL tab. 

3. Click on Build.

4. Select "Microsoft OLE DB Provider for SQL Server" and click Next.

5. Select a server. 

6. Chose Windows integrated security or a specific username and password. 

7. Choose the database for connection and click OK. 
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8. Enter a SQL statement in the Query box (e.g. "Select * from products"). 

9. Click OK to return to the report design surface. 

To connect to an XML database

1. Click on the gray report DataSource icon in the Detail section to open the Datasource dialog. 

2. Select the XML tab.  

3. Click the ellipsis button beside File URL to browse for the access path to Customer.xml. 

4. Click Open once you have selected the appropriate access path. 

5. In the Recordset Pattern field, enter a pattern (e.g. "//ITEM"). 

6. Click OK to return to the report design surface. 

 

Note: The Datasource dialog contains an Unbound tab. This tab does not provide the mechanism by 
which you can set unbound data, but provides an overview on how to start working with unbound data 
sources.

In addition to being able to set the report's data source with the DataSource icon, ActiveReports for .NET 3.0 
allows you to use the dataset and other .NET data providers directly within the ActiveReport environment. To 
use a dataset at design time, add the necessary data controls to the ActiveReport, set the report's 
DataSource and DataMember properties, and bind the report's controls to the corresponding data fields 

Note: If your project already contains a dataset that you want to use within the ActiveReport designer, 
drag the DataSet object from the Data tab of the toolbox onto the report surface. This will open the 
Add Dataset dialog. To select your dataset, select the Typed dataset option then choose your 
dataset.

To add data controls to the ActiveReport

1. While in an ActiveReport, click the Data toolbox tab. Select any available DataAdapter object and drag it 
onto the report surface; the Data Adapter Configuration Wizard will open and you will see a visual 
representation of the DataAdapter object in the ActiveReports component tray.  

Using a Dataset
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2. Click Next.  

3. Click New Connection, which will open the Data Link Properties dialog, and select the "Provider" tab. 

4. Select the appropriate provider. 

5. Select the "Connection" tab and enter or browse for the path to the desired database file and click OK to 
close the dialog and return to the Configuration Wizard. 

6. Click Next twice, enter the appropriate SQL Select statement and click the Next button again. 

7. Click Finish to close the wizard. A connection object will now reside with the DataAdapter object in the 
ActiveReports component tray. 

8. To generate the dataset, right-click the DataAdapter object, click on "Generate DataSet," select "Add this 
dataset the the designer," and click OK. 

To set the report's DataSource and DataMember properties 

1. Click in the gray area of the design area to select the ActiveReport. 

2. From the Properties grid, set the DataSource property to the newly generated dataset and the 
DataMember to the DataTable. 

After setting the report's data source, all bound fields appear under the Bound node, which is accessed by 
expanding the Fields node in the Report Explorer.

ActiveReports for .NET 3 User Guide | 147



 

To bind the report's controls to the corresponding data fields

1. Drag any desired controls onto the section of the ActiveReport in which you want to place them. 

Note: You can quickly bind an ActiveReports TextBox control to any field by directly dragging the 
field from the Report Explorer onto the ActiveReport design surface.

2. Write code to fill the dataset. In this case, the dataset is filled during the ReportStart_Event.

'Visual Basic
Private Sub rptDataSet_ReportStart(ByVal sender As System.Object, ByVal e As System.EventArgs)_

Handles MyBase.ReportStart
Me.OleDbDataAdapter1.Fill(Me.DataSet11.Employees)

End Sub
 

//C#
private void rptDataSet_ReportStart(object sender, System.EventArgs e)

{
this.oleDbDataAdapter1.Fill(this.dataSet11.Employees);

} 

In addition to using a dataset, the report's data source can be set to a data view. This can be useful for 
creating reports containing filtered information. To use the data view in the report, set the report's 
DataSource property to the data view created from the filtered dataset. 

The following example shows what the code for the method looks like.

'Visual Basic

Using a Data View
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Dim m_dbPath As String
Dim usView As New DataView()
Private Sub Form1_Load(ByVal sender As System.Object, ByVal e As System.EventArgs) _

Handles MyBase.Load
m_dbPath = getDatabasePath()
Me.oleDbConnection1.ConnectionString = "Provider=Microsoft.Jet.OLEDB.4.0;_

 Data Source=" + m_dbPath + "\\Northwind.mdb;Persist Security Info=False"
Me.oleDbDataAdapter1.Fill(Me.dataSet11)
usView = me.dataSet11.Tables("employees"))
usView.RowFilter = "Country = 'USA'"
Me.dataGrid2.DataSource = usView

End Sub
//C#
DataView usView;
private void Form1_Load(object sender, System.EventArgs e)
{

string m_dbPath = getDatabasePath();
this.oleDbConnection1.ConnectionString = "Provider=Microsoft.Jet.OLEDB.4.0;

Data Source=" + m_dbPath + "\\Northwind.mdb;Persist Security Info=False";
this.oleDbDataAdapter1.Fill(this.dataSet11);
usView = new DataView(this.dataSet11.Tables["employees"]);
usView.RowFilter = "Country ='USA'";
this.dataGrid2.DataSource = usView;

}

When deploying a solution that includes the End User Report Designer, you must include the version of the 
Microsoft Rich Text Edit Control DLL which is installed with ActiveReports in a location like this: C:\Program 
Files\Common Files\Data Dynamics\ActiveReports for .NET 3.0\riched20.dll.

If you do not deploy Product version 4 (File version 5.40.11.2210) or higher of riched20.dll with the End User 
Report Designer, it might load a version that is unable to render RTF tables correctly in edit mode of the 
RichText control.

This file should be placed in the same directory as the ActiveReports assemblies.

To deploy this DLL

1. Open the Registry Editor. 

2. Expand the treeview to My Computer\HKEY_CURRENT_USER\Software\Data Dynamics\ActiveReports 
for .NET 3.0. 

3. Right-click in the pane to the right, and choose New > String Value. 

4. Name the new String Value RtfPath. 

5. Double-click RtfPath, and type in the path to the newer version of riched20.dll.

In ActiveReports, a report can consist of single or multiple nested groups, with each group having its own 
header and footer sections. The header section is inserted and printed immediately before the Detail section. 
The footer section is inserted and printed immediately after the Detail section. Up to 32 nested groups are 
allowed in a single report. 

Note: ActiveReports does not order records for grouping. It assumes the data is already sorted in the 
same grouping order. The data source needs to be ordered by the field on which you want your data 
grouped to achieve the desired results. 

Grouping Data in a Report

To group data in a report

1. Right-click in the Detail section of the report design surface, select Insert, and click on Group 

Deploying The End User Report Designer

Grouping Data
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Header/Footer. 

2. This will insert a new group header/footer section into your report. 

3. In the Properties window for the group header, change the DataField property to the field on which you 
want your data grouped. 

4. Change the name of the group header to reflect the field on which data is being grouped.  For example, 
"ghCategories" would be the name of the group header field with the DataField property of "CategoryID". 

ActiveReports provides custom components for several formats, including PDF, HTML, RTF, Excel, TIFF and 
plain text. For information on using these export filters, see the Exporting Output or Custom Web 
Exporting walkthrough. Please note the following limitations in use for each ActiveReports export filter. 

HTML Legacy 
Not 100% WYSIWYG
Does not support: 

l Line control 

l Control borders 

l Shapes (other than filled rectangles) 

l Overlapping controls. 

HTML DHTML
Not 100% WYSIWYG
Does not support: 

l Diagonal line control 

l Control borders 

l Shapes (other than filled rectangles) 

PDF
WYSIWYG as long as you use the correct fonts with foreign text. 

l Does not support full justification 

Excel
Not 100% WYSIWYG
Does not support: 

l Line control 

l Shapes (other than filled rectangles) 

l Overlapping controls 

l Borders on controls with angled text 

Tiff
Image of page, so it's 100% WYSIWYG. 

RTF
Not WYSIWYG
Does not support: 

l Full justification (unless you set the EnableShapes* property to True) 

l Line control (unless you set the EnableShapes* property to True) 

l Section Backcolors 

Limitations in Export Formats

 

ActiveReports for .NET 3 User Guide | 150



l Control Backcolors (unless you set the EnableShapes* property to True) 

l Shapes (unless you set the EnableShapes* property to True) 

l Overlapping controls 

l Control borders (unless you set the EnableShapes* property to True) 

l Angled text 

*Note: If you set the EnableShapes property to True, the resulting RTF file displays correctly only in 
Web Layout View in Microsoft Word.

Text
Not WYSIWYG 

l Supports plain text only. 

l Supports encoding for foreign language support. 

In ActiveReports, you can localize settings for the Windows Forms Viewer control by modifying a provided 
"strings" text file, generating a resources file, embedding the resources file in your ActiveReports project and 
adding the localization code needed in your Form_Load event.

Making localization changes to the strings text file

To make changes to the text file

1. Click here (Script\Strings.txt) to open the text file in your browser. 

2. Right-click on the text and select "View Source." 

3. This will open the file in Notepad. Make changes to localize settings for the viewer control. 

4. Click on Save As., rename your text file "localization.txt" and save it to the location of your choice. 

Generating the resources file from the text file

To generate the resources file

1. From the Start bar, click on All Programs > Microsoft Visual Studio.NET > Visual Studio .NET Tools > 
Visual Studio .NET Command Prompt. 

2. Change the prompt path to reflect the location of your localization.txt file. 

3. Type "resgen localization.txt localization.resources." 

4. This creates a resources file in the same location as the text file. 

Adding the resources file to your Windows application

To add the resources file

1. Open your ActiveReports Windows application which includes an ActiveReports Windows Forms Viewer 
control. 

2. In the Solution Explorer window, click on the icon to "Show All Files." 

3. Right-click on the name of your project and click Add > Add Existing Item.

4. Select the appropriate file path to the localization.resources file and click Open. 

5. This adds the resources file to your application. 

Adding code to the Form1_Load event

To write the code for the viewer in Visual Basic

l Right-click on Form1, and click on View Code to display the code view for the form. At the top left of the 
code view for Form1, click the drop-down arrow and select (Base Class Events). At the top right of the 

Localizing the Viewer Control
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code window, click the drop-down arrow and select Load. This creates an event-handling method for the 
Form1_Load event. 

To write the code for the viewer in C#

l Click on the blue section at the top of Form1 to select the form. Click on the events icon in the 
Properties window to display available events for Form1. Double-click Load. This creates an event-
handling method for the Form1_Load event. 

The following example shows what the code for the method looks like.

' Visual Basic
Private Sub Form1_Load(ByVal sender As System.Object, ByVal e As System.EventArgs) _

Handles MyBase.Load
Dim res As New ResourceManager("YourProjectName.localization", Me.GetType() _

 .Assembly)
Me.Viewer1.Localize = res
Dim rpt As New rptLocalize()
Viewer1.Document = rpt.Document
rpt.Run(True)

End Sub
//C#
private void Form1_Load(object sender, System.EventArgs e)
{

ResourceManager res = new ResourceManager("YourProjectName.localization", 
this.GetType().Assembly);

this.viewer1.Localize = res;
rptLocalize rpt = new rptLocalize();
viewer1.Document = rpt.Document;
rpt.Run(true);

}

In ActiveReports, ruler measurements can be changed from inches to centimeters and centimeters to inches 
from design time. Conversion values for centimeters to inches or inches to centimeters can be called at run 
time as well. 

To change ruler measurements at design time

1. In an existing ActiveReports project, click on Report> Settings.

2. In the Report Settings dialog, click on Global Settings. 

3. Change Ruler Units from inches to centimeters or centimeters to inches. 

Using Metric Units
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To call a measurement conversion at run time

l Call the CmToInch method or InchToCm method whenever needed. For example, if you were working in 
centimeters and needed to convert a label's position measurements from centimeters to inches at run 
time, you would use the following code. 

 

'Visual Basic
Me.lblMyLabel.Left = ActiveReport.CmToInch(2)
Me.lblMyLabel.Top = ActiveReport.CmToInch(2)
//C#
this.lblMyLabel.Left = ActiveReport.CmToInch(2);
this.lblMyLabel.Top = ActiveReport.CmToInch(2);

Optimization can be crucial for very large reports (i.e. well over 100 pages). Here is some information which 
will help you to achieve the best possible results for such reports. To optimize ActiveReports for the web, 
please refer to the memory considerations section.

Memory Considerations
l Images Limit the use of large images when exporting to RTF and TIFF formats. Note that even one 

image uses a lot of memory if it's repeated on every page of a very long report exported to TIFF or RTF. 
If you are not exporting, or if you are exporting to Excel, PDF, or HTML, repeated images are stored only 
once to save memory, but the comparison necessary to detect duplicate images slows the processing 
time for the report. 

l Subreports Limit the use of subreports in repeating sections because each subreport instance consumes 
memory. For example, consider that a subreport in the Detail section of a report in which the Detail 
section is repeated 2,000 times will have 2,000 instances of the subreport. Nested subreports will 
compound the number of instances. If you need to use subreports in repeating sections, instantiate them 
in the ReportStart event instead of the Format event of the repeating section so that they will be 
instantiated only once and use less memory. 

Optimizing ActiveReports
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l CacheToDisk Set the CacheToDisk property of the Document object to True. Although it will slow down 
the processing time, this will cause the document to be cached to disk instead of loading the whole report 
in memory. The PDF export will also detect this setting and use the cached report to export. Please note 
that only the PDF export is affected by the CacheToDisk Property; other exports may run out of memory 
with very large reports. Also note that CacheToDisk uses IsolatedStorage to store a page’s canvasItems 
to disk. To use CacheToDisk you must have IsolatedStorageFilePermission. 

l Summaries Placing summaries (primarily page count and report totals) in header sections will have an 
adverse effect on memory as well as rendering speed with large reports using the CacheToDisk property. 
Since the rendering of the header is delayed until ActiveReports determines the total or page count of the 
following sections, CacheToDisk is unable to perform any optimization. The greater the number of 
affected sections, the longer rendering is delayed and the less optimization CacheToDisk will offer. 
Therefore, a group total in a group header section does not affect performance and memory as much as a 
report total in the report header. 

Speed Considerations
l Images An image repeated on every page of a very long report is stored only once to improve memory, 

but the comparison necessary to detect duplicate images slows performance. This is not only the case 
with the report document itself, but also with the Excel, PDF, and HTML exports as they perform their 
own comparisons. 

l Summaries Placing summaries (primarily page count and report totals) in header sections will slow 
report processing. ActiveReports must determine the total or page count of the following sections before 
it can render the header section. The greater the number of affected sections, the longer rendering is 
delayed. Therefore, a group total in a group header section does not affect performance and memory as 
much as a report total in the report header. 

l CacheToDisk Be sure that the CacheToDisk property of the Document object is not set to True. Setting 
it to True increases the amount of time the report takes to load, and should only be used with very large 
reports that use a lot of memory. If this is used with smaller reports of less than 100 pages, it may 
actually cause more memory to be used.  

l Stored Procedures Using stored procedures instead of SELECT statements speeds up the processing 
time of a report, as it reduces the number of records handled by ActiveReports. Using SELECT * 
statements is not recommended unless you are actually using all of the data returned by such a 
statement. Consult your database administrator for other ways to speed up data retrieval, such as 
indexing tables.

ActiveReports for .NET 3.0 provides two ways for you to preview report output. One way to 
preview your report is by adding the ActiveReports Winforms viewer control. This requires you to run 
your project. A second way is to preview the report via the designer's preview tab.

Using the ActiveReports WinForm viewer
Learn how to preview reports with the WinForm viewer. 

Using the Designer's Preview tab
Learn how to preview reports at design time with the designer's preview tab. 

 

To use the ActiveReports WinForm Viewer to preview report output

1. Add an ActiveReport to your Visual Studio project and rename it rptMain. 

2. Add a new "Windows Form" to your project. 

3. Click on the ActiveReports viewer control in the appropriate toolbox and drag it onto your Windows form. 

4. Set the viewer control's Dock property to Fill. 

To write the code for the viewer in Visual Basic

Viewing Reports

Using the ActiveReports WinForm Viewer
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l Double-click the title bar of the Windows Form to create an event-handling method for the Form_Load 
event. Add code to the handler to: 

l Format the viewer to show the report when it is run

To write the code for the viewer in C#

l Double-click the title bar of the Windows Form to create an event-handling method for the Form_Load 
event. Add code to the handler to: 

l Format the viewer to show the report when it is run 

The following example shows what the code for the method looks like.

' Visual Basic
Private Sub Form1_Load(ByVal sender As Object, ByVal e As System.EventArgs) Handles _

MyBase.Load
Dim rpt As New rptMain()
Viewer1.Document = rpt.Document
rpt.Run()

End Sub
//C#
private void Form1_Load(object sender, System.EventArgs e)
{

rptMain rpt = new rptMain();
this.viewer1.Document = rpt.Document;
rpt.Run();

}
Note: You need to include references to the RtfExport and TextExport dlls in order to enable the 
viewer's copy button

ActiveReports for .NET makes it easy for you to preview your report while you are still creating it. To get a 
preview of your report, click on the Preview tab at the bottom of the ActiveReport designer. In this way you 
can see and work with the report without needing to run your project for visual feedback each time you make 
changes. 

 

ActiveReports allows reports to be saved into their own standard format called an RDF file (Report Document 
Format). Once a report has been saved to an RDF file, it can be loaded into the viewer control and used to 
display reports in custom preview applications.  

To write the code to save a report as an RDF file in Visual Basic

l Right-click in any section of the Windows Form, and click on View Code to display the code view for the 
Windows Form. Add the following code to create the saveRDF event. 

To write the code to save a report as an RDF file in C#

l Double-click on the Windows Form to see the code view for the Windows form. Add the following code to 
create the saveRDF event. 

The following example shows what the code for the method looks like.

'Visual Basic
Dim rpt As New ActiveReport1()

Previewing Reports at Design Time

Saving and Loading RDF Files
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Private Sub saveRDF()
rpt.Run()
rpt.Document.Save(Application.StartupPath + "\\NewRDF.RDF"

End Sub
//C#
private void saveRDF()
{

ActiveReport1 rpt = new ActiveReport1();
rpt.Run();
rpt.Document.Save(Application.StartupPath + "\\NewRDF.RDF";

}
 

To write the code to load the saved RDF into the ActiveReports viewer in Visual Basic

l Right-click in any section of the Windows Form, and click on View Code to display the code view for the 
Windows Form. Add the following code to create the loadRDF event. 

To write the code to load the saved RDF into the ActiveReports viewer in C#

l Double-click on the Windows Form to see the code view for the Windows form. Add the following code to 
create the loadRDF event. 

The following example shows what the code for the method looks like.

'Visual Basic
Private Sub loadRDF()

rpt.Run()
Viewer1.Document.Load(Application.StartupPath + "\\NewRDF.RDF"

End Sub
//C#
private void loadRDF()
{

ActiveReport1 rpt = new ActiveReport1();
rpt.Run();
viewer1.Document.Load(Application.StartupPath + "\\NewRDF.RDF");

}

Although ActiveReports for .NET 3.0 writes report layouts in C# or VB.NET, depending on the .NET 
environment in which the report is created, you can choose to save your the layout of your report as an RPX 
(report XML) file for portability and editing. If you make changes to the RPX and bring the report back into 
the Visual Studio IDE, ActiveReports will reflect the changes in C# or VB.NET.

Note: When an RPX-based layout is loaded into a project it will supersede the currently active report. 
Thus, in order to avoid replacing any important layouts in the current project, a new blank ActiveReport 
must be created before loading the file. After you have created the new ActiveReport, load the RPX file 
into it. 

To save a current report as an RPX file

1. While in an ActiveReport, from the Report menu, select Save Layout.

2. Name the file appropriately and select the location in which to save it.

Saving and Loading RPX Files
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3. Select the type of layout you wish to save. You can choose the old Arnet Format for backward 
compatibility, or the new Arnet3 Format which saves component tray items. Note that datasets are not 
able to be saved in the component tray, but can be easily regenerated from the data adapter, which is 
saved. 

4. Click Save to save the selected report layout. 

To load an existing RPX file

1. While in an ActiveReport, click Report > Load Layout. 

2. Select the RPX file from the appropriate location. 

3. Click Open to load the selected report layout. 

To write the code to save a report as an RPX file in Visual Basic

l Right-click on the Windows Form and select View Code from the shortcut menu to see the code view for 
the Windows form. Add the following code to create the saveRPX event. 

To write the code to save a report as an RPX file in C#

l Right-click on the Windows Form and select View Code from the shortcut menu to see the code view for 
the Windows form. Add the following code to create the saveRPX event. 

The following example shows what the code for the method looks like.
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'Visual Basic
Dim rpt As New ActiveReport1()
Private Sub SaveRPX()

rpt.Run()
rpt.SaveLayout("C:\NewRPX.RPX", DataDynamics.ActiveReports.ActiveReport3.RpxFormat.Arnet3)

End Sub
//C#
private void SaveRPX()
{

NewActiveReport1 rpt = new ActiveReport1();
rpt.Run();
rpt.SaveLayout(@"C:\NewRPX.RPX", DataDynamics.ActiveReports.ActiveReport3.RpxFormat.Arnet3);

}
Note: The SaveLayout method uses utf-16 encoding when you save to a stream, and utf-8 encoding 
when you save to a file.

To write the code to load the saved RPX into the ActiveReports viewer in Visual Basic

l Double-click on the Windows Form to see the code view for the Windows form. Add the following code to 
create the loadRPX event. 

To write the code to load the saved RPX into the ActiveReports viewer in C#

l Double-click on the Windows Form to see the code view for the Windows form. Add the following code to 
create the loadRPX event. 

The following example shows what the code for the method looks like.

'Visual Basic
Dim rpt As New ActiveReport1()
Private Sub LoadRPX()

rpt.LoadLayout("C:\NewRPX.RPX")
Viewer1.Document = rpt.Document
rpt.Run()

End Sub
//C#
private void loadRPX()
{

NewActiveReport1 rpt = new ActiveReport1();
rpt.LoadLayout(@"C:\NewRPX.rpx");
viewer1.Document = rpt.Document;
rpt.Run();

}
Note: When saving to an RPX file, be sure to save the report before it runs. Saving the layout after the 
report runs will cause any dynamic changes made to properties or sections to be saved in the layout. 
When calling SaveLayout inside the report's code, use the ReportStart event. Also note that when 
saving a report layout, only the code in the script editor will be saved to the file. Any code behind the 
report in the .cs or .vb file will not be saved to the RPX file.

Notes About Datasets and Component Trays
When saving a layout which contains a dataset to the Arnet3 Format, the data adapter and data 
connection are saved in the component tray, but the dataset itself is lost. When the saved layout is loaded 
into another report, you must generate the dataset again, as there is no convenient way to reconnect the old 
dataset.

If you load an Arnet3 Format RPX file with items in the component tray into a report, and subsequently load 
an Arnet Format RPX file into the same report, the component tray remains on the report. Since there was 
no component tray in the old format, loading an old format layout file ignores any existing component tray on 
the report.

The new Chart control in ActiveReports allows you to display data with even greater visual impact.

Adding, Moving or Deleting a Chart

Using Charts
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Learn how to add, move, or delete a chart. 

Creating a Simple Bar Chart 
Learn how to create a simple bar chart. 

Saving and Loading Charts 
Learn how to save charts to XML files and load charts from XML files. 

To add a Chart control to an ActiveReport

1. Select the ChartControl from the ActiveReports toolbox. 

2. Draw the chart onto the report design surface. 

To move the chart

1. Click the chart on the report. 

2. Drag it to the new location. 

To delete the chart

1. Click the chart to select it. 

2. Right-click and choose Delete from the shortcut menu. 

In ActiveReports, you can create a simple bar chart by placing a chart control on the report and adding some 
data points.

Placing a chart control on the report

To place a chart control on the report

1. Resize the section in which you want to place the chart. 

2. Select the ChartControl from the ActiveReports toolbox and draw it onto the report. 

Adding, Moving or Deleting a Chart

Creating a Simple Bar Chart
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Adding data points to the chart

To add data points to the chart

1. With the chart control highlighted, click the Customize verb below the Properties panel to open 
the Chart Designer dialog. 
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2. Click the Series button on the left side of the Chart Designer. 

 

3. With Series1 selected, click the Points tab on the right side of the Chart Designer. 
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4. Add points to the series by clicking the Add new item icon. 

 

5. For each point that you add, supply an XValue and YValue in the Point Properties box. 
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6. Delete Series2 and Series3, leaving only the first one. 

 

7. Click the Finish button to see these values reflected in a simple bar chart.

Saving and Loading Charts
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After you have added a chart control to your ActiveReport, you can save the chart to an XML file as well as 
load an existing XML-based chart into your project. A chart can be saved to or loaded from an XML file at 
design time using the "Load" and "Save As" verbs below the Properties window.

Note: When an XML-based chart layout is loaded into a project it will supersede the chart layout in the 
currently active report. Thus, in order to avoid replacing any important layouts in the current project, a 
new blank ActiveReport must be created before loading the file. After you have created the new 
ActiveReport, load the XML file into it. 

The following code demonstrates how you can do this programmatically.

'VB
Private Sub ReportHeader_Format(ByVal sender As Object, ByVal e As System.EventArgs) _

Handles ReportHeader.Format
Me.ChartControl2.Save(Application.StartupPath & "\savedChart.xml")

End Sub

Private Sub Detail1_Format(ByVal sender As Object, ByVal e As System.EventArgs) Handles _
Detail1.Format

Me.ChartControl1.Load(Application.StartupPath & "\Bezier.xml")
End Sub
 

//C#
private void ReportHeader_Format(object sender, System.EventArgs eArgs)
{

this.ChartControl2.Save(System.Windows.Forms.Application.StartupPath + 
"\\savedChart.xml");

private void detail_Format(object sender, System.EventArgs eArgs)
{

this.ChartControl1.Load(System.Windows.Forms.Application.StartupPath + 
"\\Bezier.xml");

}
}
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The WinForms viewer control now provides for the placement of annotations on the viewer's report view via 
the Annotations button on the viewer control's toolbar. This makes it possible to add notes, special 
instructions, etc., directly on the ActiveReport itself, making team collaboration, feedback, and end-user 
support an easier task. Design-time annotations live off of the Page object in which they are placed, therefore 
they are destroyed when the report closes. In order to save annotations you must add them via code. Once 
added in code, you can save your report as an RDF with your annotations intact. 

The following shows several types of ActiveReports' annotations and how they can be used to convey special 
instructions. 

 

Adding Annotations to your ActiveReport
ActiveReports for .NET 3.0 makes it easy to add annotations to your projects. You can do so at design time 
via the report's toolbar or at run time through the Annotations collection.

To add annotations at design time

1. Click the Annotations button on the ActiveReports for .NET 3.0 toolbar. 

 

2. Select the type of annotation you want to add from the annotation menu and drag it onto the viewer. 

Using Annotations
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Available annotations include: 

¡ AnnotationText—Displays a rectangular box that can have text within it. 

¡ AnnotationCircle—Displays a circle without text functionality. 

¡ AnnotationRectangle—Displays a rectangular box without text functionality. 

¡ AnnotationArrow—Displays a 2D arrow that can have text within it. 

¡ AnnotationBalloon—Displays a balloon caption that can have text within it. The balloon's "tail" can be 
placed in one of eight positions around the balloon. 

¡ AnnotationLine—Displays a line with area for text. 

 

3. Set the annotation look and feel or delete it from your project by right-clicking the annotation and 
selecting Properties or Delete from the shortcut menu. 

To add annotations at run time

The following example shows how annotations can be added at run time and saved to an RDF file.

'Visual Basic
Imports DataDynamics.Viewer.Annotations
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Dim rpt As New rptAnnotations
Private Sub AddAnnotations() 

'Run the report first
rpt.Run()

'Assign the viewer
Me.Viewer1.Document = rpt.Document

'Create an annotation and assign property values
Dim circle As New AnnotationCircle
circle.Color = System.Drawing.Color.GreenYellow
circle.Border.Color = System.Drawing.Color.Chartreuse

'Add the annotation
circle.Attach(1,1) 'screen location
Me.Viewer1.Document.Pages(0).Annotations.Add(circle)

'Set the size properties. The annotation must be added to the page first.
circle.Height = 0.25
circle.Width = 0.50

'Save annotations to an RDF file
rpt.Document.Save("C:\\MyAnnotations.rdf")

End Sub

//C#
using DataDynamics.ActiveReports.Viewer.Annotations;

rptAnnotations rpt = new rptAnnotations();
private void AddAnnotations()
{

//Run the report first
rpt.Run();
 
//Assign the viewer
this.viewer1.Document = rpt.Document;
 
//Create an annotation and assign property values
AnnotationCircle circle = new AnnotationCircle();
circle.Color = System.Drawing.Color.GreenYellow;
circle.Border.Color = System.Drawing.Color.Chartreuse;

 
//Add the annotation
circle.Attach(1,1) //screen location
this.viewer1.Document.Pages[0].Annotations.Add(circle);

//Set the size properties. The annotation must be added to the page first.
circle.Height = 0.25f;
circle.Width = 0.50f;

//Save annotations to an RDF file
rpt.Document.Save("C:\\MyAnnotations.rdf");

}

ActiveReports for .NET 3.0 has many new features that enhance the reporting capabilities already praised by 
developers in previous versions of ActiveReports.

New Support for Visual Studio.NET 2005
ActiveReports for .NET 3.0 now offers support for Visual Studio .NET Versions 2003 and 2005. 

New File Format
ActiveReports are now written in C# or Visual Basic for .NET, depending on the type of .NET environment 
in which you create the report. A new ActiveReports Report Converter can be used to convert RPX-based 

What's New
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reports, ensuring that older ActiveReports will be fully supported by the new architecture. 

New Chart types
With the addition of the seven new chart types, developers are freed from the need to find a separate 
charting component. This not only saves money, but also time, as the Chart control is already integrated 
into ActiveReports. New chart types include the following: 

l Funnel Charts show how the percentage of each data item contributes to the whole. 

l Gantt Charts graph the progress of project tasks. 

l Kagi Charts display supply and demand trends. 

l Point and Figure Charts define pricing trends. 

l Pyramid Charts share the same function as Funnel charts but show the data in a different format. 

l Renko Charts keep track of price movement. 

l Three Line Break Charts illustrate price changes. 

New Design-time Functionality
ActiveReports boasts new design-time features that can reduce the amount of written code and give you 
greater control over the layout of your reports, such as the following: 

l A preview tab that provides real-time report feedback, allowing you to quickly see the run-time impact 
of your coding and design-time drag-and-drop actions. With a click of the mouse, you can preview 
your report and then return to the designer to make changes. 

To preview your ActiveReport, click the Preview tab below the report design surface. To return to the 
design surface, click the Designer tab.

 

l The addition of a zoom toolbar item allows developers and end users to magnify the design surface of 
the report for more precise placement and viewing of report controls. 

Note: The magnification ComboBox is viewable in Preview mode, at run time, and with the End-
User Report Designer that is included in the Professional edition. Only the zoom control is 
available at design time.

l The Report Explorer's Fields listbox has been replaced by the Fields node, giving the Report Explorer a 
more self-contained look and feel. Expanding the Fields node reveals the report's data fields. 

l The Report Explorer now contains a node for Calculated Fields. You can add, delete, and 
modify calculated fields at design time.  

 

l A Parameters node has been added to the Report Explorer. You can easily add, delete, and modify 
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report parameters at design time.   

 

l .NET data components can now be dropped directly onto the design surface of an ActiveReport, 
resulting in a visual representation of the component in the new ActiveReports component tray. This 
makes it easy to use custom data. 

 

l More Shortcut Key Support 

¡ Pressing CTRL+A while in a report section selects all of the controls in that selection. 

¡ Pressing the CTRL key while dragging a control allows you to copy the control to a different report 
section. 

¡ Pressing the SHIFT key while dragging a control allows you to move that control to a different 
report section. 

l New ReportInfo control can be dragged from the ActiveReports 3.0 toolbox onto any section of the 
report, allowing you to easily display report information such as "page N of M" and/or run-time 
dates in multiple formats through manipulation of the ReportInfo.FormatString property. 
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Viewer Enhancements
The Viewer control in ActiveReports for .NET 3.0 has been improved with several new features that 
improve the look and feel and behavior of your ActiveReports projects. 

l Annotations in the Viewer control

The WinForms viewer control now provides for the placement of annotations on the viewer's report 
view. This makes it possible to add notes, special instructions, etc., directly on the ActiveReport itself, 
making team collaboration, feedback, and end-user support an easier task.

l Tabbed Viewing 

ActiveReports now uses the HyperLink property of controls to provide tabbed viewing for TOC contents 
and Web links. When hyperlinks that point to a Web page or the TOC, ActiveReports opens the link as 
a new tab within the viewer. In this way, report navigation becomes much easier and more appealing 
to end users, who can quickly move from links back to their original place in the report by clicking the 
tabs at the top of the report. Additionally, links set to e-mail addresses shell out to the operating 
system, which opens the default e-mail program.

l New HyperLink Properties for the Viewer Control

Five additional hyperlink properties have been added to the viewer control that allow developers to 
further customize the look and behavior of their reports. 

Enhanced End-User Report Designer
The professional edition of ActiveReports now contains a redesigned end-user report designer that 
exposes the CommandBar library for developers who wish to customize the look and feel of the user 
interface. Developers now have at their disposal all of the any or all of the inherent toolbar items 
packaged within ActiveReports as well as the option to place their own custom toolbar objects on the end-
user report designer.  

Property Function

HyperLinkForeColor Sets the foreground color of the viewer's hyperlinks 

HyperLinkBackColor Sets the background color of the control that hosts a hyperlink

HyperLinkUnderline Determines whether hyperlinks will be underlined

SearchResultsForeColor Sets the foreground color of the highlighted text when using 
the find dialog 

SearchResultsBackColor Sets the background color of the highlighted text when using 
the find dialog 
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Change to the Document.Print() Method
The Document.Print() method now returns Boolean overloads to indicate whether report printing has been 
aborted due to an unhandled exception, the user pressing the Cancel button, or if the report completed 
printing. 

Added Scripting Capabilities
ActiveReports now supports the use of Visual Basic .NET and C# as scripting languages. To take 
advantage of this new feature, specify your preferred scripting language by setting the ScriptLanguage 
property on ActiveReports, which will be saved in the RPX file for the report. 

Enhanced Access Conversion
Easily convert existing Microsoft® Access® reports into ActiveReports with the new ActiveReports 
Microsoft Access Import Wizard. 

New Barcode
New barcode type EAN128. 

New CacheToDiskLocation property on the Document object
The new CacheToDiskLocation property allows users to specify the location of the CacheToDisk temp files. 

A New Event in the End User Report Designer control
With the addition of the DataSourceIconClick event, developers can customize the datasource dialog that 
end users see in the Professional Edition. 

New Web Viewer Export Options
You can now set export properties directly on the WebViewer control using the Properties grid. Expand the 
HtmlExportOptions and PdfExportOptions properties in the Properties grid to see all of the properties you 
can set. 

Licensing a Machine for ActiveReports for .NET 3.0

To license a machine for ActiveReports for .NET 3.0

1. Locate the original downloaded electronic store package or shipped CD. 

2. Locate the licensing application based on the edition 

¡ Standard Edition: LicenseStd3.exe or UpgradeStd3.exe 

¡ Professional Edition: LicensePro3.exe or UpgradePro3.exe

3. Run the machine licensing executable you located in the above step. 

4. Enter the information as prompted (User Name, Company Name) without commas or periods. (The keys 
in the web.config file are comma delimited and entering a comma will cause errors.) 

5. Determine whether your project is a Windows Forms Solution or a Web Form Solution. Visit the 
appropriate section below.

Checking ActiveReports Windows Applications for Licensing

To check an existing ActiveReports Windows application for licensing

1. Open an existing ActiveReports Windows application project. 

2. In the Solution Explorer window, choose the "Show All Files" icon. 

To access the script editor, click the Script tab 
below the report design surface.

Licensing Reports
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3. If there is a file called "licenses.licx" in your application's file list, the ActiveReports application is licensed. 

4. If the "licenses.licx" file does not appear in your application's file list, follow the instructions under 
"Licensing Existing Windows Forms Projects" below. 

Licensing a Project Using the SetLicense Method

To license a project using the SetLicense method

1. Create a "web.config" key by running the "Create Web.Config Key" described in the Web Forms section 
below. 

2. In your application class, create a report instance and use the SetLicense() method to properly set the 
key you created from Step A. The string value for the generated key should be "[Name], [Company 
Name], [Serial Number], [Hash Code]". 

Licensing Existing Windows Forms Projects

To license Windows Forms Projects

Note: Please note that the above steps will license your machine for new Windows Forms projects 
only. If you have an existing Windows Forms project created before you purchased the license, you 
must open the project after performing the steps above and rebuild the solution. This will work unless 
your project is a special solution as listed below. 

1. If the project does not have a licenses.licx file in the startup project, use one of the following methods: 

¡ Add a temporary ActiveReport to the startup project and choose Rebuild from the Build menu before 
deleting the ActiveReport. 

¡ Or copy the licenses.licx from the project containing the reports to the startup project. Ensure that 
the build action is set to "Embedded Resource."

2. If the startup project includes a licenses.licx file, verify that it includes the following line: 
"DataDynamics.ActiveReports.ActiveReport3, ActiveReports" 

3. If the startup project only contains an End User Designer use one of the following methods to license it: 

¡ Add a new designer to the project and choose Rebuild from the Build menu. Once this is done, and 
you've verified that the "DataDynamics.ActiveReports.Designer.Designer, ActiverReports.Design" line 
has been added to your licenses.licx file, you can safely remove the extra designer from the project. 

¡ Or add the line "DataDynamics.ActiveReports.Designer.Designer, ActiverReports.Design" to the 
licenses.licx file manually. Once this is added, Rebuild the solution from the Build menu.

Licensing Web Forms Projects

To license Web Forms Projects 

1. If you are using a Web Forms project you must create a web.config key for your project using the utility 
located in the Start Menu under All Programs > Data Dynamics > ActiveReports for .NET > Create 
Web.Config Key. 

2. Enter the same information you used to license the machine and it will create a key that you can copy 
into your project's Web.Config file between <configuration> and <system.web> to remove the licensing 
message. The web.config key looks like this: 
<configuration>

<appSettings>
<add key="DataDynamicsARLic" value="FIRST NAME,LAST NAME,LICENSE KEY,KAJSDKQFGJKJSADFFP" />

</appSettings>
</configuration>
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This topic will show you how to locate Readme information as well as how to obtain support for ActiveReports 
for .NET 3.0.

 

Readme File
Find out how to locate the Readme file. 

Product Support 

Find out how to obtain product support for ActiveReports for .NET 3.0. 

Related Sections

Introducing ActiveReports for .NET 3.0
ActiveReports leverages the latest technologies including XML, scripting and CSS along with 

open architecture to provide a fully-integrated and user-friendly report designer. 

Frequently Asked Questions
This section lists questions and answers about ActiveReports for .NET 3.0. 

Installation and Setup
This topic will help you find out what is necessary to install ActiveReports and direct you to 

appropriate help for the installation process. 

Samples and Walkthroughs
This section contains sample code and applications that illustrate basic techniques and uses of 

ActiveReports. 

After installation, you can locate the Readme.hta file in the "Introduction" folder of the root ActiveReports 
for .NET 3.0 installation folder. Use your Internet browser to open and view the file. 

This topic will explain how to register your ActiveReports for .NET 3.0 purchase and obtain technical support.

In this section

Product Registration
Learn how to register your product purchase with Data Dynamics. 

Technical Support
Find how to receive technical support for ActiveReports for .NET 3.0. 

In order to receive telephone support, product news, and upgrade announcements, you must register your 
product purchase with Data Dynamics. We encourage you to register your purchase as soon as you receive it 
by completing the registration form on our Web site at 
http://www.datadynamics.com/Products/Register.aspx. 

Getting Assistance

Readme File

Product Support

Product Registration

Technical Support
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Technical support is available for ActiveReports for .NET 3.0 in a variety of media. 

Telephone Support
Telephone support is available for registered users of ActiveReports for .NET 3.0.

When contacting Data Dynamics with support questions, be prepared to provide a serial number, the full 
version number of ActiveReports, a complete description of the problem, as well as hardware and operating 
environment specifications.

Support telephone number:  (614) 895-3142 (9:00am-5:00pm US Eastern Standard Time)

E-mail Support
E-mail support is available for ActiveReports for .NET 3.0. Contact 
activereports.support@datadynamics.com . 

Web site
The Data Dynamics web site offers the latest product news, white papers, tutorials, report samples and 
product service packs. Please visit the web site for the latest news about ActiveReports for .NET 3.0 before 
contacting technical support.

Product Upgrades

Minor upgrades and service packs will be made available for download from the Data Dynamics web site free 
of charge.

http://www.datadynamics.com/Products/default.aspx?Mode=Downloads

Major upgrades will carry an upgrade price that is determined separately for each release. You will be eligible 
for a free major upgrade if you purchased the product within 30 days of the upgrade release date.

KnowledgeBase articles

The Data Dynamics KnowledgeBase contains hundreds of helpful articles for all Data Dynamics products. You 
can search the entire KnowledgeBase for keywords or narrow down your search first by choosing a specific 
product before submitting your search criteria.

KnowledgeBase (http://www.datadynamics.com/Products/default.aspx?
Mode=Knowledge+Base)

Support Forums

The Data Dynamics support forums can be used to read and post questions and answers about issues you 
encounter with ActiveReports for .NET 3.0. Tips and tricks can be communicated with other users and access 
to the Data Dynamics technical support team can be gained in an online community forum. Data Dynamics' 
technical support engineers monitor the forums constantly and are available to answer questions and assist 
with any issues encountered using the product. Product announcements will also be posted to the forums.

Support forum address for ActiveReports for .NET 3.0: 
http://www.datadynamics.com/ShowForum.aspx?ForumID=73

This section contains example code and sample applications that illustrate basic techniques and uses of 
ActiveReports. 

In This Section

Samples
Review various samples in C# and Visual Basic .NET.  

Walkthroughs
Learn how to create various reports and report constituents with step-by-step instructions. 

Related Sections

Introducing ActiveReports for .NET 3.0

Samples and Walkthroughs
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ActiveReports leverages the latest technologies including XML, Scripting and CSS along with open 
architecture to provide you with a fully-integrated and user-friendly report designer.  

Getting Assistance
This topic shows you how to locate Readme information as well as how to obtain support for ActiveReports 
for .NET 3.0. 

ActiveReports includes many samples which demonstrate applications the developers created for 
ActiveReports for .NET 3.0. These samples show the use of a combination of controls and code to produce 
various reports.

In this section

Standard Edition Samples
Provides links to samples of Standard Edition applications. 

Professional Edition Samples
Provides links to samples of Professional Edition applications. 

Additional Information

Walkthroughs
Walkthroughs give basic step-by-step instructions for common situations in ActiveReports. This feature 
makes walkthroughs an excellent way to learn more about the basic features of the product. 

Annual Report
Demonstrates subreports, Nested subreports, modifying data source properties at run time, 

parameters in the chart control, alternate row highlighting and pagebreak control. 

ASP.NET Standard Edition Web Sample
Demonstrates using Standard Edition in ASP.NET. It shows how to use custom exporting without 

the Pro Edition server controls or RPX handlers as well as running reports on the server, exporting output 
to HTML or PDF streams and pushing content to the client. The sample also demonstrates using the 
ActiveX viewer control to view report output on the client machine. 

Bound Data Sample
Demonstrates binding to ADO.NET Data objects. 

CacheToDisk Sample
Demonstrates the usage and effects of the CacheToDisk property. 

Calculated Fields Sample
Demonstrates using an unbound data field to perform a calculation which can then be aggregated. 

Category Selection
Demonstrates using the ad hoc report filter by modifying the report's SQL query at run time. 

Charting Sample
Demonstrates the use of the Chart control in both bound and unbound modes. 

Cross-Tab
Demonstrates using unbound data, conditional highlighting and distributing data across columns to 

create a cross-tab view and data aggregation. 

Custom Preview
Demonstrates using viewer control customization, export filters, rich edit control and mail-merge, 

parameters in the chart control, and grouping. 

DataField Expressions
Demonstrates the use of expressions in the DataField properties of controls. 

Samples

Standard Edition Samples
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E-mail
Demonstrates rendering a stand-alone RPX file to PDF and e-mailing the PDF file as an attachment 

using the default mail client. 

Hyperlinks and Drill-Downs
Demonstrates using hyperlinks and the viewer hyperlink event to simulate drill-down from one 

report to another. 

iList Binding Sample
Demonstrates how to bind reports to objects. 

Print Multiple Pages Per Sheet
Demonstrates how to print multiple pages of a report on a single sheet of paper. 

RDF File Viewer
Demonstrates customizing the WinForms viewer control toolbar, loading Report Document Files 

(RDF) and using the export filters. 

Report Assemblies
Demonstrates distributing reports as separate assembly files and calling them from the main 

application .exe file. 

Subreports
Shows the proper use of Reports with SubReports to minimize memory usage. 

Unbound Data
Demonstrates retrieving data from an array and from a text file in unbound mode. 

XML Data
Demonstrates the XML data source and using it to run multi-level reports with and without using 

subreports. 

The Annual Report Sample demonstrates subreports, Nested subreports, modifying data source properties at 
run time, parameters in the chart control, alternate row highlighting, and the pagebreak control.

To run this sample

1. Open the sample folder at <Installation Folder>\Samples 

2. Open the .sln file. 

3. Press F5 to start the application. 

The ASP.NET Web sample demonstrates using Standard Edition in ASP.NET. It shows how to use custom 
exporting without the Pro Edition server controls as well as running reports on the server, exporting output to 
HTML or PDF streams and pushing content to the client. The sample also demonstrates using the ActiveX 
viewer control to view report output on the client machine.

Notes: The web samples for Visual Studio 2003 will need to be configured using the auto-configuration 
utility or configured manually before the samples can be run (see Manually Configuring Web 
Samples for help). Also, the ASP.NET user machine will need to have ASP.NET write access before 
running the samples or an exception may be thrown during execution. 

To run this sample

1. Open the sample folder at <Installation Folder>\Samples 

2. Open the .sln file. 

3. Press F5 to start the application. 

Annual Report Sample

ASP.NET Standard Edition Web Sample for Visual Studio 2003

Bound Data Sample
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The Bound Data Sample demonstrates binding to ADO.NET Data objects.

To run this sample

1. Open the sample folder at <Installation Folder>\Samples 

2. Open the .sln file. 

3. Press F5 to start the application. 

The CacheToDisk Sample demonstrates the usage and effects of the CacheToDisk property. 

To run this sample

1. Open the sample folder at <Installation Folder>\Samples 

2. Open the .sln file. 

3. Press F5 to start the application. 

The Calculated Fields Sample demonstrates using an unbound data field to perform a calculation that can 
then be aggregated. 

To run this sample

1. Open the sample folder at <Installation Folder>\Samples 

2. Open the .sln file. 

3. Press F5 to start the application. 

The Category Selection Sample demonstrates using the ad hoc report filter by modifying the report's SQL 
query at run time.

To run this sample

1. Open the sample folder at <Installation Folder>\Samples 

2. Open the .sln file. 

3. Press F5 to start the application. 

The Charting Sample demonstrates the use of the Chart control in both bound and unbound modes. 

To run this sample

1. Open the sample folder at <Installation Folder>\Samples 

2. Open the .sln file. 

3. Press F5 to start the application. 

CacheToDisk Sample

Calculated Fields Sample

Category Selection Sample

Charting Sample

Cross-Tab Sample
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The Cross-Tab Sample demonstrates using unbound data, conditional highlighting and distributing data 
across columns to create a cross-tab view and data aggregation.

To run this sample

1. Open the sample folder at <Installation Folder>\Samples 

2. Open the .sln file. 

3. Press F5 to start the application. 

The Custom Preview Sample demonstrates using viewer control customization, export filters, rich edit control 
and mail-merge, parameters in the chart control, and grouping.

To run this sample

1. Open the sample folder at <Installation Folder>\Samples 

2. Open the .sln file. 

3. Press F5 to start the application. 

The DataField Expressions Sample demonstrates the use of expressions in the DataField properties of 
controls.

To run this sample

1. Open the sample folder at <Installation Folder>\Samples 

2. Open the .sln file. 

3. Press F5 to start the application. 

The E-mail Sample demonstrates rendering a stand-alone RPX file to PDF and e-mailing the PDF file as an 
attachment using the default mail client.

To run this sample

1. Open the sample folder at <Installation Folder>\Samples 

2. Open the .sln file. 

3. Press F5 to start the application. 

The Hyperlinks and Drill-Downs Sample demonstrates using hyperlinks and the viewer hyperlink event to 
simulate drill-down from one report to another.

To run this sample

1. Open the sample folder at <Installation Folder>\Samples 

2. Open the .sln file. 

3. Press F5 to start the application. 

Custom Preview Sample

DataField Expressions Sample

E-mail Sample

Hyperlinks and Drill-Down Sample
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The iListBinding Sample demonstrates how to bind reports to objects.

To run this sample

1. Open the sample folder at <Installation Folder>\Samples 

2. Open the .sln file. 

3. Press F5 to start the application. 

The Print Multiple Pages Per Sheet Sample demonstrates how to print multiple pages of a report on a single 
sheet of paper using page scaling. 

To run this sample

1. Open the sample folder at <Installation Folder>\Samples 

2. Open the .sln file. 

3. Press F5 to start the application. 

The RDF File Viewer Sample demonstrates customizing the WinForms viewer control toolbar, loading Report 
Document Files (RDF) and using the export filters.

To run this sample

1. Open the sample folder at <Installation Folder>\Samples 

2. Open the .sln file. 

3. Press F5 to start the application. 

The Report Assemblies Sample demonstrates distributing reports as separate assembly files and calling them 
from the main application .exe file.

To run this sample

1. Open the sample folder at <Installation Folder>\Samples 

2. Open the .sln file. 

3. Press F5 to start the application. 

The SubReports Sample shows the proper use of Reports with SubReports to minimize memory usage.

To run this sample

1. Open the sample folder at <Installation Folder>\Samples 

2. Open the .sln file. 

3. Press F5 to start the application. 

iList Binding Sample

Print Multiple Pages Per Sheet Sample

RDF File Viewer Sample

Report Assemblies Sample

Subreports Sample
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The Unbound Data Sample demonstrates retrieving data from an array and from a text file in unbound mode.

To run this sample

1. Open the sample folder at <Installation Folder>\Samples 

2. Open the .sln file. 

3. Press F5 to start the application. 

The XML Data Sample demonstrates the XML data source and using it to run multi-level reports with and 
without using subreports.

To run this sample

1. Open the sample folder at <Installation Folder>\Samples 

2. Open the .sln file. 

3. Press F5 to start the application. 

ASP.NET Web Sample
Demonstrates the use of Professional Edition ASP.NET features, including RPX HTTP Handlers, Report 
Caching and the Server Viewer Control. 

End-User Report Designer Control
Demonstrates a custom End-User Report Designer that can be integrated in your applications to allow 
users to modify report layouts. 

The ASP.NET Web Sample demonstrates the use of Professional Edition ASP.NET features, including HTTP 
Handlers, Report Caching, and the Server Viewer Control.

Note The web samples will need to be configured using the auto-configuration utility or configured 
manually before the samples can be run (see Manually Configuring Web Samples for help). Also, 
the ASP.NET user machine will need to have ASP.NET write access before running the samples or an 
exception may be thrown during execution. 

To run this sample

1. Open the sample folder at <Installation Folder>\Samples 

2. Open the .sln file. 

3. Press F5 to start the application. 

The End-User Report Designer Sample demonstrates a custom end-user report designer that can be 
integrated in your applications to allow users to modify report layouts.

To run this sample

Unbound Data Sample

XML Data Sample

Professional Edition Samples

ASP.NET Web Sample

End-User Report Designer Sample
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1. Open the sample folder at <Installation Folder>\Samples\Professional Edition 

2. Open the .sln file. 

3. Press F5 to start the application. 

Learn how to create various applications in C# and Visual Basic .NET--one step at a time.

In this section

Standard Edition Walkthroughs
This section includes step-by-step instructions for creating applications in the Standard edition of 
ActiveReports for .NET 3.0. 

Professional Edition Walkthroughs
This section includes step-by-step instructions for creating applications using features available in the 
Professional edition of ActiveReports for .NET 3.0. 

Additional Information

Samples
ActiveReports includes many samples which demonstrate applications the developers created for 
ActiveReports. These samples show the use of a combination of controls and code to produce various 
reports. 

Walkthroughs give basic step-by-step instructions for common situations in ActiveReports. This feature 
makes walkthroughs an excellent way to learn more about the basic features of the product. For most 
walkthroughs, it is assumed that references to the DataDynamics.ActiveReports and 
DataDynamics.ActiveReports.Document namespaces have been added to the project.

In this section

Address Labels
Describes how to print labels using columns. 

Bookmarks
Describes how to set up Bookmarks to organize reports for easy navigation. 

Calculated Fields
Describes how to use a field's DataField property to perform calculations in a report. 

Charts
Describes how to use the Chart control in a report. 

Columnar Reports
Describes how to format a report to use columns. 

Custom Controls and ChartFX
Describes how to ChartFX as a custom control with ActiveReports. 

Customizing the Viewer Control
Describes how to customize the viewer control in a report. 

Data Bound Reports
Describes how to connect a report to a data source using the DataSource icon. 

Datasets Containing Relationships with Subreports
Describes how to use datasets containing relationships with subreports. 

Deploying Compiled Reports
Describes how to deploy compiled reports. 

Exporting Output

Walkthroughs

Standard Edition Walkthroughs
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Describes how to use export filters to make reports available in other formats. 

Green Bar Reports
Describes how to use background color to create a green bar report. 

Grouping Data
Describes how to incorporate grouping in a report. 

Hyperlinks
Describes the incorporation and function of hyperlinks in a report. 

Localization
Describes how to localize ActiveReports. 

Master Detail Reports
Describes how to implement master detail reports. 

Modifying Report Documents
Describes several methods of modifying report documents. 

Page Numbering
Describes how to use page numbering in the page footer and in the group header. 

Parameters
Describes how to use parameters with simple reports and subreports. 

Printing
Describes how to use different printing functions in a report. 

Rich Text
Describes how to use Rich Text, field merging, and HTML in a report. 

Run-Time Reporting
Describes how to create dynamic reports at run time. 

Saving and Loading to a Memory Stream
Describes how to save reports to and load reports from a memory stream. 

Scripting
Describes how to use scripting to generate stand-alone reports, including subreports. 

SpreadBuilder
Describes how to use the SpreadBuilder to create Excel files. 

Style Sheets
Describes how to use style sheets in a report. 

Subreports
Describes how to add subreports to a report. 

Summary Fields
Describes how to add summary fields to a report to calculate totals, counts, averages and other 
aggregations. 

Top N Reports
Describes how to display the top ten customers in a report. 

Unbound Reports
Describes the basics of using the Data_Initialize and Fetch_Data events to connect a report to a data 
source. 

ActiveReports can be used to print any label size by using the newspaper column layout.

This walkthrough illustrates how to create a report that prints labels to a laser printer labels sheet and 
to repeat labels using the LayoutAction property. The labels in this example are 1" x 2.5" and print 30 labels 
per 8½" x 11" sheet. 

The walkthrough is split up into the following activities: 

l Creating a new Visual Studio project 

l Adding an ActiveReport to a Visual Studio project 

Address Labels
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l Connecting the report to a data source 

l Adding controls to the report to contain data 

l Adding code to the detail_Format event to repeat labels 

l Viewing the report  

To complete the walkthrough, you must have access to the Northwind database. For your convenience, a 
copy is included with ActiveReports at the following default location: 
C:\Program Files\Data Dynamics\ActiveReports for .NET 3.0\Data\NWIND.MDB.

When you have finished this walkthrough, you will have a report that looks similar to the following.

Creating a new Visual Studio project

To create a new Visual Studio project

1. Open Visual Studio. 

2. From the File menu, select New > Project.

3. Select the project type and click on Windows Application. 

4. Change the name of your project and click OK. 

Adding an ActiveReport to a Visual Studio project

To add an ActiveReport to your project

1. From the Project menu, select Add New Item. 

2. Select ActiveReports 3.0 File and rename the file rptLabels. 
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3. Click Open. 

Connecting the data source to a database

To connect the data source to a database

1. Click on the gray report DataSource icon in the Detail section to open report DataSource dialog. 

2. Select the "OLE DB" tab.  

3. Click the Build button. 

4. Select "Microsoft Jet 4.0 OLE DB Provider" and click Next. 

5. Click the ellipsis button to browse for the access path to the Northwind database. Click Open once you 
have selected the appropriate access path. 

6. Click OK to continue. 

7. In the Query field, type "Select ContactName, CompanyName, Address, City, PostalCode, Country FROM 
Customers". 

8. Click OK to return to the report design surface. 

Adding controls to contain data

To add controls to the report

1. Remove the PageHeader and Footer sections from the report by right-clicking in the PageHeader section 
and selecting "Delete." 

2. In the Report menu, click Settings and change the margins as follows: 

¡ Top margin: 0.5 

¡ Bottom margin: 0.5 

¡ Left margin: 0.2 

¡ Right margin: 0.2 

3. Select rptLabels in the Visual Studio Properties Window and Set the PrintWidth property of the report 
to 8.1 (the width of the label sheet less the Left and Right margins). 

4. Click on the detail section of the report to select it and make the following changes: 

¡ Set the CanGrow and CanShrink properties to False 

¡ Change the ColumnCount property to 3

¡ Change the ColumnDirection property to AcrossDown

¡ Set the ColumnSpacing property to 0.2

¡ Set the height of the Detail section to 1 (the height of the label)

5. In the Report Explorer, expand the Fields node, then the Bound node. Drag the following fields onto 
the detail section and set the Text and Location properties of each textbox as indicated. 

 

Notes: When you drag a field from the Report Explorer onto the design surface of the 
report, the DataField and Name properties of the textbox object are automatically set to the field.  

Field Text Location

ContactName Contact Name 0, 0 

CompanyName Company Name 0, 0.198 

Address Address 0, 0.396

City City 0, 0.594

PostalCode Postal Code 0, 0.792

Country Country 1.5, 0.792
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Adding code to the detail_Format event to repeat labels

To add code to the the detail_Format event

1. Double-click in the detail section to create a Detail_Format event 

2. Add the following code to the event to repeat each label across all three columns. 
' Visual Basic
Private Sub Detail_Format(ByVal sender As Object, ByVal e As System.EventArgs) Handles _

Detail.Format
'print each label three times
Static counter As Integer
counter = counter + 1
If counter <= 2 Then

Me.LayoutAction = 3
Else

Me.LayoutAction = 7
counter = 0

End If
End Sub
//C#
int counter=0; 
private void Detail_Format(object sender, System.EventArgs eArgs)
{

//print each label three times
counter = counter + 1; 
if (counter <= 2) 
{ 

this.LayoutAction =  LayoutAction.MoveLayout|LayoutAction.PrintSection; 
} 
else 
{ 

this.LayoutAction = LayoutAction.MoveLayout|LayoutAction.NextRecord|LayoutAction
 .PrintSection; 
counter = 0; 

}
}

Viewing the report

To view the report

1. Add the ActiveReports viewer control to your Windows form and set its Dock property to Fill. 

2. Add the code needed to set the viewer document equal to the report document. See Using the 
ActiveReports WinForm Viewer for help. 

Note: You can quickly view your report at design time by clicking the Preview tab at the bottom 
of the designer.

Setting up Bookmarks (formerly called Table of Contents) allows reports to be organized and easily 
navigated. By default, no Bookmarks are created when a report is run. However, by adding simple code to 
the desired section event, Bookmark entries can be set up as the report runs.

Note: Only add bookmarks at the Page level during report processing. Do not add or remove them 
using the BookmarksCollection methods until after the document is completely loaded into the viewer. 
This is because the viewer clears the BookmarksCollection and then recreates it using the bookmarks 
that are contained in each individual page.

Bookmarks with Grouping
Describes how Bookmarks can be used with grouping. 

Bookmarks with Simple Reports
Describes how Bookmarks can be used with simple reports. 

Bookmarks Walkthroughs
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Bookmarks with Subreports
Describes how Bookmarks can be used with subreports. 

ActiveReports allows Bookmarks to be easily set up and used with grouping by adding code to the 
Detail_Format event of the report and in the group header Format event.

This walkthrough illustrates how to set up and use Bookmarks with grouping in a report.

This walkthrough is split up into the following activities:

l Adding an ActiveReport to a Visual Studio project 

l Connecting the report to a data source 

l Adding controls to the report to contain data 

l Adding code to the Detail_Format event 

l Adding code to the GroupHeader_Format event 

l Previewing the report and Bookmarks collection in the designer 

l Viewing the report  

l Viewing the Bookmarks collection 

l Adding special bookmarks at run time 

To complete the walkthrough, you must have access to the Northwind database. For your convenience, a 
copy is included with ActiveReports at the following default location: C:\Program Files\Data 
Dynamics\ActiveReports for .NET 3.0\Data\NWIND.MDB.

When you have completed this walkthrough, you will have a report that looks similar to the following.

Walkthrough: Bookmarks with Grouping
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Adding an ActiveReport to a Visual Studio project

To add an ActiveReport to your project

1. Open a new project in Visual Studio. 

2. From the Project menu, select Add New Item. 

3. Select ActiveReports 3.0 File and rename the file rptBookmarkGroup. 

4. Click Open. 

Connecting the report to a data source

To connect the report to a data source

1. Click on the gray report DataSource icon in the Detail section to open the report DataSource dialog. 

2. Select the "OLE DB" tab. 

3. Click the Build button. 

4. Select Microsoft Jet 4.0 OLE DB Provider and click Next. 

5. Click the ellipsis button to browse for the access path to the Northwind database. Click Open once you 
have selected the appropriate access path. 

6. Click OK to continue. 

7. In the Query field, type "Select * from customers order by country". 

8. Click OK to return to the report design surface. 
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Adding controls to the report to contain data

To add controls to the report

1. Add a GroupHeader/Footer section to rptBookmarkGroup (see Grouping Data for help). 

2. Make the following changes to the group header: 

¡ Change the name to ghCustomers 

¡ Change the BackColor property to RosyBrown  

¡ Change the DataField property to Country 

3. In the Report Explorer, expand the Fields node, then the Bound node. Drag the following field onto 
the GroupHeader section and set the Text and Location properties of the created textbox as indicated. 

4. In the Report Explorer, expand the Fields node, then the Bound node. Drag the following fields onto the 
detail section and set the following properties of each textbox as indicated.  

 

Adding code to the Detail_Format event

To write the code in Visual Basic

l Double-click in the Detail section of rptBookmarkGroup. This creates an event-handling method for 
rptBookmarkGroup's Detail_Format event. Add code to the handler to: 

l Set up a bookmark for each city 

l Nest city bookmarks within each country

To write the code in C#

l Double-click in the Detail section of rptBookmarkGroup. This creates an event-handling method for 
rptBookmarkGroup's Detail_Format event. Add code to the handler to: 

l Set up a bookmark for each city 

l Nest city bookmarks within each country

The following example shows what the code for the method looks like.

'Visual Basic
Private Sub Detail1_Format(ByVal sender As Object, ByVal e As System.EventArgs) Handles _

Detail1.Format
Me.Detail1.AddBookmark(txtCountry1.Text + "\" + txtCity1.Text + "\" + _

txtCompanyName1.Text)
End Sub
//C#
private void detail_Format(object sender, System.EventArgs eArgs)
{

detail1.AddBookmark(txtCountry1.Text + "\\" + txtCity1.Text + "\\" + 
txtCompanyName1.Text);

}

Adding code to the ghCustomers_Format event

To write the code in Visual Basic

l Double-click in the Group Header section of rptBookmarkGroup. This creates an event-handling method 
for rptBookmarkGroup's ghCustomers_Format event. Add code to the handler to: 

Field Text Location

Country Country 0, 0 

Field Text Location

CompanyName Company Name 0, 0

City City 2.375, 0
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l Set up a bookmark for each country

To write the code in C#

l Double-click in the Group Header section of rptBookmarkGroup. This creates an event-handling method 
for rptBookmarkGroup's ghCustomers_Format event. Add code to the handler to: 

l Set up a bookmark for each country

The following example shows what the code for the method looks like.

' Visual Basic
Private Sub ghCustomers_Format(ByVal sender As Object, ByVal e As System.EventArgs) _

Handles ghCustomers.Format
Me.ghCustomers.AddBookmark(txtCountry1.Text)

End Sub
//C#
private void ghCustomers_Format(object sender, System.EventArgs eArgs)
{

this.ghCustomers.AddBookmark(txtCountry1.Text);
}

Previewing the report and Bookmarks Collection in the designer

To preview the report and Bookmarks Collection in the designer

1. Click the "Preview" tab at the bottom of the designer. 

2. Click on the "Table of Contents" icon to view the Bookmarks collection. 

Viewing the report and Bookmarks Collection at run time

To view the report at run time

1. Add the ActiveReports viewer control to your Windows form. 

2. Add the code needed to set the viewer document equal to the report document. See Using the 
ActiveReports WinForm Viewer for help. 

3. Press F5 to run the report. 

4. Click the "Table of Contents" icon to view the Bookmarks collection. 

Adding Special Bookmarks at Run Time
To create and add special bookmarks to the bookmarks collection at run time, add the bookmarks to the 
report document's pages collection since the bookmarks are generated from the pages collection.

'Visual Basic
Private Sub Detail1_Format(ByVal sender As Object, ByVal e As System.EventArgs) Handles _

Detail1.Format
Dim i As Integer
Try

For i = 0 To Me.Document.Pages.Count - 1
Me.Document.Pages(1).AddBookmark("New Bookmark", 8)

Next
Catch ex As Exception
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End Try
End Sub

//C#
private void detail_Format(object sender, System.EventArgs eArgs)
{

for(int i = 0; i<Document.Pages.Count;i++)
{

this.Document.Pages[i].AddBookmark("New Bookmark", 25);
}

}
Note: Only add bookmarks at the Page level during report processing. Do not add or remove them 
using the BookmarksCollection methods until after the document is completely loaded into the viewer. 
This is because the viewer clears the BookmarksCollection and then recreates it using the bookmarks 
that are contained in each individual page.

ActiveReports allows Bookmarks to be easily set up and used in simple reports by adding code to the 
Detail_Format event of the report.

This walkthrough illustrates how to set up and use Bookmarks in a simple report.

This walkthrough is split up into the following activities:

l Adding an ActiveReport to a Visual Studio project 

l Connecting the report to a data source 

l Adding controls to the report to contain data 

l Adding code to the Detail Format event to set up bookmarks 

l Viewing the report  

l Viewing the Bookmarks collection with the report 

l Adding special bookmarks at run time 

To complete the walkthrough, you must have access to the Northwind database. For your convenience, a 
copy is included with ActiveReports at the following default location: C:\Program Files\Data 
Dynamics\ActiveReports for .NET 3.0\Data\NWIND.MDB.

When you have completed this walkthrough, you will have a report that looks similar to the following.

Walkthrough: Bookmarks with Simple Reports
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Adding an ActiveReport to a Visual Studio project

To add an ActiveReport to your project

1. Open a new project in Visual Studio. 

2. From the Project menu, select Add New Item. 

3. Select ActiveReports 3.0 File and rename the file rptBookmarks. 

4. Click Open. 

Connecting the report to a data source

To connect the report to a data source

1. Click on the gray report DataSource icon in the Detail section to open the report DataSource dialog. 

2. Select the "OLE DB" tab. 

3. Click on Build.

4. Select Microsoft Jet 4.0 OLE DB Provider and click Next.

5. Click the ellipsis button to browse for the access path to the Northwind database. Click Open once you 
have selected the appropriate access path. 

6. Click OK to continue. 

7. In the Query field, type "Select * from categories inner join products on categories.categoryid = 
products.categoryid order by categoryname, productname". 

8. Click OK to return to the report design surface. 
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Adding controls to the report to contain data

To add controls to the report

l In the Report Explorer, expand the Fields node, then the Bound node. Drag the following fields onto 
the detail section and set the following properties of each textbox as indicated. 

l Set the BackColor property of the detail section to Thistle. 

l Set the CanShrink property of the detail section to True.

Adding code to the Detail_Format event

To write the code in Visual Basic

l Double-click on the detail section of the report. This creates an event-handling method for rptBookmarks' 
Detail_Format event. Add code to the handler to: 

l Set up Bookmarks 

To write the code in C#

l Double-click on the detail section of the report. This creates an event-handling method for rptBookmarks' 
Detail_Format event. Add code to the handler to: 

l Set up Bookmarks 

The following example shows what the code for the method looks like.

' Visual Basic
Private Sub Detail1_Format(ByVal sender As Object, ByVal e As System.EventArgs) Handles _

Detail1.Format
Me.Detail1.AddBookmark(txtCategoryName1.text)

End Sub
//C#
private void detail1_Format(object sender, System.EventArgs eArgs)
{

detail1.AddBookmark(txtCategoryName1.Text);
}
The following example shows what the code for the method looks like to set up leveled or 
nested Bookmarks.

' Visual Basic
Private Sub Detail1_Format(ByVal sender As Object, ByVal e As System.EventArgs) Handles _

Detail1.Format
Me.Detail1.AddBookmark(txtCategoryName1.Text + "\" + txtProductName1.Text)

End Sub
//C#
private void detail1_Format(object sender, System.EventArgs eArgs)
{

detail1.AddBookmark(txtCategoryName1.Text + "\\" + txtProductName1.Text);
}

Previewing the report and Bookmarks Collection in the designer

To preview the report and Bookmarks Collection in the designer

1. Click the "Preview" tab at the bottom of the designer. 

DataField Text Location

ProductName Product Name 1.125, 0

CategoryName Category Name 0, 0

UnitsInStock Units In Stock 2.25, 0

UnitsOnOrder Units On Order 3.375, 0

UnitPrice Unit Price 4.5, 0
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2. Click on the "Table of Contents" icon to view the Bookmarks collection. 

Viewing the report and Bookmarks Collection at run time

To view the report at run time

1. Add the ActiveReports viewer control to your Windows form. 

2. Add the code needed to set the viewer document equal to the report document. See Using the 
ActiveReports WinForm Viewer for help. 

3. Press F5 to run the report. 

4. Click the "Table of Contents" icon to view the Bookmarks collection. 

Adding Special Bookmarks at Run Time
To create and add special bookmarks to the bookmarks collection at run time, you will need to add the 
bookmarks to the report document's pages collection since the bookmarks are generated from the pages 
collection.

' Visual Basic
Private Sub Detail1_Format(ByVal sender As Object, ByVal e As System.EventArgs) Handles _

Detail1.Format
Dim i As Integer
Try

For i = 0 To Me.Document.Pages.Count - 1
Me.Document.Pages(1).AddBookmark("New Bookmark", 8)

Next
Catch ex As Exception
End Try

End Sub
//C#

private void detail_Format(object sender, System.EventArgs eArgs)
{

for(int i = 0; i<Document.Pages.Count;i++)
{

this.Document.Pages[i].AddBookmark("New Bookmark", 25);
}

}
Note: Only add bookmarks at the Page level during report processing. Do not add or remove them 
using the BookmarksCollection methods until after the document is completely loaded into the viewer. 
This is because the viewer clears the BookmarksCollection and then recreates it using the bookmarks 
that are contained in each individual page.

ActiveReports allows Bookmarks to be easily set up and used in subreports by adding code to the 
Detail_Format event of the parent and child reports.

This walkthrough illustrates how to set up and use Bookmarks in a subreport.

Walkthrough: Bookmarks with Subreports
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This walkthrough is split up into the following activities:

l Adding two ActiveReports to a Visual Studio project 

l Connecting rptMain to a data source 

l Adding controls to rptMain to contain data 

l Adding controls to rptSub to contain data 

l Adding the code needed to save the current record's CategoryID to use in the rptSub's SQL query 

l Adding the code to create a data source for rpt Main and pass it to rptSub 

l Adding code to the Detail Format event of rptMain to set up bookmarks 

l Adding code to the Detail Format event of rptSub  to set up bookmarks 

l Viewing the report  

l Viewing the Bookmarks collection with the report 

l Adding special bookmarks at run time 

To complete the walkthrough, you must have access to the Northwind database. For your convenience, a 
copy is included with ActiveReports at the following default location: C:\Program Files\Data 
Dynamics\ActiveReports for .NET 3.0\Data\NWIND.MDB.

When you have completed this walkthrough, you will have a report that looks similar to the following.

Adding two ActiveReports to a Visual Studio project

To add two ActiveReports to a Visual Studio project

1. Open a new project in Visual Studio. 
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2. From the Project menu, select Add New Item. 

3. Select ActiveReports 3.0 File and rename the file rptMain. 

4. Click Open. 

5. From the Project menu, select Add New Item. 

6. Select ActiveReports 3.0 File and rename the file rptSub. 

7. Click Open. 

Connecting rptMain to a data source

To connect the parent report to a data source

1. Click on the gray report DataSource icon in the Detail section of rptMain to open the report DataSource 
dialog. 

2. Select the "OLE DB" tab. 

3. Click on Build.

4. Select Microsoft Jet 4.0 OLE DB Provider and click Next.

5. Click the ellipsis button to browse for the access path to the Northwind database. Click Open once you 
have selected the appropriate access path. 

6. Click OK to continue. 

7. In the Query field, type "Select * from categories." 

8. Click OK to return to the report design surface. 

Adding controls to rptMain to contain data

To add controls to the report

1. Add the following controls to the Detail section of rptMain: 

2. Set the CanShrink property of the Detail section to True. 

Adding a control to rptSub to contain data

To add a control to the report

1. Set the CanShrink property of the Detail section to True. 

2. Set the BackColor property of the Detail section to DarkSeaGreen. 

3. Add the following control to the Detail section of rptSub: 

Adding the code needed to save the current record's categoryID

To write the code in Visual Basic

Control DataField Name Text Location Miscellaneous

Label lblProductName Product 
Name: 

0, 0.31

Label lblCategoryName Category 
Name: 

0, 0 

TextBox CategoryName txtCategoryName1 CategoryName 1.25, 0 Bold;
ForeColor = 
DarkGreen

Subreport ctlSubreport 1.25, 
0.31 

Control DataField Name Text Location Miscellaneous

TextBox ProductName txtProductName ProductName 0, 0 Size = 3, 0.19
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l Right-click in any section of the design window of rptMain, and click on View Code to display the code 
view for the report. At the top left of the code view for rptMain, click the drop-down arrow and select 
(Base Class Events) (or (rptMain events) in Visual Studio 2005). At the top right of the code window, click 
the drop-down arrow and select FetchData. This creates an event-handling method for rptMain's 
FetchData event. Add code to the handler to: 

l Save the current record's categoryID to use in the subreport's SQL query 

To write the code in C#

l Click in the gray area below rptMain to select the report. Click on the events icon in the Properties
window to display available events for the report. Double-click FetchData. This creates an event-handling 
method for rptMain's FetchData event. Add code to the handler to: 

l Save the current record's categoryID to use in the subreport's SQL query 

The following example shows what the code for the method looks like.

' Visual Basic
Dim m_categoryID As String
Private Sub rptMain_FetchData(ByVal sender As Object, ByVal eArgs As DataDynamics _

.ActiveReports.ActiveReport.FetchEventArgs) Handles MyBase.FetchData
m_categoryID = Me.Fields("CategoryID").Value

End Sub
//C#
string m_categoryID;
private void rptMain_FetchData(object sender, DataDynamics.ActiveReports.ActiveReport3

.FetchEventArgs eArgs)
{

m_categoryID = Fields["CategoryID"].Value.ToString();
}

Adding the code to create a data source for rptMain and pass it to rptSub

To write the code in Visual Basic or C#

l Double-click in the Detail section of rptMain. This creates an event-handling method for rptMain's 
Detail_Format event. Add code to the handler to: 

¡ Create a new DataDynamics OleDBDataSource 

¡ Set the connection string 

¡ Set the SQL query 

¡ Pass the new data source to the subreport

The following example shows what the code for the method looks like.

' Visual Basic
Private Sub Detail1_Format(ByVal sender As Object, ByVal e As System.EventArgs) Handles _

Detail1.Format
Dim rpt As New rptSub()
Dim subDS As New DataDynamics.ActiveReports.DataSources.OleDBDataSource()
subDS.ConnectionString = Me.DataSource.ConnectionString
subDS.SQL = "Select * from products where categoryID = " + m_categoryID
rpt.DataSource = subDS
Me.ctlSubreport.Report = rpt

End Sub
//C#
private void detail1_Format(object sender, System.EventArgs eArgs)
{

rptSub rpt = new rptSub();
DataDynamics.ActiveReports.DataSources.OleDBDataSource subDS = new DataDynamics.

ActiveReports.DataSources.OleDBDataSource();
subDS.ConnectionString = this.DataSource.ConnectionString;
subDS.SQL = "Select * from products where categoryID = " + m_categoryID;
rpt.DataSource = subDS;
ctlSubReport.Report = rpt;

}
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Adding code to the Detail Format event for both reports

To write the code in Visual Basic

l Double-click in the Detail section of rptMain to return to the report's Detail Format event. 

l Double-click in the Detail section of rptSub. This creates an event-handling method for the report's Detail 
Format event.  

To write the code in C#

l Double-click in the Detail section of rptMain to return to the report's Detail Format event. 

l Double-click in the Detail section of rptSub. This creates an event-handling method for the report's Detail 
Format event.   

l The following example shows what the code for the method looks like for rptMain.

' Visual Basic
Private Sub Detail1_Format(ByVal sender As Object, ByVal e As System.EventArgs) Handles _

Detail1.Format
Me.Detail1.AddBookmark(txtCategoryName1.text)

End Sub
//C#
private void detail1_Format(object sender, System.EventArgs eArgs)
{

detail.AddBookmark(txtCategoryName1.Text);
}
The following example shows what the code for the method looks like for rptSub.

' Visual Basic
Private Sub Detail1_Format(ByVal sender As Object, ByVal e As System.EventArgs) Handles _

Detail1.Format
Me.Detail.AddBookmark(CType(Me.ParentReport.Sections("Detail1").Controls _

("txtCategoryName1"), TextBox).Text + "\" + Me.txtProductName1.Text)
End Sub
//C#
private void detail1_Format(object sender, System.EventArgs eArgs)
{

this.detail1.AddBookmark(((TextBox)(this.ParentReport.Sections["Detail1"].Controls
["txtCategoryName1"])).Text + "\\" + this.txtProductName1.Text);

}

Previewing the report and Bookmarks Collection in the designer

To preview the report and Bookmarks Collection in the designer

1. Click the "Preview" tab at the bottom of the designer. 

2. Click on the "Table of Contents" icon to view the Bookmarks collection. 

Viewing the report and Bookmarks Collection at run time

To view the report at run time

1. Add the ActiveReports viewer control to your Windows form. 

2. Add the code needed to set the viewer document equal to the report document. See Using the 
ActiveReports WinForm Viewer for help. 

3. Press F5 to run the report. 

4. Click the "Table of Contents" icon to view the Bookmarks collection. 
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Adding Special Bookmarks at Run Time
To create and add special bookmarks to the bookmarks collection at run time, you will need to add the 
bookmarks to the report document's pages collection since the bookmarks are generated from the pages 
collection.

' Visual Basic
Private Sub Detail1_Format(ByVal sender As Object, ByVal e As System.EventArgs) Handles _

Detail1.Format
Dim i As Integer
Try

For i = 0 To Me.Document.Pages.Count - 1
Me.Document.Pages(1).AddBookmark("New Bookmark", 8)

Next
Catch ex As Exception
End Try

End Sub
//C#

private void detail_Format(object sender, System.EventArgs eArgs)
{

for(int i = 0; i<Document.Pages.Count;i++)
{

this.Document.Pages[i].AddBookmark("New Bookmark", 25);
}

}
Note: Only add bookmarks at the Page level during report processing. Do not add or remove them 
using the BookmarksCollection methods until after the document is completely loaded into the viewer. 
This is because the viewer clears the BookmarksCollection and then recreates it using the bookmarks 
that are contained in each individual page.

ActiveReports allows you to use the DataField property of a textbox to perform calculations based on the 
value of specific data fields. 

This walkthrough illustrates how to create a simple report using calculated fields.

The walkthrough is split up into the following activities: 

l Adding an ActiveReport to a Visual Studio project 

l Connecting the report to a data source 

l Adding controls to the report to contain data 

l Viewing the run-time report  

To complete the walkthrough, you must have access to the Northwind database. For your convenience, a 
copy is included with ActiveReports at the following default location: C:\Program Files\Data 
Dynamics\ActiveReports for .NET 3.0\Data\NWIND.MDB.

When you have finished this walkthrough, you will have a report that looks similar to the following.

Walkthrough: Calculated Fields
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Adding an ActiveReport to a Visual Studio project

To add an ActiveReport to your project

1. Open a new project in Visual Studio. 

2. From the Project menu, select Add New Item. 

3. Select ActiveReports 3.0 File and rename the file rptCalFields. 

4. Click Open. 

Connecting the data source to a database

To connect the data source to a database

1. Click on the gray report DataSource icon in the Detail section to open the report DataSource dialog. 

2. Select the "OLE DB" tab. 

3. Click on Build.

4. Select "Microsoft Jet 4.0 OLE DB Provider" and click Next.

5. Click the ellipsis button to browse for the access path to the Northwind database. Click Open once you 
have selected the appropriate access path. 

6. Click OK to continue. 

7. In the Query field, type "Select Customers.CompanyName, Products.ProductName, [Order 
Details].UnitPrice, [Order Details].Quantity FROM Products INNER JOIN ((Customers INNER JOIN Orders 
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ON Customers.CustomerID = Orders.CustomerID) INNER JOIN [Order Details] ON Orders.OrderID = 
[Order Details].OrderID) ON Products.ProductID = [Order Details].ProductID WHERE (((DatePart("yyyy", 
[OrderDate])) = 1996)) ORDER BY Customers.CompanyName, Products.ProductName". 

8. Click OK to return to the report design surface. 

Adding controls to contain data

To add controls to the report

1. Add a GroupHeader/Footer section to rptCalFields. 

2. Make the following changes to the group header: 

¡ Change the Name property to ghProducts

¡ Change the DataField property to CompanyName

¡ Change the BackColor property to Gainsboro

¡ Change the Height property to 5.5 to accommodate the labels

3. In the Report Explorer, expand the Fields node, then the Bound node. Drag the following fields onto the 
detail section and set the following properties of each textbox as indicated. 

4. Set the CanShrink property of the Detail section to True. 

5. Add the following controls from the ActiveReports 3.0 toolbox to ghProducts and make the property 
changes as indicated: 

6. In the Report Explorer, right-click on the Calculated node and select "Add" from the shortcut menu. This 
creates an unbound field named "field1" that can be used to perform custom calculations. 

7. Make the following changes to field1 in the Properties window: 

¡ Change the Name property to TotalPrice 

¡ Change the Formula property to Quantity * UnitPrice to bind it to the product of the Quantity and 
UnitPrice fields

8. Drag TotalPrice from the Unbound node onto the detail section of the report. This creates an 
ActiveReports TextBox object, txtTotalPrice1, and sets its DataField property equal to TotalPrice. 

9. Make the following changes to txtTotalPrice1: 

¡ Change the Location property to "5, 0" 

¡ Change the OutPutFormat property to "Currency"

Viewing the report

To view the report

1. Add the ActiveReports viewer control to a Windows Form. 

2. Add the code needed to set the viewer document equal to the report document. See Using the 
ActiveReports WinForm Viewer for help. 

Field Section OutputFormat Text Location

CompanyName ghProducts NA Company Name 0, 0 

ProductName Detail NA Product Name 0, 0

Quantity Detail NA Quantity 2.2, 0

UnitPrice Detail Currency Unit Price 3.5, 0

Control Name Location Text

Label lblProductName 0, 0.3 Product Name

Label lblQuantity 2.2, 0.3 Quantity

Label lblUnitPrice 3.5, 0.3 Unit Price 

Label lblTotalPrice 5, 0.3 Total Price
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Note: You can quickly view your report at design time by clicking the Preview tab at the bottom of the 
designer.

Charts add quick visual impact to your reports, and allow data to be readily grasped even by casual 
readers. With a built-in chart control, ActiveReports makes it easy to provide premium reporting without the 
need to purchase extra tools.

 

Bar Chart  
Describes how to create a bar chart which compares items across categories. 

3D Pie Chart
Describes how to create a three dimensional pie chart which shows how the percentage of each data item 
contributes to a total percentage.  

Financial Chart
Describes how to create a financial chart which lets you plot high, low, opening, and closing prices. 

Simple Unbound Chart
Describes how to create a simple unbound chart. 

Bar charts are useful in comparing items across categories.

This walkthrough illustrates how to create a simple bar chart.

The walkthrough is split up into the following activities: 

l Creating a new Visual Studio project 

l Adding an ActiveReport to a Visual Studio project 

l Adding a chart control to the report 

l Setting a data source for the chart 

l Setting the chart's properties 

l Viewing the report  

To complete the walkthrough, you must have access to the Northwind database. For your convenience, a 
copy is included with ActiveReports at the following default location: C:\Program Files\Data 
Dynamics\ActiveReports for .NET 3.0\Data\NWIND.MDB.

When you have finished this walkthrough, you will have a report that looks similar to the following.

Chart Walkthroughs

2D Bar Chart
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Creating a new Visual Studio project

To create a new Visual Studio project

1. Open Visual Studio. 

2. From the File menu, select New > Project.

3. Select the project type and click on Windows Application. 

4. Change the name of your project and click OK. 

Adding an ActiveReport to a Visual Studio project

To add an ActiveReport to your project

1. Open a new project in Visual Studio. 

2. From the Project menu, select Add New Item. 

3. Select ActiveReports 3.0 File and rename the file rptBarChart. 

4. Click Open. 

Adding a chart control to the report

To add a chart control to the report

1. Resize the section in which you want to place the chart. 

2. Click the ChartControl icon in the ActiveReports toolbox and draw it onto the report.

Note: If the chart wizard appears, click Cancel. If you do not want it to appear each time you add a 
chart, deselect the Auto Run Wizard checkbox.

Setting a data source for the chart

To connect the data source to a database

1. With the chart control highlighted, click the Data Source verb below the Properties Window to open the 
Chart DataSource dialog box. (If the verb is not visible, right-click an empty space in the Properties 
Window and click Commands to check that option.)  

2. Click Build.

3. Select "Microsoft Jet 4.0 OLE DB Provider" and click Next .

4. Click the ellipsis to browse to the Northwind database. Click Open once you have selected the file. 
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5. Click OK to continue. 

6. In the Query field, type "SELECT ShipCountry, SUM(Freight) AS Expr1 FROM Orders GROUP BY 
ShipCountry." 

7. Click OK to return to the report design surface. 

Setting the chart's properties

To set the chart's properties

1. With the chart control highlighted, click the Customize verb below the Properties Window to open the 
Chart Designer dialog box. 

2. In the ChartAreas section which displays by default, click to expand the Axes. 

3. Click Axis X, and on the Common tab in the pane to the right, type Country in the Title textbox and 
increase the font size to 12. 

4. Choose the Labels tab in the pane on the right, and select the Staggered Labels option to avoid 
overlapping labels. 

5. Click Axis Y on the left, and on the Common tab in the pane to the right, type Freight in the Title
textbox and increase the font size to 12. 

6. Click the Titles button on the left side of the Chart Designer. 

7. Type Simple Bar Chart in the Caption textbox on the header title, and increase the font size to 14. 

8. Click the footer title in the upper left corner of the dialog, and delete it. 

9. Click the Series button on the left side of the Chart Designer, and click Series1 to select it. 

10. In the Data Binding box, set X (Name) to ShipCountry, and set Y to Expr1. 

11. Delete Series2 and Series3. 

12. Click the Legend button on the left side of the Chart Designer. 

13. Deselect the Visible checkbox at the top of the Common tab to hide the legend. 

14. Click the Finish button to exit the Chart Designer.

Viewing the report

To view the report

1. Add the ActiveReports viewer control to a Windows Form. 

2. Add the code needed to set the viewer document equal to the report document. See Using the 
ActiveReports WinForm Viewer for help. 

Note: You can quickly view your report at design time by clicking the Preview tab at the bottom of the 
designer.

Pie charts are useful in showing how the percentage of each data item contributes to the total. 

This walkthrough illustrates how to create a three dimensional pie chart.

The walkthrough is split up into the following activities: 

l Creating a new Visual Studio project 

l Adding an ActiveReport to a Visual Studio project 

l Adding a chart control to the report 

l Adding a series and data points to the chart 

l Setting the chart's properties 

l Viewing the report  

When you have finished this walkthrough, you will have a chart that looks similar to the following.

3D Pie Chart
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Creating a new Visual Studio project

To create a new Visual Studio project

1. Open Visual Studio. 

2. From the File menu, select New > Project.

3. Select the project type and click on Windows Application. 

4. Change the name of your project and click OK. 

Adding an ActiveReport to a Visual Studio project

To add an ActiveReport to your project

1. Open a new project in Visual Studio. 

2. From the Project menu, select Add New Item. 

3. Select ActiveReports 3.0 File and rename the file rpt3DPieChart. 

4. Click Open. 

Adding a chart control to the report

To add a chart control to the report

1. Resize the section in which you want to place the chart. 

2. Click the ChartControl icon in the ActiveReports toolbox and draw it onto the report.

Adding a series and data points to the chart

To add a series and data points to the chart

1. With the chart control highlighted, click the Series (Collection) property in the Properties Window, then 
click the ellipsis button that appears to open the Series Collection Editor. 

2. Click Series1 to select it. 

3. Under Series Properties, change the ColorPalette property of the new series to Confetti. 

4. Change the Type property to Doughnut3D. 

5. Click the Points (Collection) property, then click the ellipsis button that appears.  

6. Click Add to add a data point, set its LegendText property to Figs, and set its Y value to 19. Expand the 
Properties and set the ExplodeFactor to .5 to pull this slice out from the pie. 
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7. Click Add to add another data point, set its LegendText property to Raspberries, and set its YValues 
property to 15. 

8. Click Add to add another data point, set its LegendText property to Blueberries, and set its YValues 
property to 37. 

9. Click Add to add another data point, set its LegendText property to Bananas, and set its YValues 
property to 21. 

10. Click OK to return to the Series Collection Editor. 

11. Remove Series2 and Series3. 

12. Click OK to return to the report design surface.

Setting the chart's properties

To set the chart's properties

1. With the chart control highlighted, click the ChartAreas (Collection) property in the Properties Window, 
then click the ellipsis button that appears to open the ChartArea Collection Editor. 

2. Expand the Projection property and change the VerticalRotation property to 50. This allows you to see 
more of the top of the pie.  

3. Click OK to return to the report design surface. 

4. With the chart control highlighted, click the Titles (Collection) property in the Properties Window, then 
click the ellipsis button that appears to open the Title Collection Editor. 

5. In the header properties, change the Text property to "3D Pie Chart." 

6. Expand the Font property and set the Size to 14 to make your title stand out more. 

7. Remove the footer title. 

8. Click OK to return to the report design surface.

Viewing the report

To view the report

1. Add the ActiveReports viewer control to a Windows Form. 

2. Add the code needed to set the viewer document equal to the report document. See Using the 
ActiveReports WinForm Viewer for help. 

Note: You can quickly view your report at design time by clicking the Preview tab at the bottom of the 
designer.

Financial charts are useful for displaying stock information using High, Low, Open and Close values.  

This walkthrough illustrates how to create a Candle chart.

The walkthrough is split up into the following activities: 

l Creating a new Visual Studio project 

l Adding an ActiveReport to a Visual Studio project 

l Adding a chart control to the report 

l Adding a series and data points to the chart 

l Setting the chart's properties 

l Viewing the report  

When you have finished this walkthrough, you will have a chart that looks similar to the following.

Financial Chart
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Creating a new Visual Studio project

To create a new Visual Studio project

1. Open Visual Studio. 

2. From the File menu, select New > Project.

3. Select the project type and click on Windows Application. 

4. Change the name of your project and click OK. 

Adding an ActiveReport to a Visual Studio project

To add an ActiveReport to your project

1. Open a new project in Visual Studio. 

2. From the Project menu, select Add New Item. 

3. Select ActiveReports 3.0 File and rename the file rptCandleChart. 

4. Click Open. 

Adding a chart control to the report

To add a chart control to the report

1. Resize the section in which you want to place the chart. 

2. Click the ChartControl icon in the ActiveReports toolbox and draw it onto the report.

Adding a series and data points to the chart

To add a series and data points to the chart

1. With the chart control highlighted, click the Series (Collection) property in the Properties Window, then 
click the ellipsis button that appears to open the Series Collection Editor. 

2. Click Series1 to select it. 

3. Under Series Properties, change the Type property to Candle. 

4. Expand the Properties and set the BodyDownswingBackdrop property to (Default) so that you can 
expand it and change the color to Fuchsia. 
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5. Set the BodyUpswingBackdrop property to (Default) so that you can expand it and change the color to 
DarkViolet. 

6. Set the BodyWidth property to 5 to make the opening to closing figure bar, the candle, wider than the 
wick. 

7. Set the WickLine property to (Default) for a black wick. 

8. Click the Points (Collection) property, then click the ellipsis button that appears.  

9. Click Add to add a data point, and set its YValues property to 99; 37; 53; 88. 

Note: The first YValue is the high figure or top of the wick; the second is the low figure, or bottom 
of the wick; the third is the opening figure; the fourth is the closing figure.  If the fourth figure is 
higher than the third, the candle is DarkViolet, the BodyUpswingBackdrop.

10. Click Add to add another data point, and set its YValues property to 115; 22; 101; 35. 

11. Click Add to add another data point, and set its YValues property to 87; 1; 7; 80. 

12. Click Add to add another data point, and set its YValues property to 63; 14; 57; 25. 

13. Click Add to add another data point, and set its YValues property to 130; 25; 25; 120. 

14. Click OK to return to the Series Collection Editor. 

15. Set the Legend property to (none). 

16. Remove Series2 and Series3. 

17. Click OK to return to the report design surface. 

Setting the chart's properties

To set the chart's properties

1. With the chart control highlighted, click the ChartAreas (Collection) property in the Properties Window, 
then click the ellipsis button that appears to open the ChartArea Collection Editor. 

2. In the defaultArea properties, click the Axes (Collection) property, then click the ellipsis button that 
appears to open the AxisBase Collection Editor. 

3. Click the AxisX member, and click the Labels (Collection) property, then click the ellipsis button that 
appears to open the Array Data Editor.  Type the following into the editor, each item on a separate line as 
shown: 

¡ Monday 

¡ Tuesday 

¡ Wednesday 

¡ Thursday 

¡ Friday

4. Click the OK button to return to the AxisBase Collection Editor, and delete the text from the Title 
property.  

5. Click the AxisY member, expand the MajorTick property and set the Step property to 10. 

6. Set the AxisY member's LabelsVisible property to True. 

7. Set the AxisY member's Title property to $,000 and click OK to return to the ChartArea Collection 
Editor. 

8. Click OK to return to the report design surface. 

9. With the chart control highlighted, click the Titles (Collection) property in the Properties Window, then 
click the ellipsis button that appears to open the Title Collection Editor. 

10. In the header properties, change the Text property to "Candle Chart." 

11. Expand the Font property and set the Size to 14. 

12. Remove the footer title, and click OK to return to the report design surface. 

13. With the Chart control highlighted, click the Legends (Collection) property to open the Legend Collection 
Editor. 

14. Set the Visible property to False, and click OK to return to the report design surface.
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Viewing the report

To view the report

1. Add the ActiveReports viewer control to a Windows Form. 

2. Add the code needed to set the viewer document equal to the report document. See Using the 
ActiveReports WinForm Viewer for help. 

Note: You can quickly view your report at design time by clicking the Preview tab at the bottom of the 
designer.

The Chart control allows you to bind charts to any type of data source, including arrays. You can create a 
chart without setting its data source then load the data into the control at run time. 

This walkthrough illustrates how to create a simple unbound chart.

The walkthrough is split up into the following activities: 

l Creating a new Visual Studio project 

l Adding an ActiveReport to the project 

l Adding the chart control to the report 

l Adding code to connect the chart to a data source 

l Viewing the report  

To complete the walkthrough, you must have access to the NorthWind database.

When you have finished this walkthrough, you will have a report that looks similar to the following.

Simple Unbound Chart
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Creating a new Visual Studio project

To create a new Visual Studio project

1. Open Visual Studio. 

2. From the File menu, select New > Project.

3. Select the project type and click on Windows Application. 

4. Change the name of your project and click OK. 

Adding an ActiveReport to a Visual Studio project

To add an ActiveReport to your project

1. Open a new project in Visual Studio. 

2. Click on Project > Add New Item. 

3. Select ActiveReports 3.0 File and rename the file rptUnboundChart. 

4. Click Open. 

Adding the chart control to the report

To add a chart control to the report

1. Click the ChartControl in the ActiveReports toolbox, and draw it onto the report surface. 

2. With the chart control highlighted, click the Customize verb below the Properties Window to open the 
Chart Designer dialog.  
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3. Click the Series button on the left side, and delete Series1, Series2, and Series3. 

4. Click the Titles button on the left side of the Chart Designer. 

5. Type Unbound Chart in the header title Caption and increase the font size to 14. 

6. Delete the footer title. 

7. Click the ChartAreas button on the left side of the wizard, and expand the Axes button. 

8. Click AxisX to select it, and enter Company Name in the AxisX Title and increase the font size to 12. 

9. Click AxisY to select it, and enter Freight in US$ in the AxisY Title and increase the font size to 12. 

10. Click the Legends button on the left side of the Chart Designer. 

11. Clear the Visible check box at the top. 

12. Click Finish.

Adding code to connect the chart to a data source

To write the code in Visual Basic

l Double-click in the gray area below rptUnbound. This creates an event-handling method for 
rptUnboundChart's ReportStart event. Add code to the handler to: 

l Create the series 

l Create the dataset 

l Set the DataSource, ValueMembersX and ValueMembersY properties 

l Angle the labels to avoid overlap 

To write the code in C#

l Double-click in the gray area below rptUnbound. This creates an event-handling method for 
rptUnboundChart's ReportStart event. Add code to the handler to: 

l Create the series 

l Create the dataset 

l Set the DataSource, ValueMembersX and ValueMembersY properties 

l Angle the labels to avoid overlap  

The following example shows what the code for the method looks like.

' Visual Basic
Private Sub rptUnboundChart_ReportStart(ByVal sender As Object, ByVal e As System _

.EventArgs) Handles MyBase.ReportStart
' create the series
Dim series As New DataDynamics.ActiveReports.Chart.Series
series.Type = Chart.ChartType.Bar3D
Dim connectionString As String = "Provider=Microsoft.Jet.OLEDB.4.0;Data Source= _

 C:/NWIND.mdb;Persist Security Info=False"
Dim connection As New System.Data.OleDb.OleDbConnection(connectionString)
Dim adapter As System.Data.OleDb.OleDbDataAdapter

' create the dataset
Dim ds As DataSet
adapter = New System.Data.OleDb.OleDbDataAdapter("SELECT * from Orders WHERE _

 OrderDate < #08/17/1994#", connectionString)
ds = New DataSet
oDBAdapter.Fill(ds, "Orders")

' set the DataSource, ValueMembersY, and ValueMembersX properties
Me.ChartControl1.DataSource = ds
Me.ChartControl1.Series.Add(series)
Me.ChartControl1.Series(0).ValueMembersY = ds.Tables("Orders").Columns(7).ColumnName
Me.ChartControl1.Series(0).ValueMemberX = ds.Tables("Orders").Columns(8).ColumnName

' angle the labels to avoid overlapping
Me.ChartControl1.ChartAreas(0).Axes(0).LabelFont.Angle = 90

End Sub
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//C#
private void rptUnboundChart_ReportStart(object sender, System.EventArgs eArgs)
{

// create the series
DataDynamics.ActiveReports.Chart.Series series = new DataDynamics.ActiveReports.Chart

.Series();
series.Type = Chart.ChartType.Bar3D;
string connectionString = "Provider=Microsoft.Jet.OLEDB.4.0;Data Source=C:/NWIND.mdb;

Persist Security Info=False";   
System.Data.OleDb.OleDbConnection connection = new System.Data.OleDb.OleDbConnection

(connectionString);       
System.Data.OleDb.OleDbDataAdapter adapter;

// create the dataset
System.Data.DataSet ds = new System.Data.DataSet();
adapter = new System.Data.OleDb.OleDbDataAdapter("SELECT * from Orders WHERE 

OrderDate < #08/17/1994#", connectionString);
oDBAdapter.Fill(da, "Orders");

// set the DataSource, ValueMembersY, and ValueMembersX properties
this.ChartControl1.DataSource = ds;
this.ChartControl1.Series.Add(series);
this.ChartControl1.Series[0].ValueMembersY = ds.Tables["Orders"].Columns[7]

.ColumnName;
this.ChartControl1.Series[0].ValueMemberX = ds.Tables["Orders"].Columns[8]

.ColumnName;

// angle the labels to avoid overlapping
this.ChartControl1.ChartAreas[0].Axes[0].LabelFont.Angle = 90;

}

Viewing the report

To view the report

1. Add the ActiveReports viewer control to a Windows Form. 

2. Add the code needed to set the viewer document equal to the report document. See Using the 
ActiveReports WinForm Viewer for help. 

Note: You can quickly view your report at design time by clicking the Preview tab at the bottom of the 
designer.

ActiveReports supports newspaper column layouts in both the Detail and Group sections. You can render the 
columns either horizontally or vertically in the section with options to break the column on the Group section 
(i.e. start a new column on the change of a group).  There is also a 
Boolean ColumnGroupKeepTogether property on the GroupHeader. When set to True, 
ColumnGroupKeepTogether attempts to prevent a group from splitting across columns.  If a group cannot fit 
in the current column, it tries the next.  If the group is too large for a single column, the property is ignored.

Note: The ColumnGroupKeepTogether property is only implemented when the GroupHeader's 
GroupKeepTogether property is set to All. This walkthrough illustrates how to create a simple report 
using columns.

The walkthrough is split up into the following activities: 

l Adding an ActiveReport to a Visual Studio project 

l Connecting the report to a data source 

l Adding controls to the report to contain data 

l Viewing the report  

To complete the walkthrough, you must have access to the Northwind database.

Columnar Reports
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When you have finished this walkthrough, you will have a report that looks similar to the following.

Adding an ActiveReport to a Visual Studio project

To add an ActiveReport to your project

1. Open a new project in Visual Studio. 

2. Click on Project > Add New Item. 

3. Select ActiveReports 3.0 File and rename the file rptColumnar. 

4. Click Open. 

Connecting the data source to a database

To connect the data source to a database

1. Click on the gray report DataSource icon in the Detail section to open the report DataSource dialog. 

2. Select the "OLE DB" tab. 

3. Click on Build.

4. Select "Microsoft Jet 4.0 OLE DB Provider" and click Next .

5. Click the ellipsis button to browse for the access path to the Northwind database. Click Open once you 
have selected the appropriate access path. 

6. Click OK to continue. 

7. In the Query field, type "Select Country, CompanyName, ContactName, Phone FROM Customers ORDER 
BY Country". 

8. Click OK to return to the report design surface. 

Adding controls to contain data

To add controls to the report

1. Add a GroupHeader/Footer section to rptColumnar. 

2. Make the following changes to the group header: 

¡ Change the Name property to ghCountry

¡ Change the BackColor property to Gold

¡ Change the DataField property to Country

¡ Change the ColumnGroupKeepTogether property to True

¡ Change the GroupKeepTogether property to All 
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3. Change the BackColor property of the group footer to Goldenrod. 

4. Drag the Country field from the Report Explorer into the GroupHeader section with the indicated 
properties: 

5. Change the BackColor property of the PageHeader section to Linen and add a label control to it with the 
indicated properties: 

6. Make the following changes to the Detail section: 

¡ Change the ColumnCount property to 2

¡ Change the CanShrink property to True

7. Drag the following fields from the Report Explorer to the Detail section: 

Viewing the report

To view the report

1. Add the ActiveReports viewer control to a Windows Form. 

2. Add the code needed to set the viewer document equal to the report document. See Using the 
ActiveReports WinForm Viewer for help. 

Note: You can quickly view your report at design time by clicking the Preview tab at the bottom of the 
designer.

ActiveReports for .NET 3.0 allows you to drop a third party control as a custom control onto an ActiveReport. 

This walkthrough illustrates how to use ChartFX as a custom control with ActiveReports.

This walkthrough is split up into the following activities: 

l Adding an ActiveReport to a Visual Studio project 

l Adding the ChartFX control to the ActiveReport 

l Adding a label to the page header 

l Adding code for the chart control 

To complete the walkthrough, you must have ChartFX installed.

When you have completed this walkthrough, you will have a report with a chart that looks similar to the 
following.

DataField Font Name Text Location

Country Arial, 12pt, style=Bold txtCountry Country 0, 0 

DataField Font Name Text Location

Arial, 14pt lblPhone Customer Telephone List by Country 0, 0 

DataField Name Text Location

CompanyName txtCompanyName Company Name 0, 0 

ContactName txtContactName Contact Name 1.188, 0 

Phone txtPhone Telephone Number 2.25, 0 

Custom Controls and ChartFX
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Adding an ActiveReport to a Visual Studio project

To add an ActiveReport to your project

1. Open a new project in Visual Studio. 

2. From the Project menu, select Add New Item. 

3. Select ActiveReports 3.0 File and rename the file rptChart. 

4. Click Open. 

Adding the ChartFX control to rptChart

To add the ChartFX control to rptChart

1. Click on the ChartFX control in the appropriate toolbox to select it. 

1. To add the ChartFX chart control to Visual Studio 2003, right-click the toolbox and 
select Add/Remove items . 

2. Select Chart (SoftwareFX.ChartFX namespace, ChartFX(6.2.x)). 

3. Click the OK button.

2. Drag and drop the Chart control onto the Detail section of rptChart. 

3. Resize the chart control to fill the Detail section. 

Adding a Label to the PageHeader

To add a label to the PageHeader

1. Drag and drop the Label control from the ActiveReports toolbox to the PageHeader section. 

2. Change the Alignment property to Center. 

3. Change the Font Size property to 14 pt. 

4. Change the Text property to "ChartFX Chart based on random values with ActiveReports for .NET 
3.0". 
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5. Resize the Label to show the text on two lines.   

Adding code for the ChartFx control
Before you can use the following code, you need to add references to ChartFX for .NET (Windows.Forms)
and ChartFX Base to your project.

To write the code in Visual Basic or C#

l Double-click the Detail section for rptChart. This creates an event-handling method for the Detail_Format 
event. 

l The following example shows what the code for the method looks like.

' Visual Basic

Private Sub Detail1_Format(ByVal sender As Object, ByVal e As System.EventArgs) Handles _
Detail1.Format

Dim r As New System.Random()
Dim ChartControl1 As SoftwareFX.ChartFX.Chart
'Cast customControl as ChartFX chart
ChartControl1 = CType(Me.CustomControl1.Control, SoftwareFX.ChartFX.Chart)

 
Dim i As Integer
Dim j As Integer

 
'Open the communication channel
ChartControl1.OpenData(SoftwareFX.ChartFX.COD.Values, 3, 3)
For i = 0 To 2

For j = 0 To 2
'Assign the values to the series selected
ChartControl1.Value(i, j) = r.NextDouble() * 100

Next j
Next i
'Close the communication channel
ChartControl1.CloseData(SoftwareFX.ChartFX.COD.Values)

End Sub
//C#

private void detail1_Format(object sender, System.EventArgs eArgs)
{

System.Random r = new System.Random();
Chart ChartControl1 = new Chart();
//Cast customControl as ChartFX chart
ChartControl1 = ((SoftwareFX.ChartFX.Chart)this.customControl1.Control);
//Open the communication channel
ChartControl1.OpenData(SoftwareFX.ChartFX.COD.Values, 3, 3);

for (int i=0;i<3;i++)
{

for (int j=0;j<3;j++)
{

//Assign the values to the series selected
ChartControl1.Value[i, j] = r.NextDouble() *  100;

}
}
//Close the communication channel
ChartControl1.CloseData(SoftwareFX.ChartFX.COD.Values);

}

Viewing the report

To view the report

1. Add the ActiveReports viewer control to a Windows Form. 

2. Add the code needed to set the viewer document equal to the report document. See Using the 
ActiveReports WinForm Viewer for help. 

Note: You can quickly view your report at design time by clicking the Preview tab at the bottom of the  
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designer.

ActiveReports includes a control to view report output in custom preview forms. The viewer allows developers 
to modify the toolbars or add custom menu commands to the preview form.

This walkthrough illustrates how to add the ActiveReports viewer control to your report and customize it.

This walkthrough is split up into the following activities: 

l Creating a basic previewer 

l Using split windows on the viewer control 

l Adding a custom print button to the viewer control 

To complete the walkthrough, you must have the ActiveReports controls added to your Visual Studio toolbox. 
For more information, see Adding ActiveReports Controls to the Visual Studio Toolbox.

Creating a basic previewer

To create a basic previewer

1. Open a new Windows Forms project in Visual Studio and size the form according to your needs. 

2. Click the Viewer icon on the ActiveReports toolbox. 

 

4. Place the control on your form and set the Dock property to Fill. 

5. From the Project menu, select Add New Item. 

6. Select ActiveReports 3.0 File and click the Add button. 

7. Add the following code to the Form1 Load event. 
' Visual Basic
Dim rpt as new NewActiveReport1
rpt.Run()
Viewer1.Document = rpt.Document
//C#

ActiveReport1 rpt = new ActiveReport1();
rpt.Run();
viewer1.Document = rpt.Document;

8. Press F5 to run the report. 

Using split windows on the viewer control

To use split windows on the viewer control

1. Run your report with the viewer added by pressing F5. 

2. Drag the splitter control down. 

 

3. When the viewer is split into two sections, report layouts can be examined and report pages can be 
compared easily. 

Adding a custom print button to the viewer control

To add a custom print button to the viewer control

Walkthrough: Customizing the Viewer Control
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1. Add a second form to the project created above and rename it frmPrintDlg. 

2. Add a label to frmPrintDlg and change the Text property to This is the custom print dialog . 

3. Add a button to frmPrintDlg and change the Text property to OK .

4. Add the following code to the Form1 Load event to remove the default print button and add your own. 

' Visual Basic
' Remove the default print button
Me.Viewer1.Toolbar.Tools.RemoveAt(2)
' Create and add the custom button
Dim btn As New DataDynamics.ActiveReports.Toolbar.Button()
btn.Caption = "MyPrint"
btn.ToolTip = "Custom Print Button"
btn.ImageIndex = 1
btn.ButtonStyle = DataDynamics.ActiveReports.Toolbar.ButtonStyle.TextAndIcon
btn.Id = 333Me.Viewer1.Toolbar.Tools.Insert(2, btn)
//C#
// Remove the default printer button
this.viewer1.Toolbar.Tools.RemoveAt(2);
// Create and add the custom button
DataDynamics.ActiveReports.Toolbar.Button btn = new DataDynamics.ActiveReports.Toolbar

.Button();
btn.Caption = "MyPrint";
btn.ToolTip = "Custom Print Button";
btn.ImageIndex = 1;
btn.ButtonStyle = DataDynamics.ActiveReports.Toolbar.ButtonStyle.TextAndIcon;
btn.Id = 333;
this.viewer1.Toolbar.Tools.Insert(2,btn);

5. Add the following code to the Viewer1 ToolClick event to display frmPrintDlg when the custom print 
button is clicked. 
' Visual Basic
' Capture the new tool's click to show the dialog
If e.Tool.Id = 333 Then

Dim dlg As New frmPrintDlg()
dlg.ShowDialog(Me)

End If
//C#
// Capture the new tool's click to show the dialog
if(e.Tool.Id == 333)
{

frmPrintDlg dlg = new frmPrintDlg();
dlg.ShowDialog(this);

}
6. Press F5 to run the project and see the custom MyPrint button on the viewer.

In ActiveReports, the simplest reporting style is a tabular listing of fields from a record source. 

This walkthrough illustrates the basics of setting up bound reports by introducing the ideas of using the 
DataSource icon and connecting textbox controls to the data source through the DataField property.

The walkthrough is split up into the following activities: 

l Creating a new Visual Studio project 

l Adding an ActiveReport to the Visual Studio project 

l Connecting the data source to a database 

l Adding controls to contain the data 

l Viewing the report  

To complete the walkthrough, you must have access to the Northwind database. For your convenience, a 
copy is included with ActiveReports at the following default location: C:\Program Files\Data 
Dynamics\ActiveReports for .NET 3.0\Data\NWIND.MDB.

Walkthrough: Data Bound Reports
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When you have finished this walkthrough, you will have a report that looks similar to the following.

Creating a new Visual Studio project

To create a new Visual Studio project

1. Open Visual Studio. 

2. From the File menu, select New > Project.

3. Select the project type and click Windows Application. 

4. Change the name of your project and click OK. 

Adding an ActiveReport to the Visual Studio project

To add an ActiveReport to your project

1. From the Project menu, select Add New Item. 

2. Select ActiveReports 3.0 File and rename the file rptBound. 

3. Click Open. 

Connecting the data source to a database

To connect the data source to a database

1. Click the gray report DataSource icon in the Detail section to open the report Datasource dialog. 

2. Select the "OLE DB" tab. 

3. Click Build. 
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4. Select "Microsoft Jet 4.0 OLE DB Provider" and click Next. 

5. Click the ellipsis button to browse for the access path to the Northwind database. Click Open once you 
have selected the appropriate access path. 

6. Click OK to continue. 

7. In the Query field, type "Select * from products." 

8. Click OK to return to the report design surface. 

Adding controls to contain data

To add controls to contain data

1. In the Report Explorer, expand the Fields node, then the Bound node. Drag the following fields onto 
the detail section and set the following properties of each textbox as indicated. 

2. Set the CanShrink property of the detail section to True to eliminate white space in the rendered report. 

Viewing the report

To view the report

1. Add the ActiveReports viewer control to a Windows Form. 

2. Add the code needed to set the viewer document equal to the report document. See Using the 
ActiveReports WinForm Viewer for help. 

Note: To enable the viewer's copy button, add references to the RtfExport and TextExport dlls. 

Note 2: You can quickly view your report at design time by clicking the Preview tab at the bottom of 
the designer.

In ActiveReports for .NET 3.0, datasets with relationships can be used to populate fields in subreports. 

Note: Subreports do not render PageHeader/Footer sections. To save on processing time, always 
delete PageHeader/Footer sections from subreports.

This walkthrough illustrates how to use datasets with relationships in nested subreports.

This walkthrough is split up into the following activities: 

l Adding three ActiveReports to a Visual Studio project 

l Adding controls to each report to display the data 

l Setting the data connection for the reports, creating and filling data adapters and adding dataset 
relations 

l Adding the code needed to set the subreport control's data source equal to the returned row collection of 
the dataset 

l Viewing the report  

To complete the walkthrough, you must have access to the Northwind database. For your convenience, a 
copy is included with ActiveReports at the following default location: C:\Program Files\Data 
Dynamics\ActiveReports for .NET 3.0\Data\NWIND.MDB.

Note: We will be establishing a relationship between the Categories, Products, and Order Details
tables at run time.

Field Text Location Size

ProductName Product Name 0, 0 2.3, 0.19

QuantityPerUnit Quantity 2.38, 0 1.55, 0.19

UnitsInStock Stock 4, 0 1, 0.19

Walkthrough: Using DataSets Containing Relationships with 
Subreports
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When you have finished this walkthrough, you will have a report that looks similar to the following.

Adding three ActiveReports to a Visual Studio project

To add three ActiveReports to a Visual Studio project

1. Open a new project in Visual Studio. 

2. From the Project menu, select Add New Item. 

3. Select ActiveReports 3.0 File and rename the file rptCategories. 

4. Click Open. 

5. From the Project menu, select Add New Item. 

6. Select ActiveReports 3.0 File and rename the file rptProductsSub. 

7. Click Open. 

8. From the Project menu, select Add New Item. 

9. Select ActiveReports 3.0 File and rename the file rptOrderDetailsSub. 

10. Click Open. 

Adding controls to display the data

To add controls to the reports

1. Add a GroupHeader/Footer section to rptCategories. 

2. Make the following changes to the group header: 
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¡ Change the Name property to ghCategories

¡ Change the UnderlayNext property to True

¡ Change the GroupKeepTogether property to All

¡ Change the DataField property to CategoryName

¡ Change the BackColor property to Gainsboro

3. Change the BackColor property of the page header to Silver. 

4. Add the following controls to rptCategories, setting the properties as indicated and resizing as necessary: 

5. Add a GroupHeader/Footer section to rptProductsSub. 

6. Make the following changes to the group header: 

¡ Change the Name property to ghProducts

¡ Change the UnderlayNext property to True

¡ Change the GroupKeepTogether property to All

¡ Set the DataField property to ProductName

¡ Change the BackColor property to LightSteelBlue

7. Add the following controls to rptProductsSub, setting the properties as indicated: 

8. Add the following controls to rptOrderDetailsSub, setting the properties as indicated: 

9. Set the CanShrink property of the detail section to True.

Setting the data connections, data adapters and dataset relations

To set the data connections

Control DataField Name Text Section Location
Font 
Size

Label lblCategoryName Category 
Name 

PageHeader 0, 0 12

Label lblProduct Product PageHeader 1.5, 0 12

Label lblOrderDetails Order 
Details 

PageHeader 2.75, 0 12

TextBox CategoryName txtCategoryName Category 
Name 

GroupHeader 0, 0 

Subreport SubReport1 Detail 1.5, 0 

Control Miscellaneous Name Text Section Location

TextBox DataField = 
ProductName 

txtProductName Product 
Name 

GroupHeader 0, 0 

Label Underlined lblUnitPrice Unit Price Detail 1, 0 

Label Underlined lblQuantity Quantity Detail 1.75, 0 

Label Underlined lblDiscount Discount Detail 2.44, 0 

Subreport NA SubReport1 NA Detail 1, 0.25 

Control DataField Name Text OutputFormat Alignment Location

TextBox UnitPrice txtUnitPrice Unit 
Price

Currency Right 0, 0

TextBox Quantity txtQuantity Quantity NA Right 0.75, 0

TextBox Discount txtDiscount Discount 0% Right 1.44, 0
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1. Add a Windows Form to your project. 

2. Add an ActiveReports viewer control to Form1 and set the Dock property to Fill. 

To write the code for the viewer in Visual Basic or C#

l Double-click on the title bar of the Windows Form. This creates an event-handling method for the 
Form_Load event. Add code to the handler to: 

l Set the data connections 

l Create and fill the data adapters 

l Create dataset relationships 

l Format the viewer to show the report when it is run 

The following example shows what the code for the method looks like.

'Visual Basic
'Create the dataset
Dim myJoinedDataSet As New DataSet()
Private Sub Form1_Load(ByVal sender As System.Object, ByVal e As System.EventArgs) _

Handles MyBase.Load
'Create a new instance of rptCategories and set the viewer document equal to the report's document 
Dim rpt As New rptCategories()
Me.Viewer1.Document = rpt.Document

'Create the data connection
Dim connString As String
Dim conn As New OleDb.OleDbConnection()
'Change the path to your data source as necessary
connString = "Provider=Microsoft.Jet.OLEDB.4.0;Data Source=c:\Northwind.mdb"
conn = New OleDb.OleDbConnection(connString)
conn.Open()

'Create the data adapters with the SQL SelectCommand to retrieve data from the Northwind database
Dim adapterCategories As New OleDb.OleDbDataAdapter("Select * from categories order by _

categoryname", conn)
Dim adapterProducts As New OleDb.OleDbDataAdapter("Select * from products order by _

productname", conn)
Dim adapterOrderDetails As New OleDb.OleDbDataAdapter("Select * from [order details]", conn)

'Fill the dataset with the retrieved data
adapterCategories.Fill(myJoinedDataSet, "Categories")
adapterProducts.Fill(myJoinedDataSet, "Products")
adapterOrderDetails.Fill(myJoinedDataSet, "OrderDetails")

'Create the relationships between the dataset's tables
Me.myJoinedDataSet.Relations.Add("CategoriesProducts", myJoinedDataSet.Tables("Categories") _

.Columns("CategoryID"), myJoinedDataSet.Tables("Products").Columns("CategoryID"))
Me.myJoinedDataSet.Relations.Add("ProductsOrderDetails", myJoinedDataSet.Tables("Products") _

.Columns("ProductID"), myJoinedDataSet.Tables("OrderDetails").Columns("ProductID"))

'Set the data source for rptCategories
rpt.DataSource = (myJoinedDataSet)
rpt.DataMember = "Categories"

'Run the report
rpt.Run()

End Sub 
//Create the dataset
public DataSet myJoinedDataSet = new DataSet();
private void Form1_Load(object sender, System.EventArgs e)
{

//Create a new instance of rptCategories and set the viewer document equal to the report's document
rptCategories rpt = new rptCategories();
this.viewer1.Document = rpt.Document;

//Create the data connection
//Change the path to your data source as necessary
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string connString = @"Provider=Microsoft.Jet.OLEDB.4.0;Data Source=c:\NWIND.MDB";
OleDbConnection conn = new OleDbConnection(connString);
conn.Open();

//Create the data adapters with the SQL SelectCommand to retrieve data from the Northwind database
OleDbDataAdapter adapterCategories  = new OleDbDataAdapter("Select * from categories order 

by categoryname",conn);
OleDbDataAdapter adapterProducts  = new OleDbDataAdapter("Select * from products order by 

productname",conn);
OleDbDataAdapter adapterOrderDetails  = new OleDbDataAdapter("Select * from [order details]",

conn);

//Fill the dataset with the retrieved data
adapterCategories.Fill(myJoinedDataSet, "Categories");
adapterProducts.Fill(myJoinedDataSet, "Products");
adapterOrderDetails.Fill(myJoinedDataSet, "OrderDetails");

//Create the relationships between the dataset's tables
this.myJoinedDS.Relations.Add("CategoriesProducts", myJoinedDataSet.Tables

["Categories"].Columns["CategoryID"], myJoinedDataSet.Tables["Products"].Columns
["CategoryID"]);

this.myJoinedDS.Relations.Add("ProductsOrderDetails", myJoinedDataSet.Tables
["Products"].Columns["ProductID"], myJoinedDataSet.Tables["OrderDetails"].Columns
["ProductID"]);

//Set the data source for rptCategories
rpt.DataSource = (myJoinedDataSet);
rpt.DataMember = "Categories";

//Run the report
rpt.Run();

}

Adding the code needed to set the subreport's data source control equal to 
the dataset's returned row collection for rptCategories

To write the code in Visual Basic or C#

l Double-click on the detail section of rptCategories. This creates an event-handling method for 
rptCategories' Detail_Format event. 

The following example shows what the code for the method looks like.

'Visual Basic
Dim counter As Integer
Private Sub Detail1_Format(ByVal sender As Object, ByVal e As System.EventArgs) _

Handles Detail1.Format
Dim drc As DataRow
If CType(Me.DataSource, DataSet).Tables("Categories").Rows.Count > counter Then

 drc = CType(Me.DataSource, DataSet).Tables("Categories") _
 .Rows(counter)
 counter = counter + 1
End If
Dim rpt As New rptProductsSub()
rpt.DataSource = drc.GetChildRows(CType(Me.DataSource, DataSet) _

 .Relations("CategoriesProducts"))
Me.SubReport1.Report = rpt

End Sub
 

//C#
int counter;
private void detail_Format(object sender, System.EventArgs eArgs)
{

DataRow drc = null;
if(((DataSet)this.DataSource).Tables["Categories"].Rows.Count>counter)
{

drc = ((DataSet)this.DataSource).Tables["Categories"]
.Rows[counter];
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counter++;
}
rptProductsSub rpt = new rptProductsSub();
rpt.DataSource = drc.GetChildRows(((DataSet)this.DataSource)

.Relations["CategoriesProducts"]);
this.SubReport1.Report = rpt;

}

Adding the code needed to set the subreport's data source control equal to 
the dataset's returned row collection for rptProductsSub

To write the code in Visual Basic or C#

l Double-click on the detail section of rptProductsSub. This creates an event-handling method for 
rptProductsSub's Detail_Format event. 

The following example shows what the code for the method looks like.

'Visual Basic
Dim counter As Integer
Private Sub Detail1_Format(ByVal sender As Object, ByVal e As System.EventArgs) _

Handles Detail1.Format
Dim rpt As New rptOrderDetailsSub()
Dim drc() As DataRow
drc = CType(Me.DataSource, DataRow())
rpt.DataSource = drc(counter).GetChildRows("ProductsOrderDetails")
Me.SubReport1.Report = rpt
counter = counter + 1

End Sub
 

//C#
int counter;
private void detail_Format(object sender, System.EventArgs eArgs)
{

rptOrderDetailsSub rpt = new rptOrderDetailsSub();
DataRow[] drc = ((DataRow[])this.DataSource);
rpt.DataSource = drc[counter].GetChildRows("ProductsOrderDetails");
this.SubReport1.Report = rpt;
counter++;

}

Viewing the report

To view the report

1. Add the ActiveReports viewer control to a Windows Form. 

2. Add the code needed to set the viewer document equal to the report document. See Using the 
ActiveReports WinForm Viewer for help. 

Note: You can quickly view your report at design time by clicking the Preview tab at the bottom of the 
designer.

With ActiveReports, compiled reports can be set up for deployment by including the ActiveReports 
deployment .msm file in your Visual Studio deployment project. 

This walkthrough illustrates how to create a deployment project in ActiveReports for a compiled report. 

This walkthrough is split up into the following activities: 

l Adding an installer project to an existing ActiveReports project 

l Adding the ActiveReports .msm file 

l Adding the ActiveReports application to the installer 

l Deploying the installer application 

Walkthrough: Deploying Compiled Reports
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Adding an installer project to an existing ActiveReports project

To add the installer project

1. Open an existing ActiveReports project or create a new report. 

2. On the Build menu, click "Build [your ActiveReports project name]" to build your report project. 

3. On the File menu, select Add Project and click on New Project.

4. Under Project Types in the Add New Project dialog, select Setup and Deployment Projects. 

5. In the Templates window, select Setup Project, rename the file and click OK . 

6. Select the Installer project in the Solution Explorer. In the Properties window, select the ProductName
property and type in the name of your file.

Note: The ProductName property determines the name that will be displayed for the application in 
folder names and in the Add/Remove Programs dialog box.

Adding the ActiveReports .msm file

To add the ActiveReports .msm file

1. In the Solution Explorer, right-click the Installer project. 

2. Point to Add and click Merge Module to open the Add Modules dialog.  

3. Open the Deployment folder where ActiveReports is installed (e.g. c:\\program files\Data 
Dynamics\ActiveReports for .NET 3.0\Deployment). 

4. Select "ActiveReportsDistrib.msm" and click Open. This adds all of the ActiveReports distributed 
assemblies to your project.

Note: Since the Setup and Deployment project will automatically detect and add any existing assembly 
dependencies to your project and the .msm file adds all ActiveReports assemblies, you will need to 
exclude any duplicate ActiveReports DLLs from the "Detected Dependencies" folder in the Solution 
Explorer window.

Adding the ActiveReports application to the installer

To add the ActiveReports application

1. Select the Installer project in the Solution Explorer. 

2. In the File System Editor, choose the Application folder. 

3. On the Action menu, select Add> Project Output.

4. In the Add Project Output Group dialog, choose your ActiveReports project name from the drop-down 
list. 

5. Select "Primary Output" from the list and click OK. 

6. On the Build menu, click "Build [your Installer project name]" to build your Installer project. 

Deploying the installer application

To deploy the installer application

1. Select the Installer project in the Solution Explorer. 

2. On the Project menu, click Install. 

3. The Installer application will run and install the project on your computer. 

Included with ActiveReports are several specialized export filters (HTML, PDF, RTF, Excel, TIFF and Text). 
With these export filters, reports can be easily made available to others in various file formats. 

This walkthrough illustrates how to export a report to PDF, HTML, RTF, Text, TIFF and Excel files.

Walkthrough: Exporting Output
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This walkthrough is split up into the following activities: 

l Adding an ActiveReport to a Visual Studio project 

l Adding the appropriate export filters to your project 

l Connecting the report to a data source 

l Adding controls to display the data 

l Using the export methods to export data to all available file formats 

To complete the walkthrough, you must have access to the Northwind database. For your convenience, a 
copy is included with ActiveReports at the following default location: C:\Program Files\Data 
Dynamics\ActiveReports for .NET 3.0\Data\NWIND.MDB.

When you have completed this walkthrough, you will have created PDF, HTML, RTF, Text, TIFF and Excel files 
which can be found in the Bin/Debug (C#) or Bin (VB.NET) subfolder of your project's folder.

Adding an ActiveReport to a Visual Studio project

To add an ActiveReport to your project

1. Open a new project in Visual Studio. 

2. From the Project menu, select Add New Item. 

3. Select ActiveReports 3.0 File and rename the file rptExports. 

4. Click Open. 

Adding the export filters to your project

To add the export filters to your project

1. Click on the following export controls one at a time in the appropriate toolbox to select them. 

¡ HtmlExport 

¡ PdfExport 

¡ RtfExport 

¡ TextExport 

¡ TiffExport 

¡ XlsExport 

2. Drag each control onto the Windows Form. 

3. The controls will appear in the component tray underneath the Windows Form. 

Connecting the report to a data source

To connect the report to a data source

1. Return to the report and click the gray report DataSource icon in the Detail section to open the Report 
Datasource dialog. 

2. Select the "OLE DB" tab.  

3. Click Build. 

4. Select Microsoft Jet 4.0 OLE DB Provider and click Next. 

5. Click the ellipsis to browse for the access path to the Northwind database. Click Open once you have 
selected the appropriate access path. 

6. Click OK to continue. 

7. In the Query field, type "Select LastName, FirstName from Employees." 

8. Click OK to return to the report design surface. 

Adding controls to display the data

To add controls to the report
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l In the Report Explorer, expand the Fields node, then the Bound node. Drag the following fields onto the 
detail section and set the following properties of each textbox as indicated. 

Using the export methods to export files to all available file formats

To write the code in Visual Basic

l In the Designer view of the Windows Form, double-click the form to create an event-handling method for 
the Form_Load event. Add code to the handler to: 

l Export the report to all available file formats

To write the code in C#

l In the Designer view of the Windows Form, double-click the form to create an event-handling method for 
the Form_Load event. Add code to the handler to: 

l Export the report to all available file formats

The following example shows what the code for the method looks like.

'Visual Basic
Private Sub Form1_Load(ByVal sender As System.Object, ByVal e As System.EventArgs) _

Handles MyBase.Load
Dim rpt As New rptExports()
rpt.Run()

 
Me.HtmlExport1.Export(rpt.Document, Application.StartupPath + "\\HTMLExpt.html")
Me.PdfExport1.Export(rpt.Document, Application.StartupPath + "\\PDFExpt.pdf")
Me.RtfExport1.Export(rpt.Document, Application.StartupPath + "\\RTFExpt.rtf")
Me.TextExport1.Export(rpt.Document, Application.StartupPath + "\\TextExpt.txt")
Me.TiffExport1.Export(rpt.Document, Application.StartupPath + "\\TIFFExpt.tiff")
Me.XlsExport1.Export(rpt.Document, Application.StartupPath + "\\XLSExpt.xls")

End Sub
//C#
private void Form1_Load(object sender, System.EventArgs e)
{

rptExports rpt = new rptExports();
rpt.Run();

 
this.htmlExport1.Export(rpt.Document, Application.StartupPath + "\\HTMLExpt.html");
this.pdfExport1.Export(rpt.Document, Application.StartupPath + "\\PDFExpt.pdf");
this.rtfExport1.Export(rpt.Document, Application.StartupPath + "\\RTFExpt.rtf");
this.textExport1.Export(rpt.Document, Application.StartupPath + "\\TextExpt.txt");
this.tiffExport1.Export(rpt.Document, Application.StartupPath + "\\TIFFExpt.tiff");
this.xlsExport1.Export(rpt.Document, Application.StartupPath + "\\XLSExpt.xls");

}
Build the project then navigate to the appropriate folder to see each export.

Green bar printouts can be created by alternating the shading or background color of the report's Detail 
section in the Format event.

This walkthrough illustrates how to create a green bar report.

The walkthrough is split up into the following activities: 

l Creating a new Visual Studio project 

l Adding an ActiveReport to a Visual Studio project 

l Connecting the report to a data source 

Field Text Location

LastName Last Name 0.06, 0.06

FirstName First Name 1.188, 0.063

Green Bar Reports

 

ActiveReports for .NET 3 User Guide | 227



l Adding controls to the report to contain data 

l Adding code to the Detail_Format event to alternate colors 

l Viewing the report  

To complete the walkthrough, you must have access to the Northwind database. For your convenience, a 
copy is included with ActiveReports at the following default location: C:\Program Files\Data 
Dynamics\ActiveReports for .NET 3.0\Data\NWIND.MDB. 

When you have finished this walkthrough, you will have a report that looks similar to the following.

Creating a new Visual Studio project

To create a new Visual Studio project

1. Open Visual Studio. 

2. From the File menu, select New > Project.

3. Select the project type and click on Windows Application. 

4. Change the name of your project and click OK. 

Adding an ActiveReport to a Visual Studio project

To add an ActiveReport to your project

1. Open a new project in Visual Studio. 

2. From the Project menu, select Add New Item. 

3. Select ActiveReports 3.0 File and rename the file rptGreenBar. 
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4. Click Open. 

Connecting the data source to a database

To connect the data source to a database

1. Click on the gray report DataSource icon in the Detail section to open the Report Data Source dialog. 

2. Select the "OLE DB" tab. 

3. Click Build. 

4. Select "Microsoft Jet 4.0 OLE DB Provider" and click Next. 

5. Click the ellipsis button to browse for the access path to the Northwind database. Click Open once you 
have selected the appropriate access path. 

6. Click OK to continue. 

7. In the Query field, type "SELECT * FROM Products". 

8. Click OK to return to the report design surface. 

Adding controls to contain data

To add controls to the report

1. Set the CanShrink property of the Detail section to True. 

2. In the Report Explorer, expand the Fields node, then the Bound node. Drag the following fields onto 
the detail section and set the properties of each textbox as indicated. 

3. Set the CanShrink property of the PageHeader section to True. 

4. Add the following controls to the PageHeader section: 

Adding code to the Detail_Format event to alternate colors

To add code to the the Detail_Format event

1. Double-click in the Detail section to create a Detail Format event. 

2. Add the following code to the event to alternate background colors. 

'Visual Basic
Dim I As Integer
Private Sub Detail1_Format(ByVal sender As Object, ByVal e As System.EventArgs) Handles _

Detail1.Format
If (I Mod 2) = 0 Then

Field Text Location

ProductID Product ID 0, 0 

ProductName Product Name 0.9, 0 

UnitsInStock Units in Stock 3.5, 0 

UnitsOnOrder Units on Order 4.5, 0 

ReorderLevel Reorder Level 5.6, 0 

Control Name Text Formatting Location

Label lblTitle Reorder Sheet Font 14pt; Bold; Center 0, 0 

Label lblProductID Product ID Underline 0, 0.37

Label lblProductName Product Name Underline 0.9, 0.37

Label lblUnitsInStock Units in Stock Underline 3.5, 0.37

Label lblUnitsOnOrder Units on Order Underline 4.5, 0.37

Label lblReorderLevel Reorder Level Underline 5.6, 0.37
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Detail1.BackColor = System.Drawing.Color.DarkSeaGreen
Else

Detail1.BackColor = System.Drawing.Color.Transparent
End If
I = I + 1

End Sub
//C#
bool color;
private void detail_Format(object sender, System.EventArgs eArgs)
{

if(color)
{

color =false;
this.detail.BackColor = System.Drawing.Color.DarkSeaGreen;

}
else
{

this.detail.BackColor = System.Drawing.Color.Transparent;
color = true;

}
}

Viewing the report

To view the report

1. Add the ActiveReports viewer control to a Windows Form. 

2. Add the code needed to set the viewer document equal to the report document. See Using the 
ActiveReports WinForm Viewer for help. 

Note: You can quickly view your report at design time by clicking the Preview tab at the bottom of the 
designer.

With ActiveReports, grouping can be easily added to your reports. The following walkthroughs describe 
exactly how to include various grouping options in your report.

 

Conditional Show/Hide Detail
Describes how reports can be grouped to show or hide information based on set conditions. 

Group on a Field Expression
Describes how reports can be grouped by using a group header with the DataField property set to a field 
expression. 

Group on Simple Fields
Describes how reports can be grouped by using simple fields and setting the DataField property to the 
database field on which they are being grouped. 

Group on Unbound Fields
Describes how reports can be grouped on unbound fields. 

Keeptogether Options
Describes how to use Keeptogether options with grouping in a report. 

ActiveReports allows you to hide or show information from the data source in the Detail section of your report 
based on conditions in your data. This can be achieved by setting section properties in the Format event. 

This walkthrough illustrates how to create a report based on conditions that will show specific data from your 
data source at run time. 

Grouping Data Walkthroughs

Walkthrough: Conditional Show-Hide Detail
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This walkthrough is split up into the following activities: 

l Adding an ActiveReport to a Visual Studio project 

l Connecting the report to a data source 

l Adding controls to the report to contain data 

l Adding code to retrieve data from the data source 

l Adding conditions in code to the Format event 

l Viewing the report  

To complete the walkthrough, you must have access to the Northwind database. For your convenience, a 
copy is included with ActiveReports at the following default location: C:\Program Files\Data 
Dynamics\ActiveReports for .NET 3.0\Data\NWIND.MDB.

When you have completed this walkthrough, you will have a report that looks similar to the following.

Adding an ActiveReport to a Visual Studio project

To add an ActiveReport to your project

1. Open a new project in Visual Studio. 

2. From the Project menu, select Add New Item. 

3. Select ActiveReports 3.0 File and rename the file rptCondSH. 

4. Click Open. 

Connecting the report to a data source
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To connect the report to a data source

1. Click on the gray report DataSource icon in the Detail section to open the report DataSource dialog. 

2. Select the "OLE DB" tab. 

3. Click the Build button. 

4. Select Microsoft Jet 4.0 OLE DB Provider and click Next. 

5. Click the ellipsis button to browse for the access path to the Northwind database. Click Open once you 
have selected the appropriate access path. 

6. Click OK to continue. 

7. In the Query field, type "Select * from Products ORDER BY ProductName". 

8. Click OK to return to the report design surface. 

Adding controls to the report to contain data

To add controls to the report

1. Add labels with the following properties set to the PageHeader section: 

2. Set the CanShrink property of the Detail section to True. 

3. In the Report Explorer, expand the Fields node, then the Bound node. Drag the following fields onto 
the detail section and set the following properties of each textbox as indicated. 

Adding conditions in code to the format event

To write the code in Visual Basic or C#

l Double-click in the Detail section to create an event-handling method for rptCondSH's Detail_Format 
event. Add code to the handler to: 

l Set conditions in the Format event 

The following example shows what the code for the method looks like.

'Visual Basic
Private Sub Detail1_Format(ByVal sender As Object, ByVal e As System.EventArgs) Handles _

Detail1.Format
If  Me.txtReorderLevel.Value=0 And Me.txtDiscontinued.Value = False Then

Me.Detail1.Visible = True
Me.txtDiscontinued.Text = ""
Me.txtReorderLevel.Text = "Need to Reorder"
Me.txtReorderLevel.ForeColor = System.Drawing.Color.DarkRed

Else
Me.Detail.Visible = False

End If

Miscellaneous Name Text Location

Bold lblProductID Product ID 0, 0 

Bold lblProductName Product Name 1.063, 0 

Bold lblReorderLevel Reorder Level 3.813, 0 

Bold lblInStock Units In Stock 2.5, 0 

Field Text Location

ProductID Product ID 0, 0

ProductName Product Name 1.063, 0

UnitsInStock Units In Stock 2.510, 0

ReorderLevel Reorder Level 3.833, 0

Discontinued Discontinued 5.291, 0
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End Sub

//C#
int m_dis;
private void detail_Format(object sender, System.EventArgs eArgs)
{

m_dis = bool.Parse(txtDiscontinued.Text)? 1 : 0;
 

if((short)txtReorderLevel.Value == 0 && m_dis == 0)
{

this.detail.Visible = true;
this.txtDiscontinued.Text = "";
this.txtReorderLevel.Text = "Need to Reorder";
this.txtReorderLevel.ForeColor = System.Drawing.Color.DarkRed;

}
else
{

this.detail.Visible = false;
}

}

Viewing the report

To view the report

1. Add the ActiveReports viewer control to a Windows Form. 

2. Add the code needed to set the viewer document equal to the report document. See Using the 
ActiveReports WinForm Viewer for help. 

Note: You can quickly view your report at design time by clicking the Preview tab at the bottom of the 
designer.

In ActiveReports, reports can be grouped by using a group header with the DataField property set to the 
database field on which it is being grouped. ActiveReports allows up to 32 nested groups in a single report. 
When using grouping, make sure the returned dataset is ordered by the fields on which it is being grouped.

This walkthrough illustrates the basics of setting up grouping on simple fields in a report.

The walkthrough is split up into the following activities: 

l Adding an ActiveReport to your project 

l Connecting the data source to a database 

l Adding controls to the report to contain data 

l Viewing the report  

To complete the walkthrough, you must have access to the Northwind database. For your convenience, a 
copy is included with ActiveReports at the following default location: C:\Program Files\Data 
Dynamics\ActiveReports for .NET 3.0\Data\NWIND.MDB.

When you have finished this walkthrough, you will have a report that looks similar to the following.

Walkthrough: Group on Simple Fields
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Adding an ActiveReport to your project

To add an ActiveReport to your project

1. Click Project > Add New Item.

2. Click ActiveReports 3.0 File. 

3. Change the name of the report to rptSimpleGroup and click Open. 

4. The ActiveReports design surface is displayed. 

Connecting the data source to a database

To connect the data source to a database

1. Click on the gray report DataSource icon in the Detail section to open the report DataSource dialog. 

2. Select the "OLE DB" tab.  

3. Click the Build button. 

4. Select "Microsoft Jet 4.0 OLE DB Provider" and click Next. 

5. Click the ellipsis button to browse for the access path to the Northwind database. Click Open once you 
have selected the appropriate access path. 

6. Click OK to continue. 

7. In the Query field, type "Select * from customers ORDER BY country". 

8. Click OK to return to the report design surface. 
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Adding controls to contain data

To add controls to the report

1. Add a GroupHeader/Footer section to your report (see Grouping Data for help). 

2. Make the following changes to the group header: 

¡ Change the Name property to ghOrderGroup

¡ Change the DataField property to Country

3. Add labels with the following propertiess to ghOrderGroup: 

4. Add a field with the following properties set to ghOrderGroup: 

5. In the Report Explorer, expand the Fields node, then the Bound node. Drag the following fields onto 
the detail section and set the following properties of each textbox as indicated. 

6. Set the CanShrink property of the detail section to True.

Viewing the report

To view the report

1. Add the ActiveReports viewer control to a Windows Form. 

2. Add the code needed to set the viewer document equal to the report document. See Using the 
ActiveReports WinForm Viewer for help. 

Note: You can quickly view your report at design time by clicking the Preview tab at the bottom of the 
designer.

In ActiveReports, reports can be grouped by using a group header with the DataField property set to a field 
expression. ActiveReports allows up to 32 nested groups in a single report. When using grouping, make sure 
the returned dataset is ordered by the fields on which it is being grouped.

This walkthrough illustrates the basics of setting up grouping on simple fields in a report.

The walkthrough is split up into the following activities: 

l Adding an ActiveReport to your project 

l Connecting the data source to a database 

Miscellaneous Name Text Location

Bold; Underlined lblCustomerID Customer ID 0, 0.31 

Bold; Underlined lblCompanyName Company Name 1.06, 0.31 

Bold; Underlined lblContactName Contact Name 3.25, 0.31 

Bold; Underlined lblContactTitle Contact Title 5, 0.31 

Miscellaneous DataField Name Text Location

Font size = 14; ForeColor = 
DarkRed; Bold 

Country txtCountry Country 0.313, 
0.063 

Field Text Location Size

CustomerID Customer ID 0, 0 1, 0.2

CompanyName Company Name 1.06, 0 2.06, 0.2

ContactName Contact Name 3.25, 0 1.63, 0.2

ContactTitle Contact Title 5, 0 1.5, 0.2

Group on a Field Expression
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l Adding controls to the report to contain data 

l Viewing the report 

To complete the walkthrough, you must have access to the Northwind database. For your convenience, a 
copy is included with ActiveReports at the following default location: C:\Program Files\Data 
Dynamics\ActiveReports for .NET 3.0\Data\NWIND.MDB.

When you have finished this walkthrough, you will have a report that looks similar to the following.

Adding an ActiveReport to your project

To add an ActiveReport to your project

1. From the Project menu, select Add New Item. 

2. Click ActiveReports 3.0 File. 

3. Change the name of the report to rptGroup and click Open. 

4. The ActiveReports design surface is displayed.

Connecting the data source to a database

To connect the data source to a database

1. Click on the gray report DataSource icon in the Detail section to open the report DataSource dialog. 

2. Select the "OLE DB" tab. 

3. Click Build. 

4. Select "Microsoft Jet 4.0 OLE DB Provider" and click Next. 
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5. Click the ellipsis to browse for the access path to the Northwind database. Click Open once you have 
selected the appropriate access path. 

6. Click OK to continue. 

7. In the Query field, type "Select * from customers ORDER BY (city + country)". 

8. Click OK to return to the report design surface.

Adding controls to contain data

To add controls to the report

1. Add a GroupHeader/Footer section to your report (see Grouping Data for help). 

2. Make the following changes to the group header: 

¡ Change the Name property to ghCityCountryGroup 

¡ Change the DataField property to =City + Country

¡ Change the GroupKeepTogether property to All

¡ Change the BackColor property to Gainsboro

3. Add the following controls to the PageHeader section: 

 

4. Add the following controls to the GroupHeader section: 

 

5. Add the following controls to the Detail section: 

 

Viewing the report

To view the report

1. Add the ActiveReports viewer control to a Windows Form. 

2. Add the code needed to set the viewer document equal to the report document. See Using the 
ActiveReports WinForm Viewer for help.

Note: You can quickly view your report at design time by clicking the Preview tab at the bottom of the 
designer.

ActiveReports allows you to set up grouping in unbound reports. When setting up grouping, the group 
header's DataField property is used to retrieve the grouping data from the database in the same manner as a 
textbox's DataField property.

This walkthrough illustrates how to set up grouping in an unbound report.

This walkthrough is split into the following activities: 

l Adding an ActiveReport to a Visual Studio project 

Control Name Text Location

Label; Font size 
= 12

lblCustomers Customers by City and 
Country

2.219, 0 (centered across 
entire report)

Control DataField Name Text Location

TextBox =City + ", " + Country txtCityCountry CityCountry 1.125, 0

Control DataField Name Text Location

TextBox CompanyName txtCompanyName Company Name 0, 0

Group on Unbound Fields
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l Adding code to connect the report to a data source 

l Adding controls to contain the data 

l Using the DataInitialize event to add fields to the report's fields collection 

l Using the FetchData event to populate the report fields 

l Viewing the report  

To complete the walkthrough, you must have access to the Northwind database. For your convenience, a 
copy is included with ActiveReports at the following default location: C:\Program Files\Data 
Dynamics\ActiveReports for .NET 3.0\Data\NWIND.MDB.

When you have completed this walkthrough, you will have a report that looks similar to the following.

Adding an ActiveReport to a Visual Studio project

To add an ActiveReport to your project

1. Open a new project in Visual Studio. 

2. From the Project menu, select Add New Item. 

3. Select ActiveReports 3.0 File and rename the file rptUnboundGrp. 

4. Click Open. 

Adding code to connect the report to a data source

To write the code in Visual Basic or C#

l Double-click the gray area below rptUnboundGrp. This creates an event-handling method for 
rptUnboundGrp's ReportStart event. Add code to the handler to: 
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l Set the data source connection string 

l Set the data source SQL query 

l Open the connection to create the DataReader 

The following example shows what the code for the method looks like. Be sure to change the Data Source 
path to reflect the location of the Northwind database on your system.

'Visual Basic
Imports System.Data.OleDb
Dim connection As System.Data.OleDb.OleDbConnection
Dim reader As System.Data.OleDb.OleDbDataReader
Private Sub rptUnboundGrp_ReportStart(ByVal sender As Object, ByVal e As System.EventArgs) Handles MyBase.ReportStart

'Create the data connection and change the data source path as necessary
Dim connectionString As String
connectionString = "Provider=Microsoft.Jet.OLEDB.4.0;Data Source=c:\Northwind.mdb"
connection = New OleDb.OleDbConnection(connectionString)
cnn.Open()

Dim sqlString As String
sqlString = "SELECT * FROM categories INNER JOIN products ON categories.categoryid" _

& "= products.categoryid WHERE categories.categoryid = 1"
Dim command As System.Data.OleDb.OleDbCommand
command.CommandText = sqlString
command.Connection = connection
'Retrieve data
reader = command.ExecuteReader()

End Sub

//C#
using System.Data.OleDb;
private string connectionString;
private System.Data.OleDb.OleDbConnection connection;
private System.Data.OleDb.OleDbDataReader reader;
private void rptUnboundGrp_ReportStart(object sender, System.EventArgs eArgs)

{
//Create the data connection and change the data source path as necessary
connectionString = @"Provider=Microsoft.Jet.OLEDB.4.0;Data Source=c:\Northwind.mdb";
connection=new OleDbConnection(connectionString);
connection.Open();

string sqlString = "SELECT * FROM categories INNER JOIN products ON categories.categoryid" + 
"= products.categoryid WHERE categories.categoryid = 1";

System.Data.OleDb.OleDbCommand command = new System.Data.OleDb.OleDbCommand(sqlString, connection);   
//Retrieve data
reader = command.ExecuteReader();

}

Adding code to close the connection to the data source

To write the code in Visual Basic

l At the top left of the code view for rptUnboundGrp, click the drop-down arrow and select (rptUnboundGrp 
Events). At the top right of the code window, click the drop-down arrow and select ReportEnd. This 
creates an event-handling method for rptUnboundGrp's ReportEnd event. Add code to the handler to: 

l Close the connection 

To write the code in C#

l Click in the gray area below rptUnboundGrp to select the report. Click on the events icon in the 
Properties window to display available events for the report. Double-click ReportEnd. This creates an 
event-handling method for rptUnboundGrp's ReportEnd event. Add code to the handler to: 

l Close the connection 

The following example shows what the code for the method looks like.

'Visual Basic
Private Sub rptGrp_ReportEnd(ByVal sender As Object, ByVal eArgs As System.EventArgs) 

reader.Close() 
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connection.Close() 
End Sub

//C#
private void rptGrp_ReportEnd(object sender, System.EventArgs eArgs)
{

reader.Close();
connection.Close();

}

Adding controls to the report to contain data

To add controls to the report

1. Add a GroupHeader/Footer section to your report (see Grouping Data for help). 

2. Make the following changes to the group header: 

l Change the Name property to ghCategories

l Change the BackColor property to Silver

l Change the DataField property to CategoryID

l Set the GroupKeepTogether property to All

l Set the KeepTogether property to True

3. Make the following change to the group footer: 

l Change the name to gfCategories 

4. Add the following controls to the GroupHeader section: 

5. Change the FontSize property of txtCategoryName to 12, the BackColor property to LightGray, and 
the ForeColor property to Blue. 

6. Add the following controls to the Detail section: 

7. Add the following controls to the GroupFooter section: 

Control DataField Name Text Miscellaneous Location

TextBox CategoryName txtCategoryName Category 
Name

ForeColor = 
Blue; Font size 
= 12

0.063, 
0.063

TextBox Description txtDescription Description Size = 6, 0.2 0.063, 
0.375 

Label NA lblProductName Product 
Name 

Bold 0.063, 
0.688

Label NA lblUnitsInStock Units In 
Stock 

Bold 4.38, 
0.688 

Control DataField Name Text Location

TextBox ProductName txtProductName Product Name 0.063, 0.063 

TextBox UnitsInStock txtUnitsInStock Units In Stock 4.75, 0.064 

Control DataField Name Text Miscellaneous Location

Label TotalLabel lblTotalLabel Total 
Number of 
Beverages

NA 2.6, 0

TextBox ProductName txtTotalItems Total Items SummaryType = 
SubTotal 
SummaryFunc = 
Count 
SummaryRunning = 

4.75, 0
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Using the DataInitialize event to add fields
Note: The Fields collection should never be accessed outside the DataInitialize and FetchData events.

To write the code in Visual Basic

l Right-click in any section of the design window of rptUnboundGrp, and click on View Code to display the 
code view for the report. At the top left of the code view for rptUnboundGrp, click the drop-down arrow 
and select (rptUnboundGrp Events). At the top right of the code window, click the drop-down arrow and 
select DataInitialize. This creates an event-handling method for rptUnboundGrp's DataInitialize event. 
Add code to the handler to: 

l Add fields to the report's Fields collection. 

To write the code in C#

l Click in the gray area below rptUnboundGrp to select the report. Click on the events icon in the 
Properties window to display available events for the report. Double-click DataInitialize. This creates 
an event-handling method for rptUnboundGrp's DataInitialize event. Add code to the handler to: 

l Add fields to the report's Fields collection. 

The following example shows what the code for the method looks like.

'Visual Basic
Private Sub rptUnboundGrp_DataInitialize(ByVal sender As Object, ByVal e As _

System.EventArgs) Handles MyBase.DataInitialize
Fields.Add("CategoryID")
Fields.Add("CategoryName")
Fields.Add("ProductName")
Fields.Add("UnitsInStock")
Fields.Add("Description")
Fields.Add("TotalLabel")

End Sub

//C#
private void UnboundGrp_DataInitialize(object sender, System.EventArgs eArgs)
{

Fields.Add("CategoryID");
Fields.Add("CategoryName");
Fields.Add("ProductName");
Fields.Add("UnitsInStock");
Fields.Add("Description");
Fields.Add("TotalLabel");

}

Using the FetchData event to populate the report fields

To write the code in Visual Basic

l Right-click in any section of the design window of rptUnboundGrp, and click on View Code to display the 
code view for the report. At the top left of the code view for rptUnboundGrp, click the drop-down arrow 
and select (rptUnboundGrp Events). At the top right of the code window, click the drop-down arrow and 
select FetchData. This creates an event-handling method for rptUnboundGrp's FetchData event. Add code 
to the handler to: 

l Retrieve information to populate the report fields. 

Group 
SummaryGroup = 
ghCategories

Line NA Line1 LineWeight = 3 X1 = 
1.875 
Y1 = 0 
X2 = 
6.438 
Y2 = 0 

ActiveReports for .NET 3 User Guide | 241



To write the code in C#

l Click in the gray area below rptUnboundGrp to select the report. Click on the events icon in the 
Properties window to display available events for the report. Double-click FetchData. This creates an 
event-handling method for rptUnboundGrp's FetchData event. Add code to the handler to: 

l Retrieve information to populate the report fields. 

The following example shows what the code for the method looks like.

'Visual Basic
Private Sub rptUnboundGrp_FetchData(ByVal sender As Object, ByVal eArgs As DataDynamics.ActiveReports.ActiveReport3.FetchEventArgs) Handles MyBase.FetchData

Try
reader.Read()
Me.Fields("CategoryID").Value = reader("categories.CategoryID")
Me.Fields("CategoryName").Value = reader("CategoryName")
Me.Fields("ProductName").Value = reader("ProductName")
Me.Fields("UnitsInStock").Value = reader("UnitsInStock")
Me.Fields("Description").Value = reader("Description")
Me.Fields("TotalLabel").Value = "Total Number of " + reader("CategoryName") + ":"
eArgs.EOF = False

Catch ex As Exception
System.Windows.Forms.MessageBox.Show(ex.ToString())
eArgs.EOF = True

End Try
End Sub

//C#
private void UnboundGrp_FetchData(object sender, DataDynamics.ActiveReports.ActiveReport3.FetchEventArgs eArgs)
{

try
{

reader.Read();
Fields["CategoryID"].Value = reader["categories.CategoryID"].ToString();
Fields["CategoryName"].Value = reader["CategoryName"].ToString();
Fields["ProductName"].Value = reader["ProductName"].ToString();
Fields["UnitsInStock"].Value = reader["UnitsInStock"].ToString();
Fields["Description"].Value = reader["Description"].ToString();
Fields["TotalLabel"].Value = "Total Number of " + reader["CategoryName"].ToString() + ":";
eArgs.EOF = false;

}
catch

{
eArgs.EOF = true;

}
}

Viewing the report

To view the report

1. Add the ActiveReports viewer control to a Windows Form. 

2. Add the code needed to set the viewer document equal to the report document. See Using the 
ActiveReports WinForm Viewer for help. 

Note: You can quickly view your report at design time by clicking the Preview tab at the bottom of the 
designer. When previewing reports that have SQL statements generated at run time, a Save File As dialog 
will prompt you to save your queries in the project folder.
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ActiveReports allows you to set KeepTogether options for your reports so that the group detail is kept 
together on one page when printed. 

This walkthrough illustrates how to set the KeepTogether and GroupKeepTogether options to allow all group 
detail to print together on one page.

This walkthrough is split up into the following activities: 

l Adding an ActiveReport to a Visual Studio project 

l Connecting the report to a data source 

l Adding controls to the report to contain data 

l Viewing the report  

To complete the walkthrough, you must have access to the Northwind database. For your convenience, a 
copy is included with ActiveReports at the following default location: C:\Program Files\Data 
Dynamics\ActiveReports for .NET 3.0\Data\NWIND.MDB.

When you have completed this walkthrough, you will have a report that looks similar to the following.

Walkthrough: KeepTogether Options
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Adding an ActiveReport to a Visual Studio project

To add an ActiveReport to your project

1. Open a new project in Visual Studio. 

2. From the Project menu, select Add New Item. 

3. Select ActiveReports 3.0 File and rename the file rptKeepTG. 

4. Click Open. 

Connecting the report to a data source

To connect the report to a data source

1. Click on the gray report DataSource icon in the Detail section to open the report DataSource dialog. 

2. Select the "OLE DB" tab.  

3. Click the Build button. 

4. Select Microsoft Jet 4.0 OLE DB Provider and click Next. 

5. Click the ellipsis button to browse for the access path to the Northwind database. Click Open once you 
have selected the appropriate access path. 

6. Click OK to continue. 

7. In the Query field, type "SELECT DISTINCTROW Orders.*, [Order Details].*, Products.* FROM Products 
INNER JOIN (Orders INNER JOIN [Order Details] ON Orders.OrderID = [Order Details].OrderID) ON 
Products.ProductID = [Order Details].ProductID order by orderdate". 
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8. Click OK to return to the report design surface. 

Adding controls to the report to contain data

To add controls to the report

1. Add a GroupHeader/Footer section to rptKeepTG (see Grouping Data for help). 

2. Make the following changes to the group header: 

¡ Change the Name property to ghOrders 

¡ Change the BackColor property to RosyBrown

¡ Change the DataField property to OrderDate

¡ Change the GroupKeepTogether property to All

¡ Change the KeepTogether property to True

3. Add the following controls to the GroupHeader section: 

4. In the Report Explorer, expand the Fields node, then the Bound node. Drag the following fields onto 
the detail section and set the following properties of each textbox as indicated. 

Viewing the report

To view the report

1. Add the ActiveReports viewer control to a Windows Form. 

2. Add the code needed to set the viewer document equal to the report document. See Using the 
ActiveReports WinForm Viewer for help. 

Note: You can quickly view your report at design time by clicking the Preview tab at the bottom of the 
designer.

ActiveReports allows hyperlinks to be added to reports. These reports can then be previewed, displayed in 
the viewer control or exported. The hyperlink property can be set to any HTML-style link, used to simulate 
drill-down reporting or set to items in the Table of Contents. By using the hyperlink property, reports can 
have "clickable" controls that can be used for a variety of different tasks, including running and displaying 
other reports, executing mail links, and opening tabbed views that display Web links or links to . 
ActiveReports now uses the HyperLink property of controls to provide tabbed viewing for TOC contents and 
Web links. Report navigation becomes much easier and appealing to end users, who can now quickly 

Miscellaneous Name Text Location

Bold lblOrderDate Order Date 0, 0 

Bold lblOrderID Order ID 1.13, 0 

Bold lblProductName Product Name 2.24, 0 

Bold lblQuantity Quantity 4.63, 0 

Bold lblUnitPrice Unit Price 5.5, 0 

Field Text Location Output Format

orders.OrderID Order ID 1.13, 0 NA

ProductName Product Name 2.24, 0 NA

products.UnitPrice Unit Price 5.5, 0 Currency
 

OrderDate Order Date 0, 0 MM/dd/yy

Quantity Quantity 4.63, 0 NA

Hyperlinks Walkthroughs
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move from one view to another through by clicking the tabs at the top of the report. Additionally, the viewer 
now shells out and executes e-mail links as determined by the operating system.The following walkthroughs 
demonstrate the different ways hyperlinking can be used in reports.

 

Hyperlinks
Describes how to use HTML-style hyperlinks in a report. 

Hyperlinks and Bookmarks
Describes how to use hyperlinks in a report to generate an index tied to the bookmarks collection. 

Hyperlinks and Simulated Drill-Down Reporting
Describes how to use hyperlinks in a report to simulate drill-down reporting. 

ActiveReports allows you to add hyperlinks to reports. The hyperlink property can be set to any HTML-style 
link such as http:// or mailto://.

This walkthrough illustrates how to add to add hyperlinks to a report in the PageFooter section.

This walkthrough is split up into the following activities: 

l Adding an ActiveReport to a Visual Studio project 

l Connecting the report to a data source 

l Adding controls to the report to display data 

l Viewing the report  

To complete the walkthrough, you must have access to the Northwind database. For your convenience, a 
copy is included with ActiveReports at the following default location: C:\Program Files\Data 
Dynamics\ActiveReports for .NET 3.0\Data\NWIND.MDB.

When you have completed this walkthrough, you will have a report that looks similar to the following.

Walkthrough: Hyperlinks
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Adding an ActiveReport to a Visual Studio project

To add an ActiveReport to a Visual Studio project

1. Open a new project in Visual Studio. 

2. From the Project menu, select Add New Item. 

3. Select ActiveReports 3.0 File and rename the file rptHyper. 

4. Click Open. 

Connecting the report to a data source

To connect the report to a data source

1. Click the gray report DataSource icon in the Detail section to open report DataSource dialog. 

2. Select the "OLE DB" tab. 

3. Click Build. 

4. Select Microsoft Jet 4.0 OLE DB Provider and click Next. 

5. Click the ellipsis to browse for the access path to the Northwind database. Click Open once you have 
selected the appropriate access path. 

6. Click OK to continue. 

7. In the Query field, type "Select * from suppliers order by CompanyName". 

8. Click OK to return to the report design surface. 
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Adding controls to display the data

To add controls to the reports

1. Add a GroupHeader/Footer section to rptHyper (see Grouping Data for help). 

2. Make the following changes to the group header: 

¡ Change the name to ghSuppliers 

¡ Change the DataField property to CompanyName

¡ Change the GroupKeepTogether property to All

¡ Change the KeepTogether property to True

3. Add the following controls to the GroupHeader section: 

4. In the Report Explorer, expand the Fields node, then the Bound node. Drag the following fields onto the 
detail section and set the following properties of each textbox. 

5. Add the following controls to the PageFooter section: 

Viewing the report

To view the report

1. Add the ActiveReports viewer control to a Windows Form. 

2. Add the code needed to set the viewer document equal to the report document. See Using the 
ActiveReports WinForm Viewer for help. 

Note: You can quickly view your report at design time by clicking the Preview tab at the bottom of the 
designer.

Control Name Text Location

Label lblCompanyName Company Name 0, 0 

Label lblContactName Contact Name 1.562, 0 

Label lblPhone Phone # 2.687, 0 

Label lblFax Fax # 3.812, 0 

Label lblHomePage1 Home Page 4.875, 0 

Field Text Location

CompanyName Company Name 0, 0 

ContactName Contact Name 1.562, 0 

Phone Phone 2.687, 0 

Fax Fax 3.812, 0 

HomePage Home Page 4.854, 0 

Control Name Text Miscellaneous Location

Label lblEmail Need Assistance? E-
mail Support: 
Support@company.com

HyperLink = 
mailto:support@company.com

0, 0.125

Label lblHomePage Visit our home page: 
www.datadynamics.com

HyperLink = 
www.datadynamics.com

0, 0.375

Walkthrough: Hyperlinks and Bookmarks
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ActiveReports allows you to use the hyperlink property to reference back to the bookmarks collection. 

This walkthrough illustrates how to add hyperlinks to a report that references items in the bookmarks 
collection and create a directory to match the items in the bookmarks collection.

This walkthrough is split up into the following activities: 

l Adding two ActiveReports to a Visual Studio project 

l Connecting the main report to a data source 

l Adding controls to rptMain to display data 

l Adding controls to rptBookmarks to display data 

l Adding code to the main report's Detail_Format event 

l Adding code to the main report's ReportEnd event 

l Adding code to the second report's Detail_Format event 

l Adding code to the second report's FetchData event 

l Viewing the report  

l Viewing the Bookmarks collection 

To complete the walkthrough, you must  have access to the Northwind database.

When you have completed this walkthrough, you will have a report that looks similar to the following.

Adding two ActiveReports to a Visual Studio project

To add two ActiveReports to a Visual Studio project

1. Open a new project in Visual Studio. 
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2. From the Project menu, select Add New Item. 

3. Select ActiveReports 3.0 File and rename the file rptMain. 

4. Click Open. 

5. From the Project menu, select Add New Item. 

6. Select ActiveReports 3.0 File and rename the file rptBookmarks. 

7. Click Open. 

Connecting rptMain to a data source

To connect the report to a data source

1. Click on the gray report DataSource icon in the Detail section to open the report DataSource dialog. 

2. Select the "OLE DB" tab. 

3. Click the Build button. 

4. Select Microsoft Jet 4.0 OLE DB Provider and click Next. 

5. Click the ellipsis button to browse for the access path to the Northwind database. Click Open once you 
have selected the appropriate access path. 

6. Click OK to continue. 

7. In the Query field, type "Select * from suppliers order by CompanyName". 

8. Click OK to return to the report design surface. 

Adding controls to rptMain display the data

To add controls to the report

1. Add a GroupHeader/Footer section to rptMain (see Grouping Data for help). 

2. Make the following changes to the group header: 

¡ Change the Name property to ghSuppliers 

¡ Change the DataField property to CompanyName

¡ Change the GroupKeepTogether property to All

¡ Change the KeepTogether property to True

¡ Add the following controls to ghSuppliers: 

¡ In the Report Explorer, expand the Fields node, then the Bound node. Drag the following fields 
onto the detail section of rptMain and set the following properties of each textbox. 

Control Name Text Location

Label lblCompanyName Company Name 0, 0 

Label lblContactName Contact Name 1.562, 0 

Label lblPhone Phone # 2.687, 0 

Label lblFax Fax # 3.812, 0 

Label lblHomePage1 Home Page 4.875, 0 

Field Text Location

CompanyName Company Name 0, 0 

ContactName Contact Name 1.562, 0 

Phone Phone 2.687, 0 

Fax Fax 3.812, 0 

HomePage Home Page 4.875, 0 
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¡ Set the CanShrink property of the detail section to True. 

¡ Add the following controls to the PageFooter section: 

Adding controls to rptBookmarks display the data

To add controls to the report

1. Set the CanShrink property of the detail section to True. 

2. Add the following controls to the PageHeader section: 

3. Add the following controls to the Detail section: 

Adding the code to rptMain's Detail_Format event
Add code to the Format event to parse the URL out of the HomePage field and assign it to the HyperLink 
property of txtHomePage, and to remove the URL markers from the text displayed in txtHomePage.

To write the code in Visual Basic or C#

l Double-click the Detail section of rptMain. This creates an event-handling method for rptMain's 
Detail_Format event. 

The following example shows what the code for the method looks like.

' Visual Basic
Private Sub Detail1_Format(ByVal sender As Object, ByVal e As System.EventArgs) Handles _

Detail1.Format
Me.Detail1.AddBookmark(Me.txtCompanyName.Text)
Dim iStart As Integer
Dim sHTML As String
If txtHomePage.Text <> "" Then

iStart = InStr(1, txtHomePage.Text, "#", CompareMethod.Text)
sHTML = Right(txtHomePage.Text, (Len(txtHomePage.Text) - iStart))
sHTML = Replace(sHTML, "#", "", 1, -1, CompareMethod.Text)
txtHomePage.HyperLink = sHTML
txtHomePage.Text = Replace(txtHomePage.Text, "#", "", 1, -1, CompareMethod _

.Text)
End If

End Sub
//C#

Control Name Text Miscellaneous Location

Label lblEmail Need Assistance? E-
mail Support: 
Support@company.com 

HyperLink = 
mailto:support@company.com 

0, 0.125 

Label lblHomePage Visit our home page: 
www.datadynamics.com 

HyperLink = 
www.datadynamics.com 

0, 0.375 

Control Name Text Location

Label lblDirectory Directory 0.5, 0 

Label lblCompanyName Company Name 1.125, 0.437 

Label lblPage Page 3.312, 0.437 

Line Line1 X1 = 0
X2 = 6.5
Y1 = 0.697
Y2 = 0.697

Control Name Text Location

TextBox txtEntry Company Name 1.125, 0

TextBox txtPage Page 3.312, 0
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private void detail_Format(object sender, System.EventArgs eArgs)
{

this.detail.AddBookmark(this.txtCompanyName.Text);
int iStart;
string sHTML;
if (txtHomePage.Text != "")

{
iStart = txtHomePage.Text.IndexOf("#",0);
sHTML = txtHomePage.Text.Substring(iStart, txtHomePage.Text.Length -

iStart);
sHTML = sHTML.Replace("#", "");
txtHomePage.HyperLink = sHTML;
txtHomePage.Text = txtHomePage.Text.Replace("#", "");

}
}

Adding the code to rptMain's ReportEnd event
Add code to the ReportEnd event to run rptBookmarks and insert its pages collection at the beginning of 
rptMain.

To write the code in Visual Basic

l Right-click in any section of the design surface of rptMain, and click on View Code to display the code 
view for the report. At the top left of the code view for rptMain, click the drop-down arrow and select 
(rptMain Events). At the top right of the code window, click the drop-down arrow and select ReportEnd. 
This creates an event-handling method for the ReportEnd event. 

To write the code in C#

l Click in the gray area below rptMain to select the report. Click on the events icon in the Properties
window to display available events for the report. Double-click ReportEnd. This creates an event-handling 
method for the ReportEnd event. 

The following example shows what the code for the method looks like.

' Visual Basic
Private Sub rptMain_ReportEnd(ByVal sender As Object, ByVal e As System.EventArgs) _

Handles MyBase.ReportEnd
Dim rpt As New rptBookmarks()
rpt.pBM = Me.Document.Bookmarks
rpt.Run()
Me.Document.Pages.InsertRange(0, rpt.Document.Pages)

End Sub
//C#
private void rptMain_ReportEnd(object sender, System.EventArgs eArgs)
{

rptBookmarks rpt = new rptBookmarks();
rpt.pBM = this.Document.Bookmarks;
rpt.Run();
this.Document.Pages.InsertRange(0, rpt.Document.Pages);

}

Adding the code to rptBookmarks' Detail_Format event
Add code to the Format event to create a hyperlink which navigates to a bookmark and to display the page 
number of the bookmark.

To write the code in Visual Basic or C#

l Double-click the Detail section of rptBookmarks. This creates an event-handling method for 
rptBookmarks' Detail_Format event. 

The following example shows what the code for the method looks like.

' Visual Basic
Public pBM As New BookmarksCollection()
Dim iEntry As Integer
Private Sub Detail1_Format(ByVal sender As Object, ByVal e As System.EventArgs) Handles _

Detail1.Format
Me.txtEntry.HyperLink = "toc://" + pBM(iEntry - 1).Label
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Me.txtEntry.Text = pBM(iEntry - 1).Label
Me.txtPage.Text = pBM(iEntry - 1).PageNumber

End Sub
//C#
public BookmarksCollection pBM = new BookmarksCollection();
int iEntry;
private void detail_Format(object sender, System.EventArgs eArgs)
{

this.txtEntry.HyperLink = "toc://" + pBM[iEntry - 1].Label;
this.txtEntry.Text = pBM[iEntry - 1].Label;
this.txtPage.Text = pBM[iEntry - 1].PageNumber.ToString();

}

Adding code to rptBookmarks' FetchData event
Add code to the FetchData event to get the page number of the bookmark.

To write the code in Visual Basic

l Right-click in any section of the design window of rptBookmarks, and click on View Code to display the 
code view for the report. At the top left of the code view for rptBookmarks, click the drop-down arrow 
and select (rptBookmarks Events). At the top right of the code window, click the drop-down arrow and 
select FetchData. This creates an event-handling method for rptBookmarks' FetchData event. 

To write the code in C#

l Click in the gray area below rptBookmarks to select the report. Click on the events icon in the Properties
window to display available events for the report. Double-click FetchData. This creates an event-handling 
method for rptBookmarks' FetchData event. 

The following example shows what the code for the method looks like.

' Visual Basic
Private Sub rptBookmarks_FetchData(ByVal sender As Object, ByVal eArgs As DataDynamics _

.ActiveReports.ActiveReport.FetchEventArgs) Handles MyBase.FetchData
If iEntry > pBM.Count - 1 Then

eArgs.EOF = True
Else

eArgs.EOF = False
 iEntry += 1

End If
End Sub
//C#
private void rptBookmarks_FetchData(object sender, DataDynamics.ActiveReports

.ActiveReport.FetchEventArgs eArgs)
{

if (iEntry > pBM.Count - 1)
{

eArgs.EOF = true;
}

else
{

eArgs.EOF = false;
iEntry += 1;

}
}

Viewing the report

To view the report

1. Add the ActiveReports viewer control to a Windows Form. 

2. Add the code needed to set the viewer document equal to the report document. See Using the 
ActiveReports WinForm Viewer for help. 

Note: You can quickly view your report at design time by clicking the Preview tab at the bottom of the 
designer.
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Viewing the Bookmarks Collection 

To view the Bookmarks collection 

1. Press F5 to run the report. 

2. Click on the "Table of Contents" icon to view the Bookmarks collection. 

Hyperlinks can be used in ActiveReports to simulate drill-down reporting. 

This walkthrough illustrates how to set up hyperlinks in a report to simulate drill-down reporting. 

This walkthrough is split up into the following activities: 

l Adding three ActiveReports to a Visual Studio project 

l Connecting each report to a data source 

l Adding controls to each report to display the data 

l Adding three Windows Forms with viewer controls to the project 

l Adding code to frmViewMain and frmViewDrillDown1 

l Adding code to frmViewMain and frmViewDrillDown2 

l Adding the code needed to set hyperlink properties 

l Viewing the report  

To complete the walkthrough, you must have access to the Northwind database. For your convenience, a 
copy is included with ActiveReports at the following default location:
C:\Program Files\Data Dynamics\ActiveReports for .NET 3.0\Data\NWIND.MDB.

When you have finished this walkthrough, you will have a main report that looks similar to the following.

Walkthrough: Hyperlinks and Simulated Drill-Down Reporting
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Adding three ActiveReports to a Visual Studio project

To add three ActiveReports to a Visual Studio project

1. From the Project menu, select Add New Item. 

2. Select ActiveReports 3.0 File and rename the file rptMain. 

3. Click Open. 

4. Click the detail section of the report to select it and change the BackColor property to Thistle.  

5. From the Project menu, select Add New Item. 

6. Select ActiveReports 3.0 File and rename the file rptDrillDown1. 

7. Click Open. 

8. Click the detail section of the report to select it and change the BackColor property to RosyBrown. 

9. From the Project menu, select Add New Item. 

10. Select ActiveReports 3.0 File and rename the file rptDrillDown2. 

11. Click the detail section of the report to select it and change the BackColor property to LightSteelBlue. 

12. Click Open. 

Connecting rptMain to a data source

To connect the report to a data source

1. Click the gray report DataSource icon in the Detail section to open the report DataSource dialog. 
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2. Select the "OLE DB" tab. 

3. Click Build. 

4. Select Microsoft Jet 4.0 OLE DB Provider and click Next. 

5. Click the ellipsis to browse for the access path to the Northwind database. Click Open once you have 
selected the appropriate access path. 

6. Click OK to continue. 

7. In the Query field, type "Select * from customers order by customerID". 

8. Click OK to return to the report design surface. 

Connecting rptDrillDown1 to a data source

To connect the report to a data source

1. Click the gray report DataSource icon in the Detail section to open the report DataSource dialog. 

2. Select the "OLE DB" tab. 

3. Click Build. 

4. Select Microsoft Jet 4.0 OLE DB Provider and click Next. 

5. Click the ellipsis to browse for the access path to the Northwind database. Click Open once you have 
selected the appropriate access path. 

6. Click OK to continue. 

7. In the Query field, type "Select * from orders where customerID = <%customerID%> order by 
orderdate". 

8. Click OK to return to the report design surface. 

9. Set the report's ShowParameterUI property to False to avoid displaying a UI requesting parameters.

Connecting rptDrillDown2 to a data source

To connect the report to a data source

1. Click the gray report DataSource icon in the Detail section to open the report DataSource dialog. 

2. Select the "OLE DB" tab. 

3. Click Build. 

4. Select Microsoft Jet 4.0 OLE DB Provider and click Next. 

5. Click the ellipsis button to browse for the access path to the Northwind database. Click Open once you 
have selected the appropriate access path. 

6. Click OK to continue. 

7. In the Query field, type "Select * from [order details] where orderID = <%orderID||10248%> order by 
productid". 

Note: Setting a default value for the parameter in this query allows you to see fields in the Report 
Explorer instead of an error message.

8. Click OK to return to the report design surface. 

9. Set the report's ShowParameterUI property to False to avoid displaying a UI requesting parameters.

Adding controls to display the data

To add controls to the reports

1. Add the following controls to rptMain, setting their properties as indicated: 

Control Section Location Name DataField Text Miscellaneous

Label PageHeader 0, 0 lblCustomer NA Customer ForeColor = 
Purple; Font = 
12pt
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2. Add the following controls to rptDrillDown1, setting their properties as indicated: 

3. Add the following controls to rptDrillDown2, setting their properties as indicated: 

Label PageHeader 1.188, 0 lblCompanyName NA Company 
Name 

ForeColor = 
Purple; Font = 
12pt 

Label PageHeader 3.563, 0 lblContactName  NA Contact 
Name 

ForeColor = 
Purple; Font = 
12pt

TextBox Detail 0, 0 txtCustomerID CustomerID Customer 
ID 

ForeColor = 
Blue; Underline 
= True 

TextBox Detail 1.183, 0 txtCompanyName  CompanyName Company 
Name 

ForeColor = 
Black

TextBox Detail 3.563, 0 txtContactName ContactName Contact 
Name

ForeColor = 
Black

Control Section Location Name DataField Text Miscellaneous

Label PageHeader 0,0 lblCustomerID NA Customer 
ID 

ForeColor = 
Maroon; Font 
= 12pt

Label PageHeader 1.188, 0 lblOrderID NA Order ID  ForeColor = 
Maroon; Font 
= 12pt

Label PageHeader 2.438, 0 lblEmployeeID  NA Employee 
ID 

ForeColor = 
Maroon; Font 
= 12pt

Label PageHeader 3.625, 0 lblOrderDate  NA Order 
Date 

ForeColor = 
Maroon; Font 
= 12pt

Label PageHeader  4.813, 0 lblShippedDate NA Shipped 
Date  

ForeColor = 
Maroon; Font 
= 12pt

TextBox Detail 0, 0 txtCustomerID CustomerID Customer 
ID

ForeColor = 
Black

TextBox Detail 1.188, 0 txtOrderID OrderID Order ID ForeColor = 
Blue; Underline 
= True 

TextBox Detail 2.438, 0 txtEmployeeID EmployeeID Employee 
ID 

ForeColor = 
Black

TextBox Detail 3.625, 0 txtOrderDate OrderDate Order 
Date 

ForeColor = 
Black

TextBox Detail 4.813, 0 txtShippedDate ShippedDate Shipped 
Date 

ForeColor = 
Black

Control Section Location Name DataField Text Miscellaneous

Label PageHeader 0, 0 lblOrderID NA Order 
ID

ForeColor = 
Navy; Font = 
12pt

Label PageHeader 1.188, 0 lblProductID NA Product 
ID

ForeColor = 
Navy; Font = 
12pt
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Adding three Windows Forms with viewer controls to your project

To add three Windows Forms with viewer controls to your project

1. Change the name of the default Windows Form to frmViewMain. 

2. Place an ActiveReports viewer control on frmViewMain and set its Dock property to Fill. 

3. Click on Project > Add Windows Form. 

4. Select Windows Form and rename it frmViewDrillDown1. 

5. Click Open. 

6. Place an ActiveReports viewer control on frmViewDrillDown1 and set its Dock property to Fill. 

7. Click on Project > Add Windows Form. 

8. Select Windows Form and rename it frmViewDrillDown2. 

9. Click Open. 

10. Place an ActiveReports viewer control on frmViewDrillDown2 and set its Dock property to Fill.  

Adding code to frmViewMain

To write the code in Visual Basic

l Double-click at the top of frmViewMain to display the code view for the report. At the top left of the code 
view for frmViewMain, click the drop-down arrow and select Viewer1. At the top right of the code window, 
click the drop-down arrow and select Hyperlink . This creates an event-handling method for frmViewMain's 
Viewer1_Hyperlink event. 

To write the code in C#

l Click in the Viewer section of frmViewMain to select the viewer. Click on the events icon in the 
Properties window to display available events for the viewer. Double-click Hyperlink. This creates an 
event-handling method for frmViewMain's Viewer1_Hyperlink event.

The following example shows what the code for the method looks like.

'Visual Basic
Private Sub Viewer1_HyperLink(ByVal sender As Object, ByVal e As DataDynamics.ActiveReports _ .Viewer.HyperLinkEventArgs) Handles Viewer1.HyperLink 

Dim rpt2 As New rptDrillDown1() 
Dim frm2 As New frmViewDrillDown1() 
rpt2.Parameters("customerID").Value = e.HyperLink.ToString 

Label PageHeader 2.375, 0 lblUnitPrice NA Unit 
Price

ForeColor = 
Navy; Font = 
12pt

Label PageHeader 3.563, 0 lblQuantity NA Quantity ForeColor = 
Navy; Font = 
12pt

Label PageHeader 4.75, 0 lblDiscount NA Discount ForeColor = 
Navy; Font = 
12pt

TextBox Detail 0, 0 txtOrderID OrderID Order 
ID

ForeColor = 
Black

TextBox Detail 1.188, 0 txtProductID ProductID Product 
ID

ForeColor = 
Black

TextBox Detail 2.375, 0 txtUnitPrice UnitPrice Unit 
Price

OutputFormat 
= Currency

TextBox Detail 3.563, 0 txtQuantity Quantity Quantity ForeColor = 
Black

TextBox Detail 4.75, 0 txtDiscount Discount Discount OutputFormat 
= Currency
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rpt2.Run() 
frm2.My_Viewer.Document = rpt2.Document 
frm2.ShowDialog(Me)  

End Sub 

//C# 
private void viewer1_HyperLink(object sender, DataDynamics.ActiveReports.Viewer .HyperLinkEventArgs e) 
{ 

rptDrillDown1 rpt2 = new rptDrillDown1(); 
frmViewDrillDown1 frm2 = new frmViewDrillDown1(); 
rpt2.Parameters["customerID"].Value = e.HyperLink.ToString();
rpt2.Run(); 
frm2.viewer1.Document = rpt2.Document; 
frm2.ShowDialog(this); 

}

Adding code to frmViewDrillDown1

To write the code in Visual Basic

l Double-click at the top of frmViewDrillDown1 to display the code view for the report. At the top left of the 
code view for frmViewDrillDown1, click the drop-down arrow and select Viewer1. At the top right of the 
code window, click the drop-down arrow and select Hyperlink. This creates an event-handling method for 
frmViewDrillDown1's Viewer1_Hyperlink event. 

To write the code in C#

l Click in the Viewer section of frmViewDrillDown1 to select the viewer. Click on the events icon in the 
Properties window to display available events for the viewer. Double-click Hyperlink. This creates an 
event-handling method for frmViewDrillDown's Viewer1_Hyperlink event. 

The following example shows what the code for the method looks like.

'Visual Basic
Private Sub Viewer1_HyperLink(ByVal sender As Object, ByVal e As DataDynamics _

.ActiveReports.Viewer.HyperLinkEventArgs) Handles Viewer1.HyperLink
Dim rpt3 As New rptDrillDown2()
Dim frm3 As New frmViewDrillDown2()
rpt3.Parameters("orderID").Value = e.HyperLink.ToString
rpt3.Run()
frm3.My_Viewer.Document = rpt3.Document
frm3.ShowDialog(Me)

End Sub

//C#
private void viewer1_HyperLink(object sender, DataDynamics.ActiveReports.Viewer

.HyperLinkEventArgs e)
{

rptDrillDown2 rpt3 = new rptDrillDown2();
frmViewDrillDown2 frm3 = new frmViewDrillDown2();
rpt3.Parameters["orderID"].Value = e.HyperLink.ToString();
rpt3.Run();
frm3.My_Viewer.Document = rpt3.Document;
frm3.ShowDialog(this);

}

Adding code to frmViewDrillDown

To write the code in Visual Basic

l Double-click at the top of frmViewDrillDown1 to display the code view for the report. At the top left of the 
code view for frmViewDrillDown1, click the drop-down arrow and select Viewer1. At the top right of the 
code window, click the drop-down arrow and select Hyperlink. This creates an event-handling method for 
frmViewDrillDown1's Viewer1_Hyperlink event. 

To write the code in C#

l Click in the Viewer section of frmViewDrillDown1 to select the viewer. Click on the events icon in the 
Properties window to display available events for the viewer. Double-click Hyperlink. This creates an 
event-handling method for frmViewDrillDown's Viewer1_Hyperlink event. 
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The following example shows what the code for the method looks like.

'Visual Basic
'Create a property to return the ActiveReports viewer
Friend ReadOnly Property My_Viewer() As DataDynamics.ActiveReports.Viewer.Viewer

Get
Return Me.Viewer1

End Get
End Property

//C#
//Create a property to return the ActiveReports viewer.
internal DataDynamics.ActiveReports.Viewer.Viewer My_Viewer
{

get
{

return this.viewer1;
}

}

Adding the code needed to set the hyperlink property for rptMain

To write the code in Visual Basic

l Right-click in any section of the design window of rptMain, and click on View Code to display the code 
view for the report. At the top left of the code view for rptMain, click the drop-down arrow and select 
Detail. At the top right of the code window, click the drop-down arrow and select BeforePrint. This creates 
an event-handling method for rptMain's Detail_BeforePrint event. 

To write the code in C#

l Click in the Detail section of rptMain to select the section. Click on the events icon in the Properties
window to display available events for the section. Double-click BeforePrint. This creates an event-
handling method for rptMain's Detail_BeforePrint event. 

The following example shows what the code for the method looks like.

'Visual Basic
Private Sub Detail_BeforePrint(ByVal sender As Object, ByVal e As System.EventArgs) _

Handles Detail.BeforePrint
Me.txtCustomerID.HyperLink = Me.txtCustomerID.Text

End Sub

//C#
private void Detail_BeforePrint(object sender, System.EventArgs eArgs)
{

this.txtCustomerID.HyperLink = this.txtCustomerID.Text;
}

Adding the code needed to set the hyperlink property for rptDrillDown1

To write the code in Visual Basic

l Right-click in any section of the design window of rptDrillDown1, and click on View Code to display the 
code view for the report. At the top left of the code view for rptDrillDown1, click the drop-down arrow and 
select Detail. At the top right of the code window, click the drop-down arrow and select BeforePrint. This 
creates an event-handling method for rptDrillDown1's Detail_BeforePrint event. 

To write the code in C#

l Click in the Detail section of rptDrillDown1 to select the section. Click on the events icon in the 
Properties window to display available events for the section. Double-click BeforePrint. This creates an 
event-handling method for rptDrillDown1's Detail_BeforePrint event. 

The following example shows what the code for the method looks like.

'Visual Basic
Private Sub Detail_BeforePrint(ByVal sender As Object, ByVal e As System.EventArgs) _

Handles Detail.BeforePrint
Me.txtOrderID.HyperLink = Me.txtOrderID.Text

End Sub
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//C#
private void Detail_BeforePrint(object sender, System.EventArgs eArgs)
{

this.txtOrderID.HyperLink = txtOrderID.Text;
}

Viewing the report

To view the report

1. Add the code needed to set the viewer document of frmViewMain equal to the document for rptMain. See 
Using the ActiveReports WinForm Viewer for help. 

2. Click the hyperlink in frmViewMain to drill-down to the next report level.

Note: You can quickly view your report at design time by clicking the Preview tab at the bottom of the 
designer.

ActiveReports provides support for the ActiveReports run time dialogs to be localized. The following 
walkthroughs explain how to localize the ActiveReports viewer control, designer control, and report engine.

 

Localizing the Viewer Control
Describes how to set up localization for the ActiveReports Viewer control. 

Localizing the Report Engine
Describes how to set up localization for the ActiveReports Report Engine.

In ActiveReports, the viewer control and associated dialogs can be localized. 

This walkthrough illustrates the basics of setting up localized strings for the ActiveReports viewer control.

The walkthrough is split up into the following activities: 

l Creating a new Visual Studio project 

l Creating a directory 

l Using the Windows Resource Localization Editor for the resource files  

l Running the Satellite Assembly Utility to create a satellite assembly 

l Adding the ActiveReports Viewer control to the project  

l Adding Code to Change the Culture Information (Optional step) 

l Running the project 

To complete the walkthrough, you must have the following files: 

¡ Strings.txt 

¡ Descriptions.txt 

¡ FindDialog.resx 

¡ PrintingStatus.resx 

¡ TableOfContents.resx 

¡ PublicKey.snk 

¡ SatelliteAssembly.exe

You can find these files in your Program Files/Data Dynamics/ActiveReports for .NET 
3.0/Localization folder. You will also need access to the current ActiveReports.Viewer.dll installed on your 
machine, which you can find in the Program Files/Common Files/Data Dynamics/ActiveReports 

Localization Walkthroughs

Localizing the ActiveReports Viewer Control
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for .NET 3.0 folder.

When you have finished this walkthrough, you will have a localized ActiveReports viewer control that looks 
similar to the following. For purposes of this walkthrough, Japanese was used to localize the viewer control.

Creating a new Visual Studio project

To create a new Visual Studio project

1. Open Visual Studio. 

2. From the File menu, select New > Project. 

3. Select the project type and click on Windows Application. 

4. Change the name of your project and click OK. 

Creating a Directory

To create a directory

1. Open Windows Explorer and browse to the folder in which your project's EXE file will be contained when 
the report is run. For Visual Basic .NET, this will be the bin folder. For C#, this will be the bin/Debug
folder. 

2. On the File menu, click New > Folder. 

3. Name the folder according to the CultureInfo that you will use to localize your project. For example, you 
would use "ja" for Japanese. 

4. Copy the required files (Strings.txt, Descriptions.txt, PrintingStatus.resx, FindDialog.resx, 
TableOfContents.resx, SatelliteAssembly.exe, ActiveReports.Viewer.dll, and PublicKey.snk) to this new 
folder. 

Using the Windows Resource Localization Editor

To use the Windows Resource Localization Editor 

1. Open a Visual Studio .NET 2003 or 2005 command prompt.  
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2. Run the Windows Resource Localization Editor by typing "winres" and hitting Enter. This editor allows 
you to edit dialog .resx files for a certain locale. The utility is included as part of the .NET framework. 

3. Click on File > Open on the Localization Editor's menu bar. 

4. Change the file type to "ResX File(*.resx)". 

5. Navigate to the directory that you created and copied the required files into, choose the FindDialog.resx 
file, and click Open to open the file in the Editor. 

6. On the menu bar, click File > Save, select your localization culture from the list, and then press OK. 

7. Repeat Steps 3-6 for the PrintingStatus.resx file. 

8. Repeat Steps 3-6 for the TableOfContents.resx file. 

9. Close the Windows Resource Localization Editor. 

10. Close the Visual Studio .NET 2003 or 2005 command prompt window. 

11. In Windows Explorer, browse the the folder containing the required files and rename the .txt files 
(Strings.txt and Descriptions.txt) according to the culture you have chosen. For example, you 
would change "Strings.txt" to "Strings.ja.txt" for Japanese. 

Note: If any .resx files contain combo box items then the .resx files need to be modified after they are 
saved. 

Running the Satellite Assembly Utility

To run the Satellite Assembly Utility

1. Double-click the SatelliteAssembly.exe file to run the utility. 

2. On the menu bar, select File > New. This creates a project window for the Satellite assembly. 

3. On the menu bar, select Edit > Properties. 

4. On the Build tab of the Properties dialog: 

¡ Select the correct localization culture. 

¡ Set the input and output directories to the directory you created that contains the .resx and .txt files. 

¡ Set the output file name to "ActiveReports.Viewer.resources.dll". 

¡ Select or type in the Framework version to match the number found in the Visual Studio Help menu > 
About dialog.

5. On the Assembly tab of the Properties dialog: 

¡ In the Assembly Attributes section, set the Version number to match the version of the 
ActiveReports.Viewer.dll file located in the directory you created. 

¡ In the Delayed Signing section, set the Strong Name KeyFile to the publickey.snk key file in the 
directory you created. 

¡ In the Use Template File section, browse to the ActiveReports.Viewer.dll file located in the directory 
you created. Click OK to continue. 

6. Right-click on the Resource file list view and select Add. 

7. With the File Type set to "Resx", add the FindDialog, PrintingStatus, and TableOfContents .resx files that 
have the culture information added to the file names. For example, for Japanese, you would choose 
"FindDialog.ja.resx" and "PrintingStatus.ja.resx" and "TableOfContents.ja.resx". Click OK to add the files 
to the list. 

8. Right-click on the list view and select Add again. Change the File Type to "Strings File" and select the 
two .txt files that you renamed according to the culture you have chosen. Click OK to add the files to the 
list. 

9. Select all of the files in the list view, then right-click and select Edit to open the Edit dialog for each file. 

10. Change the namespace for each culture-localized file according to the list below. Click OK after each 
change to save the namespace changes.  

File Namespace

FindDialog DataDynamics.ActiveReports.Viewer
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11. Select Save As. from the File menu. Click the OK button. This will create a .loc file for the culture you 
have chosen which contains all of the project-related information. 

12. Double-click on each item in the list view, select Editor, and edit each file for the language you have 
chosen to localize. Below is an image of part of the "Strings.ja.txt" file used for this project. 

Note: You need to include references to the RtfExport and TextExport dlls in order to enable the 
viewer's copy button. 

13. When all of the resources have been localized, you can build the Satellite assembly 
(ActiveReports.Viewer.resources.dll) by selecting Build Assembly from the Build menu. 

Note: If you are unable to edit the .txt files using the Satellite Assembly utility, you can open the files 
using Notepad and save them with Unicode encoding instead of ANSI. 

Adding the ActiveReports Viewer control

To add the viewer control

1. Drag and drop the ActiveReports Viewer control from the appropriate toolbox to Form1. 

2. Set the Dock property for the viewer to Fill. 

Adding Code to Change the Culture Information (Optional Step)
Note: This step is only necessary if you are developing on a machine with culture information different 
from that in the project you are localizing. 

PrintingStatus DataDynamics.ActiveReports.Document

TableOfContents DataDynamics.ActiveReports.Viewer

Strings DataDynamics.ActiveReports.Viewer.Resources

Descriptions DataDynamics.ActiveReports.Viewer.Resources
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To add code to change the culture information  

l Add the following code in the form's constructor just before the InitializeComponent method is called. 
Make sure you replace the "ja" shown in the example code with the appropriate culture information for 
your project.  

l ' Visual Basic
System.Threading.Thread.CurrentThread.CurrentUICulture = New System.Globalization _

.CultureInfo("ja")
//C#
System.Threading.Thread.CurrentThread.CurrentUICulture = new System.Globalization

.CultureInfo("ja");

Running the Project

To run the project

1. Press F5 to run the application. 

2. If the satellite assembly in the directory you created has only been signed with the Data Dynamics public 
key, you will need to turn off sn security for the assembly. You can do this by going to the Visual 
Studio .NET command prompt, browsing to the directory in which the file is located and typing in the 
following line: "sn -Vr ActiveReports.Viewer.resources.dll". 

Note: Prior to deploying the project, you can send the ActiveReports.Design2.resources.dll file to 
ActiveReports.Support@DataDynamics.com to have it signed. When you deploy the project, if your other 
DLLs are being sent to the Global Assembly Cache, this file will also need to be sent there.

In ActiveReports, the report engine and associated dialogs can be localized. 

This walkthrough illustrates the basics of setting up localized strings for the ActiveReports report engine.

The walkthrough is split up into the following activities: 

l Creating a new Visual Studio project 

l Creating a directory 

l Using the Windows Resource Localization Editor for the resource files  

l Running the Satellite Assembly Utility to create a satellite assembly 

l Adding an ActiveReport with parameters to the project  

l Adding code to change the culture information for the project (optional step) 

l Running the project 

To complete the walkthrough, you must have the following files: 

¡ Strings.txt 

¡ Descriptions.txt 

¡ ParamPromptDialog.resx 

¡ PublicKey.snk 

¡ SatelliteAssembly.exe

You can find these files in your Program Files/Data Dynamics/ActiveReports for .NET 
3.0/Localization folder. You will also need access to the current ActiveReports.dll installed on your machine 
which you can find in the Program Files/Common Files/Data Dynamics/ActiveReports for .NET 3.0
folder.

When you have finished this walkthrough, you will have a localized ActiveReports parameters dialog that 
looks similar to the following. For purposes of this screen shot, Japanese was used to localize the report 
engine.

Localizing the ActiveReports Engine
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Creating a new Visual Studio project

To create a new Visual Studio project

1. Open Visual Studio. 

2. From the File menu, select New > Project. 

3. Select the project type and click on Windows Application. 

4. Change the name of your project and click OK. 

Creating a Directory

To create a directory

1. Open Windows Explorer and browse to the folder in which your project's EXE file will be contained when 
the report is run. For Visual Basic .NET, this will be the "bin" folder. For C#, this will be the "bin/Debug" 
folder. 

2. On the File menu, click New > Folder. 

3. Name the folder according to the CultureInfo that you will use to localize your project. For example, you 
would use "ja" for Japanese. 

4. Copy the required files (Strings.txt, Descriptions.txt, ParamPromptDialog.resx, ActiveReports.dll, 
PublicKey.snk, and SatelliteAssembly.exe) to this new folder. 

Using the Windows Resource Localization Editor

To use the Windows Resource Localization Editor 

1. Open a Visual Studio .NET 2003 or 2005 command prompt from the Start menu > All Programs > Visual 
Studio .NET > Visual Studio .NET Tools.  

2. Run the Windows Resource Localization Editor by typing "winres" and hitting Enter. This editor allows 
you to edit dialog .resx files for a certain locale. The utility is included as part of the .NET framework. 

3. Click on File > Open on the Localization Editor's menu bar. 

4. Change the file type to "ResX File(*.resx)". 

5. Navigate to the directory that you created and copied the required files into, choose the 
ParamPromptDialog.resx file, and click Open to open the file in the Editor. 

6. On the menu bar, click File > Save, select your localization culture from the list, and then press OK . 

7. Close the Windows Resource Localization Editor. 

8. Close the Visual Studio .NET 2003 or 2005 command prompt window. 

9. In Windows Explorer, browse to the folder containing the required files and rename the .txt files 
(Strings.txt and Descriptions.txt) according to the culture you have chosen. For example, you 
would change "Strings.txt" to "Strings.ja.txt" for Japanese. 

Note If any .resx files contain combo box items then the .resx files need to be modified after they are 
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saved. 

Running the Satellite Assembly Utility

To run the Satellite Assembly Utility

1. Double-click the SatelliteAssembly.exe file to run the utility. 

2. On the menu bar, select File > New. This creates a project window for the Satellite assembly. 

3. On the menu bar, select Edit > Properties.

4. On the Build tab of the Properties dialog: 

¡ Select the correct localization culture. 

¡ Set the input and output directories to the directory you created that contains the .resx and .txt files. 

¡ Set the output file name to "ActiveReports.resources.dll". 

¡ Select or type the correct .NET Framework version.

5. On the Assembly tab of the Properties dialog: 

¡ In the Assembly Attributes section, set the Version number to match the version of the 
ActiveReports.dll file located in the directory you created. 

¡ In the Delayed Signing section, set the Strong Name KeyFile to the publickey.snk key file in the 
directory you created. 

¡ In the Use Template File section, browse to the ActiveReports.dll file located in the directory you 
created. Click OK to continue. 

6. Right-click on the Resource file list view and select Add. 

7. With the File Type set to "Resx", add the ParamPromptDialog.resx file that has the culture information 
added to the file name. For example, for Japanese, you would choose "ParamPromptDialog.ja.resx ". Click 
Open to add the file to the list. 

8. Right-click on the list view and select Add. again. Change the File Type to "Strings File" and select the 
two .txt files that you renamed according to the culture you have chosen. Click Open to add the files to 
the list. 

9. Select all of the files in the list view, then right-click and select Edit to open the Edit dialog for each file. 

10. Change the namespace for each culture-localized file according to the list below. Click OK after each 
change to save the namespace changes.  

11. Select Save As. from the File menu. Click the Save button. This will create a .loc file for the culture you 
have chosen which contains all of the project-related information. 

12. Double-click on each item in the list view, select Editor., and edit each file for the language you have 
chosen to localize. Below is an image of part of the "Strings.ja.txt" file used for this project. 

File Namespace

ParamPromptDialog DataDynamics.ActiveReports

Strings DataDynamics.ActiveReports.Viewer.Resources

Descriptions DataDynamics.ActiveReports.Viewer.Resources
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13. When all of the resources have been localized, you can build the Satellite assembly 
(ActiveReports.resources.dll) by selecting Build Assembly from the Build menu. 

Note If you are unable to edit the .txt files using the Satellite Assembly utility, you can open the files 
using Notepad and save them with Unicode encoding instead of ANSI. 

Adding an ActiveReport with Parameters

To add the ActiveReport with Parameters

1. In your project, from the Project menu, select Add New Item . 

2. Select ActiveReports 3.0 File and rename the file rptParams. 

3. Follow the instructions in the Parameters with Simple Reports walkthrough to create your report with 
parameters. 

Adding Code to Change the Culture Information (Optional Step)
Note: This step is only necessary if you are developing on a machine with culture information different 
from that in the project you are localizing. 

To add code to change the culture information

l Add the following code in the form's constructor just before the InitializeComponent method is called. 
Make sure you replace the "ja" shown in the example code with the appropriate culture information for 
your project.  
' Visual Basic
System.Threading.Thread.CurrentThread.CurrentUICulture = New System.Globalization _

.CultureInfo("ja")
//C#
System.Threading.Thread.CurrentThread.CurrentUICulture = new System.Globalization

.CultureInfo("ja");
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Running the Project

To run the project

1. Press F5 to run the application. 

2. If the satellite assembly in the directory you created has only been signed with the Data Dynamics public 
key, you will need to turn off sn security for the assembly. You can do this by going to the Visual 
Studio .NET 2003 or 2005 command prompt, browsing to the directory in which the file is located and 
typing in the following line: "sn -Vr ActiveReports.resources.dll". 

Note: Prior to deploying the project, you can send the ActiveReports.Design2.resources.dll file to 
ActiveReports.Support@DataDynamics.com to have it signed. When you deploy the project, if your other 
DLLs are being sent to the Global Assembly Cache, this file will also need to be sent there.

With ActiveReports, Master Detail reports can be created quickly and easily. The following walkthroughs 
describe how to create different types of Master Detail reports.

 

Master Detail Reports with Grouping
Describes how Master Detail reports can be created using grouping. 

Master Detail Reports with Subreports
Describes how Master Detail reports can be created with subreports. 

Master Detail Reports with XML Data
Describes how Master Detail reports can be created using XML data. 

ActiveReports allows you to create Master Detail reports with grouping by using the GroupHeader and Detail 
sections to contain data from master files and detail files. 

This walkthrough illustrates how to create a Master Detail report using grouping to organize the report. 

This walkthrough is split up into the following activities: 

l Adding an ActiveReport to a Visual Studio project 

l Connecting the report to a data source 

l Adding controls to the report to contain data 

l Viewing the report  

To complete the walkthrough, you must have access to the Northwind database. For your convenience, a 
copy is included with ActiveReports at the following default location: C:\Program Files\Data 
Dynamics\ActiveReports for .NET 3.0\Data\NWIND.MDB.

When you have completed this walkthrough, you will have a report that looks similar to the following.

Master Detail Reports Walkthroughs

Walkthrough: Master Detail Reports with Grouping
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Adding an ActiveReport to a Visual Studio project

To add an ActiveReport to your project

1. Open a new project in Visual Studio. 

2. From the Project menu, select Add New Item. 

3. Select ActiveReports 3.0 File and rename the file rptMD. 

4. Click Open. 

Connecting the report to a data source

To connect the report to a data source

1. Click on the gray report DataSource icon in the Detail section to open the report DataSource dialog box. 

2. Select the "OLE DB" tab. 

3. Click the Build button. 

4. Select Microsoft Jet 4.0 OLE DB Provider and click Next. 

5. Click the ellipsis button to browse for the access path to the Northwind database. Click Open once you 
have selected the appropriate access path. 

6. Click OK to continue. 

7. In the Query field, type "Select * from orders, [order details], products where orders.OrderID = [order 
details].OrderID and products.productID = [order details].productID order by OrderDate". 

8. Click OK to return to the report design surface. 
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Adding controls to the report to contain data

To add controls to the report

1. Change the BackColor property of the page header to Silver.

2. Add labels to the page header with the following properties set: 

3. Add a GroupHeader/Footer section to your report. 

4. Make the following changes to the group header: 

¡ Change the Name property to ghOrders 

¡ Change the BackColor property to LightGray

¡ Change the DataField property to orders.OrderID 

5. In the Report Explorer, expand the Fields node, then the Bound node. Drag the following fields onto 
ghOrders and set the properties as indicated.  

6. Add another GroupHeader/Footer section to your report. 

7. Change the BackColor property of the group header to LightSteelBlue. 

8. Add labels to the group header with the following properties set: 

9. Make the following changes to the detail section: 

¡ Change the BackColor property to AliceBlue

¡ Change the CanShrink property to True

10. In the Report Explorer, expand the Fields node, then the Bound node. Drag the following fields 
onto the detail section and set the properties as indicated.   

Name Text Font Style Location

lblOrderDate Order Date Bold 0, 0 

lblShipName Ship Name Bold 3, 0 

lblShippedDate Shipped Date Bold 1, 0 

lblShipAddress Ship Address Bold 4, 0 

lblShipCountry Ship Country Bold 5.5, 0 

Control DataField Name Text OutputFormat Location

Textbox OrderDate txtOrderDate1 Order Date MM/dd/yy 0, 0

Textbox ShippedDate txtShippedDate1 Shipped Date MM/dd/yy 3, 0

Textbox ShipName txtShipName1 Ship Name Size = 2, 0.19 1, 0

Textbox ShipAddress txtShipAddress1 Ship Address 4, 0 

Textbox ShipCountry txtShipCountry1 Ship Country 5.5, 0 

Name Text Font Style Location

lblUnitPrice Unit Price Bold 1, 0

lblQuantity Quantity Bold 5.75, 0

lblOrderID Order ID Bold 0, 0

lblProductName Product Name Bold 3, 0

lblProductID Product ID Bold 2, 0

Control DataField Name Text Miscellaneous Location

Textbox ProductName txtProductName Product 3, 0
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Viewing the report

To view the report

1. Add the ActiveReports viewer control to a Windows Form. 

2. Add the code needed to set the viewer document equal to the report document. See Using the 
ActiveReports WinForm Viewer for help. 

Note: You can quickly view your report at design time by clicking the Preview tab at the bottom of the 
designer.

ActiveReports allows you to create Master Detail reports by using subreports to retrieve and group data. 

This walkthrough illustrates how to create a Master Detail report with subreports. 

This walkthrough is split up into the following activities: 

l Adding two ActiveReports to a Visual Studio project 

l Connecting the Master report to a data source 

l Connecting the Detail report to a data source 

l Adding controls to rptMaster to contain data 

l Adding controls to rptDetail to contain data 

l Adding code to pass the OrderID field of rptMaster to the parameter in rptDetail 

l Viewing the report  

To complete the walkthrough, you must have access to the Northwind database. For your convenience, a 
copy is included with ActiveReports at the following default location: C:\Program Files\Data 
Dynamics\ActiveReports for .NET 3.0\Data\NWIND.MDB.

When you have completed this walkthrough, you will have a report that looks similar to the following.

Name

Textbox Quantity txtQuantity Quantity 5.75, 0

Textbox orders.OrderID txtOrderID Order ID 0, 0

Textbox products.UnitPrice txtUnitPrice Unit 
Price

OutputFormat = 
Currency

1, 0

Textbox products.ProductID txtProductID Product 
ID

2, 0

Walkthrough: Master Detail Reports with Subreports
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Adding two ActiveReports to a Visual Studio project

To add two ActiveReports to your project

1. Open a new project in Visual Studio. 

2. From the Project menu, select Add New Item. 

3. Select ActiveReports 3.0 File and rename the file rptMaster. 

4. Click Open. 

5. From the Project menu, select Add New Item. 

6. Select ActiveReports 3.0 File and rename the file rptDetail. 

7. Click Open. 

Connecting the Master report to a data source

To connect the Master report to a data source

1. Click the gray report DataSource icon in the Detail section to open the report DataSource dialog. 

2. Select the "OLE DB" tab. 

3. Click the Build button. 

4. Select Microsoft Jet 4.0 OLE DB Provider and click Next. 

5. Click the ellipsis button to browse for the access path to the Northwind database. Click Open once you 
have selected the appropriate access path. 

6. Click OK to continue. 

7. In the Query field, type "Select * from orders". 

8. Click OK to return to the report design surface. 

Connecting the Detail report to a data source

To connect the Detail report to a data source

1. Click on the gray report DataSource iconin the Detail section to open the report DataSource dialog box. 

2. Select the "OLE DB" tab. 
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3. Click the Build button. 

4. Select Microsoft Jet 4.0 OLE DB Provider and click Next. 

5. Click the ellipsis button to browse for the access path to the Northwind database. Click Open once you 
have selected the appropriate access path. 

6. Click OK to continue. 

7. In the Query field, type "Select * from [order details] inner join products on [order details].productid = 
products.productID where [order details].orderID = <%OrderID%>". 

8. Click OK to return to the report design surface. 

Adding controls to rptMaster to contain data

To add controls to rptMaster

1. Add a shape control to the detail section and make the following changes to it: 

¡ Set the BackColor property to Indigo

¡ Set the LineColor property to Transparent

¡ Set the Location property to 0, 0

¡ Set the Size property to 6.5, 0.2

2. Add labels with the following properties to the shape control: 

3. Make the following changes to the detail section: 

¡ Set the BackColor property to MediumPurple

¡ Set the CanShrink property to True

4. Add the following controls to the detail section below the shape control: 

Font Style ForeColor Name Text Location

Bold White lblOrderDate Order Date 0, 0

Bold White lblShipName Ship Name 0.85, 0

Bold White lblShipDate Ship Date 2.25, 0

Bold White lblShipAddress Ship Address 2.98, 0

Bold White lblShipCountry Ship Country 5, 0

Bold White lblFreight Freight 5.97, 0

Control DataField Name Text Miscellaneous Location Size

Textbox OrderDate txtOrderDate Order 
Date 

OutputFormat 
= MM/dd/yy

0, 0.25 0.75, 
0.19

Textbox ShipName txtShipName Ship 
Name 

0.85, 
0.25 

1.34, 
0.19

Textbox ShippedDate txtShippedDate Shipped 
Date 

OutputFormat 
= MM/dd/yy

2.25, 
0.25 

0.65, 
0.19

Textbox ShipAddress txtShipAddress Ship 
Address 

2.98, 
0.25 

2, 
0.19

Textbox ShipCountry txtShipCountry Ship 
Country 

5, 0.25 0.9, 
0.19

Textbox Freight txtFreight Freight OutputFormat 
= Currency

5.97, 
0.25 

0.5, 
0.19

Subreport ctlSubReport 0.06, 
0.53 

6.38, 
1

Label lblWhiteLine BackColor = 0, 1.66 6.5, 
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Adding controls to rptDetail to contain data

To add controls to rptDetail

1. Delete the page header section. (Page headers are not displayed in subreports, so deleting them saves 
on processing.) 

2. Set the ShowParameterUI property of the report to False to avoid asking users for parameters. 

3. Add a group header/footer to the report. 

4. Set the BackColor property of the group header to LightBlue

5. Add labels with the following properties to the group header section: 

6. Make the following changes to the detail section: 

¡ Set the BackColor property to LightBlue

¡ Set the CanShrink property to True

7. Add the following controls to the detail section: 

Adding the code to create a new data source for the subreport

To write the code in Visual Basic

l Double-click the Detail section of rptMaster to create an event-handling method for the Detail_Format 
event. Add code to the handler to:  

l Create a new DataDynamics OleDBDataSource 

l Set the connection string of the new data source 

l Set the new data source's SQL query 

l Set the subreport's data source equal to the new data source 

l Set the Report property of ctlSubReport to rptDetail

To write the code in C#

l Double-click the Detail section of rptMaster to create an event-handling method for the Detail_Format 

White 0.19

Font Style Name Text Location

Bold lblOrderID Order ID 0, 0

Bold lblProductID Product ID 0.81, 0

Bold lblProductName Product Name 2.25, 0

Bold lblQuantity Quantity 4.8, 0

Bold lblDiscount Discount 5.5, 0

Control DataField Name Text Miscellaneous Location

Textbox OrderID txtOrderID Order ID 0, 0

Textbox ProductName txtProductName Product 
Name

2.25, 0

Textbox products.ProductID txtProductID Product 
ID

0.81, 0

Textbox Quantity txtQuantity Quantity 4.8, 0

Textbox Discount txtDiscount Discount OutputFormat = 
Currency; 
Alignment = 
Right

5.5, 0
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event. Add code to the handler to: 

l Create a new DataDynamics OleDBDataSource 

l Set the connection string of the new data source 

l Set the new data source's SQL query 

l Set the subreport's data source equal to the new data source 

l Set the Report property of ctlSubReport to rptDetail

The following example shows what the code for the method looks like.

'Visual Basic
Private Sub detail_Format(ByVal sender As Object, ByVal e As EventArgs) 

Dim rpt As rptDetail = New rptDetail 
'get new datasource object
Dim subDS As DataDynamics.ActiveReports.DataSources.OleDBDataSource = New DataDynamics.ActiveReports.DataSources.OleDBDataSource 
'cast this report's datasource to an OleDBDataSource to get ConnectionString
subDS.ConnectionString = CType(Me.DataSource, DataDynamics.ActiveReports.DataSources.OleDBDataSource).ConnectionString 
'build new SQL statement
subDS.SQL = "Select * from [order details] inner join products on [order details].productid = products.productID where [order details].orderID = " + m_OrderID 
rpt.DataSource = subDS 'set reference to new datasource object
Me.ctlSubreport.Report = rpt 'set reference to report for subreport control

End Sub 

'add this code to get the OrderID for each record in master
Private m_OrderID As String 
Private Sub rptMaster_FetchData(ByVal sender As Object, ByVal eArgs As FetchEventArgs) 
m_OrderID = Me.Fields("OrderID").Value.ToString 
End Sub

//C#
//change the detail_Format code to set SQL for subreport's datasource
private void detail_Format(object sender, EventArgs e)
{

rptDetail rpt = new rptDetail(); //get new instance of subreport

//get new datasource object
DataDynamics.ActiveReports.DataSources.OleDBDataSource subDS = new DataDynamics.ActiveReports.DataSources.OleDBDataSource();
//cast this report's datasource to an OleDBDataSource to get ConnectionString
subDS.ConnectionString = ((DataDynamics.ActiveReports.DataSources.OleDBDataSource)this.DataSource).ConnectionString;
//build new SQL statement
subDS.SQL = "Select * from [order details] inner join products on [order details].productid = products.productID where [order details].orderID = " + m_OrderID;

rpt.DataSource = subDS; //set reference to new datasource object
this.ctlSubreport.Report = rpt; //set reference to report for subreport control

}

//add this code to get the OrderID for each record in master
string m_OrderID;
private void rptMaster_FetchData(object sender, FetchEventArgs eArgs)
{

m_OrderID = this.Fields["OrderID"].Value.ToString();
}

Viewing the report

To view the report

1. Add the ActiveReports viewer control to a Windows Form. 

2. Add the code needed to set the viewer document equal to the report document. See Using the 
ActiveReports WinForm Viewer for help. 

Note: You can quickly view your report at design time by clicking the Preview tab at the bottom of the 
designer.

Walkthrough: Master Detail Reports with XML Data
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ActiveReports allows you to create Master Detail reports with data from an XML database. 

This walkthrough illustrates how to create a Master Detail report using XML data and grouping. 

This walkthrough is split up into the following activities: 

l Adding an ActiveReport to a Visual Studio project 

l Connecting the report to a XML data source 

l Adding controls to the report to contain data 

l Viewing the report  

To complete the walkthrough, you must have access to the XML Customer database (customer.xml).

When you have completed this walkthrough, you will have a report that looks similar to the following.

Adding an ActiveReport to a Visual Studio project

To add an ActiveReport to your project

1. Open a new project in Visual Studio. 

2. From the Project menu, select Add New Item. 

3. Select ActiveReports 3.0 File and rename the file rptMD. 

4. Click Open. 

Connecting the report to a XML data source

To connect the report to a data source

1. Click on the gray report DataSource icon in the Detail section to open the report DataSource dialog. 

2. Click on the Data Source drop-down arrow and select XML. 

3. Click the ellipsis button beside File URL to browse for the access path to CCustomer.xml. (Typically 
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C:\Program Files\Data Dynamics\ActiveReports for .NET 3.0\Samples\CSharp\XMLSample\customer.xml 
or C:\Program Files\Data Dynamics\ActiveReports for .NET 3.0\Samples\VB\XMLSample\customer.xml.) 

4. Click Open. 

5. In the Recordset Pattern field, type "//ITEM". 

6. Click OK to return to the report design surface. 

Adding controls to the report to contain data

To add controls to the report

1. Add two GroupHeader/Footer sections to your report. 

2. Make the following changes to the group header just below the page header: 

¡ Change the Name property to ghCustomer 

¡ Change the BackColor property to LightBlue

¡ Change the DataField property to ../../@id

3. Add the following controls to ghCustomer: 

4. Make the following changes to the group header just above the detail section: 

¡ Change the Name property to ghOrders

¡ Change the BackColor property to LightCyan

¡ Change the DataField property to ../Number

¡ Add the following controls to ghOrders: 

¡ Add the following controls to the Detail section: 

Control DataField Name Text Location Font Style

Label lblID ID 0, 0 Bold

Label lblEmailAddress E-mail Address 2, 0 Bold

Label lblName Name 4, 0 Bold

TextBox ../../@id txtID ID 0, 0.25 

TextBox ../../@email txtEmail E-mail 2, 0.25 

TextBox ../../NAME txtName Name 4, 0.25 

Control DataField Name Text Location

Label lblNumber Order Number: 0.38, 0

TextBox ../NUMBER txtNumber Number 1.5, 0 

TextBox ../DATE txtDate Date 4.5, 0 

Label lblISBN ISBN 0, 0.31

Label lblBookTitle Book Title 1.13, 0.31 

Label lblPrice Price 5.69, 0.31 

Label lblAuthor Author 3.5, 0.31 

Label lblPublisher Publisher 4.56, 0.31 

Control DataField Name Text Miscellaneous Location

TextBox @isbn txtISBN ISBN 0, 0

TextBox TITLE txtTitle Title 1.13, 0

TextBox AUTHOR txtAuthor Author 3.5, 0
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¡ Add the following controls to GroupFooter2: 

Viewing the report

To view the report

1. Add the ActiveReports viewer control to a Windows Form. 

2. Add the code needed to set the viewer document equal to the report document. See Using the 
ActiveReports WinForm Viewer for help. 

Note: You can quickly view your report at design time by clicking the Preview tab at the bottom of the 
designer.

ActiveReports allows report documents to be modified easily. The following walkthroughs illustrate how report 
documents can be changed based on user needs.

 

Adding Pages
Demonstrates how to add pages to a report. 

Applying Page Templates
Demonstrates how to set up and apply page templates to a report. 

Merging Reports
Demonstrates how report documents can be merged. 

ActiveReports allows you to add pages to your report in Visual Studio for previewing in the viewer control or 
printing. The document containing the inserted pages can also be saved to an RDF file or exported. 

This walkthrough illustrates how to create two reports and insert the second report as a cover page for the 
first one.

This walkthrough is split up into the following activities: 

l Adding two ActiveReports to a Visual Studio project 

l Connecting the report to a data source 

l Adding controls to both reports 

l Adding code to the Form_Load event to insert the second report as a cover page 

l Viewing the report  

To complete the walkthrough, you must have access to the Northwind database. For your convenience, a 
copy is included with ActiveReports at the following default location: C:\Program Files\Data 
Dynamics\ActiveReports for .NET 3.0\Data\NWIND.MDB.

TextBox PUBLISHER txtPublisher Publisher 4.56, 0

TextBox PRICE txtPrice Price OutputFormat = Currency 5.69, 0

Control DataField Name Text Miscellaneous Location

Label lblSubtotal Subtotal Font Style = Bold 4.5, 0

TextBox PRICE txtSubtotal Subtotal OutputFormat = Currency 

SummaryType = SubTotal

SummaryGroup = ghOrders

5.69, 0

Modifying Report Documents Walkthroughs

Walkthrough: Adding Pages
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When you have completed this walkthrough, you will have a report that looks similar to the following.

Adding two ActiveReports to a Visual Studio project

To add two ActiveReports to a Visual Studio project

1. Open a new project in Visual Studio. 

2. From the Project menu, select Add New Item. 

3. Select ActiveReports 3.0 File and rename the file rptInsertPage. 

4. Click Open. 

5. From the Project menu, select Add New Item. 

6. Select ActiveReports 3.0 File and rename the file rptCoverPage. 

7. Click Open. 

Connecting the report to a data source

To connect rptInsertPage to a data source

1. Click on the gray report DataSource icon in the Detail section to open the report DataSource dialog. 

2. Select the "OLE DB" tab. 

3. Click the Build button. 

4. Select Microsoft Jet 4.0 OLE DB Provider and click Next. 

5. Click the ellipsis button to browse for the access path to the Northwind database. Click Open once you 
have selected the appropriate access path. 

6. Click OK to continue. 

7. In the Query field, type "Select * from products order by productname". 

8. Click OK to return to the report design surface. 
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Adding controls to display the data

To add controls to rptInsertPage

1. Add a GroupHeader/Footer section. 

2. Make the following changes to the group header: 

¡ Change the Name property to ghProducts 

¡ Change the BackColor property to LightSteelBlue

¡ Change the DataField property to ProductName

¡ Change the GroupKeepTogether property to FirstDetail

¡ Change the KeepTogether property to True 

3. Add labels with the following propertiess to the GroupHeader section of rptInsertPage: 

4. In the Report Explorer, expand the Fields node, then the Bound node. Drag the following fields onto 
the detail section and set the following properties of each textbox as indicated.  

To add controls to rptCoverPage

1. Make the following changes to the PageHeader section: 

¡ Change the Height property to 0.8

¡ Change the BackColor property to LightSlateGray

2. Add the following controls to the page header: 

Font Style Name Text Location

Bold lblProductID Product ID 0, 0 

Bold lblProductName Product Name 1.3, 0 

Bold lblUnitsInStock Units In Stock 2.65, 0 

Bold lblUnitsOnOrder Units On Order 3.9, 0 

Bold lblUnitPrice Unit Price 5.25, 0 

Field Text Miscellaneous Location

ProductID Product ID 0, 0 

ProductName Product Name 1.3, 0 

UnitsInStock Units in Stock 2.65, 0 

UnitPrice Unit Price OutputFormat = Currency 5.25, 0 

UnitsOnOrder Units on Order 3.9, 0 

Control Name Text Miscellaneous Location

Label lblCompanyInfo Company Street Name 
Company City, Company 
State Company Zip Code 

Text-Align = 
Center 

Size = 2, 0.56

0.2, 0.13 

Label lblCompanyName Company Name Font Size = 16, 
Style = Bold

3.5, 0.25

Line Line1 Y1 = 0.06 

Y2 = 0.06

X1 = 2.3 

X2 = 6.4

Line Line2 Y1 = 0.72 

Y2 = 0.72

X1 = 2.3 

X2 = 6.4

Line Line3 Y1 = 0.07 X1 = 2.3 
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3. Set the Height property of the Detail section to 2.8. 

4. Add the following controls to the detail section: 

Adding code to the Form_Load event

To write the code in Visual Basic

l Right-click at the top of Form1, and click on View Code to display the code view for the form. At the top 
left of the code view for Form1, click the drop-down arrow and select (Base Class Events). At the top 
right of the code window, click the drop-down arrow and select Load. This creates an event-handling 
method for the Form1_Load event. Add code to the handler to: 

l Insert rptCoverPage at the beginning of rptInsertPage 

To write the code in C#

l Click at the top of Form1 to select the form. Click on the events icon in the Properties window to display 

Y2 = 0.72 X2 = 2.3

Line Line4 Y1 = 0.06 

Y2 = 0.72

X1 = 6.4 

X2 = 6.4

 

Control Name Text Miscellaneous Location

Label lblFax Fax Font Size = 24, Style = 
Bold

0.25, 0

Label lblTo To: Font Size = 12, Style = 
Bold

1, 0.75

Label lblFax2 Fax #: Font Size = 12, Style = 
Bold

1, 1

Label lblPhone Phone #: Font Size = 12, Style = 
Bold

1, 1.25

Label lblRe Re: Font Size = 12, Style = 
Bold

1, 1.5

Label lblCC CC: Font Size = 12, Style = 
Bold

3, 1.5

Label lblDate Date: Font Size = 12, Style = 
Bold

3, 1.25

Label lblPages Pages: Font Size = 12, Style = 
Bold

3, 1

Label lblFrom From Font Size = 12, Style = 
Bold

3, 0.75

CheckBox chkUrgent Urgent 0.5, 2

CheckBox chkForReview For Review 1.5, 2

CheckBox chkPleaseComment Please 
Comment

2.75, 2

CheckBox chkPleaseReply Please Reply 4.5, 2

Line Line5 Y1 = 2.38 

Y2 = 2.38

X1 = 
0.06 

X2 = 
6.44

Label lblComments Comments: 1, 2.5
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available events for the form. Double-click Load. This creates an event-handling method for the 
Form1_Load event. Add code to the handler to: 

l Insert rptCoverPage at the beginning of rptInsertPage 

The following example shows what the code for the Insert method looks like.

' Visual Basic
Private Sub Form1_Load(ByVal sender As System.Object, ByVal e As System.EventArgs) _

Handles MyBase.Load
Dim rpt As New rptInsertPage()
Viewer1.Document = rpt.Document
rpt.Run()
Dim rpt2 As New rptCoverPage()
rpt2.Run()
rpt.Document.Pages.Insert(0, rpt2.Document.Pages(0))

End Sub
//C#
private void Form1_Load(object sender, System.EventArgs e)
{

rptInsertPage rpt = new rptInsertPage();
rptCoverPage rpt2 = new rptCoverPage();
viewer1.Document = rpt.Document;
rpt.Run();
rpt2.Run();
rpt.Document.Pages.Insert(0, rpt2.Document.Pages[0]);

}
The following example shows what the code for the InsertNew method looks like. This method allows you 
to insert a new page at the location you specify.

' Visual Basic
Private Sub Form1_Load(ByVal sender As System.Object, ByVal e As System.EventArgs) _

Handles MyBase.Load
Dim rpt As New rptInsertPage()
rpt.Run()
rpt.Document.Pages.InsertNew(3)
Viewer1.Document = rpt.Document

End Sub
//C#
private void Form1_Load(object sender, System.EventArgs e)
{

rptInsertPage rpt = new rptInsertPage();
rpt.Run();
rpt.Document.Pages.InsertNew(3);
viewer1.Document = rpt.Document;

}

Viewing the report

To view the report

1. Add the ActiveReports viewer control to a Windows Form. 

2. Add the code needed to set the viewer document equal to the report document. See Using the 
ActiveReports WinForm Viewer for help. 

Note: You can quickly view your report at design time by clicking the Preview tab at the bottom of the 
designer.

ActiveReports allows you to apply a page template to an existing report by using the Overlay method. 

This walkthrough illustrates how to overlay an ActiveReport with a "letterhead" page template.

This walkthrough is split up into the following activities: 

l Adding two ActiveReports to a Visual Studio project 

Walkthrough: Applying Page Templates
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l Connecting the report to a data source 

l Adding controls to both reports 

l Adding code to the Form_Load event to overlay the report pages with the "letterhead" template 

l Viewing the report  

To complete the walkthrough, you must have access to the Northwind database. For your convenience, a 
copy is included with ActiveReports at the following default location: C:\Program Files\Data 
Dynamics\ActiveReports for .NET 3.0\Data\NWIND.MDB.

When you have completed this walkthrough, you will have a report that looks similar to the following.

Adding two ActiveReports to a Visual Studio project

To add two ActiveReports to a Visual Studio project

1. Open a new project in Visual Studio. 

2. From the Project menu, select Add New Item. 

3. Select ActiveReports 3.0 File and rename the file rptReport. 

4. Click Open. 

5. From the Project menu, select Add New Item. 

6. Select ActiveReports 3.0 File and rename the file rptTemplate. 

7. Click Open. 

Connecting the report to a data source

To connect rptReport to a data source

1. Click on the gray report DataSource icon in the Detail section to open the report DataSource dialog. 

2. Select the "OLE DB" tab.  

3. Click the Build button. 

4. Select Microsoft Jet 4.0 OLE DB Provider and click Next. 

5. Click the ellipsis button to browse for the access path to the Northwind database. Click Open once you 
have selected the appropriate access path. 
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6. Click OK to continue. 

7. In the Query field, type "Select * from customers order by country". 

8. Click OK to return to the report design surface. 

Adding controls to display the data

To add controls to rptReport

1. Select the page header section, and set the Height property to 0.4. (This will match the height of the 
page header in the template.) 

2. Add a GroupHeader/Footer section. 

3. Make the following changes to the group header: 

¡ Change the Name property to ghCustomers

¡ Change the BackColor property to MediumSlateBlue

¡ Change the CanShrink property to True

¡ Change the DataField property to Country

4. Add labels with the following properties to ghCustomers: 

5. Make the following changes to the detail section: 

¡ Change the BackColor property to LightGray

¡ Change the CanShrink property to True

6. In the Report Explorer, expand the Fields node, then the Bound node. Drag the following fields onto 
the detail section and set the following properties of each textbox as indicated. 

To add controls to rptTemplate

1. Make the following changes to the page header: 

¡ Change the BackColor property to DarkSlateBlue

¡ Change the Height property to 0.4

2. Add labels with the following propertiess to the page header: 

Font Style Name Text Section Location

Bold lblCustomerID Customer ID GroupHeader 0, 0 

Bold lblCompanyName Company Name GroupHeader 0.94, 0 

Bold lblAddress Address GroupHeader 2.44, 0 

Bold lblCity City GroupHeader 4.63, 0 

Bold lblCountry Country GroupHeader 5.69, 0 

Control DataField Name Text Size Location

TextBox CustomerID txtCustomerID Customer ID 0.88, 0.19 0, 0 

TextBox CompanyName txtCompanyName CompanyName 1.44, 0.19 0.94, 0 

TextBox Address txtAddress Address 2.13, 0.19 2.44, 0 

TextBox City txtCity City 1, 0.19 4.63, 0 

TextBox Country txtCountry Country 0.8, 0.19 5.69, 0

Font Name Text ForeColor Location

Size = 18

Style=Bold

lblCompanyName Company Name White 0, 0

Size = 16 lblCompanyLogo (Company Logo) White 4.69, 0
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3. Add a label with the following properties to the page footer: 

Adding code to the Form_Load event

To write the code in Visual Basic or C#

Double-click at the top of Form1. This creates an event-handling method for the Form1_Load event. Add 
code to the handler to:

l Apply the "letterhead" template page to rptReport 

The following example shows what the code for the Overlay method looks like.

' Visual Basic
Private Sub Form1_Load(ByVal sender As System.Object, ByVal e As System.EventArgs) Handles _

MyBase.Load
Dim rpt As New rptReport()
rpt.Run()
Dim rpt2 As New rptTemplate()
rpt2.Run()
Viewer1.Document = rpt.Document
For i = 0 To rpt.Document.Pages.Count - 1

rpt.Document.Pages(i).Overlay(rpt2.Document.Pages(0))
Next

End Sub

//C#
private void Form1_Load(object sender, System.EventArgs e)
{

rptReport rpt = new rptReport();
rpt.Run();
rptTemplate rpt2 = new rptTemplate();
rpt2.Run();
viewer1.Document = rpt.Document;
for(int i = 0; i < rpt.Document.Pages.Count; i++)
{

rpt.Document.Pages[i].Overlay(rpt2.Document.Pages[0]);
}
 

Viewing the report

To view the report

1. Add the ActiveReports viewer control to a Windows Form. 

2. Add the code needed to set the viewer document equal to the report document. See Using the 
ActiveReports WinForm Viewer for help. 

Note: You can quickly view your report at design time by clicking the Preview tab at the bottom of the 
designer.

ActiveReports allows you to merge two or more reports in Visual Studio for previewing in the viewer control 
or printing. The document containing the merged reports can also be saved to an RDF file or exported. 

Style=Bold

Miscellaneous Name Text ForeColor Location

Style = Bold

Size = 6.5, 
0.2

lblCompanyInfo Company Address, Phone 
Number, Fax Number, URL

White 0, 0

Walkthrough: Merging Reports
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This walkthrough illustrates how to create two ActiveReports and merge the reports into one document.

This walkthrough is split up into the following activities: 

l Adding two ActiveReports to a Visual Studio project 

l Connecting the reports to a data source 

l Adding controls to both reports to contain data 

l Adding code to the Form_Load event to combine the reports 

l Viewing the report  

To complete the walkthrough, you must have access to the Northwind database. For your convenience, a 
copy is included with ActiveReports at the following default location: C:\Program Files\Data 
Dynamics\ActiveReports for .NET 3.0\Data\NWIND.MDB.

When you have completed this walkthrough, you will have a report that looks similar to the following.

Adding two ActiveReports to a Visual Studio project

To add two ActiveReports to a Visual Studio project

1. Open a new project in Visual Studio. 

2. From the Project menu, select Add New Item. 

3. Select ActiveReports 3.0 File and rename the file rptOne. 

4. Click Open. 

5. From the Project menu, select Add New Item. 

6. Select ActiveReports 3.0 File and rename the file rptTwo. 

7. Click Open. 

Connecting the reports to a data source

To connect rptOne to a data source

1. Click on the gray report DataSource icon in the Detail section to open the report DataSource dialog. 
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2. Select the "OLE DB" tab. 

3. Click the Build button. 

4. Select Microsoft Jet 4.0 OLE DB Provider and click Next. 

5. Click the ellipsis button to browse for the access path to the Northwind database. Click Open once you 
have selected the appropriate access path. 

6. Click OK to continue. 

7. In the Query field, type "Select * from orders". 

8. Click OK to return to the report design surface. 

To connect rptTwo to a data source

1. Click on the gray report DataSource icon in the Detail section to open the report DataSource dialog. 

2. Select the "OLE DB" tab. 

3. Click on Build.

4. Select Microsoft Jet 4.0 OLE DB Provider and click Next.

5. Click the ellipsis button to browse for the access path to the Northwind database. Click Open once you 
have selected the appropriate access path. 

6. Click OK to continue. 

7. In the Query field, type "Select * from products". 

8. Click OK to return to the report design surface. 

Adding controls to display the data

To add controls to rptOne

1. Change the following properties of the detail section: 

¡ Set the BackColor property to Thistle

¡ Set the CanShrink property to True

2. In the Report Explorer, expand the Fields node, then the Bound node. Drag the following fields onto 
the detail section and set the properties of each textbox as indicated. 

To add controls to rptTwo 

1. Change the following properties of the detail section: 

¡ Set the BackColor property to LightSteelBlue

¡ Set the CanShrink property to True

2. Drag the following fields onto the detail section and set the properties of each textbox as indicated. 

Size DataField Name Text Location OutputFormat

0.6, 0.19 OrderDate txtOrderDate Order Date 0, 0 MM/dd/yy

0.5, 0.19 OrderID txtOrderID Order ID 0.69, 0 

1.94, 0.19 ShipName txtShipName Ship Name 1.25, 0 

2.3, 0.19 ShipAddress txtShipAddress Ship Address 3.25, 0 

0.88, 0.19 ShipCity txtShipCity Ship City 5.63, 0 

Size DataField Name Text Location

0.88, 0.19 ProductID txtProductID Product ID 0, 0

2.44, 0.19 ProductName txtProductName Product Name 1, 0

1.38, 0.19 QuantityPerUnit txtQuantityPerUnit Quantity Per Unit 3.5, 0

0.75, 0.19 ReorderLevel txtReorderLevel Reorder Level 4.94, 0
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Adding code to the Form_Load event

To write the code in Visual Basic or C#

l Double-click the top of Form1 This creates an event-handling method for the Form1_Load event. Add 
code to the handler to: 

l Add rptTwo to rptOne 

The following example shows what the code for the AddRange method looks like.

' Visual Basic
Private Sub Form1_Load(ByVal sender As System.Object, ByVal e As System.EventArgs) _

Handles MyBase.Load
Dim rpt As New rptOne()
rpt.Run()
Dim rpt2 As New rptTwo()
rpt2.Run()
rpt.Document.Pages.AddRange(rpt2.Document.Pages)
Viewer1.Document = rpt.Document

End Sub
//C#
private void Form1_Load(object sender, System.EventArgs e)
{

rptOne rpt1 = new rptOne();
rpt1.Run();
rptTwo rpt2 = new rptTwo();
rpt2.Run();
rpt1.Document.Pages.AddRange(rpt2.Document.Pages);
viewer1.Document = rpt1.Document;

}
The following example shows what the code for the Add method looks like.

'Visual Basic
Dim i As Integer
Private Sub Form1_Load(ByVal sender As System.Object, ByVal e As System.EventArgs) _

Handles MyBase.Load
Dim rpt As New rptOne()
rpt.Run()
Dim rpt2 As New rptTwo()
rpt2.Run()
For i = 0 To rpt2.Document.Pages.Count - 1

rpt.Document.Pages.Add(rpt2.Document.Pages(i))
Next
Viewer1.Document = rpt.Document

End Sub
//C#
int i;
private void Form1_Load(object sender, System.EventArgs e)
{

rptOne rpt1 = new rptOne();
rpt1.Run();
rptTwo rpt2 = new rptTwo();
rpt2.Run();
for(i = 0; i < rpt2.Document.Pages.Count; i++)
{

rpt1.Document.Pages.Add(rpt2.Document.Pages[i]);
}
viewer1.Document = rpt1.Document;

}

Viewing the report

To view the report

0.75, 0.19 UnitsOnOrder txtUnitsOnOrder Units On Order 5.75, 0
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1. Add the ActiveReports viewer control to a Windows Form. 

2. Add the code needed to set the viewer document equal to the report document. See Using the 
ActiveReports WinForm Viewer for help. 

Note: You can quickly view your report at design time by clicking the Preview tab at the bottom of the 
designer.

With ActiveReports, page numbering can be set up using either the report's PageHeader/Footer sections or 
GroupHeader/Footer section. The following walkthroughs illustrate how to set up page numbering in the 
GroupHeader section and in the PageFooter section.

 

Page Numbering in the Group Header
Describes how to set up page numbering using the report's group header. 

Page Numbering in the Page Footer
Describes how set up page numbering using the report's page footer. 

With ActiveReports, page numbering can be easily applied to groups in a report using the GroupHeader 
section. 

This walkthrough illustrates the basics of setting up page numbering for groups in the GroupHeader section.

The walkthrough is split up into the following activities: 

l Adding an ActiveReport to a Visual Studio project 

l Connecting the data source to a database 

l Adding controls to the report to contain data 

l Viewing the report  

To complete the walkthrough, you must have access to the Northwind database. For your convenience, a 
copy is included with ActiveReports at the following default location: C:\Program Files\Data 
Dynamics\ActiveReports for .NET 3.0\Data\NWIND.MDB.

When you have finished this walkthrough, you will have a report that looks similar to the following.

Page Numbering Walkthroughs

Walkthrough: Page Numbering in the Group Header
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Adding an ActiveReport to a Visual Studio project

To add an ActiveReport to your project

1. From the Project menu, select Add New Item.

2. Select ActiveReports 3.0 File and rename it rptNumberGH. 

3. Change the name of the report and click Open. 

4. The ActiveReports design surface is displayed. 

Connecting the data source to a database

To connect the data source to a database

1. Click on the gray report DataSource icon in the Detail section to open the report DataSource dialog. 

2. Select the "OLE DB" tab. 

3. Click on Build.

4. Select "Microsoft Jet 4.0 OLE DB Provider" and click Next .

5. Click the ellipsis button to browse for the access path to the NorthWind database. Click Open once you 
have selected the appropriate access path. 

6. Click OK to continue. 

7. In the Query field, type "Select * from customers order by country". 

8. Click OK to return to the report design surface. 

Adding controls to contain data
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To add controls to contain data

1. Add a GroupHeader/Footer section to rptNumberGH. 

2. Make the following changes to the group header: 

¡ Change the name to ghCustomers 

¡ Change the DataField property to Country

¡ Change the GroupKeepTogether property to FirstDetail

¡ Change the KeepTogether property to True

3. Add the following controls to the GroupHeader section: 

4. In the Report Explorer, expand the Fields node, then the Bound node. Drag the following fields onto the 
detail section and set the following properties of each textbox as indicated.   

Viewing the report

To view the report

1. Add the ActiveReports viewer control to a Windows Form. 

2. Add the code needed to set the viewer document equal to the report document. See Using the 
ActiveReports WinForm Viewer for help. 

Note: You can quickly view your report at design time by clicking the Preview tab at the bottom of the 
designer.

With ActiveReports, page numbering can be easily applied to a report using the PageFooter section. 

This walkthrough illustrates the basics of setting up page numbering in the PageFooter section.

The walkthrough is split up into the following activities: 

Control Name Text Miscellaneous Location

ReportInfo reportInfo1 Report Info FormatString= Page
{PageNumber} of 
{PageCount}

SummaryGroup= 
ghCustomers

SummaryRunning = 
Group

0, 0

Label lblCustomerID CustomerID NA 0, 0.25 

Label lblCompanyName CompanyName NA 1.1875, 
0.25 

Label lblAddress Address NA 3.3125, 
0.25 

Label lblCountry Country NA 5.125, 
0.25 

Field Text Location

CustomerID CustomerID 0, 0

CompanyName Company Name 1.1875, 0

Address Address 3.3125, 0

Country Country 5.114, 0

Walkthrough: Page Numbering in the Page Footer

 

ActiveReports for .NET 3 User Guide | 292



l Adding an ActiveReport to a Visual Studio project 

l Connecting the data source to a database 

l Adding controls to the report to contain data 

l Viewing the report  

To complete the walkthrough, you must have access to the Northwind database. For your convenience, a 
copy is included with ActiveReports at the following default location: C:\Program Files\Data 
Dynamics\ActiveReports for .NET 3.0\Data\NWIND.MDB.

When you have finished this walkthrough, you will have a report that looks similar to the following.

Adding an ActiveReport to a Visual Studio project

To add an ActiveReport to your project

1. From the Project menu, select Add New Item.

2. Select ActiveReports 3.0 File and rename it rptNumberPF. 

3. Change the name of the report and click Open. 

4. The ActiveReports design surface is displayed. 

Connecting the data source to a database

To connect the data source to a database

1. Click on the gray report DataSource icon in the Detail section to open the report DataSource dialog. 

2. Select the "OLE DB" tab. 
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3. Click the Build button. 

4. Select "Microsoft Jet 4.0 OLE DB Provider" and click Next. 

5. Click the ellipsis button to browse for the access path to the NorthWind database. Click Open once you 
have selected the appropriate access path. 

6. Click OK to continue. 

7. In the Query field, type "Select * from products order by categoryID". 

8. Click OK to return to the report design surface. 

Adding controls to contain data

To add controls to contain data

1. Add a GroupHeader/Footer section to rptNumberPF. 

2. Make the following changes to the group header: 

¡ Change the name to ghProducts 

¡ Change the BackColor property to Gainsboro

¡ Change the DataField property to CategoryID 

¡ Change the GroupKeepTogether property to All

¡ Change the KeepTogether property to True

3. Add the following controls to the GroupHeader section: 

4. In the Report Explorer, expand the Fields node, then the Bound node. Drag the following fields onto the 
detail section and set the following properties of each textbox as indicated.   

5. Add the following controls to the PageFooter section: 

Viewing the report

To view the report

1. Add the ActiveReports viewer control to a Windows Form. 

2. Add the code needed to set the viewer document equal to the report document. See Using the 
ActiveReports WinForm Viewer for help. 

Note: You can quickly view your report at design time by clicking the Preview tab at the bottom of the 
designer.

Control Name Text Location

Label lblProductID Product ID 0, 0 

Label lblProductName Product Name 1.1875, 0 

Label lblUnitsInStock Units In Stock 3, 0 

Label lblUnitPrice Unit Price 4.375, 0 

Field Text Miscellaneous Location
ProductID Product ID NA 0, 0 
ProductName Product Name NA 1.1875, 0 
UnitsInStock Units In Stock NA 3, 0 
UnitPrice Unit Price OutputFormat = Currency 4.375, 0 

Control Name Text Miscellaneous Location

ReportInfo reportInfo1 Report 
Info

FormatString=Page{PageNumber} of 
{PageCount} 
SummaryGroup=ghProducts 
SummaryRunning = Group

0, 0 
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With ActiveReports, parameters may be used with simple reports to prompt a user for input before running 
the report or used with subreports to link a subreport to a parent report.

 

Parameters with Simple Reports
Describes how parameters can be used with simple reports. 

Parameters with Subreports
Describes how parameters can be used to connect a subreport to a parent report. 

Parameters with Charts
Describes how parameters can be used to connect a chart to a report. 

In ActiveReports, the Parameters dialog can be used to prompt for user input when reports are generated. If 
you add "<%FieldName | PromptString | DefaultValue | Type %>" to the report's SQL string, the Parameters 
dialog appears when the report opens.  

This walkthrough illustrates the basics of using parameters in simple reports.

The walkthrough is split up into the following activities: 

l Adding an ActiveReport to a Visual Studio project 

l Connecting the data source to a database 

l Adding controls to contain the data 

l Viewing the report  

To complete the walkthrough, you must have access to the Northwind database. For your convenience, a 
copy is included with ActiveReports at the following default location: C:\Program Files\Data 
Dynamics\ActiveReports for .NET 3.0\Data\NWIND.MDB.

When you have finished this walkthrough, you will have a report that looks similar to the following.

Adding an ActiveReport to a Visual Studio project

To add an ActiveReport to your project

1. Open a new project in Visual Studio. 

2. From the Project menu, select Add New Item. 

3. Select ActiveReports 3.0 File and rename the file rptParams. 

4. Click Open. 

Connecting the report to a data source

To connect the report to a data source

1. Click on the gray report DataSource icon in the Detail section to open the report DataSource dialog. 

2. Select the "OLE DB" tab. 

3. Click on Build.

Parameters Walkthroughs

Walkthrough: Parameters with Simple Reports
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4. Select Microsoft Jet 4.0 OLE DB Provider and click Next.

5. Click the ellipsis button to browse for the access path to the NorthWind database. Click Open once you 
have selected the appropriate access path. 

6. Click OK to continue. 

7. In the Query field, type "SELECT * FROM orders INNER JOIN [order details] ON orders.orderid = [order 
details].orderid WHERE orderdate =#<%Date|Order date:|1/1/1994|D%>#". 

8. Click OK to return to the report design surface. 

Adding controls to the report to contain data

To add controls to the report

1. Add a GroupHeader/Footer section to rptParams. 

2. Make the following changes to the group header: 

¡ Change the Name property to ghOrders

¡ Change the BackColor property to Orchid

3. Add the following controls to the GroupHeader section: 

4. In the Report Explorer, expand the Fields node, then the Bound node. Drag the following fields onto 
the detail section and set the properties of each textbox as indicated.  

Viewing the report

To view the report

1. Add the ActiveReports viewer control to a Windows Form. 

2. Add the code needed to set the viewer document equal to the report document. See Using the 
ActiveReports WinForm Viewer for help. 

3. When you run the report, a parameter UI is presented. Enter 9/2/94 to see the report shown above.

Note: You can quickly view your report at design time by clicking the Preview tab at the bottom of the 
designer.

Parameters can be used with subreports to connect the subreport to the parent report. By setting a 
parameter for the field that links the parent report to the subreport, the parent report can pass the 
information to the subreport through the parameters.

Note: Subreports will not render PageHeader/Footer sections. 

This walkthrough illustrates how to set up a subreport using parameters to link the parent report to the 
subreport.

This walkthrough is split up into the following activities:

l Adding two ActiveReports to a Visual Studio project 

Control Name Text Location

Label lblOrderDate Order Date 0, 0 

Label lblShipName Ship Name 1, 0 

Label lblShipAddress Ship Address 3, 0 

Field Text Location Size

OrderDate Order Date (OutputFormat = MM/dd/yy) 0, 0 1, 0.19

ShipName Ship Name 1, 0 1.9, 0.19

ShipAddress Ship Address 3, 0 1.7, 0.19

Walkthrough: Parameters with Subreports
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l Connecting the parent report to a data source 

l Connecting the child report to a data source using parameters 

l Adding controls to display the data 

l Adding the code needed to link the subreport to the current record's supplierID 

l Adding the code to set the subreport's ShowParametersUI property to False 

l Viewing the report 

To complete the walkthrough, you must have access to the Northwind database. For your convenience, a 
copy is included with ActiveReports at the following default location: C:\Program Files\Data 
Dynamics\ActiveReports for .NET 3.0\Data\NWIND.MDB.

When you have finished this walkthrough, you will have a report that looks similar to the following.

Adding two ActiveReports to a Visual Studio project

To add two ActiveReports to a Visual Studio project

1. Open a new project in Visual Studio. 

2. From the Project menu, select Add New Item. 

3. Select ActiveReports 3.0 File and rename the file rptParent. 

4. Click Open. 

5. From the Project menu, select Add New Item. 

6. Select ActiveReports 3.0 File and rename the file rptChild. 

7. Click Open.

Connecting the parent report to a data source

To connect the parent report to a data source

1. Click on the gray report DataSource icon in the Detail section to open the report DataSource dialog. 

2. Select the "OLE DB" tab. 
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3. Click on Build.

4. Select Microsoft Jet 4.0 OLE DB Provider and click Next.

5. Click the ellipsis button to browse for the access path to the NorthWind database. Click Open once you 
have selected the appropriate access path. 

6. Click OK to continue. 

7. In the Query field, type "Select * from suppliers order by country". 

8. Click OK to return to the report design surface.

Connecting the child report to a data source using parameters

To connect the child report to a data source

1. Click on the gray report DataSource icon in the Detail section to open the report DataSource dialog. 

2. Select the "OLE DB" tab. 

3. Click on Build.

4. Select Microsoft Jet 4.0 OLE DB Provider and click Next.

5. Click the ellipsis button to browse for the access path to the NorthWind database. Click Open once you 
have selected the appropriate access path. 

6. Click OK to continue. 

7. In the Query field, type "SELECT * FROM products INNER JOIN categories ON products.categoryid = 
categories.categoryid WHERE products.supplierID =<%SupplierID%>". 

8. Click OK to return to the report design surface.

Adding controls to display the data

To add controls to the reports

1. Add a GroupHeader/Footer section to rptParent. 

2. Make the following changes to the group header: 

¡ Change the Name property to ghSuppliers

¡ Change the DataField property to Country

3. Add the following controls to rptParent, setting the properties as indicated:   

 

4. Add a GroupHeader/Footer section to rptChild. 

5. Make the following changes to the group header: 

¡ Change the Name property to ghProducts

¡ Change the BackColor property to Silver

¡ Change the CanShrink property to True

¡ Change the DataField property to CategoryName

6. Drag the following fields onto rptChild, setting the properties as indicated:   

Control DataField Name Text Section Location Miscellaneous

TextBox Country txtCountry Country GroupHeader 0, 0 Font size = 12

TextBox CompanyName txtCompanyName Company 
Name

Detail 0, 0 Size = 1.94, 
0.19

TextBox ContactName txtContactName Contact 
Name

Detail 2, 0 Size = 1.9, 
0.19

TextBox Phone txtPhone Phone Detail 4, 0 Size = 1, 0.19

Subreport Subreport1 Detail 0, 0.31 Size = 5, 1
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Adding the code needed to link the subreport to the current record's 
supplierID

To write the code in Visual Basic

l Double-click in the detail section of rptParent. This creates an event-handling method for rptParent's 
Detail_Format event. Add code to the handler to: 

l Link the subreport to the current record's supplierID

To write the code in C#

l Double-click in the detail section of rptParent. This creates an event-handling method for rptParent's 
Detail_Format event. Add code to the handler to: 

l Link the subreport to the current record's supplierID

The following example shows what the code for the method looks like.

'Visual Basic
Private Sub Detail1_Format(ByVal sender As Object, ByVal e As System.EventArgs) Handles _

Detail1.Format
Dim rpt As New rptChild()
Me.SubReport1.Report = rpt

End Sub
 

//C#
private void detail_Format(object sender, System.EventArgs eArgs)
{

rptChild rpt = new rptChild();
this.SubReport1.Report = rpt;

}
 

Adding the code to set the subreport's ShowParametersUI property to False

To write the code in Visual Basic

l Double-click in the gray area below rptChild. This creates an event-handling method for the rptChild's 
ReportStart event. Add code to the handler to: 

l Set the subreport's ShowParametersUI property to False

To write the code in C#

l Double-click in the gray area below rptChild. This creates an event-handling method for rptChild's 
ReportStart event. Add code to the handler to: 

l Set the subreport's ShowParametersUI property to False

The following example shows what the code for the method looks like.

'Visual Basic
Private Sub rptChild_ReportStart(ByVal sender As Object, ByVal e As System.EventArgs) _

Handles MyBase.ReportStart
Me.ShowParameterUI = False

End Sub
 

//C#
private void rptChild_ReportStart(object sender, System.EventArgs eArgs)
{

this.ShowParameterUI = false;

Size DataField Name Text Section Location

2.5, 
0.19

CategoryName txtCategoryName Category 
Name

GroupHeader 0, 0

2.5, 
0.19

ProductName txtProductName Product Name Detail 0, 0

ActiveReports for .NET 3 User Guide | 299



}
 

Viewing the report

To view the report

1. Add the ActiveReports viewer control to a Windows Form. 

2. Add the code needed to set the viewer document equal to the report document. See Using the 
ActiveReports WinForm Viewer for help.

Note: You can quickly view your report at design time by clicking the Preview tab at the bottom of the 
designer.

Parameters can be used with charts to connect the information shown in the chart to that shown in the 
report. By setting a parameter for the field that links the report to the chart, the report can pass the 
information to the chart through the parameters.

This walkthrough illustrates how to set up a chart using parameters to link the report to the chart.

This walkthrough is split up into the following activities:

l Creating a new Visual Studio project 

l Adding an ActiveReport to a Visual Studio project 

l Connecting the report to a data source 

l Adding controls to display the data 

l Setting a data source for the chart using parameters 

l Setting the chart's properties 

l Viewing the report 

To complete the walkthrough, you must have access to the Northwind database. For your convenience, a 
copy is included with ActiveReports at the following default location: C:\Program Files\Data 
Dynamics\ActiveReports for .NET 3.0\Data\NWIND.MDB.

When you have finished this walkthrough, you will have a report that looks similar to the following.

Parameters with Charts
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Creating a new Visual Studio project

To create a new Visual Studio project

1. Open Visual Studio. 

2. From the File menu, select New > Project.

3. Select the project type and click on Windows Application. 
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4. Change the name of your project and click OK.

Adding an ActiveReport to a Visual Studio project

To add two ActiveReports to a Visual Studio project

1. Open a new project in Visual Studio. 

2. From the Project menu, select Add New Item. 

3. Select ActiveReports 3.0 File and rename the file rptChartParams. 

4. Click Open.

Connecting the report to a data source

To connect the report to a data source

1. Click on the gray report DataSource icon in the Detail section to open the report DataSource dialog. 

2. Select the "OLE DB" tab. 

3. Click on Build.

4. Select Microsoft Jet 4.0 OLE DB Provider and click Next.

5. Click the ellipsis button to browse for the access path to the NorthWind database. Click Open once you 
have selected the appropriate access path. 

6. Click OK to continue. 

7. In the Query field, type "SELECT * FROM Products ORDER BY CategoryID, ProductName". 

8. Click OK to return to the report design surface.

Adding controls to display the data

To add controls to the reports

1. Right-click on the report and delete the PageHeader/Footer section pair. 

2. Right-click on the report and insert a GroupHeader/Footer section pair. 

3. Make the following changes to the GroupHeader section: 

¡ Change the Name property to ghCategoryID

¡ Change the DataField property to CategoryID

¡ Change the GroupKeepTogether property to All

¡ Change the Height property to 5.65 in

4. Change the Height property of the Detail section to 0.23 in. 

5. Change the Height property of the GroupFooter section to 0 in. 

6. Add the following controls to rptChartParams, setting the properties as indicated: 

 

Control DataField Name Text Section Location

Label NA lblCategoryID Category ID 
Number:

ghCategoryID 1.78, 0

TextBox CategoryID txtCategoryID CategoryID ghCategoryID 3.72, 0

ChartControl NA chartControl1 NA ghCategoryID 0.063, 
0.313

Label NA lblProductName Product 
Name

ghCategoryID 0.23, 
5.43

Label NA lblUnitsInStock Units In 
Stock

ghCategoryID 5, 5.43

TextBox ProductName txtProductName ProductName Detail 0.23, 0
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Setting a data source for the chart

To connect the data source to a database

1. With the chart control highlighted, click the Data Source verb below the Properties Window to open the 
Chart DataSource dialog. 

2. Click Build.

3. Select "Microsoft Jet 4.0 OLE DB Provider" and click Next .

4. Click the ellipsis button to browse to the NorthWind database. Click Open once you have selected the file. 

5. Click OK to continue. 

6. In theQuery field, type "SELECT * FROM Products WHERE CategoryID = <%CategoryID||1%> ORDER BY 
ProductName." 

7. Click OK to return to the report design surface.

NOTE: When using parameters, the chart will draw at run time but not at design time if you do not provide a 
default value. 

NOTE 2: If you don't set the ORDER in both SQL statements (i.e. that of the report and that of the chart), 
the chart data will not be ordered.

Setting the chart's properties

To set the chart's properties

1. With the chart control highlighted, click the ChartAreas (Collection) property in the Properties Window, 
then click the ellipsis button to open the ChartArea Collection Editor. 

2. In the defaultArea Properties, click the Axes (Collection) property, then click the ellipsis button to open 
the AxisBase Collection Editor. 

3. Click the AxisX member, and set its LabelFont > Angle property to 90 so the ProductName labels will 
not overlap. 

4. Click the AxisY member, and set its Title property to "Units in Stock". 

5. Still in the AxisY member, expand the MajorTick property treeview node and set the following 
properties: 

¡ Change the GridLine > Style property to Dot

¡ Change the GridLine > Color property to Silver

¡ Change the GridLine > Weight property to 1

6. Click OK to return to the ChartArea Collection Editor. 

7. Click OK to return to the report design surface. 

8. With the chart control highlighted, click the Series (Collection) property in the Properties Window, then 
click the ellipsis button to open the Series Collection Editor. 

9. Click Series1 to select it. 

10. Change the ValueMembersY property to UnitsInStock. 

11. Change the ValueMembersX property to ProductName. 

12. Remove Series2 and Series3. 

13. Click OK to return to the report design surface. 

14. With the chart control highlighted, click the Titles (Collection) property in the Properties Window, then 
click the ellipsis button to open the Title Collection Editor. 

15. In the header properties, change the Text property to "Products In Stock." 

16. Remove the footer title and click OK to return to the report design surface. 

17. With the chart control highlighted, click the Legends (Collection) property in the Properties Window, then 

TextBox UnitsInStock txtUnitsInStock UnitsInStock Detail 5, 0.23
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click the ellipsis button to open the Legend Collection Editor. 

18. Change the Visible property of the defaultLegend to False. 

19. Click OK to return to the report design surface.

Viewing the report

To view the report

1. Add the ActiveReports viewer control to a Windows Form. 

2. Add the code needed to set the viewer document equal to the report document. See Using the 
ActiveReports WinForm Viewer for help.

Note: You can quickly view your report at design time by clicking the Preview tab at the bottom of the 
designer.

With ActiveReports, printer settings can be modified at design time as well as at run time. The following 
walkthroughs will describe how to make such modifications in your report.

Note: Printer values are set after the ReportStart event fires.  The values that will be applied to the 
Printer object are in the PageSettings object, so to modify the values in the PageSettings object before 
they are applied to the Printer object, do so in the ReportStart event.

 

Also note that calling Document.Print will not run the report. The report must be run before attempting to 
print the document.

 

Duplexing
Describes how to set up duplexing when printing your report. 

Multiple Copies
Describes how to set multiple copies for printing your report. 

Orientation
Describes how to change the paper orientation for printing your report. 

This walkthrough illustrates how to set the type of duplex action to use when printing out double-sided 
reports. 

This walkthrough is split up into the following activities: 

l Accessing the printer settings dialog 

l Setting the type of duplexing for printing double-sided reports 

l Using code to set the type of duplexing for printing 

l Viewing the report  

To complete this walkthrough, you must have a print driver which supports printing in duplex in .NET.

Accessing the printer settings dialog

To access the printer settings dialog

1. Open an existing ActiveReport. 

2. Click on any section of the report to select it. 

3. Click on Report > Settings.

Printing Walkthroughs

Walkthrough: Duplexing
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4. Click on Printer Settings. 

Setting the type of duplexing for printing double-sided reports

To set the type of duplexing for printing double-sided reports

1. Go to the printer settings dialog. 

2. For Duplex, choose one of the four options: 

 Printer default: the report will use the default setting on the selected printer.

 Simplex: turns off duplex printing.

 Horizontal: prints horizontally on both sides of the paper.

 Vertical: prints vertically on both sides of the paper.

 

Using code to set the type of duplexing at run time

To write the code in Visual Basic

l Click in the gray section underneath the report to select the report, then double-click. This creates an 
event-handling method for the report's ReportStart event. Add code to the handler to: 

l Set the type of duplexing needed in the report 

To write the code in C#

l Click in the gray section underneath the report to select the report, then double-click. This creates an 
event-handling method for the report's ReportStart event. Add code to the handler to: 

l Set the type of duplexing needed in the report 

The following example shows what the code for the method looks like for setting horizontal duplexing.

'Visual Basic
Private Sub rptKeepTG_ReportStart(ByVal sender As Object, ByVal e As System.EventArgs) _

Handles MyBase.ReportStart
Me.PageSettings.Duplex = Drawing.Printing.Duplex.Horizontal

End Sub
//C#
private void rptprint_ReportStart(object sender, System.EventArgs eArgs)
{

this.PageSettings.Duplex = System.Drawing.Printing.Duplex.Horizontal
}

Viewing the report

To view the report

1. Add the ActiveReports viewer control to a Windows Form. 
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2. Add the code needed to set the viewer document equal to the report document. See Using the 
ActiveReports WinForm Viewer for help. 

Note: You can quickly view your report at design time by clicking the Preview tab at the bottom of the 
designer.

This walkthrough illustrates how to set multiple copies for printing a report.

This walkthrough is split up into the following activities: 

l Setting multiple copies for printing a report from the print dialog at run time 

l Setting multiple copies in code for printing a report 

l Using code to set multiple copies for printing 

l Viewing the report  

Note: Setting the number of copies is only supported in .NET Framework 1.0 SP3 and 1.1 SP1.

Setting multiple copies for printing a report from the print dialog at run time

To set multiple copies for printing a report from the print dialog at run time

1. Press F5 to run an existing ActiveReport. 

2. Click on the printer icon in the viewer window. 

 

3. In the Copies box, select the number of copies needed. 

  

Using code to set multiple copies for printing at run time

To write the code in Visual Basic

l Click in the gray section underneath the report to select the report, then double-click. This creates an 
event-handling method for the report's ReportStart event. Add code to the handler to: 

l Set multiple copies of the report for printing 

To write the code in C#

l Click in the gray section underneath the report to select the report, then double-click. This creates an 
event-handling method for the report's ReportStart event. Add code to the handler to: 

l Set multiple copies of the report for printing 

The following example shows what the code for the method looks like for printing five copies.

'Visual Basic
Private Sub ActiveReport1_ReportStart(ByVal sender As Object, ByVal e As System _

.EventArgs) Handles MyBase.ReportStart

Walkthrough: Multiple Copies
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Me.Document.Printer.PrinterSettings.Copies = 5
End Sub
Private Sub rptPrint_ReportEnd(ByVal sender As Object, ByVal e As System.EventArgs) _

Handles MyBase.ReportStart
Me.Document.Print(false, false)

End Sub
//C#
private void ActiveReport1_ReportStart(object sender, System.EventArgs eArgs)
{

this.Document.Printer.PrinterSettings.Copies = 5;
}
private void rptPrint_ReportEnd(object sender, System.EventArgs eArgs)
{

this.Document.Print(false, false);
}

Viewing the report

To view the report

1. Add the ActiveReports viewer control to a Windows Form. 

2. Add the code needed to set the viewer document equal to the report document. See Using the 
ActiveReports WinForm Viewer for help. 

Note: You can quickly view your report at design time by clicking the Preview tab at the bottom of the 
designer.

This walkthrough illustrates how to make simple modifications to the page orientation of your report for 
printing. 

This walkthrough is split up into the following activities: 

l Accessing the printer settings dialog 

l Changing the page orientation of your report for printing 

l Using code to change the page orientation for printing 

l Viewing the report  

Accessing the printer settings dialog

To access the printer settings dialog

1. Open an existing ActiveReport. 

2. Click on any section of the report to select it. 

3. From the Report menu, select Settings.

4. Select the Printer Settings tab. 

Changing the page orientation of your report for printing

Walkthrough: Orientation
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To change the page orientation of your report for printing

1. On the Printer Settings tab, in the orientation box, select either portrait or landscape. 

2. Click OK to return to the report. 

Note: Page orientation can only be modified before the report runs. Otherwise, changes made to the 
page orientation will not be reflected when printed.

Using code to change the page orientation

To write the code in Visual Basic

l Click in the gray section underneath the report to select the report, then double-click. This creates an 
event-handling method for the report's ReportStart event. Add code to the handler to: 

l Change the page orientation of the report for printing 

To write the code in C#

l Click in the gray section underneath the report to select the report, then double-click. This creates an 
event-handling method for the report's ReportStart event. Add code to the handler to: 

l Change the page orientation of the report for printing 

The following example shows what the code for the method looks like for changing the page orientation 
to landscape.

'Visual Basic
Private Sub rptPrint_ReportStart(ByVal sender As Object, ByVal e As System.EventArgs) _

Handles MyBase.ReportStart
Me.PageSettings.Orientation = PageOrientation.Landscape

End Sub
//C#
private void rptPrint_ReportStart(object sender, System.EventArgs eArgs)
{

this.PageSettings.Orientation = DataDynamics.ActiveReports.Document
.PageOrientation.Landscape;

}

Viewing the report

To view the report

1. Add the ActiveReports viewer control to a Windows Form. 

2. Add the code needed to set the viewer document equal to the report document. See Using the 
ActiveReports WinForm Viewer for help. 

Note: You can quickly view your report at design time by clicking the Preview tab at the bottom of the 
designer.

With ActiveReports, RichText can be used for field merging as well as for formatting text. The following 
walkthroughs describe how to use the features of the RichText control.

RichText and Field Merging
Illustrates how to create a mail-merge report using the RichText control. 

HTML, Tables and Exporting with RichText

RichText Walkthroughs
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Illustrates how to create and export a report which contains the RichText control. 

ActiveReports supports field merged reports using the RichText control. The RichText control can contain field 
placeholders that are replaceable with their values (merged) at run time. 

This walkthrough illustrates how to create a mail-merge report using the RichText control.

This walkthrough is split up into the following activities: 

l Adding an ActiveReport to the Visual Studio project 

l Connecting the report to a data source 

l Adding controls to the report to contain data 

l Adding fields to the RichText control 

l Using the FetchData event to get information from the data source 

l Adding code to update field values in the RichText control for each record 

l Adding code to the group header BeforePrint event 

l Viewing the report  

To complete the walkthrough, you must have access to the Northwind database. For your convenience, a 
copy is included with ActiveReports at the following default location: C:\Program Files\Data 
Dynamics\ActiveReports for .NET 3.0\Data\NWIND.MDB.

When you complete this walkthrough, you will have a report that looks similar to the following:

Adding an ActiveReport to the Visual Studio project

To add an ActiveReport to your project

1. Open a new project in Visual Studio. 

2. From the Project menu, select Add New Item. 

Walkthrough: Rich Text and Field Merging
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3. Select ActiveReports 3.0 File and rename the file rptLetter. 

4. Click Open. 

Connecting the report to a data source

To connect the report to a data source

1. Click on the gray report DataSource icon in the Detail section to open the report DataSource dialog. 

2. Click on Build.

3. Select Microsoft Jet 4.0 OLE DB Provider and click Next.

4. Click the ellipsis button to browse for the access path to the NorthWind database. Click Open once you 
have selected the appropriate access path. 

5. Click OK to continue. 

6. In the Query field, type "SELECT 
Customers.CustomerID, Customers.CompanyName, 
Customers.ContactName, Customers.Address, 
Customers.City, Customers.Region, Customers.Country, Customers.PostalCode, Orders.OrderID, 
Orders.OrderDate, [Order Subtotals].Subtotal
FROM Customers INNER JOIN ([Order Subtotals] INNER JOIN Orders ON [Order Subtotals].OrderID = 
Orders.OrderID) ON Customers.CustomerID = Orders.CustomerID". 

7. Click OK to return to the report design surface. 

Adding controls to the report to contain data 

To add controls to the report

1. Add a GroupHeader/Footer section to rptLetter.  

2. Make the following changes to the group header: 

¡ Change the Name property to ghCustomerID

¡ Change the DataField property to CustomerID

¡ Change the ColumnLayout property to False

¡ Change the KeepTogether property to True

3. Make the following changes to the group footer: 

¡ Change the Name property to gfCustomerID

¡ Change the ColumnLayout property to False

¡ Change the KeepTogether property to True

¡ Change the NewPage property to After. 

4. Add the following controls to the PageHeader section: 

5. Add the following controls to the GroupHeader section: 

Control Name Text Location

Picture imgLogo 4, 0 

Label lblNorthWind NorthWind 5, 0.0625 

Label lblTraders Traders 5, 0.4375 

Control DataField Name Text Miscellaneous Location

RichText rtf 0, 0 

Textbox Subtotal txtTotalOrders Visible = False 

OutputFormat = 
Currency

SummaryType = 

5.437, 
0.0625 
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6. In the Report Explorer, expand the Fields node, then the Bound node. Drag the following fields onto 
the detail section and set the following properties of each textbox as indicated.  

7. Add the following controls to the GroupFooter section: 

8. Add the following controls to the PageFooter section: 

Adding fields to the RichText control

To add fields to the RichText control

1. Double-click inside the RichText control box to select it. 

2. Right-click inside the box and choose Insert Field. 

3. Insert the following fields in the following order: 

¡ Date 

¡ CompanyName 

¡ ContactName 

¡ AddressLine 

¡ City 

¡ Region 

¡ Country 

¡ PostalCode 

¡ ContactName 

¡ TotalOrders 

4. Add the following text to the RichText control box: "Dear [!ContactName], Thank you for your business, 
below is a list of your orders for the past year with a total of [!TotalOrders]. Please take this opportunity 
to review each order and total for accuracy. Call us at 1-800-DNT-CALL with any questions or concerns." 

SubTotal

SummaryGroup = 
ghCustomerID

Label lblOrderID Order ID 0.875, 
2.25 

Label lblOrderDate Order 
Date 

1.875, 
2.25 

Label lblAmount Amount 4.375, 
2.25 

Field Text Miscellaneous Location

OrderID Order ID Alignnent: Right 0.8125, 0 

OrderDate Order Date OutputFormat = MM/dd/yy 1.875, 0 

Subtotal Subtotal OutputFormat = Currency 

Alignment: Right

4.3125, 0 

Control Name Text Location

Label lblYours Yours, 0.1875, 0.125 

Label lblNTAP Accounts Receivable 0.1875, 0.4375 

Control Name Text Location

Label lblNWAddress NorthWind Traders, One Portals Way, Twin Points 
WA 98156

0, 
0.0625
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5. Your RichText control should be arranged like the following. 

Using the FetchData event to get information from the data source

To write the code in Visual Basic

l Right-click in any section of the design window of rptLetter, and click on View Code to display the code 
view for the report. At the top left of the code view for rptLetter, click the drop-down arrow and select 
(Base Class Events). At the top right of the code window, click the drop-down arrow and select 
FetchData. This creates an event-handling method for rptLetter's FetchData event. Add code to the 
handler to: 

l Retrieve information from the data source 

To write the code in C#

l Click in the gray area below rptLetter to select the report. Click on the events icon in the Properties
window to display available events for the report. Double-click FetchData. This creates an event-handling 
method for rptLetter's FetchData event. Add code to the handler to: 

l Retrieve information from the data source 

The following example shows what the code for the method looks like.

' Visual Basic
Dim m_companyName As String
Dim m_contactName As String
Dim m_addressLine As String
Dim m_city As String
Dim m_region As String
Dim m_country As String
Dim m_postalCode As String
Private Sub rptLetter_FetchData(ByVal sender As Object, ByVal eArgs As DataDynamics _

.ActiveReports.ActiveReport.FetchEventArgs) Handles MyBase.FetchData
m_companyName = Fields("CompanyName").Value
m_contactName = Fields("ContactName").Value
m_addressLine = Fields("Address").Value
m_city = Fields("City").Value
If Fields("Region").Value Is System.DBNull.Value Then

m_region = ""
Else

m_region = Fields("Region").Value
End If
m_country = Fields("Country").Value
m_postalCode = Fields("PostalCode").Value

End Sub
//C#
string m_companyName;
string m_contactName;
string m_addressLine;
string m_city;
string m_region;
string m_country;
string m_postalCode;
private void rptLetter_FetchData(object sender, DataDynamics.ActiveReports.ActiveReport3 

.FetchEventArgs eArgs)
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{
m_companyName = Fields["CompanyName"].Value.ToString();
m_contactName = Fields["ContactName"].Value.ToString();
m_addressLine = Fields["Address"].Value.ToString();
m_city = Fields["City"].Value.ToString();
if(Fields["Region"].Value is System.DBNull)

m_region = "";
else
m_region = Fields["Region"].Value.ToString();
m_country = Fields["Country"].Value.ToString();
m_postalCode = Fields["PostalCode"].Value.ToString();

}

Adding code to update the field values in the Rich Text control

To write the code in Visual Basic

l Right-click in any section of the design window of rptLetter, and click on View Code to display the code 
view for the report. At the top left of the code view for rptLetter, click the drop-down arrow and select 
ghCustomerID. At the top right of the code window, click the drop-down arrow and select Format. This 
creates an event-handling method for rptLetter's ghCustomerID_Format event. Add code to the handler 
to: 

l Update the field values in the RichText control 

To write the code in C#

l Click in the GroupHeader section of rptLetter to select it. Click on the events icon in the Properties
window for ghCustomerID to display available events for the section. Double-click Format. This creates an 
event-handling method for rptLetter's ghCustomerID_Format event. Add code to the handler to: 

l Update the field values in the RichText control

The following example shows what the code for the method looks like.

'Visual Basic
Private Sub ghCustomerID_Format(ByVal sender As Object, ByVal e As System.EventArgs) _

Handles ghCustomerID.Format
Me.rtf.ReplaceField("CompanyName", m_companyName)
Me.rtf.ReplaceField("ContactName", m_contactName)
Me.rtf.ReplaceField("AddressLine", m_addressLine)
Me.rtf.ReplaceField("City", m_city)
Me.rtf.ReplaceField("Region", m_region)
Me.rtf.ReplaceField("Country", m_country)
Me.rtf.ReplaceField("PostalCode", m_postalCode)
Me.rtf.ReplaceField("Date", System.DateTime.Today.Date)

End Sub
//C#
private void ghCustomerID_Format(object sender, System.EventArgs eArgs)
{

this.rtf.ReplaceField("CompanyName", m_companyName);
this.rtf.ReplaceField("ContactName", m_contactName);
this.rtf.ReplaceField("AddressLine", m_addressLine);
this.rtf.ReplaceField("City", m_city);
this.rtf.ReplaceField("Region", m_region);
this.rtf.ReplaceField("Country", m_country);
this.rtf.ReplaceField("PostalCode", m_postalCode);
this.rtf.ReplaceField("Date", System.DateTime.Today.Date.ToString());

}

Adding code to the Group Header BeforePrint Event

To write the code in Visual Basic

l Right-click in any section of the design window of rptLetter, and click on View Code to display the code 
view for the report. At the top left of the code view for rptLetter, click the drop-down arrow and select 
ghCustomerID. At the top right of the code window, click the drop-down arrow and select BeforePrint. 
This creates an event-handling method for rptLetter's ghCustomerID_BeforePrint event. 

To write the code in C#
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l Click in the GroupHeader section of rptLetter to select it. Click on the events icon in the Properties
window for ghCustomerID to display available events for the section. Double-click BeforePrint. This 
creates an event-handling method for rptLetter's ghCustomerID_BeforePrint event. 

The following example shows what the code for the method looks like.

'Visual Basic
Private Sub ghCustomerID_BeforePrint(ByVal sender As Object, ByVal e As System.EventArgs) _

Handles ghCustomerID.BeforePrint
Me.rtf.ReplaceField("TotalOrders", Me.txtTotalOrders.Text)

End Sub
//C#
private void ghCustomerID_BeforePrint(object sender, System.EventArgs eArgs)
{

this.rtf.ReplaceField("TotalOrders",this.txtTotalOrders.Text);
}

Viewing the report

To view the report

1. Add the ActiveReports viewer control to a Windows Form. 

2. Add the code needed to set the viewer document equal to the report document. See Using the 
ActiveReports WinForm Viewer for help. 

Note: You can quickly view your report at design time by clicking the Preview tab at the bottom of the 
designer.

ActiveReports supports exporting with tables in the RichText control. RichText controls can be loaded with an 
RTF file which contains tables, or even an HTML file, and the resulting report can be exported to any of a 
number of formats. 

This walkthrough illustrates how to create and export a report which contains the RichText control.

This walkthrough is split up into the following activities: 

l Adding an ActiveReport to the Visual Studio project 

l Adding the appropriate export filters to your project 

l Adding controls to the report to contain data 

l Loading an RTF file into a RichText control 

l Creating an HTML file to be loaded into a RichText control 

l Loading the HTML file into a RichText control 

l Viewing the report 

l Using the export methods to export data to all available file formats 

To complete the walkthrough, you will need an RTF file which contains a table.

Adding an ActiveReport to the Visual Studio project

To add an ActiveReport to your project

1. Open a new project in Visual Studio. 

2. From the Project menu, select Add New Item. 

3. Select ActiveReports 3.0 File and rename the file rptRich. 

4. Click Open. 

Adding the export filters to your project

To add the export filters to your project

HTML, Tables and Exporting with RichText
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1. Click on the following export controls one at a time in the appropriate toolbox to select them. 

¡ HtmlExport 

¡ PdfExport 

¡ RtfExport 

¡ TextExport 

¡ TiffExport 

¡ XlsExport 

2. Drag each control onto the Windows Form. 

3. The controls will appear in the tray below the Windows Form. 

Adding controls to the report to contain data 

To add controls to the report

1. Add the following controls to the Detail section: 

Creating an RTF file to be loaded into a RichText control

To write a quick RTF file

l Open Wordpad, and paste the following text into it. 
Customer List by Country

Argentina
¡ Rancho grande 

¡ Océano Atlántico Ltda. 

¡ Cactus Comidas para llevar 

Austria
¡ Piccolo und mehr 

¡ Ernst Handel 

Belgium
¡ Suprêmes délices 

¡ Maison Dewey 

Brazil
¡ Familia Arquibaldo 

¡ Wellington Improtadora 

¡ Que Delícia 

¡ Tradição Hipermercados 

¡ Ricardo Adocicados 

¡ Hanari Carnes 

¡ Queen Cozinha 

¡ Comércio Mineiro 

¡ Gourmet Lanchonetes 

Control Name Size Location

RichText rtfRTF 3, 1.5 0, 0

RichText rtfHTML 3, 1.5 3.25, 0
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l Save the file as "sample.rtf" in the bin directory (VB) or the debug directory in the bin (C#) of your 
project. 

Loading an RTF file into a RichText control 

To load an RTF file into the RichText control

To write the code in Visual Basic or C#

l Double-click in the detail section of of rptRich. This creates an event-handling method for rptRich's 
Detail_Format event. Add code to the handler to: 

¡ Load an RTF file into the RichText control 

The following example shows what the code for the method looks like.

'Visual Basic
Private Sub Detail_Format(ByVal sender As Object, ByVal e As System.EventArgs) Handles _

Detail.Format
rtfRTF.LoadFile(Application.StartupPath & "\sample.rtf")

End Sub
//C#
private void Detail_Format(object sender, System.EventArgs eArgs)
{

rtfRTF.LoadFile(System.Windows.Forms.Application.StartupPath + "\\sample.rtf");
}

Creating an HTML file to be loaded into a RichText control

To write a quick HTML file

l Open a Notepad, and paste the following code into it. 
<html>
<body>
<center><h1>Customer List by Country</h1></center>
<h2>Argentina</h2>
<ul>
<li>Rancho grande
<li>Océano Atlántico Ltda.
<li>Cactus Comidas para llevar
</ul>
<h2>Austria</h2>
<ul>
<li>Piccolo und mehr
<li>Ernst Handel
</ul>
<h2>Belgium</h2>
<ul>
<li>Suprêmes délices
<li>Maison Dewey
</ul>
<h2>Brazil</h2>
<ul>
<li>Familia Arquibaldo
<li>Wellington Improtadora
<li>Que Delícia
<li>Tradição Hipermercados
<li>Ricardo Adocicados
<li>Hanari Carnes
<li>Queen Cozinha
<li>Comércio Mineiro
<li>Gourmet Lanchonetes
</ul>

Month Sales
October $4,872
November $8,517
December $9,623
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<table>
<tr><th>Month</th><th>Sales</th></tr>
<tr><td>October</td><td>$4,872</td></tr>
<tr><td>November</td><td>$8,517</td></tr>
<tr><td>December</td><td>$9,623</td></tr>
</table>
</body>
</html>

l Save the file as "sample.html" in the bin directory (VB) or the debug directory in the bin (C#) of your 
project. 

Loading the HTML file into a RichText control

To write the code in Visual Basic

l Right-click in any section of the design window of rptRich, and click on View Code to display the code 
view for the report. In the event-handling method for rptRich's Detail_Format event created previously, 
add code to the handler to: 

l Load the HTML file into the RichText control 

To write the code in C#

l Right-click in any section of the design window of rptRich, and click on View Code to display the code 
view for the report. In the event-handling method for rptRich's Detail_Format event created previously, 
add code to the handler to: 

l Load the HTML file into the RichText control 

The following example shows what the code for the method looks like.

'Visual Basic
Private Sub Detail_Format(ByVal sender As Object, ByVal e As System.EventArgs) Handles _

Detail.Format
rtfRTF.LoadFile(Application.StartupPath & "\sample.rtf")

Dim stream As New System.IO.FileStream(Application.StartupPath & "\sample.html", _
IO.FileMode.Open)

rtfHTML.LoadFile(stream)
End Sub
//C#
private void detail_Format(object sender, System.EventArgs eArgs)
{

rtfRTF.LoadFile(System.Windows.Forms.Application.StartupPath + "\\sample.rtf");
System.IO.FileStream stream = new System.IO.FileStream(System.Windows.Forms
.Application.StartupPath + "\\sample.html",System.IO.FileMode.Open);

rtfHTML.LoadFile(stream);
}

Viewing the report

To view the report

1. Add the ActiveReports viewer control to Form1. 

2. Set the viewer control's Dock property to Fill. 

3. Add the code needed to set the viewer document equal to the report document. 

Note: You can quickly view your report at design time by clicking the Preview tab at the bottom of the 
designer.

To write the code for the viewer in Visual Basic

l Double-click the center of the viewer control. This creates an event-handling method for the Viewer1 
_Load event. Add code to the handler to: 

l Format the viewer to show the report when it is run

To write the code for the viewer in C#

l Double-click the center of the viewer control. This creates an event-handling method for the 
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viewer1_Load event. Add code to the handler to: 

l Format the viewer to show the report when it is run 

The following example shows what the code for the method looks like.

'Visual Basic
Private Sub Viewer1_Load(ByVal sender As Object, ByVal e As System.EventArgs) Handles _

Viewer1.Load
Dim rpt As New rptRich()
Viewer1.Document = rpt.Document
rpt.Run()

End Sub
//C#
private void viewer1_Load(object sender, System.EventArgs e)
{

rptRich rpt = new rptRich();
this.viewer1.Document = rpt.Document;
rpt.Run();

}

Using the export methods to export data to all available file formats

To write the code in Visual Basic or C#

l In the event-handling method for the Viewer1_Load event created previously, add code to the handler to: 

l Export the report to all available file formats

The following example shows what the code for the method looks like.

'Visual Basic
Private Sub Viewer1_Load(ByVal sender As System.Object, ByVal e As System.EventArgs) _

Handles arv.Load
Dim rpt As New rptRich
rpt.Run()
Viewer1.Document = rpt.Document

Me.HtmlExport1.Export(rpt.Document, Application.StartupPath + "\\HTMLExpt.html")
Me.PdfExport1.Export(rpt.Document, Application.StartupPath + "\\PDFExpt.pdf")
Me.RtfExport1.Export(rpt.Document, Application.StartupPath + "\\RTFExpt.rtf")
Me.TextExport1.Export(rpt.Document, Application.StartupPath + "\\TextExpt.txt")
Me.TiffExport1.Export(rpt.Document, Application.StartupPath + "\\TIFFExpt.tiff")
Me.XlsExport1.Export(rpt.Document, Application.StartupPath + "\\XLSExpt.xls")

End Sub
//C#
private void viewer1_Load(object sender, System.EventArgs e)
{

rptDD rpt = new rptRich();
rpt.Run();
viewer1.Document = rpt.Document;

this.htmlExport1.Export(rpt.Document, Application.StartupPath + 
"\\HTMLExpt.html");
this.pdfExport1.Export(rpt.Document, Application.StartupPath + "\\PDFExpt.pdf");
this.rtfExport1.Export(rpt.Document, Application.StartupPath + "\\RTFExpt.rtf");
this.textExport1.Export(rpt.Document, Application.StartupPath + "\\TextExpt.txt");
this.tiffExport1.Export(rpt.Document, Application.StartupPath + "\\TIFFExpt.tiff");
this.xlsExport1.Export(rpt.Document, Application.StartupPath + "\\XLSExpt.xls");

}

ActiveReports allows objects, controls and the data source to be completely accessible at run time. These 
properties can be modified to provide a dynamic view of your report.

 

Run-Time Reporting Walkthroughs
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Creating and Modifying Report Layouts at Run Time
Describes how to create and modify report layouts dynamically. 

Modifying the Report Data Source at Run Time
Describes how to change the report data source at run time using the ReportStart event. 

ActiveReports objects and controls are completely accessible at run time. The properties of any of the report 
sections or controls can be modified to produce a dynamic view of the report. The format event allows the 
properties of report sections and controls to be modified including height, visibility and other visual 
properties. The format event is the only event in which the printable area of a section can be modified. Once 
this event is completed, any changes to the section's height will not be reflected in the report output. 

Note Controls may be added dynamically in the ReportStart event but should not be added 
dynamically after the ReportStart event fires as problems may result. 

This walkthrough illustrates how to create a report layout at run time based on user input. 

This walkthrough is split up into the following activities: 

l Adding an ActiveReport to a Visual Studio project 

l Connecting the report to a data source 

l Adding controls to the Windows Form to contain data 

l Adding the data adapter to the Windows Form and generating a dataset 

l Adding code to the blank report 

l Adding code to the Windows Form 

l Adding code to the report's Detail_Format event 

l Adding code to the report's ReportStart event 

l Adding code to the Window Form's "Generate Report" button Click event 

l Adding code to the Checked ListBox's SelectedIndexChanged event on the Windows Form 

l Adding code to the Form_Load event 

l Viewing the report  

To complete the walkthrough, you must have access to the Northwind database. For your convenience, a 
copy is included with ActiveReports at the following default location: C:\Program Files\Data 
Dynamics\ActiveReports for .NET 3.0\Data\NWIND.MDB.

When you have completed this walkthrough, you will have output that looks similar to the following.

Walkthrough: Creating and Modifying Report Layouts at Run Time
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Adding an ActiveReport to your project

To add an ActiveReport to your project

1. Open a new project in Visual Studio. 

2. From the Project menu, select Add New Item. 

3. Select ActiveReports 3.0 File and rename the file rptFieldsRT. 

4. Click Open. 

Connecting the report to a data source
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To connect the report to a data source

1. Click on the gray report DataSource icon in the Detail section to open the report DataSource dialog. 

2. Click on Build.

3. Select "Microsoft Jet 4.0 OLE DB Provider" and click Next.

4. Click the ellipsis button to browse for the access path to the Northwind database. Click Open once you 
have selected the appropriate access path. 

5. Click OK to continue. 

6. In the Query field, type "Select * from products". 

7. Click OK to return to the report design surface. 

Adding controls to the Windows Form to contain data

To add controls to the form

l Add the following controls to the Windows Form: 

Adding a data adapter to the Windows Form and generating the dataset

To add a data adapter to the form

1. On the Data toolbox, double-click OleDbDataAdapter. 

2. This adds the adapter to the Windows Form and opens the Data Adapter Configuration Wizard. 

3. Follow the instructions to choose the data connection, select the data provider, select the database and 
enter the SQL statement, "SELECT CategoryID, Discontinued, ProductID, ProductName, QuantityPerUnit, 
ReorderLevel, SupplierID, UnitPrice, UnitsInStock, UnitsOnOrder FROM Products" (For help with this, see 
"Connecting the report to a data source" above. 

4. Click "Finish" to return to the Windows Form. 

To generate the dataset

1. Click on Data > Generate Dataset. on the Visual Studio menu bar. 

2. This opens the Generate Dataset dialog. 

3. Click New and make sure the selected table to be added to the dataset is Products. 

Control
Dock 
Property Name Text Miscellaneous

Panel Left Panel1 Height: 406 

Width: 200

Label Top lblSelectFields Select Fields for 
Your Report

Location: Panel1

Checked 
ListBox

Fill clbFields Report Fields Location: Panel1

Button Bottom btnGenRep Generate Report Location: Panel1

CheckBox Bottom chkGroup Group By Category 
ID

Location: Panel1

Viewer Fill Viewer1 Location: Windows 
Form
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4. Check "Add this dataset to the designer" and click OK. 

Adding code to the blank ActiveReport

To add code to the blank report

l Insert the following code beneath "ActiveReports Designer generated code." 
' Visual Basic
Private m_arrayFields As ArrayListPublic WriteOnly Property FieldsList() As ArrayList

Set(ByVal Value As ArrayList)
m_arrayFields = Value

End Set
End Property
Private m_useGroups As BooleanPublic WriteOnly Property UseGroups() As Boolean

Set(ByVal Value As Boolean)
m_useGroups = False
m_useGroups = Value

End Set
End Property
Private Sub constructReport()

Try
Me.Detail1.CanGrow = True
Me.Detail1.CanShrink = True
Me.Detail1.KeepTogether = True
If m_useGroups = True Then

Me.Sections.InsertGroupHF()
CType(Me.Sections("GroupHeader1"), GroupHeader)._

DataField = "CategoryID"
Me.Sections("GroupHeader1").BackColor = System.Drawing _

.Color.SlateBlue
Me.Sections("GroupHeader1").CanGrow = True
Me.Sections("GroupHeader1").CanShrink = True
CType(Me.Sections("GroupHeader1"), GroupHeader).RepeatStyle  _

= RepeatStyle.OnPageIncludeNoDetail
Me.Sections("GroupHeader1").Height = 0
Dim txt As New TextBox()
txt.DataField = "CatagoryID"
txt.Location = New System.Drawing.PointF(0.0F, 0)
txt.Width = 2.0F
txt.Height = 0.3F
txt.Style = "font-weight: bold; font-size: 16pt"
Me.Sections("GroupHeader1").Controls.Add(txt)

End If
For i = 0 To m_arrayFields.Count - 1

If (m_useGroups = False) Or (m_useGroups AndAlso _
m_arrayFields(i).ToString <> "CategoryID") Then
Dim lbl As New Label()
lbl.Text = m_arrayFields(i) + ":"
lbl.Location() = New System.Drawing.PointF _

(0.0F, m_currentY)
lbl.Width = 0.9F
lbl.Height = m_defaultHeight
Me.Detail.Controls.Add(lbl)
Dim txt As New TextBox()
txt.DataField = m_arrayFields(i)
txt.Location = New System.Drawing.PointF _

(1.0F, m_currentY)
txt.Width = m_defaultWidth
txt.Height = m_defaultHeight
Me.Detail.Controls.Add(txt)
If m_arrayFields(i) = "UnitPrice" Then

txt.OutputFormat = "$#.00"
End If
m_currentY = m_currentY + m_defaultHeight

End If
Next

Catch ex As Exception
System.Windows.Forms.MessageBox.Show("Error in _
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Report-constructReport: " + ex.Message, "Project Error", _
System.Windows.Forms.MessageBoxButtons.OK, System.Windows _
.Forms.MessageBoxIcon.Error)

End Try
End Sub
//C#
private ArrayList m_arrayFields;
public ArrayList FieldsList
{

set{m_arrayFields = value;}
}
private bool m_useGroups = false;
public bool UseGroups
{

set{m_useGroups = value;}
}
float m_defaultHeight = .2f;
float m_defaultWidth = 4f;
float m_currentY = 0f;
private void constructReport()
{

try
{

this.detail.CanGrow = true;
this.detail.CanShrink = true;
this.detail.KeepTogether = true;
if(m_useGroups)
{

this.Sections.InsertGroupHF();
((GroupHeader)this.Sections["GroupHeader1"]).DataField =

"CategoryID";
this.Sections["GroupHeader1"].BackColor = System.Drawing

.Color.SlateBlue;
this.Sections["GroupHeader1"].CanGrow = true;
this.Sections["GroupHeader1"].CanShrink = true;
((GroupHeader)this.Sections["GroupHeader1"]).RepeatStyle =

RepeatStyle.OnPageIncludeNoDetail;
this.Sections["GroupFooter1"].Height = 0;
TextBox txt = new TextBox();
txt.DataField = "CategoryID";
txt.Location = new System.Drawing.PointF(0f,0);
txt.Width =2f;
txt.Height = .3f;
txt.Style = "font-weight: bold; font-size: 16pt;";
this.Sections["GroupHeader1"].Controls.Add(txt);

}
for(int i=0;i<m_arrayFields.Count;i++)
{

if(!m_useGroups || (m_useGroups && m_arrayFields[i]
.ToString() != "CategoryID"))

{
Label lbl = new Label();
lbl.Text = m_arrayFields[i].ToString() + ":";
lbl.Location = new System.Drawing.PointF

(0f,m_currentY);
lbl.Width =.9f;
lbl.Height = m_defaultHeight;
this.Detail.Controls.Add(lbl);
TextBox txt = new TextBox();
txt.DataField = m_arrayFields[i].ToString();
txt.Location = new System.Drawing.PointF

(1f,m_currentY);
txt.Width =m_defaultWidth;
txt.Height = m_defaultHeight;
this.Detail.Controls.Add(txt);
m_currentY = m_currentY + m_defaultHeight;

}
}
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}
catch(Exception ex)
{

System.Windows.Forms.MessageBox.Show("Error in Report-constructReport:
" + ex.Message,"Project Error",System.Windows.Forms
.MessageBoxButtons.OK,System.Windows.Forms.MessageBoxIcon.Error);

}
}

Adding code to the Windows Form

To add code to the form

l Insert the following code beneath "ActiveReports Designer generated code." 
' Visual Basic
Private Sub fillCheckBox()

For i = 0 To Me.DataSet11.Tables.Count - 1
For c = 0 To Me.DataSet11.Tables(i).Columns.Count - 1

Me.clbFields.Items.Add(Me.DataSet11.Tables(i).Columns(c).ColumnName)
Next

Next
End Sub
Private Sub launchReport()

Dim rpt As New rptFieldsRT()
Try

rpt.FieldsList = m_arrayField
rpt.ds.SQL = Me.OleDbDataAdapter1.SelectCommand.CommandText
rpt.ds.ConnectionString = Me.OleDbConnection1.ConnectionString
Viewer1.Document = rpt.Document
rpt.Run()

Catch ex As Exception
System.Windows.Forms.MessageBox.Show(Me, "Error in launchReport: " _

+ ex.Message, "Project Error", MessageBoxButtons.OK, _
MessageBoxIcon.Error)

End Try
End Sub
//C#
static void Main()
{

Application.Run(new Form1());
}
private string getDatabasePath()
{

RegistryKey regKey = Registry.LocalMachine;
regKey = regKey.CreateSubKey("SOFTWARE\\Data Dynamics\\ActiveReports.NET

\\SampleDB");
return (string)regKey.GetValue("");

}
private void fillCheckBox()
{

for(int i=0;i<this.dataSet11.Tables.Count;i++)
{

for(int c=0;c<this.dataSet11.Tables[i].Columns.Count;c++)
{

this.clbFields.Items.Add(this.dataSet11.Tables[i].Columns[c]
.ColumnName);

}
}

}
ArrayList m_arrayField = new ArrayList();
private void launchReport()
{

try
{

rptFieldsRT rpt = new rptFieldsRT();
rpt.FieldsList = m_arrayField;
rpt.ds.SQL = this.oleDbDataAdapter1.SelectCommand.CommandText;
rpt.ds.ConnectionString = this.oleDbConnection1.ConnectionString;
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this.viewer1.Document = rpt.Document;
rpt.Run();

}
catch(Exception ex)
{

MessageBox.Show(this,"Error in launchReport: " + ex.Message,"Project
Error",MessageBoxButtons.OK,MessageBoxIcon.Error);

}
}

Adding code to the Detail_Format event

To write the code in Visual Basic

l Double-click in the detail section of rptFields. This creates an event-handling method for rptFieldsRT's 
Detail_Format event. 

To write the code in C#

l Double-click in the detail section of rptFields. This creates an event-handling method for rptFieldsRT's 
Detail_Format event. 

The following example shows what the code for the method looks like.

' Visual Basic
Dim m_default
Height As Single = 0.2
Dim m_default
Width As Single = 4
Dim m_currentY As Single = 0
Dim i As Integer
Dim m_count As Integer
Private Sub Detail1_Format(ByVal sender As Object, ByVal e As System.EventArgs) _

Handles Detail1.Format
If m_count Mod 2 = 0 Then

Me.Detail.BackColor = System.Drawing.Color.SlateGray
Else

Me.Detail.BackColor = System.Drawing.Color.DarkSeaGreen
End If
m_count = m_count + 1

End Sub
//C#
int m_count;
private void detail_Format(object sender, System.EventArgs eArgs)
{

if(m_count % 2 ==0)
{

this.detail.BackColor = System.Drawing.Color.SlateGray;
}
else
{

this.detail.BackColor = System.Drawing.Color.DarkSeaGreen;
}
m_count++;

}

Adding code to the ReportStart event

To write the code in Visual Basic

l Double-click in the gray area below rptFieldsRT to create an event-handling method for rptFieldsRT. Add 
code to the handler to: 

l To write the code in C#

l Double-click in the gray area below rptFieldsRT to create an event-handling method for rptFieldsRT. Add 
code to the handler to: 

l Set the data source connection string 

l Set the data source SQL query 
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l Open the connection to create the DataReader 

an event-handling method for rptFieldsRT's ReportStart event. 

The following example shows what the code for the method looks like.

' Visual Basic
Private Sub rptFieldsRT_ReportStart(ByVal sender As Object, ByVal e As _

System.EventArgs) Handles MyBase.ReportStart
constructReport()

End Sub
//C#
private void rptFieldsRT_ReportStart(object sender, System.EventArgs eArgs)
{

constructReport();
}

Adding code for btnGenRep's Click event

To write the code in Visual Basic

l Double-click on btnGenRep. This creates an event-handling method for btnGenRep's Click event. Add the 
following code to the btnGenRep_Click event. 

To write the code in C#

l Double-click on btnGenRep. This creates an event-handling method for btnGenRep's Click event. Add the 
following code to the btnGenRep_Click event. 

The following example shows what the code for the method looks like.

' Visual Basic
Private Sub btnGenRep_Click(ByVal sender As System.Object, ByVal e As System.EventArgs) _

Handles btnGenRep.Click
Me.m_arrayField.Clear()
For i = 0 To Me.clbFields.CheckedItems.Count - 1

m_arrayField.Add(Me.clbFields.CheckedItems(i).ToString)
Next
launchReport()

End Sub
//C#
private void btnGenRep_Click(object sender, System.EventArgs e)
{

this.m_arrayField.Clear();
for(int i=0;i<this.clbFields.CheckedItems.Count;i++)
{

m_arrayField.Add(this.clbFields.CheckedItems[i].ToString());
}
launchReport();

}

Adding code to the clbFields_SelectedIndexChanged event

To write the code in Visual Basic

l Right-click in any section of the Windows Form, and click on View Code to display the code view for the 
Windows Form. At the top left of the code view for the form, click the drop-down arrow and select 
clbFields. At the top right of the code window, click the drop-down arrow and select 
SelectedIndexChanged. This creates an event-handling method for the Form1_SelectedIndexChanged 
event. 

To write the code in C#

l Click in the designer window of the Windows Form to select it. Click on the events icon in the Properties
window to display available events for the section. Double-click SelectedIndexChanged. This creates an 
event-handling method for the Form1_SelectedIndexChanged event. 

The following example shows what the code for the method looks like.

' Visual Basic
Private Sub clbFields_SelectedIndexChanged(ByVal sender As Object, ByVal e _
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As System.EventArgs) Handles CheckedListBox1.SelectedIndexChanged
If Me.clbFields.CheckedItems.Count < 0 Then

Me.btnGenRep.Enabled = False
Else

Me.btnGenRep.Enabled = True
End If

End Sub
//C#
private void clbFields_SelectedIndexChanged(object sender, System.EventArgs e)
{

if(this.clbFields.CheckedItems.Count>0)
{

this.btnGenRep.Enabled = true;
}
else
{

this.btnGenRep.Enabled = false;
}

}

Adding code to the Form1_Load event

To write the code for the viewer in Visual Basic

l Double-click the title bar of the form. This creates an event-handling method for the Form1_Load event. 
Add code to the handler to: 

l Format the viewer to show the report when it is run

To write the code for the viewer in C#

l Double-click the title bar of the form. This creates an event-handling method for the Form1_Load event. 
Add code to the handler to: 

l Format the viewer to show the report when it is run 

The following example shows what the code for the method looks like.

' Visual Basic
Dim i As Integer
Dim c As Integer
Dim m_arrayField As New ArrayList()
Private Sub Form1_Load(ByVal sender As System.Object, ByVal e As System.EventArgs) _

Handles MyBase.Load
Try

Me.OleDbConnection1.ConnectionString = "Provider=Microsoft.Jet.OLEDB.4.0;_
 Data Source=C:\Program Files\Data Dynamics\ActiveReports.NET\Data\ _

NWIND.MDB;Persist Security Info=False"
Me.OleDbDataAdapter1.Fill(Me.DataSet11)
fillCheckBox()

Catch ex As Exception
System.Windows.Forms.MessageBox.Show(Me, "Error in Form_Load: " + ex _

.Message, "Project Error", MessageBoxButtons.OK, MessageBoxIcon.Error)
End Try

End Sub
//C#
private void Form1_Load(object sender, System.EventArgs e)
{

try
{

string m_dbPath = getDatabasePath();
this.oleDbConnection1.ConnectionString = "Provider=Microsoft.Jet

.OLEDB.4.0; Data Source=" + m_dbPath + "\\the Northwind database;Persist 
Security Info=False";

this.oleDbDataAdapter1.Fill(this.dataSet11);
fillCheckBox();

}
catch(Exception ex)
{

MessageBox.Show(this,"Error in Form_Load: " + ex.Message,"Project 
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Error", MessageBoxButtons.OK,MessageBoxIcon.Error);
}

}

Viewing the report

To view the report

1. Add the ActiveReports viewer control to a Windows Form. 

2. Add the code needed to set the viewer document equal to the report document. See Using the 
ActiveReports WinForm Viewer for help. 

Note: You can quickly view your report at design time by clicking the Preview tab at the bottom of the 
designer.

ActiveReports allows you to change the data source of a report at run time based on the location of the 
sample database file on the user's computer.

This walkthrough illustrates how to set up a report to set a report's data source at run time.

This walkthrough is split up into the following activities: 

l Adding an ActiveReport to a Visual Studio project 

l Connecting the report to a data source 

l Adding controls to the report to contain data 

l Adding code to set the database path 

l Adding code to the ReportStart event to change data source at run time 

l Viewing the report  

To complete the walkthrough, you must have access to the Northwind database. For your convenience, a 
copy is included with ActiveReports at the following default location: C:\Program Files\Data 
Dynamics\ActiveReports for .NET 3.0\Data\NWIND.MDB.

Adding an ActiveReport to your project

To add an ActiveReport to your project

1. Open a new project in Visual Studio. 

2. From the Project menu, select Add New Item. 

3. Select ActiveReports 3.0 File and rename the file rptModifyDS. 

4. Click Open. 

Connecting the data source to a database

To connect the data source to a database

1. Click on the gray report DataSource icon in the Detail section to open the report DataSource dialog. 

2. Click on Build.

3. Select "Microsoft Jet 4.0 OLE DB Provider" and click Next .

4. Click the ellipsis button to browse for the access path to the Northwind database. Click Open once you 
have selected the appropriate access path. 

5. Click OK to continue. 

6. In the Query field, type "Select * from products". 

7. Click OK to return to the report design surface. 

Adding controls to contain data

Walkthrough: Modifying the Report Data Source at Run Time
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To add controls to the report

l In the Report Explorer, expand the Fields node, then the Bound node. Drag the following fields onto the 
detail section and set the following properties of each textbox as indicated. 

Adding code to set the database path

To write the code in Visual Basic

l Right-click in any section of the design window of rptModifyDS, and click on View Code to display the 
code view for the report. Underneath the "Imports System" at the top of the code view, add "Imports 
Microsoft.Win32;". Beneath "ActiveReports Designer Generated Code", type the following: "Private 
Function getDatabasePath() As String" and hit "Enter." This creates a function for getDatabasePath. 

To write the code in C#

l Click in the gray area below rptModifyDS and click on View Code to display the code view for the report. 
Underneath the "using System;" at the top of the code view, add "using Microsoft.Win32;". Beneath 
"ActiveReports Designer Generated Code", type the following: "private string getDatabasePath()". This 
creates a function for getDatabasePath. 

The following example shows what the code for the function looks like.

' Visual Basic
Private Function getDatabasePath() As String
Dim regKey As RegistryKey

regKey = Registry.LocalMachine
regKey = regKey.CreateSubKey("SOFTWARE\\Data Dynamics\\ActiveReports for .NET _
2.0\\SampleDB")
getDatabasePath = CType(regKey.GetValue(""), String)

End Function
//C#
private string getDatabasePath()
{

RegistryKey regKey = Registry.LocalMachine;
regKey = regKey.CreateSubKey("SOFTWARE\\Data Dynamics\\ActiveReports for .NET 

2.0\\SampleDB");
return (string)regKey.GetValue("");

}

Adding code to the ReportStart event

To write the code in Visual Basic

l Right-click in any section of the design window of rptModifyDS, and click on View Code to display the 
code view for the report. At the top left of the code view for rptModifyDS, click the drop-down arrow and 
select (Base Class Events). At the top right of the code window, click the drop-down arrow and select 
ReportStart. This creates an event-handling method for rptModifyDS's ReportStart event. Add code to the 
handler to: 

l Change the data source at run time 

To write the code in C#

l Click in the gray area below rptModifyDS to select the report. Click on the events icon in the Properties
window to display available events for the report. Double-click ReportStart. This creates an event-
handling method for rptModifyDS's ReportStart event. Add code to the handler to: 

Field Text Location OutputFormat

ProductID Product ID 0, 0.625 NA

ProductName Product Name 1.125, 0.0625 NA

UnitsInStock Units In Stock 2.25, 0.0625 NA

UnitsOnOrder Units On Order 3.375, 0.0625 NA

UnitPrice Unit Price 4.5, 0.0625 Currency
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l Change the data source at run time 

The following example shows what the code for the method looks like.

' Visual Basic
Dim m_cnn As OleDbConnection
Dim m_dbpath As String
Dim m_cnnString As String
Dim sqlString As String
Private Sub rptModifyDS_ReportStart(ByVal sender As Object, ByVal e As System.EventArgs) _

Handles MyBase.ReportStart
m_dbpath = getDatabasePath()
m_cnnString = "Provider=Microsoft.Jet.OLEDB.4.0;Data Source=" + m_dbpath + "\\the NorthWind database"
sqlString = "SELECT * from products" m_cnn = New OleDbConnection(m_cnnString)
If m_cnn.State = ConnectionState.Closed Then

m_cnn.Open()
End If

 
m_reader = m_Cmd.ExecuteReader()
Me.DataSource = m_reader

End Sub
//C#
private static OleDbConnection m_cnn;
private static OleDbDataReader  m_reader;
private void rptModifyDS_ReportStart(object sender, System.EventArgs eArgs)
{

string m_dbPath = getDatabasePath();
string m_cnnString = "Provider=Microsoft.Jet.OLEDB.4.0;Data Source=" + m_dbPath 

+ "\\the NorthWind database";
string sqlString = "SELECT * from products";
m_cnn = new OleDbConnection(m_cnnString);
if(m_cnn.State == ConnectionState.Closed)
{

m_cnn.Open();
}

 
m_reader = m_Cmd.ExecuteReader();
this.DataSource = m_reader;

}

Viewing the report

To view the report

1. Add the ActiveReports viewer control to a Windows Form. 

2. Add the code needed to set the viewer document equal to the report document. See Using the 
ActiveReports WinForm Viewer for help. 

Note: You can quickly view your report at design time by clicking the Preview tab at the bottom of the 
designer.

ActiveReports allows you to save and load a report as a memory stream. Saving a report as a memory 
stream makes it possible to save and load reports from a database or pass reports back and forth between 
DLLs. 

This walkthrough is split up into the following activities: 

l Adding an ActiveReport to a Visual Studio project 

l Connecting the report to a data source 

l Adding controls to the report to contain data 

l Adding the viewer to Form1 

l Adding code to the Form_Load event to save the report to a memory stream and load it to the viewer 

Walkthrough: Saving and Loading to a Memory Stream
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To complete the walkthrough, you must have access to the Northwind database. For your convenience, a 
copy is included with ActiveReports at the following default location: C:\Program Files\Data 
Dynamics\ActiveReports for .NET 3.0\Data\NWIND.MDB.

When you have completed this walkthrough, you will have a report that looks similar to the following.

Adding an ActiveReport to a Visual Studio project

To add an ActiveReport to your project

1. Open a new project in Visual Studio. 

2. From the Project menu, select Add New Item. 

3. Select ActiveReports 3.0 File and rename the file rptMemoryStream. 

4. Click Open. 

Connecting the report to a data source

To connect the report to a data source

1. Click on the gray report DataSource icon in the Detail section to open the report DataSource dialog. 

2. Click on Build.

3. Select Microsoft Jet 4.0 OLE DB Provider and click Next.

4. Click the ellipsis button to browse for the access path to the NorthWind database. Click Open once you 
have selected the appropriate access path. 

5. Click OK to continue. 

6. In the Query field, type "Select * from customers ORDER BY country". 

ActiveReports for .NET 3 User Guide | 331



7. Click OK to return to the report design surface. 

Adding controls to the report to contain data

To add controls to the report

1. Add a GroupHeader/Footer section to rptMemoryStream. 

2. Make the following changes to the group header: 

¡ Change the name to ghCustomers 

¡ Change the DataField property to Country 

3. Add the following controls to the rptMemoryStream: 

Adding the viewer to Form1

To add the viewer to Form1

1. Click on the ActiveReports viewer control in the appropriate toolbox and drag it onto Form1. 

2. Set the viewer control's Dock property to Fill. 

Adding  code to the Form1_Load event

To write the code in Visual Basic

l Double-click Form1 to create an event-handling method for the Form1_Load event. Add code to the 
handler to: 

l Save the report to a memory stream 

l Load the memory stream to the ActiveReports viewer 

To write the code in C#

l Double-click Form1 to create an event-handling method for the Form1_Load event. Add code to the 
handler to: 

l Save the report to a memory stream 

l Load the memory stream to the ActiveReports viewer 

The following example shows what the code for the method looks like.

'Visual Basic
Private Sub Form1_Load(ByVal sender As System.Object, ByVal e As System.EventArgs) _

Handles MyBase.Load
Dim strm As New System.IO.MemoryStream()
Dim rpt As New rptMemoryStream()
rpt.Run()
rpt.Document.Save(strm)
Dim theBytes(strm.Length) As Byte
strm.Read(theBytes, 0, Int(strm.Length))
strm.Position = 0
Viewer1.Document.Load(strm)

End Sub
//C#

Control DataField Name Text Section Location

TextBox Country txtCountry Country GroupHeader 0, 0

TextBox CustomerID txtCustomerID Customer ID Detail 0, 0

TextBox CompanyName txtCompanyName Company 
Name

Detail 1.125, 0

TextBox Address txtAddress Address Detail 3.01, 0

TextBox City txtCity City Detail 4.375, 0

TextBox Phone txtPhone Phone Detail 5.437, 0
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private void Form1_Load(object sender, System.EventArgs e)
{

System.IO.MemoryStream strm = new System.IO.MemoryStream();
rptMemoryStream rpt = new rptMemoryStream();
rpt.Run();
rpt.Document.Save(strm);
byte[] theBytes = new byte[strm.Length];
strm.Read(theBytes, 0, (int)strm.Length);
strm.Position =0;
viewer1.Document.Load(strm);

}

ActiveReports allows you to use scripting to provide ease in reporting functionality. Scripting permits reports 
saved to an RPX file to contain code. This characteristic allows the options of stand-alone reporting and web 
reporting without requiring .vb or .cs files. By including scripting when the report is saved as an RPX file, it 
can later by loaded, run and displayed directly to the viewer control without using the designer. Scripting can 
also be used in conjunction with RPX files to allow distributed reports to be updated without recompiling.

 

Scripting and Simple Reports
Describes how to use scripting to create a simple stand-alone report. 

Scripting and Subreports
Describes how to use scripting to create a subreport. 

ActiveReports allows you to use scripting to permit reports saved to an XML file to contain code. By including 
scripting when the reports are saved into XML, the reports later can be loaded, run and displayed directly in 
the viewer control without the use of the designer. 

This walkthrough illustrates how to include scripting in a report.

This walkthrough is split into the following activities: 

l Adding an ActiveReport to a Visual Studio project 

l Adding controls to contain the data 

l Adding scripting to supply data for the controls 

l Viewing the report  

To complete the walkthrough, you must have access to the Northwind database. For your convenience, a 
copy is included with ActiveReports at the following default location: C:\Program Files\Data 
Dynamics\ActiveReports for .NET 3.0\Data\NWIND.MDB.

When you have completed this walkthrough, you will have a report that looks similar to the following.

Scripting Walkthroughs

Walkthrough: Scripting and Simple Reports
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Adding an ActiveReport to a Visual Studio project

To add an ActiveReport to your project

1. Open a new project in Visual Studio. 

2. From the Project menu, select Add New Item. 

3. Select ActiveReports 3.0 File and rename the file rptScript. 

4. Click Open. 

Adding controls to the report to contain data

To add controls to the report

1. Add a GroupHeader/Footer section to your report. 

2. Make the following changes to the group header: 

¡ Change the Name property to ghCategories

¡ Change the BackColor property to LightBlue

¡ Change the CanShrink property to True

¡ Change the DataField property to CategoryID

¡ Set the GroupKeepTogether property to All

¡ Set the KeepTogether property to True

3. Add the following controls to the GroupHeader section: 
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4. Set the CanShrink property of the detail section to True and add text boxes with the following 
properties.  

5. Select both of the text boxes in the detail section, right-click and choose Format Border. 

¡ Select dark teal in the color combo box 

¡ Select the dotted line in the Line Styles pane 

¡ Click the bottom edge in the Preview pane 

¡ Click the OK button to add a dotted line to the bottom edge of the text boxes.

6. Make the following changes to the group footer: 

¡ Change the Name property to gfCategories

¡ Change the BackColor property to PaleGreen

¡ Change the CanShrink property to True

7. Add the following controls to the GroupFooter section: 

Adding scripting to supply data for the controls

To add scripting to the report

1. Click the Script tab located below the report designer to access the scripting editor. 

Control DataField Name Text Location Size Miscellaneous

TextBox CategoryName txtCategoryName Category 
Name 

0, 0 6.5, 
0.2

BackColor = 
CadetBlue; 
Font Style = 
Bold; Font Size 
= 12

TextBox Description txtDescription Description 0, 0.2 6.5, 
0.2

BackColor = 
CadetBlue; 
Font Style = 
Bold

Label lblProductName Product 
Name 

0, 0. 1, 
0.2

Font Style = 
Bold

Label  lblUnitsInStock Units in 
Stock 

5.5, 0.4 1, 
0.2

Font Style = 
Bold; 
Alignment = 
Right

DataField Name Text Location Size Alignment

ProductName txtProductName Product Name 0, 0 5.5, 0.19

UnitsInStock txtUnitsInStock Units in Stock 5.5, 0 1, 0.19 Right

Control DataField Name Text Miscellaneous Location

Label TotalLabel lblTotalLabel Total: Size = 3, 0.19; Font Style 
= Bold

2.5, 0

TextBox ProductName txtTotalItems Total 
Items

SummaryType = 
Subtotal; SummaryFunc 
= Count; 
SummaryRunning = 
Group; SummaryGroup = 
ghCategories; Alignment 
= Right

5.5, 0

Label lblWhiteSpace (delete 
default 
text)

BackColor = White; Size 
= 6.5, 0.2

0, 0.25
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2. Add the scripting code. 

The following example shows what the scripting code looks like.

'VB.NET
Private Shared m_reader As System.Data.OleDb.OleDbDataReader

Private Function getDatabasePath() As String
Dim regKey As Microsoft.Win32.RegistryKey = Microsoft.Win32.Registry.LocalMachine
regKey = regKey.CreateSubKey("SOFTWARE\Data Dynamics\ActiveReports.NET\SampleDB")
Return CType(regKey.GetValue(""), String)
End Function

Public Sub ActiveReport_ReportStart()
Dim databasePath As String = getDatabasePath
Dim connectionString As String = "Provider=Microsoft.Jet.OLEDB.4.0;Data Source=C:\Program Files\Data Dynamics\ActiveReports for .NET 3.0\Data\NWIND.mdb;Persist Security Info=False"

Dim sqlString As String = "SELECT * FROM categories INNER JOIN products ON categories.categoryid = products.categoryid ORDER BY products.categoryid, products.productid"
 

Dim m_cnn As System.Data.OleDb.OleDbConnection = new System.Data.OleDb.OleDbConnection(connectionString)
Dim m_Cmd As System.Data.OleDb.OleDbCommand = new System.Data.OleDb.OleDbCommand(sqlString, m_cnn)
 
If m_cnn.State = System.Data.ConnectionState.Closed Then

m_cnn.Open
End If
m_reader = m_Cmd.ExecuteReader

End Sub

Public Sub ActiveReport_DataInitialize()
rpt.Fields.Add("CategoryID")
rpt.Fields.Add("CategoryName")
rpt.Fields.Add("ProductName")
rpt.Fields.Add("UnitsInStock")
rpt.Fields.Add("Description")
rpt.Fields.Add("TotalLabel")

End Sub

Public Function ActiveReport_FetchData(ByVal eof As Boolean) As Boolean
Try

m_reader.Read
rpt.Fields("CategoryID").Value = m_reader("categories.CategoryID")
rpt.Fields("CategoryName").Value = m_reader("CategoryName")
rpt.Fields("ProductName").Value = m_reader("ProductName")
rpt.Fields("UnitsInStock").Value = m_reader("UnitsInStock")
rpt.Fields("Description").Value = m_reader("Description")
rpt.Fields("TotalLabel").Value = "Total Number of " + m_reader("CategoryName")+ " Units:"
eof = False

Catch
eof = True

End Try
Return eof
End Function

//C#
private static System.Data.OleDb.OleDbDataReader  m_reader;
 
private string getDatabasePath()
{

Microsoft.Win32.RegistryKey regKey = Microsoft.Win32.Registry.LocalMachine;
regKey = regKey.CreateSubKey(@"SOFTWARE\\Data Dynamics\\ActiveReports.NET\\SampleDB");
return (string)regKey.GetValue("");

}
public void ActiveReport_ReportStart()
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{
string m_dbPath = getDatabasePath();
string m_cnnString = @"Provider=Microsoft.Jet.OLEDB.4.0;Data Source=C:\Program 

 Files\Data Dynamics\ActiveReports for .NET 3.0\Data\NWIND.mdb;Persist 
Security Info=False";

string sqlString = "SELECT * FROM categories INNER JOIN products ON 
categories.categoryid = products.categoryid ORDER BY products.categoryid, 
products.productid";
System.Data.OleDb.OleDbConnection m_cnn = new System.Data.OleDb.OleDbConnection

(m_cnnString);
System.Data.OleDb.OleDbCommand m_Cmd = new System.Data.OleDb.OleDbCommand

(sqlString,m_cnn);
if(m_cnn.State == System.Data.ConnectionState.Closed)
{

m_cnn.Open();
}
m_reader = m_Cmd.ExecuteReader();

}
 
public void ActiveReport_DataInitialize()
{

rpt.Fields.Add("CategoryID");
rpt.Fields.Add("CategoryName");
rpt.Fields.Add("ProductName");
rpt.Fields.Add("UnitsInStock");
rpt.Fields.Add("Description");
 rpt.Fields.Add("TotalLabel");

}
 
public bool ActiveReport_FetchData(bool eof)
{

try
{

m_reader.Read();
rpt.Fields["CategoryID"].Value = m_reader["categories.CategoryID"]

.ToString();
rpt.Fields["CategoryName"].Value = m_reader["CategoryName"]

.ToString();
rpt.Fields["ProductName"].Value = m_reader["ProductName"].ToString();
rpt.Fields["UnitsInStock"].Value = m_reader["UnitsInStock"]

.ToString();
rpt.Fields["Description"].Value = m_reader["Description"].ToString();
rpt.Fields["TotalLabel"].Value = "Total Number of " + m_reader

["CategoryName"].ToString() + " Units:";
eof = false;

}
catch

{
eof = true;

}
 

return eof;
}

3. To save the report to RPX (Report XML) format, open the Report menu, select Save Layout, and choose 
either Arnet 3 Format or Arnet Format. 

Viewing the report

To view the report

1. Add the ActiveReports viewer control to a Windows Form. 

2. Add the code needed to set the viewer document equal to the report document. See Using the 
ActiveReports WinForm Viewer for help. 

Note: You can quickly view your report at design time by clicking the Preview tab at the bottom of the 
designer.
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ActiveReports allows you to use scripting to permit reports saved to an XML file to contain code. By including 
scripting when reports are saved into XML, the reports later can be loaded, run and displayed directly to the 
viewer control without needing to use the designer. 

This walkthrough illustrates how to use scripting when creating a subreport.

This walkthrough is split up into the following activities: 

Adding two ActiveReports to a Visual Studio project 

l Connecting the subreport to a data source 

l Temporarily connection the main report to a data source 

l Adding controls to each report to display the data 

l Saving the rptSub layout to RPX format 

l Adding the scripting code for rptMain 

l Saving the rptMain layout to RPX format 

l Viewing the report 

To complete the walkthrough, you must have access to the Northwind database. For your convenience, a 
copy is included with ActiveReports at the following default location: C:\Program Files\Data 
Dynamics\ActiveReports for .NET 3.0\Data\NWIND.MDB.

When you have finished this walkthrough, you will have a report that looks similar to the following.

Adding two ActiveReports to a Visual Studio project

To add two ActiveReports to a Visual Studio project

1. Open a new project in Visual Studio. 

Walkthrough: Scripting and Subreports
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2. From the Project menu, select Add New Item. 

3. Select ActiveReports 3.0 File and rename the file rptMain. 

4. Click Open. 

5. From the Project menu, select Add New Item. 

6. Select ActiveReports 3.0 File and rename the file rptSub. 

7. Click Open. 

8. Right-click the page header of rptSub and select Delete. (Page headers and footers are not displayed in 
subreports, so it is a good practice to delete them and save on processing.) 

9. Select rptSub in the Properties window and set the ShowParameterUI property to False. (This step 
prevents ActiveReports from requesting a parameter value from the user at run time.)

Connecting the subreport to a data source

To connect the subreport to a data source

1. Click on the gray report DataSource icon in the Detail section to open the report DataSource dialog. 

2. Click on Build.

3. Select Microsoft Jet 4.0 OLE DB Provider and click Next.

4. Click the ellipsis button to browse for the access path to the NorthWind database. Click Open once you 
have selected the appropriate access path. 

5. Click OK to continue. 

6. In the Query field, type "Select * from [order details] inner join products on [order details].productid = 
products.productid". 

Note: We will add parameters to the query in the script of rptMain.

7. Click OK to return to the report design surface. 

Temporarily connecting the main report to a data source

To connect the main report to a data source

1. Click on the gray report DataSource icon in the Detail section to open the report DataSource dialog. 

2. Click on Build.

3. Select Microsoft Jet 4.0 OLE DB Provider and click Next.

4. Click the ellipsis button to browse for the access path to the NorthWind database. Click Open once you 
have selected the appropriate access path. 

5. Click OK to continue. 

6. In the Query field, type "Select * from orders inner join customers on orders.customerid = 
customers.customerid order by CompanyName,OrderDate". 

Note: This step is just for convenience so that we can populate the fields list in the Report Explorer 
at design time.

7. Click OK to return to the report design surface. 

Adding controls to each report to display the data

To add controls to rptMain

1. Add a GroupHeader/Footer section to rptMain. 

2. Make the following changes to the group header: 

¡ Change the Name property to ghCompanies 

¡ Change the BackColor property to LemonChiffon

¡ Change the CanShrink property to True

¡ Change the DataField property to CompanyName

¡ Change the GroupKeepTogether property to All
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3. In the Report Explorer, expand the Fields node, then the Bound node. Drag the following field 
onto ghCompanies and set the properties as indicated.  

4. Add a second GroupHeader/Footer section to rptMain. 

5. Make the following changes to the group header: 

¡ Change the Name property to ghOrders

¡ Change the BackColor property to LightYellow

¡ Change the CanShrink property to True

¡ Change the DataField property to OrderDate

¡ Change the GroupKeepTogether property to All

6. Drag the following fields and controls onto ghOrders and set the properties as indicated.   

7. Change the CanShrink property of the detail section to True. 

8. Drag the following control onto the detail section and set the properties as indicated. 

Note: The path of the RPX will be set later.

To add controls to rptSub

1. Add a GroupHeader/Footer section to rptSub. 

2. Make the following changes to the group header: 

¡ Change the Name property to ghOrderDetails

¡ Change the BackColor property to LightSteelBlue

¡ Change the CanShrink property to True

¡ Change the DataField property to OrderID

3. Add four label controls to ghOrderDetails and set the properties as follows: 

4. Add four line controls to ghOrderDetails and set the properties as follows: 

Field Name Miscellaneous Size Location

CompanyName txtCompanyName1 Font Style = Bold; Font Size = 
12 

4, 
0.2 

0, 0 

Control DataField Name Text Miscellaneous Location

TextBox OrderDate txtOrderDate1 Order 
Date 

OutputFormat = 
MM/dd/yy

1.13, 0 

TextBox RequiredDate txtRequiredDate1 Required 
Date 

OutputFormat = 
MM/dd/yy

3.5, 0 

TextBox ShippedDate txtShippedDate1 Shipped 
Date 

OutputFormat = 
MM/dd/yy

5.5, 0 

Label lblOrderDate Ordered: Font Style = Bold 0, 0 

Label lblRequiredDate Required: Font Style = Bold 2.5, 0 

Label lblShippedDate Shipped: Font Style = Bold 4.875, 0 

Control ReportName Name Text Size Location

Subreport C:\full project path\rptSub.rpx SubReport1 6.5, 0.2 0, 0 

Font Style Name Text Alignment Location

Bold lblProductName Product Name 0, 0 

Bold lblQuantity Quantity Right 3.25, 0 

Bold lblUnitPrice Unit Price Right 4.38, 0 

Bold lblDiscount Discount Right 5.5, 0 
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5. Make the following changes to the detail section: 

¡ Change the BackColor property to Gainsboro

¡ Change the CanShrink property to True

6. Drag the following fields onto the detail section and set the properties as indicated. 

7. Add four line controls to the detail section and set the properties as follows (or copy and paste them from 
ghOrderDetails): 

 

Saving the rptSub layout to RPX format

To save the layout to RPX format

1. While in the design view of rptSub, open the Report menu and select Save Layout. 

2. Navigate to your project folder and save the report as rptSub.rpx. 

3. Leave the Save as type combo box set to Arnet 3 Format (*rpx). 

4. Click the Save button. 

5. Use Windows Explorer to navigate to rptSub.rpx and ensure that the subreport control in rptMain has the 
ReportName property set to the full path.

Adding the scripting code for rptMain

To add scripting to the report

1. Below the report designer, you will find three tabs. Click on the Script tab to expose the Script editor. 

2. Add the following scripting code. 

Name X1 X2 Y1 Y2

Line1 3.1875 3.1875 0 0.1875

Line2 4.3125 4.3125 0 0.1875

Line3 5.4375 5.4375 0 0.1875

Line4 0 6.5 0.1875 0.1875

Field Name Alignment Miscellaneous Location

ProductName txtProductName1 Right Size = 3.15, 0.19 0, 0

Quantity txtQuantity1 Right 3.25, 0

products.UnitPrice txtproducts_UnitPrice1 Right OutputFormat = 
Currency

4.4, 0

Discount txtDiscount1 Right OutputFormat = 
Currency; Size = 
0.95, 0.19

5.5, 0

Name X1 X2 Y1 Y2

Line5 3.1875 3.1875 0 0.1875

Line6 4.3125 4.3125 0 0.1875

Line7 5.4375 5.4375 0 0.1875

Line8 0 6.5 0.1875 0.1875
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The following example shows what the scripting code looks like.

'VB.NET
Public Sub ActiveReport_ReportStart()

Dim connectionString As String = "Provider=Microsoft.Jet.OLEDB.4.0;Data Source=C:\Program Files\Data Dynamics\ActiveReports For .NET 3.0\Data\NWIND.mdb;Persist Security Info=False"
Dim sqlString As String = "Select * from orders inner join customers on orders.customerid = customers.customerid order by CompanyName,OrderDate"
Dim ds As New DataDynamics.ActiveReports.DataSources.OleDBDataSource()
ds.ConnectionString = connectionString
ds.SQL = sqlString
rpt.DataSource = ds

End Sub

Public Sub Detail1_Format()
Dim rptSubCtl As DataDynamics.ActiveReports.SubReport = CType(rpt.Sections("Detail1").Controls("SubReport1"), DataDynamics.ActiveReports.SubReport)
Dim rptSub As new DataDynamics.ActiveReports.ActiveReport3()
rptSub.LoadLayout(CType(rpt.Sections("Detail1").Controls("SubReport1"), DataDynamics.ActiveReports.SubReport).ReportName)
Dim childDataSource As New DataDynamics.ActiveReports.DataSources.OleDBDataSource()
childDataSource.ConnectionString = rpt.DataSource.ConnectionString
childDataSource.SQL = "Select * from [order details] inner join products on [order details].productid = products.productid where [order details].orderid = " + orderIDString
rptSub.DataSource = childDataSource
rptSubCtl.Report = rptSub

End Sub

Dim orderIDString As String
Sub ActiveReport_FetchData(byref EOF As Boolean)

orderIDString = rpt.Fields("OrderID").Value
End Sub
 
//C#
public void ActiveReport_ReportStart()
{

string connectionString = "Provider=Microsoft.Jet.OLEDB.4.0;Data Source=C:\Program Files\Data Dynamics\ActiveReports For .NET 3.0\Data\NWIND.mdb;Persist Security Info=False";
string sqlString = "Select * from orders inner join customers on 

orders.customerid = customers.customerid order by CompanyName,OrderDate";
DataDynamics.ActiveReports.DataSources.OleDBDataSource ds = new DataDynamics

.ActiveReports.DataSources.OleDBDataSource();
ds.ConnectionString = connectionString;
ds.SQL = sqlString;
rpt.DataSource = ds;

}
public void detail_Format() 
{ 

DataDynamics.ActiveReports.SubReport rptSubCtl = ((DataDynamics.ActiveReports.SubReport)(rpt.Sections("detail").Controls("SubReport1")));
DataDynamics.ActiveReports.ActiveReport3 rptSub = new DataDynamics.ActiveReports.ActiveReport3(); 
rptSub.LoadLayout(((DataDynamics.ActiveReports.SubReport)(rpt.Sections("detail").Controls("SubReport1"))).ReportName); 
DataDynamics.ActiveReports.DataSources.OleDBDataSource childDataSource = new DataDynamics.ActiveReports.DataSources.OleDBDataSource();
childDataSource.ConnectionString = rpt.DataSource.ConnectionString; 
childDataSource.SQL = "Select * from [order details] inner join products on [order details].productid = products.productid where [order details].orderid = " + orderIDString; 
rptSub.DataSource = childDataSource; 
rptSubCtl.Report = rptSub; 

} 

string orderIDString; 
void ActiveReport_FetchData(ref bool EOF) 
{ 

orderIDString = rpt.Fields("OrderID").Value; 
}

3. Click OK to continue. 

Saving the rptMain layout to RPX format

To save the rptMain layout to RPX format

1. With the design view of the report visible, open the Report menu and select Save Layout. 

2. Choose either Arnet 3 Format or Arnet Format (for backward compatibility).

Viewing the report
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To view the report

1. Add the ActiveReports viewer control to a Windows Form. 

2. Add the code needed to set the viewer document equal to the report document. See Using the 
ActiveReports WinForm Viewer for help. 

Note: You can quickly view your report at design time by clicking the Preview tab at the bottom of the 
designer.

Included with the ActiveReports Excel export filter is the SpreadBuilder API. With this utility, you can create 
Excel spreadsheets cell by cell for maximum control. 

This walkthrough illustrates how to create a custom spreadsheet cell by cell, and save it to an Excel file.

This walkthrough is split up into the following activities: 

l Adding the Excel export filter to your project 

l Creating a Workbook, and adding a sheet to the Workbook's Sheets collection 

l Setting properties on columns and rows in the sheet 

l Setting values of cells in the sheet  

l Using the Save method to create an Excel file 

When you have completed this walkthrough, you will have created a custom Excel file which can be found in 
the Bin/Debug (C#) or Bin (VB.NET) subfolder of your project's folder.

 

Adding the export filter to your project

To add the export filter to your project

1. Click on the XlsExport export control in the appropriate toolbox to select it. 

2. Drag the control onto the Windows Form. 

3. The control will appear in the tray underneath the Windows Form. 

Creating a Workbook

To write the code in Visual Basic

l Double-click Form1 to create an event-handling method for the Form1_Load event. Add code to the 
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handler to: 

l Create a Workbook, and add a sheet to the Workbook's Sheets collection 

l Set properties on columns and rows in the sheet 

l Set values of cells in the sheet 

l Use the Save method to create an Excel file

To write the code in C#

l Double-click Form1 to create an event-handling method for the Form1_Load event. Add code to the 
handler to: 

l Create a Workbook, and add a sheet to the Workbook's Sheets collection 

l Set properties on columns and rows in the sheet 

l Set values of cells in the sheet 

l Use the Save method to create an Excel file 

The following example shows what the code for the method looks like.

'Visual Basic
Private Sub Form1_Load(ByVal sender As System.Object, ByVal e As System.EventArgs) _ 

Handles MyBase.Load
'Dimension a Workbook and add a sheet to its Sheets collection
Dim sb As New DataDynamics.SpreadBuilder.Workbook()
sb.Sheets.AddNew()
'Set up properties and values for columns, rows and cells as desired
With sb.Sheets(0)

.Name = "Customer Call List"

.Columns(0).Width = 2 * 1440

.Columns(1).Width = 1440

.Columns(2).Width = 1440

.Rows(0).Height = 1440 / 4
'Header row
.Cell(0, 0).SetValue("Company Name")
.Cell(0, 0).FontBold = True
.Cell(0, 1).SetValue("Contact Name")
.Cell(0, 1).FontBold = True
.Cell(0, 2).SetValue("Phone")
.Cell(0, 2).FontBold = True
'First row of data
.Cell(1, 0).SetValue("Data Dynamics")
.Cell(1, 1).SetValue("Mortimer")
.Cell(1, 2).SetValue("(614) 895-3142")

End With
'Save the Workbook to an Excel file
sb.Save(Application.StartupPath & "\x.xls")
MsgBox("Your Spreadsheet has been saved to " & Application.StartupPath & _ 

"\x.xls")
End Sub
//C#
private void Form1_Load(object sender, System.EventArgs e)
{

//Dimension a Workbook and add a sheet to its Sheets collection
DataDynamics.SpreadBuilder.Workbook sb = new DataDynamics.SpreadBuilder

.Workbook();
sb.Sheets.AddNew();
//Set up properties and values for columns, rows and cells as desired
sb.Sheets[0].Name = "Customer Call List";
sb.Sheets[0].Columns(0).Width = 2 * 1440;
sb.Sheets[0].Columns(1).Width = 1440;
sb.Sheets[0].Columns(2).Width = 1440;
sb.Sheets[0].Rows(0).Height = 1440/4;
//Header row
sb.Sheets[0].Cell(0,0).SetValue("Company Name");
sb.Sheets[0].Cell(0,0).FontBold = true;
sb.Sheets[0].Cell(0,1).SetValue("Contact Name");
sb.Sheets[0].Cell(0,1).FontBold = true;
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sb.Sheets[0].Cell(0,2).SetValue("Phone");
sb.Sheets[0].Cell(0,2).FontBold = true;
//First row of data
sb.Sheets[0].Cell(1,0).SetValue("Data Dynamics");
sb.Sheets[0].Cell(1,1).SetValue("Mortimer");
sb.Sheets[0].Cell(1,2).SetValue("(614) 895-3142");
//Save the Workbook to an Excel file
sb.Save (Application.StartupPath + @"\x.xls");
MessageBox.Show("Your Spreadsheet has been saved to " + Application.StartupPath 

+ @"\x.xls");
}

ActiveReports adds style class names to allow controls to be formatted easily. With the use of style sheets, 
groups of controls can be set to a single style with just a few clicks. ClassName and the different controls' 
Style property can also be used to create specialized styles in code and through scripting. 

This walkthrough illustrates how to create and use style sheets in a  report.

This walkthrough is split up into the following activities:  

l Opening an existing ActiveReport 

l Creating style sheets 

l Using created style sheets in your report at design time 

l Using created style sheets in your report at run time 

l Viewing the report  

Opening an existing ActiveReport

To open an existing ActiveReport   

1. Click Open > Project. 

2. Select your ActiveReport project from the appropriate location and click on it to select it. 

3. Click Open. 

Creating Style Sheets

To create a style sheet

1. Click anywhere on the report design surface to select it. 

2. Click on Report > Settings. 

3. Click on Styles to display the style sheet. 

4. Select New to add a new style, or select a predefined style to modify. 

5. Name the new style "MyNewStyle" and select a base style. 

6. Modify the properties to set up the desired effect and click OK . 

Using Created Style Sheets in a Report at Design Time

To use a created style sheet at design time

1. Click on the control to which you wish to apply the style. 

2. Select "MyNewStyle" from the style sheets drop-down box. 

3. The new style is applied to your selected control. 

Using Created Style Sheets in a Report at Run Time

To write the code in Visual Basic

l Right-click in any section of the design window of your report, and click on View Code to display the 
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code view for the report. At the top left of the code view for the report, click the drop-down arrow and 
select Detail. At the top right of the code window, click the drop-down arrow and select Format. This 
creates an event-handling method for the report's Detail_Format event. Add code to the handler to: 

l Update the selected control with the style sheet chosen 

To write the code in C#

l Click in the Detail section of your report to select it. Click on the events icon in the Properties window to 
display available events for the section. Double-click Format. This creates an event-handling method for 
the report's Detail_Format event. Add code to the handler to: 

l Update the selected control with the style sheet chosen

The following example shows what the code for the method looks like.

'Visual Basic
Private Sub Detail_Format(ByVal sender As Object, ByVal e As System.EventArgs) Handles Detail.Format

Me.TextBox1.ClassName = "MyNewStyle"
End Sub
//C#
private void Detail_Format(object sender, System.EventArgs eArgs)
{

this.TextBox1.ClassName = "MyNewStyle";
}

Viewing the report

To view the report

1. Add the ActiveReports viewer control to a Windows Form. 

2. Add the code needed to set the viewer document equal to the report document. See Using the 
ActiveReports WinForm Viewer for help. 

Note: You can quickly view your report at design time by clicking the Preview tab at the bottom of the 
designer.

With ActiveReports, reports may contain any number of child reports by using the Subreport control. Child 
reports, or subreports, are executed each time the parent section (i.e. the section in which the Subreport 
control is placed) is printed.

 

Hierarchical Subreports
Describes how to set up a hierarchical subreport. 

Nested Subreports
Describes how to create an embedded subreport. 

Simple Subreports
Describes how simple subreports can be set up using the subreport control. 

Subreports with XML Data
Describes how to use subreports with the XMLDataSource. 

By using the Subreport control, ActiveReports reports can contain any number of child reports. Child reports, 
or subreports, are executed each time the parent section (i.e. the section in which the Subreport control is 
placed) is printed. 

Note: Subreports will not render PageHeader/Footer sections, so you can delete them to 
save processing time. 

Subreports Walkthroughs

Walkthrough: Hierarchical Subreports
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This walkthrough illustrates how to set up a bound subreport by setting the Report property of the Subreport 
control to the child report. This walkthrough also demonstrates how to modify the subreport record source 
from the data in the parent report to retrieve the correct information.

This walkthrough is split up into the following activities: 

l Adding two ActiveReports to a Visual Studio project 

l Connecting the report, rptCustomers, to a data source 

l Adding controls to each report to display the data 

l Adding the code needed to set the subreport control equal to rptOrders 

l Viewing the report  

To complete the walkthrough, you must have access to the Northwind database. For your convenience, a 
copy is included with ActiveReports at the following default location: C:\Program Files\Data 
Dynamics\ActiveReports for .NET 3.0\Data\NWIND.MDB.

When you have finished this walkthrough, you will have a report that looks similar to the following.

Adding two ActiveReports to a Visual Studio project

To add two ActiveReports to a Visual Studio project

1. Open a new project in Visual Studio. 

2. From the Project menu, select Add New Item. 

3. Select ActiveReports 3.0 File and rename the file rptCustomers. 

4. Click Open. 

5. From the Project menu, select Add New Item. 

6. Select ActiveReports 3.0 File and rename the file rptOrders. 

ActiveReports for .NET 3 User Guide | 347



7. Click Open. 

Connecting rptCustomers to a data source

To connect the report to a data source

1. Click the gray report DataSource icon in the Detail section to open the report DataSource dialog. 

2. Click Build.

3. Select Microsoft Jet 4.0 OLE DB Provider and click Next.

4. Click the ellipsis to browse for the access path to the Northwind database. Click Open once you have 
selected the appropriate access path. 

5. Click OK to continue. 

6. In the Query field, type "SHAPE {SELECT CustomerID, CompanyName, Address FROM Customers} 
APPEND ({SELECT CustomerID, OrderID, Freight, OrderDate, EmployeeID FROM Orders} AS 
CustomerOrders RELATE CustomerID TO CustomerID)". 

7. Add "Provider=MSDataShape;" to the beginning of your Connection String and change 
"Provider=Microsoft.Jet.OLEDB.4.0;" to "Data Provider=Microsoft.Jet.OLEDB.4.0;". Your complete 
Connection String should look similar to: "Provider=MSDataShape;Data 
Provider=Microsoft.Jet.OLEDB.4.0;Data Source=C:\NWIND.mdb;Persist Security Info=False". 

8. Click OK to return to the report design surface. 

Adding controls to display the data

To add controls to the reports

1. Add the following controls to the detail section of rptCustomers, naming them as indicated: 

2. Add a GroupHeader/Footer section to rptOrders 

3. Make the following changes to the group header: 

¡ Change the name to ghOrders 

¡ Change the DataField property to CustomerID 

4. Add the following controls to rptOrders, naming them as indicated: 

Control DataField Name Text Location

TextBox CustomerID txtCustomerID Customer ID 0, 0 

TextBox CompanyName txtCompanyName Company Name 1.0625, 0 

TextBox Address txtAddress Address 3.9375, 0 

Subreport CustomerOrders Subreport1 NA 0, 0.5 

Control DataField Name Text Section Location

Label NA lblOrderDate Order Date GroupHeader 0, 0

Label NA lblOrderID Order ID GroupHeader 1.1875, 
0

Label NA lblFreight Freight GroupHeader 2.375, 0

TextBox OrderDate txtOrderDate Order Date Detail 0, 0

TextBox OrderID txtOrderID Order ID Detail 1.1875, 
0

TextBox Freight txtFreight Freight Detail 2.375, 0

TextBox EmployeeID txtEmployeeID Employee ID Detail 5.9375, 
0

Label NA lblProcessed Processed by 
Employee ID #:

Detail 3.5625, 
0
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Adding the code needed to set the subreport control equal to rptOrders

To write the code in Visual Basic

l Double-click the gray area below rptCustomers. This creates an event-handling method for rptCustomers' 
ReportStart event. Add code to the handler to: 

l Set the subreport control equal to rptOrders 

To write the code in C#

l Double-click the gray area below rptCustomers. This creates an event-handling method for rptCustomers' 
ReportStart event. Add code to the handler to: 

l Set the subreport control equal to rptOrders 

The following example shows what the code for the method looks like.

'Visual Basic
Private Sub rptCustomers_ReportStart(ByVal sender As Object, ByVal e As System.EventArgs) _

Handles MyBase.ReportStart
Me.SubReport1.Report = New rptOrders()

End Sub
//C#
private void rptCustomers_ReportStart(object sender, System.EventArgs eArgs)
{

this.SubReport1.Report = new rptOrders();
}

Viewing the report

To view the report

1. Add the ActiveReports viewer control to a Windows Form. 

2. Add the code needed to set the viewer document equal to the report document. See Using the 
ActiveReports WinForm Viewer for help. 

Note: You can quickly view your report at design time by clicking the Preview tab at the bottom of the 
designer.

ActiveReports allows reports to contain any number of child reports by using the Subreport control. Child 
reports, or subreports, are executed each time the parent section (i.e. the section in which the Subreport 
control is placed) is printed. 

Note: Subreports do not render PageHeader/Footer sections, so you can delete them to save on 
processing time.

This walkthrough illustrates how to set up a bound subreport by setting the Report property of the Subreport 
control to the child report. This walkthrough also demonstrates how to modify the subreport record source 
from the data in the parent report to retrieve the correct information.

This walkthrough is split up into the following activities: 

l Adding two ActiveReports to a Visual Studio project 

l Connecting the parent report to a data source 

l Adding controls to display the data 

l Adding the code needed to save the current record's CategoryID to use in the subreport's SQL query 

Line NA Line1 NA Detail X1: 0 

Y1: 0.25

X2: 6.5

Y2: 0.25

Walkthrough: Simple Subreports
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l Adding code to create a new data source, set its connection string and SQL query, and set the new data 
source equal to the subreport's data source 

l Viewing the report  

To complete the walkthrough, you must have access to the Northwind database. For your convenience, a 
copy is included with ActiveReports at the following default location: C:\Program Files\Data 
Dynamics\ActiveReports for .NET 3.0\Data\NWIND.MDB.

When you have finished this walkthrough, you will have a report that looks similar to the following.

Adding two ActiveReports to a Visual Studio project

To add two ActiveReports to a Visual Studio project

1. Open a new project in Visual Studio. 

2. From the Project menu, select Add New Item. 

3. Select ActiveReports 3.0 File and rename the file rptParent. 

4. Click Open. 

5. From the Project menu, select Add New Item. 
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6. Select ActiveReports 3.0 File and rename the file rptChild. 

7. Click Open. 

Connecting the parent report to a data source

To connect the parent report to a data source

1. Click the gray report Datasource icon in the Detail section to open the report Datasource dialog. 

2. Click on Build.

3. Select Microsoft Jet 4.0 OLE DB Provider and click Next.

4. Click the ellipsis button to browse for the access path to the NorthWind database. Click Open once you 
have selected the appropriate access path. 

5. Click OK to continue. 

6. In the Query field, type "Select * from categories". 

7. Click OK to return to the report design surface. 

Adding controls to display the data

To add controls to the reports

1. Add the following controls to the Detail section of rptParent, setting the properties as indicated: 

2. Add the following controls to the Detail section of rptChild, setting the properties as indicated: 

Adding the code needed to save the current record's categoryID
Note: The Fields collection should never be accessed outside the DataInitialize and FetchData events.

To write the code in Visual Basic

l Right-click in any section of the design window of rptParent, and click on View Code to display the code 
view for the report. At the top left of the code view for rptParent, click the drop-down arrow and select 
(Base Class Events) (or (rptParent events) in Visual Studio 2005). At the top right of the code window, 
click the drop-down arrow and select FetchData. This creates an event-handling method for rptParent's 
FetchData event. Add code to the handler to: 

l Save the current record's categoryID to use in the subreport's SQL query 

To write the code in C#

l Click the gray area below rptParent to select the report. Click on the events icon in the Properties
window to display available events for the report. Double-click FetchData. This creates an event-handling 
method for rptParent's FetchData event. Add code to the handler to: 

l Save the current record's categoryID to use in the subreport's SQL query 

The following example shows what the code for the method looks like.

' Visual Basic
Dim categoryIDString As String
Private Sub rptParent_FetchData(ByVal sender As Object, ByVal eArgs As DataDynamics _

.ActiveReports.ActiveReport.FetchEventArgs) Handles MyBase.FetchData

Control DataField Name Text Location

Label NA lblProducts Products 1.15, 0.25 

Label NA lblCategoryName Category Name: 0, 0 

TextBox CategoryName txtCategoryName CategoryName 1.15, 0 

Subreport NA subReport1 NA 1.15, 0.5 

Control DataField Name Text Location

TextBox ProductName txtProductName Product Name 1.15, 0

Label NA lblProductName Product Name: 0, 0
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categoryIDString = Me.Fields("CategoryID").Value
End Sub
//C#
string categoryIDString;
Private Void rptParent_FetchData(object sender, DataDynamics.ActiveReports.ActiveReport3.

FetchEventArgs eArgs)
{

categoryIDString = Fields["CategoryID"].Value.ToString();
}

Adding the code to create a new data source for the subreport

To write the code in Visual Basic

l Double-click the Detail section of rptParent to create an event-handling method for rptParent's 
Detail_Format event. Add code to the handler to:  

l Create a new DataDynamics OleDBDataSource 

l Set the connection string of the new data source 

l Set the new data source's SQL query 

l Set the subreport's data source equal to the new data source 

To write the code in C#

l Double-click the Detail section of rptParent to create an event-handling method for rptParent's 
Detail_Format event. Add code to the handler to: 

l Create a new DataDynamics OleDBDataSource 

l Set the connection string of the new data source 

l Set the new data source's SQL query 

l Set the subreport's data source equal to the new data source 

The following example shows what the code for the method looks like.

'Visual Basic
Private Sub Detail1_Format(ByVal sender As Object, ByVal e As System.EventArgs) _

Handles Detail1.Format
Dim rpt As New rptChild()
Dim childDataSource As New DataDynamics.ActiveReports.DataSources.OleDBDataSource()
childDataSource.ConnectionString = Me.DataSource.ConnectionString
childDataSource.SQL = "Select * from products where categoryID = " + categoryIDString
rpt.DataSource = childDataSource
Me.subReport1.Report = rpt

End Sub

//C#
private void detail_Format(object sender, System.EventArgs eArgs)
{

rptChild rpt = new rptChild();
DataDynamics.ActiveReports.DataSources.OleDBDataSource childDataSource = new DataDynamics.

ActiveReports.DataSources.OleDBDataSource();
childDataSource.ConnectionString = this.DataSource.ConnectionString;
childDataSource.SQL = "Select * from products where categoryID = " + categoryIDString;
rpt.DataSource = childDataSource;
subReport1.Report = rpt;

}

Viewing the report

To view the report

1. Add the ActiveReports viewer control to a Windows Form. 

2. Add the code needed to set the viewer document equal to the report document. See Using the 
ActiveReports WinForm Viewer for help. 

Note: You can quickly view your report at design time by clicking the Preview tab at the bottom of the 
designer. In this case, click the Preview tab for rptParent.
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When setting up embedded subreports in ActiveReports, the principles are the same as when setting up 
simple subreports but are applied to the child-grandchild reports. 

Note: Subreports will not render PageHeader/Footer sections, so you can delete them to save on 
processing time. 

This walkthrough illustrates how to set up embedded subreports.

This walkthrough is split up into the following activities: 

l Adding three ActiveReports to a Visual Studio project 

l Connecting each report to a data source 

l Adding controls to each report to display the data 

l Adding the code needed to set the subreport controls equal to their corresponding reports 

l Setting the subreports' ShowParametersUI property to False 

l Viewing the report  

To complete the walkthrough, you must have access to the Northwind database. For your convenience, a 
copy is included with ActiveReports at the following default location: C:\Program Files\Data 
Dynamics\ActiveReports for .NET 3.0\Data\NWIND.MDB.

When you have finished this walkthrough, you will have a report that looks similar to the following.

Adding three ActiveReports to a Visual Studio project

To add three ActiveReports to a Visual Studio project

Nested Subreports
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1. Open a new project in Visual Studio. 

2. From the Project menu, select Add New Item. 

3. Select ActiveReports 3.0 File and rename the file rptEmployees. 

4. Click Open. 

5. From the Project menu, select Add New Item. 

6. Select ActiveReports 3.0 File and rename the file rptOrders. 

7. Click Open. 

8. From the Project menu, select Add New Item. 

9. Select ActiveReports 3.0 File and rename the file rptCustomers. 

10. Click Open. 

Connecting rptEmployees to a data source

To connect the report to a data source

1. Click on the gray report DataSource icon in the Detail section to open the report DataSource dialog. 

2. Click on Build.

3. Select Microsoft Jet 4.0 OLE DB Provider and click Next.

4. Click the ellipsis button to browse for the access path to the NorthWind database. Click Open once you 
have selected the appropriate access path. 

5. Click OK to continue. 

6. In the Query field, type "Select * from employees". 

7. Click OK to return to the report design surface. 

Connecting rptOrders to a data source

To connect the report to a data source

1. Click on the gray report DataSource icon in the Detail section to open the report DataSource dialog. 

2. Click on Build.

3. Select Microsoft Jet 4.0 OLE DB Provider and click Next.

4. Click the ellipsis button to browse for the access path to the NorthWind database. Click Open once you 
have selected the appropriate access path. 

5. Click OK to continue. 

6. In the Query field, type "Select * from orders inner join [order details] on orders.orderID = [order 
details].orderID where orders.employeeID = <%employeeID%>". 

7. Click OK to return to the report design surface. 

Connecting rptCustomers to a data source

To connect the report to a data source

1. Click on the gray report DataSource icon in the Detail section to open the DataSource dialog. 

2. Click on Build.

3. Select Microsoft Jet 4.0 OLE DB Provider and click Next.

4. Click the ellipsis button to browse for the access path to the NorthWind database. Click Open once you 
have selected the appropriate access path. 

5. Click OK to continue. 

6. In the Query field, type "Select * from customers where customerID = '<%CustomerID%>' ". 

7. Click OK to return to the report design surface. 

Adding controls to display the data
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To add controls to the reports

1. Add a GroupHeader/Footer section to rptEmployees 

2. Make the following changes to the group header: 

¡ Change the name to ghEmployees 

¡ Change the DataField property to EmployeeID 

3. Add the following controls to rptEmployees, naming them as indicated: 

4. Add the following controls to the Detail section of rptOrders, setting the properties as indicated. 

5. In the Report Explorer, expand the Fields node, then the Bound node. Drag the following fields onto the 
detail section and set the following properties of each textbox as indicated. 

Adding the code needed to set subOrders equal to rptOrders in rptEmployees

To write the code in Visual Basic

Control DataField Name Text Section Location

TextBox EmployeeID txtEmployeeID Employee ID GroupHeader 0, 0 

TextBox Extension txtExtension Extension GroupHeader 3.375, 0 

TextBox LastName txtLastName Last Name GroupHeader 1.125, 0 

TextBox FirstName txtFirstName First Name GroupHeader 2.25, 0 

Label lblEmployeeID Employee ID GroupHeader 0, 0 

Label lblExtension Extension GroupHeader 3.375, 0 

Label lblLastName Last Name GroupHeader 1.125,  0 

Label lblFirstName First Name GroupHeader 2.25, 0 

Subreport subOrders Detail 0, 0 

Control DataField Name Text Location

TextBox OrderDate txtOrderDate Order Date 1.9375, 0.25 

TextBox Quantity txtQuantity Quantity 4.4375, 0.25 

TextBox orders.OrderID txtOrderID Order ID 0, 0.25 

TextBox ProductID txtProductID Product ID 3, 0.25 

Label lblOrderDate Order Date: 1.9375, 0 

Label lblQuantity Quantity: 4.4375, 0 

Label lblOrderID Order ID: 0, 0 

Label lblProductID Product ID: 3, 0 

Subreport subCustomers 0, 0.5 

Field Text Location

CompanyName Company Name 0, 0.25

ContactName Contact Name 1.25, 0.25

Phone Phone 2.3125, 0.25

Company Name 0, 0

Contact Name 1.25, 0

Phone 2.3125, 0
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l Double-click in the detail section rptEmployees. This creates an event-handling method for rptEmployees' 
Detail_Format event. Add code to the handler to: 

l Set subOrders equal to rptOrders 

To write the code in C#

l Double-click in the detail section rptEmployees. This creates an event-handling method for rptEmployees' 
Detail_Format event. Add code to the handler to: 

l Set subOrders equal to rptOrders 

The following example shows what the code for the method looks like.

'Visual Basic
Private Sub Detail1_Format(ByVal sender As Object, ByVal e As System.EventArgs) Handles _

Detail1.Format
Dim rpt As New rptOrders()
Me.subOrders.Report = rpt

End Sub
//C#
private void detail_Format(object sender, System.EventArgs eArgs)
{

rptOrders rpt = new rptOrders();
subOrders.Report = rpt;

}

Adding the code needed to set subCustomers equal to rptCustomers in 
rptOrders

To write the code in Visual Basic

l Double-click in the in the Detail section of rptOrders to create an event-handling method for rptOrders' 
Detail_Format event. Add code to the handler to: 

l Set subCustomers equal to rptCustomers 

To write the code in C#

l Double-click in the in the Detail section of rptOrders to create an event-handling method for rptOrders' 
Detail_Format event. Add code to the handler to: 

l Set subCustomers equal to rptCustomers 

The following example shows what the code for the method looks like.

'Visual Basic
Private Sub ghOrders_Format(ByVal sender As Object, ByVal e As System.EventArgs) Handles _

ghOrders.Format
Dim rpt As New rptCustomers()
Me.subCustomers.Report = rpt

End Sub
//C#
private void Detail_Format(object sender, System.EventArgs eArgs)
{

rptCustomers rpt = new rptCustomers();
subCustomers.Report = rpt;

}

Setting the ShowParametersUI property to false

To set the ShowParametersUI property to false

1. Click in the dark gray area underneath rptCustomers to select the ActiveReport. 

2. In the properties window, change the ShowParametersUI property to False. 

3. In the same way, set the ShowParametersUI property to False for rptOrders.  

Viewing the report
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To view the report

1. Add the ActiveReports viewer control to a Windows Form. 

2. Add the code needed to set the viewer document equal to the report document. See Using the 
ActiveReports WinForm Viewer for help. 

Note: You can quickly view your report at design time by clicking the Preview tab at the bottom of the 
designer.

ActiveReports allows reports to contain any number of child reports by using the Subreport control. Child 
reports, or subreports, are executed each time the parent section (i.e. the section in which the Subreport 
control is placed) is printed. 

Note: Subreports will not render PageHeader/Footer sections, so you can delete them to save on 
processing time.

This walkthrough illustrates how to set up a subreport bound to an XML DataSource by setting the Subreport 
control's Report property to the child report and how to modify the subreport record source from the data in 
the parent report to retrieve the correct information.

This walkthrough is split up into the following activities: 

l Adding two ActiveReports to a Visual Studio project 

l Connecting the parent report to an XML data source 

l Adding controls to display the data 

l Adding the code to create a new XML data source, setting the NodeList for the current record, and setting 
the new data source equal to the subreport's data source 

l Viewing the report  

To complete the walkthrough, you must have access to the XML Customer database (Customer.xml).

When you have finished this walkthrough, you will have a report that looks similar to the following.

Adding two ActiveReports to a Visual Studio project

To add two ActiveReports to a Visual Studio project

1. Open a new project in Visual Studio. 

2. From the Project menu, select Add New Item. 

Subreports with XML Data
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3. Select ActiveReports 3.0 File and rename the file rptMain. 

4. Click Open. 

5. From the Project menu, select Add New Item. 

6. Select ActiveReports 3.0 File and rename the file rptSub. 

7. Click Open. 

Connecting the parent report to a data source

To connect the parent report to a data source

1. Click on the gray report DataSource icon in the Detail section to open the report DataSource dialog. 

2. In the Data source combo box at the top of the dialog, select XML. 

3. Click the ellipsis button beside File URL to browse for the access path to Customer.xml. Click Open once 
you have selected the appropriate access path. (The default installation path is C:\Program Files\Data 
Dynamics\ActiveReports for .NET 3.0\Samples\CSharp\XMLSample\customer.xml.) 

4. In the Recordset Pattern field, type "//CUSTOMER". 

5. Click OK to return to the report design surface. 

Adding controls to display the data

To add controls to the reports

1. Add the following controls to the Detail section of rptMain, naming them as indicated: 

2. Add the following controls to the Detail section of rptSub, naming them as indicated: 

Adding the code to create a new data source 

To write the code in Visual Basic

l Double-click the Detail section in rptMain, to create an event-handling method for the report's 
Detail_Format event. Add code to the handler to: 

l Create a new DataDynamics XMLDataSource 

l Type cast the new data source as rptMain's data source and set the NodeList to the "ORDER/ITEM" 
field 

l Set the subreport's data source equal to the new data source 

To write the code in C#

l Click in the Detail section of rptMain to select the section. Click on the events icon in the Properties
window to display available events for the Detail section. Double-click Format. This creates an event-
handling method for rptMain's Detail_Format event. Add code to the handler to: 

l Create a new DataDynamics XMLDataSource 

l Type cast the new data source as rptMain's data source and set the NodeList to the "ORDER/ITEM" 
field 

Control DataField Name Text/ReportName Location

Label lblCustomerName Customer Name: 0, 0 in

TextBox NAME txtCustomerName NAME 1.2, 0 in

Label lblOrders Orders: 0.25, 0.25 in

Subreport ctlSubreport rptSub 0.75, 0.5 in

Control DataField Name Text Location

TextBox TITLE txtTitle TITLE 0, 0 in

TextBox PRICE txtPrice PRICE 3.5, 0 in
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l Set the subreport's data source equal to the new data source 

The following example shows what the code for the method looks like.

' Visual Basic
Private Sub Detail_Format(ByVal sender As Object, ByVal e As System.EventArgs) _

Handles Detail.Format
Dim xmlDS As New DataDynamics.ActiveReports.DataSources.XMLDataSource
xmlDS.NodeList = CType(CType(Me.DataSource, DataDynamics.ActiveReports.DataSources _

.XMLDataSource).Field("ORDER/ITEM", True), System.Xml.XmlNodeList)
CType(Me.SubReport.Report, rptSub).DataSource = xmlDS

End Sub
//C#

private void Detail_Format(object sender, System.EventArgs eArgs)
{

DataDynamics.ActiveReports.DataSources.XMLDataSource xmlDS = new DataDynamics
.ActiveReports.DataSources.XMLDataSource();

xmlDS.NodeList = (System.Xml.XmlNodeList)((DataDynamics.ActiveReports
.DataSources.XMLDataSource) this.DataSource).Field("ORDER/ITEM",true);

((rptSub)this.SubReport.Report).DataSource = xmlDS;
}

Viewing the report

To view the report

1. Add the ActiveReports viewer control to a Windows Form. 

2. Add the code needed to set the viewer document equal to the report document. See Using the 
ActiveReports WinForm Viewer for help. 

Note: You can quickly view your report at design time by clicking the Preview tab at the bottom of the 
designer.

In ActiveReports, summary fields can be added to any section to calculate totals, counts, averages and other 
aggregations. The summary field's placement dictates when the section containing the field, and sections 
after it, will be printed. A section with a summary field will be delayed until all the calculations are completed. 
This allows summary fields to be placed ahead of the corresponding detail. 

Summary fields are calculated according to the textbox's Summary properties. A summary textbox is 
updated with each new detail record. When a field is placed ahead of the Detail section (i.e. in the 
ReportHeader, PageHeader or GroupHeader sections), the Detail section is formatted with each record and 
the summary field is updated. When all records for the summary level are read, the header section is printed 
followed by the delayed sections.

This walkthrough illustrates how to create a report with a summary field in the GroupFooter section. 

This walkthrough is split up into the following activities: 

l Adding an ActiveReport to a Visual Studio project 

l Connecting the report to a data source 

l Adding controls to the report to contain data 

l Viewing the report  

To complete the walkthrough, you must have access to the Northwind database. For your convenience, a 
copy is included with ActiveReports at the following default location: C:\Program Files\Data 
Dynamics\ActiveReports for .NET 3.0\Data\NWIND.MDB.

When you have completed this walkthrough, you will have a report that looks similar to the following.

Walkthrough: Summary Fields
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Adding an ActiveReport to a Visual Studio project

To add an ActiveReport to your project

1. Open a new project in Visual Studio. 

2. From the Project menu, select Add New Item. 

3. Select ActiveReports 3.0 File and rename the file rptSumFields. 

4. Click Open. 

Connecting the report to a data source

To connect the report to a data source

1. Click on the gray report DataSource icon in the Detail section to open the report DataSource dialog. 

2. Click on Build.

3. Select Microsoft Jet 4.0 OLE DB Provider and click Next.

4. Click the ellipsis button to browse for the access path to the NorthWind database. Click Open once you 
have selected the appropriate access path. 

5. Click OK to continue. 

6. In the Query field, type "SELECT DISTINCTROW Orders.*, [Order Details].*, Products.* FROM Products 
INNER JOIN (Orders INNER JOIN [Order Details] ON Orders.OrderID = [Order Details].OrderID) ON 
Products.ProductID = [Order Details].ProductID order by orderdate". 

7. Click OK to return to the report design surface. 
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Adding controls to the report to contain data

To add controls to the report

1. Add a GroupHeader/Footer section to rptSumFields. 

2. Make the following changes to the group header: 

¡ Change the name to ghOrders 

¡ Change the DataField property to OrderDate 

3. Add the following controls to the GroupHeader section: 

4. In the Report Explorer, expand the Fields node, then the Bound node. Drag the following fields onto the 
detail section and set the following properties of each textbox as indicated.  

5. Add the following controls to the GroupFooter section: 

Note Distinct summarization can be used in a situation when the field's value repeats in several detail 
records and the summary function needs to include a single value from all repeating values. To do this, 
you would need to set the DistinctField property of the summary field to the appropriate value and set 
the SummaryFunc property to the appropriate distinct summary function. 

Viewing the report

To view the report

1. Add the ActiveReports viewer control to a Windows Form. 

2. Add the code needed to set the viewer document equal to the report document. See Using the 
ActiveReports WinForm Viewer for help. 

Control Name Text Location

Label lblProductID Product ID 1.208, 0 

Label lblProductName Product Name 2.489, 0 

Label lblUnitPrice Unit Price 4.56, 0 

Label lblOrderDate Order Date 0, 0 

Field Text Location Output Format

products.ProductID Product ID 1.218, 0 NA

ProductName Product Name 2.5, 0 NA

OrderDate Order Date 0, 0 NA

products.UnitPrice Unit Price 4.562, 0 Currency 

Control DataField Name Text Location Miscellaneous

Label lblSalesTotal Daily 
Sales 
Total

3, 0

TextBox products.UnitPrice txtSalesTotal Sales 
Total

4.562, 0 OutputFormat = 
Currency 

SummaryType = 
SubTotal

SummaryRunning = 
Group

SummaryGroup = 
ghOrders

Label lblWhiteLine 0, 0.25 Background color = 
white
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Note: You can quickly view your report at design time by clicking the Preview tab at the bottom of the 
designer.

Summary reports are implemented by setting the Visible property for the Detail section to False or setting 
the Height to 0. The Detail section is processed but the summary GroupHeader and Footer sections are 
printed without the Detail section.

This walkthrough illustrates how to create a summary report.

The walkthrough is split up into the following activities: 

l Creating a new Visual Studio project 

l Adding an ActiveReport to a Visual Studio project 

l Connecting the report to a data source 

l Adding code to the DataInitialize and FetchData events to create a summary field 

l Adding controls to the report to contain data 

l Viewing the report  

To complete the walkthrough, you must have access to the Northwind database. For your convenience, a 
copy is included with ActiveReports at the following default location: C:\Program Files\Data 
Dynamics\ActiveReports for .NET 3.0\Data\NWIND.MDB.

When you have finished this walkthrough, you will have a report that looks similar to the following.

Creating a new Visual Studio project

To create a new Visual Studio project

1. Open Visual Studio. 

2. From the File menu, select New > Project.

3. Select the project type and click on Windows Application. 

4. Change the name of your project and click OK. 

Adding an ActiveReport to a Visual Studio project

To add an ActiveReport to your project

1. Open a new project in Visual Studio. 

2. From the Project menu, select Add New Item. 

3. Select ActiveReports 3.0 File and rename the file rptSummary. 

4. Click Open. 

Connecting the data source to a database

To connect the data source to a database

1. Click on the gray report DataSource icon in the Detail section to open the report DataSource dialog. 

2. Click on Build.

Summary Reports
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3. Select "Microsoft Jet 4.0 OLE DB Provider" and click Next .

4. Click the ellipsis button to browse for the access path to the NorthWind database. Click Open once you 
have selected the appropriate access path. 

5. Click OK to continue. 

6. In the Query field, type "SELECT * FROM [Order Details] ORDER BY OrderID". 

7. Click OK to return to the report design surface. 

Adding Code to the DataInitialize and FetchData Events

To write the code in Visual Basic

Right-click in any section of the design window of rptSummary, and click on View Code to display the code 
view for the report. At the top left of the code view for rptSummary, click the drop-down arrow and select 
(Base Class Events). At the top right of the code window, click the drop-down arrow and select DataInitialize. 
This creates an event-handling method for rptSummary's DataInitialize event. Add code to the handler to add 
a field to the report's fields collection.

The following example shows what the code for the method looks like.

Private Sub rptSummary_DataInitialize(ByVal sender As Object, ByVal e As System.EventArgs) _
Handles MyBase.DataInitialize

Me.Fields.Add("total")
End Sub
At the top left of the code view for rptSummary, click the drop-down arrow and select (Base Class Events). At 
the top right of the code window, click the drop-down arrow and select FetchData. This creates an event-
handling method for rptSummary's FetchData event. Add code to the handler to populate the field added to 
the report's fields collection.

The following example shows what the code for the method looks like.

Private Sub rptSummary_FetchData(ByVal sender As Object, ByVal eArgs As DataDynamics _
.ActiveReports.ActiveReport.FetchEventArgs) Handles MyBase.FetchData

Me.Fields("total").Value = Me.Fields("Quantity").Value * Me.Fields("UnitPrice").Value
End Sub

To write the code in C#

Click in the gray area below rptSummary to select the report. Click on the events icon in the Properties
window to display available events for the report. Double-click DataInitialize. This creates an event-handling 
method for rptSummary's DataInitialize event. Add code to the handler to add a field to the report's fields 
collection.

The following example shows what the code for the method looks like.

private void rptSummary_DataInitialize(object sender, System.EventArgs eArgs)
{

Fields.Add("total");
}
Click in the gray area below rptSummary to select the report. Click on the events icon in the Properties
window to display available events for the report. Double-click FetchData. This creates an event-handling 
method for rptSummary's FetchData event. Add code to the handler to populate the field added to the 
report's fields collection.

The following example shows what the code for the method looks like.

private void rptSummary_FetchData(object sender, DataDynamics.ActiveReports.ActiveReport3
.FetchEventArgs eArgs)

{
this.Fields["total"].Value = this.Fields["Quantity"].Value * this.Fields

["UnitPrice"].Value;
}

Adding controls to contain data

To add controls to the report

1. Right click on the report, and choose "Insert GroupHeader/Footer" 

2. Change the GroupHeader's Name property to ghOrders and the GroupFooter's Name property to 
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gfOrders

3. Change the GroupHeader's DataField property to OrderID

4. Change the GroupHeader's UnderlayNext property to True to align the control in the GroupFooter with 
the one in the GroupHeader 

5. Change the Detail section's Visible property to False 

6. Add the following control to the Detail section: 

7. Add the following control to the PageHeader section: 

8. Add the following control to the GroupHeader section: 

9. Add the following control to the GroupFooter section: 

Viewing the report

To view the report

1. Add the ActiveReports viewer control to a Windows Form. 

2. Add the code needed to set the viewer document equal to the report document. See Using the 
ActiveReports WinForm Viewer for help. 

Note: You can quickly view your report at design time by clicking the Preview tab at the bottom of the 
designer.

ActiveReports requires no special handling for Top N Records report styles. Such reports can be easily 
implemented by setting the data source to a Top N filtered query. If the data source does not support Top N 
queries, the query can be set to return records ordered by the Top N value descending. Then the MaxRows 
property should be set to N.

For example, to list the top 10 customers by their sales numbers, you can create a query that returns all 
customer sales ordered by the sales value descending. Then set the MaxRows property of the data control to 
10. ActiveReports will process only 10 records from the sorted query results.

This walkthrough illustrates how to create a report that lists the top ten customers by sales.

The walkthrough is split up into the following activities: 

l Creating a new Visual Studio project 

l Adding an ActiveReport to a Visual Studio project 

Control DataField Name Text

TextBox total txtTotal Total 

Control Name Text Formatting Location

Label lblTitle Orders Font 14pt; Bold; Center 0, 0 

Label lblOrderID Order Number Underline 1.5, 0.438 

Label lblAmount Amount Underline 4.2, 0.438 

Control DataField Name Text Location

TextBox OrderID txtOrderID OrderID 1.5, 0 

Control DataField Name Text Location Miscellaneous
TextBox total txtTotal Total 4.2, 0 OutputFormat = Currency 

SummaryType = SubTotal

SummaryRunning = Group

SummaryGroup = ghOrders

Top N Reports
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l Connecting the report to a data source 

l Adding controls to the report to contain data 

l Viewing the report  

To complete the walkthrough, you must have access to the Northwind database. For your convenience, a 
copy is included with ActiveReports at the following default location: C:\Program Files\Data 
Dynamics\ActiveReports for .NET 3.0\Data\NWIND.MDB.

When you have finished this walkthrough, you will have a report that looks similar to the following.

Creating a new Visual Studio project

To create a new Visual Studio project

1. Open Visual Studio. 

2. From the File menu, select New > Project.

3. Select the project type and click on Windows Application. 

4. Change the name of your project and click OK. 

Adding an ActiveReport to a Visual Studio project

To add an ActiveReport to your project

1. Open a new project in Visual Studio. 

2. From the Project menu, select Add New Item. 

3. Select ActiveReports 3.0 File and rename the file rptTopN. 

4. Click Open. 

Connecting the data source to a database

To connect the data source to a database

1. Click on the gray report DataSource icon in the Detail section to open the report DataSource dialog. 

2. Click on Build.

3. Select "Microsoft Jet 4.0 OLE DB Provider" and click Next .

4. Click the ellipsis button to browse for the access path to the NorthWind database. Click Open once you 
have selected the appropriate access path. 

5. Click OK to continue. 

6. In the Query field, type "SELECT TOP 10 Customers.CompanyName, Sum([UnitPrice]*[Quantity]) AS 
Sales FROM (Customers INNER JOIN Orders ON Customers.CustomerID = Orders.CustomerID) INNER 
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JOIN [Order Details] ON Orders.OrderID = [Order Details].OrderID GROUP BY Customers.CompanyName 
ORDER BY Sum([UnitPrice]*[Quantity]) DESC". 

7. Click OK to return to the report design surface. 

Adding controls to contain data

To add controls to the report

1. In the Report Explorer, expand the Fields node, then the Bound node. Drag the following fields onto the 
detail section and set the following properties of each textbox as indicated.  

2. Add the following control to the PageHeader section: 

Viewing the report

To view the report

1. Add the ActiveReports viewer control to a Windows Form. 

2. Add the code needed to set the viewer document equal to the report document. See Using the 
ActiveReports WinForm Viewer for help. 

Note: You can quickly view your report at design time by clicking the Preview tab at the bottom of the 
designer.

ActiveReports gives you complete control to bind reports to any type of data source, including arrays, 
through its programmable object model. You can create a report without setting the report's data source then 
load the data from your data source into the report's control at run time. The Fields property allows data 
binding between the control and the run-time fields. It also allows the control's DataField property to be set 
to any of the run-time defined names. The DataInitialize and FetchData events are used to define the run-
time fields and feed the data values of these fields so they can be used with unbound controls.

This walkthrough illustrates the fundamentals of using the DataInitialize and FetchData events to set up an 
unbound report.

This walkthrough is split into the following activities: 

l Adding an ActiveReport to a Visual Studio project 

l Adding code to connect the report to a data source 

l Adding controls to contain the data 

l Using the DataInitialize event to add fields to the report's fields collection 

l Using the FetchData event to populate the report fields 

l Using the ReportEnd event to close the data connection  

l Viewing the report  

To complete the walkthrough, you must have access to the Northwind database. For your convenience, a 
copy is included with ActiveReports at the following default location: C:\Program Files\Data 
Dynamics\ActiveReports for .NET 3.0\Data\NWIND.MDB.

When you have completed this walkthrough, you will have a report that looks similar to the following.

Field Text Location

CompanyName Company Name 0.5, 0 

Sales Sales 5, 0 

Control Name Text Location

Label lblTopTen Top Ten Customers 0, 0 

Walkthrough: Unbound Reports
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Adding an ActiveReport to a Visual Studio project

To add an ActiveReport to your project

1. Open a new project in Visual Studio. 

2. From the Project menu, select Add New Item. 

3. Select ActiveReports 3.0 File and rename the file rptUnbound. 

4. Click Open. 

Adding code to connect the report to a data source

To write the code in Visual Basic

l Right-click in any section of the design window of rptUnbound, and click on View Code to display the 
code view for the report. At the top left of the code view for rptUnbound, click the drop-down arrow and 
select (rptUnbound Events). At the top right of the code window, click the drop-down arrow and select 
ReportStart. This creates an event-handling method for rptUnbound's ReportStart event. Add code to the 
handler to: 

l Set the data source connection string 

l Set the data source SQL query 

l Open the connection to create the DataReader 

To write the code in C#

l Double-click in the gray area below rptUnbound to create an event-handling method for rptUnbound's 
ReportStart event. Add code to the handler to: 

l Set the data source connection string 

l Set the data source SQL query 

l Open the connection to create the DataReader 
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The following example shows what the code for the method looks like.

'Visual Basic
Private conn As OleDbConnection
Private dr As OleDbDataReader
Private cmd As OleDbCommand
Private Sub rptUnbound_ReportStart(ByVal sender As Object, ByVal e As System.EventArgs) _

Handles MyBase.ReportStart
connString = "Provider=Microsoft.Jet.OLEDB.4.0;Data Source=C:\Program Files\ _

Data Dynamics\ActiveReports for .NET 3.0\Data\NWIND.mdb;Persist _
Security Info=False"

conn = New OleDbConnection(connString)
cmd = New OleDbCommand("SELECT * FROM categories INNER JOIN products ON _

categories.categoryid = products.categoryid ORDER BY _
products.categoryid, products.productid", conn)

conn.Open()
dr = cmd.ExecuteReader()

End Sub

//C#
private static OleDbConnection conn;
private static OleDbDataReader dr;
private void rptUnbound_ReportStart(object sender, System.EventArgs eArgs)
{

string connString = "Provider=Microsoft.Jet.OLEDB.4.0;Data Source=C:\Program 
 Files\Data Dynamics\ActiveReports for .NET 3.0\Data\NWIND.mdb;Persist 

Security Info=False";
conn = new OleDbConnection(connString);
OleDbCommand cmd = new OleDbCommand("SELECT * FROM categories INNER JOIN products ON 

 categories.categoryid = products.categoryid ORDER BY products.categoryid,
products.productid", conn);

conn.Open();
dr = cmd.ExecuteReader();

}

Adding controls to the report to contain data

To add controls to the report

Add the following controls from the ActiveReports 3.0 toolbox to the Detail section of rptUnbound:

Note: Additionally, you can set the BackColor property of the label controls to an opaque color to 
make your report easier to read. 

Control DataField Name Text Location

TextBox ProductName txtProductName Product Name 0.0625, 0.375

TextBox UnitsInStock txtUnitsInStock Units In Stock 4.75, 0.375

TextBox Description txtDescription Description 1.8125, 
0.6875

TextBox CategoryName txtCategoryName Category Name 3.125, 0.375

Label NA lblCategoryDescription Category 
Description

0.0625, 
0.6875

Label NA lblUnitsInStock Units In Stock 4.75, 0.0625

Label NA lblCategoryName Category Name 3.125, 0.0625

Label NA lblProductName Product Name 3.125, 0.375

Line NA line1 NA X1 = 0 

X2 = 6.5

Y1 = 1.0625

Y2 = 1.0625
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Using the DataInitialize event to add fields

To write the code in Visual Basic

l Right-click in any section of the design window of rptUnbound, and click on View Code to display the 
code view for the report. At the top left of the code view for rptUnbound, click the drop-down arrow and 
select (rptUnbound Events). At the top right of the code window, click the drop-down arrow and select 
DataInitialize. This creates an event-handling method for rptUnbound's DataInitialize event. Add code to 
the handler to: 

l Add fields to the report's fields collection 

To write the code in C#

l Click in the gray area below rptUnbound to select the report. Click on the events icon in the Properties
window to display available events for the report. Double-click DataInitialize. This creates an event-
handling method for rptUnbound's DataInitialize event. Add code to the handler to: 

l Add fields to the report's fields collection 

The following example shows what the code for the method looks like.

'Visual Basic
Private Sub rptUnbound_DataInitialize(ByVal sender As Object, ByVal e As _

System.EventArgs) Handles MyBase.DataInitialize
Fields.Add("CategoryName")
Fields.Add("ProductName")
Fields.Add("UnitsInStock")
Fields.Add("Description")

End Sub
//C#
private void rptUnbound_DataInitialize(object sender, System.EventArgs eArgs)
{

Fields.Add("CategoryName");
Fields.Add("ProductName");
Fields.Add("UnitsInStock");
Fields.Add("Description");

}

Using the FetchData event to populate the report fields

To write the code in Visual Basic

l Right-click in any section of the design window of rptUnbound, and click on View Code to display the 
code view for the report. At the top left of the code view for rptUnbound, click the drop-down arrow and 
select (rptUnbound Events). At the top right of the code window, click the drop-down arrow and select 
FetchData. This creates an event-handling method for rptUnbound's FetchData event. Add code to the 
handler to: 

l Retrieve information to populate the report fields 

To write the code in C#

l Click in the gray area below rptUnbound to select the report. Click on the events icon in the Properties
window to display available events for the report. Double-click FetchData. This creates an event-handling 
method for rptUnbound's FetchData event. Add code to the handler to: 

l Retrieve information to populate the report fields 

The following example shows what the code for the method looks like.

'Visual Basic
Private Sub rptUnbound_FetchData(ByVal sender As Object, ByVal eArgs As DataDynamics._

 ActiveReports.ActiveReport.FetchEventArgs) Handles MyBase.FetchData
Try

dr.Read()
Me.Fields("CategoryName").Value = dr("CategoryName")
Me.Fields("ProductName").Value = dr("ProductName")
Me.Fields("UnitsInStock").Value = dr("UnitsInStock")
Me.Fields("Description").Value = dr("Description")

 eArgs.EOF = False
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 Catch ex As Exception
eArgs.EOF = True

End Try
End Sub

//C#
private void rptUnbound_FetchData(object sender, DataDynamics.ActiveReports.ActiveReport3.

FetchEventArgs eArgs)
{

try
{

dr.Read();
Fields["CategoryName"].Value = dr["CategoryName"].ToString();
Fields["ProductName"].Value = dr["ProductName"].ToString();
Fields["UnitsInStock"].Value = dr["UnitsInStock"].ToString();
Fields["Description"].Value = dr["Description"].ToString();
eArgs.EOF = false;

}
catch
{

eArgs.EOF = true;
}

}
Note: The DataInitialize and FetchData events are the only events in which the Fields collection should 
ever be referenced.

Using the ReportEnd event to close the data connection

To write the code in Visual Basic

l Right-click in any section of the design window of rptUnbound, and click on View Code to display the 
code view for the report. At the top left of the code view for rptUnbound, click the drop-down arrow and 
select (rptUnbound Events). At the top right of the code window, click the drop-down arrow and select 
ReportEnd. This creates an event-handling method for rptUnbound's ReportEnd event. Add code to the 
handler to: 

l Close the data connection 

To write the code in C#

l Click in the gray area below rptUnbound to select the report. Click on the events icon in the Properties
window to display available events for the report. Double-click ReportEnd. This creates an event-handling 
method for rptUnbound's ReportEnd event. Add code to the handler to: 

l Close the data connection 

The following example shows what the code for the method looks like.

'Visual Basic
Private Sub rptUnbound_ReportEnd(ByVal sender As Object, ByVal e As System.EventArgs) _

Handles MyBase.ReportEnd
conn.Open()

End Sub

//C#
private void rptUnbound_ReportEnd(object sender, System.EventArgs eArgs)
{

conn.Open();
}

Viewing the report

To view the report

1. Add the ActiveReports viewer control to a Windows Form. 

2. Add the code needed to set the viewer document equal to the report document. See Using the 
ActiveReports WinForm Viewer for help. 

Note: You can quickly view your report at design time by clicking the Preview tab at the bottom of the 
designer.
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ActiveX Viewer Control
Describes how to view and print report output in a web browser. 

Custom Exporting
Describes how to set up custom exporting to various formats on the web. 

Web Deployment
Describes how to deploy ActiveReports to a Web server. 

Web Services
Describes how to use Web Services with ActiveReports.

The ActiveX Viewer Control allows you to view and print report output in a web browser. 

This walkthrough is split up into the following activities: 

l Adding an ActiveReport to an ASP.NET Web application 

l Connecting the report to a data source 

l Adding controls to the report to contain data 

l Adding the ActiveX viewer .cab file to the project folder 

l Adding a ReportOutput folder to the project folder 

l Adding required Object tags to the html code for the Web Form 

l Adding code for the window_onload event for the Web Form 

l Adding code to the Web Form's Page_Load event 

To complete the walkthrough, you must have access to the Northwind database. For your convenience, a 
copy is included with ActiveReports at the following default location: C:\Program Files\Data 
Dynamics\ActiveReports for .NET 3.0\Data\NWIND.MDB. 

You must also have access to Internet Information Services either from your computer or from the server. 
You must also run the "Configure Web Sample" option from the Data Dynamics ActiveReports for .NET 
3.0 program menu from your Windows Start button.

When you have completed this walkthrough, you will have a report that looks similar to the following.

Web Walkthroughs (Standard Edition)

Walkthrough: Using the ActiveX Viewer Control on the Web
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Adding an ActiveReport to an ASP.NET Web application

To add an ActiveReport to your project using Visual Studio 2003

1. Create a new ASP.NET Web application.  

2. From the Project menu, select Add New Item.  

3. Select ActiveReports 3.0 File and rename the file rptActiveX. 

4. Click Open. 

To add an ActiveReport to your project using Visual Studio 2005

1. Create a new ASP.NET Web site.  

2. From the Website menu, select Add New Item. 

3. Select ActiveReports 3.0 File and rename the file rptActiveX. 

4. Click Add.

5. Click Yes when a message box asks whether you would like to place the class in the 'App_Code' folder.

Connecting the report to a data source

To connect the report to a data source

1. Click on the gray report DataSource icon in the Detail section to open the report DataSource dialog. 

2. Click on Build.

3. Select Microsoft Jet 4.0 OLE DB Provider and click Next.
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4. Click the ellipsis button to browse for the access path to the NorthWind database. Click Open once you 
have selected the appropriate access path. 

5. Click OK to continue. 

6. In the Query field, type "Select * from products order by categoryID". 

7. Click OK to return to the report design surface. 

Adding controls to the report to contain data

To add controls to the report

1. Add a GroupHeader/Footer section to rptActiveX. 

2. Make the following changes to the group header: 

¡ Change the Name property to ghCategories

¡ Change the BackColor property to RosyBrown

¡ Change the DataField property to CategoryID

3. Add labels with the following properties to ghCategories: 

4. Set the CanShrink property of the detail section to True. 

5. In the Report Explorer, expand the Fields node, then the Bound node. Drag the following fields onto 
the detail section and set the following properties of each textbox as indicated. 

Adding the ActiveX .cab file to the project folder

To add the ActiveX .cab file

1. Open Windows Explorer and browse to the folder in which ActiveReports for .NET 3.0 is installed. The 
default location is "C:\Program Files\Data Dynamics\ActiveReports for .NET 3.0." 

2. Double-click the Deployment folder. Copy the file called "arview2.cab" by right-clicking on the file and 
selecting Copy . 

3. Browse to the folder in which your project is contained. 

4. Paste the .cab file into your project's folder. 

Adding a ReportOutput folder to the project folder

To add a folder to the project

1. Open Windows Explorer and browse to the folder in which your project is contained. 

2. On the File menu, click New> Folder. 

3. Name the folder "ReportOutput". 

4. Make sure that you have write permissions for this folder. 

Name Text Location

lblProductName Product Name 0, 0 

lblUnitsInStock Units In Stock 1.88, 0 

lblUnitsOnOrder Units On Order 2.94, 0 

lblUnitPrice Unit Price 4, 0 

Field Text Location Output Format

ProductName Product Name 0, 0 NA

UnitsInStock Units In Stock 1.88, 0 NA

UnitsOnOrder Units On Order 2.94, 0 NA 

UnitPrice Unit Price 4, 0 Currency
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Adding Object tags to the Web Form's HTML code

To add Object tags to the Web Form

l In the body of the HTML view of the Web Form, but outside the <form> tags, add the following code. 
<OBJECT id="arv" codeBase="arview2.cab" height="100%" width="100%" 

classid="clsid:8569D715-FF88-44BA-8D1D-AD3E59543DDE" VIEWASTEXT>
<PARAM NAME="_ExtentX" VALUE="11218">
<PARAM NAME="_ExtentY" VALUE="7329"></OBJECT>

Adding code to the Web Form's window_onload event

To add code to the window_onload event

1. At the top of the HTML view of the Web Form, click on the drop-down arrow for "Client Objects and 
Events" and select "window". 

2. Click the drop-down arrow for the available events to the right of "window" and select "onload." 

3. This creates an event-handling method for the Web Form's window_onload event. 

4. Add the following code to the window_onload event. 
arv.datapath = "ReportOutput/axreport.rdf";

Adding code to the Web Form's Page_Load event

To write the code in Visual Basic

l Return to the Design view of the Web Form and double-click on the form. This creates an event-handling 
method for the Web Form's Page_Load event. Add the following code to the Page_Load event. 

To write the code in C#

l Return to the Design view ot the Web Form and double-click on the form. This creates an event-handling 
method for Web Form's Page_Load event. Add the following code to the Page_Load event. 

The following example shows what the code for the method looks like.

'Visual Basic
Private Sub Page_Load(ByVal sender As System.Object, ByVal e As System.EventArgs) Handles _

MyBase.Load
Dim rpt As New rptActiveX()
rpt.Run()
rpt.Document.Save(Server.MapPath("") + "\ReportOutput\axreport.rdf", DataDynamics.ActiveReports.Document.RdfFormat.AR20)

End Sub
//C#
private void Page_Load(object sender, System.EventArgs e)
{

rptActiveX rpt = new rptActiveX();
rpt.Run();
rpt.Document.Save(Server.MapPath("") + "\\ReportOutput\\axreport.rdf", 

DataDynamics.ActiveReports.Document.RdfFormat.AR20);
}

ActiveReports provides custom components for several formats, including PDF, HTML, RTF, Excel and plain 
text. Ultimate customizability is available by using any ASP.NET language. The following walkthroughs 
demonstrate how to set up report custom exporting to HTML, PDF, Excel, TIFF, RTF and plain text formats. 
For each of these walkthroughs, it is assumed that a reference to the appropriate 
DataDynamics.ActiveReports export filter has been added to the project.

 

Custom Exporting with HTML
Describes how to set up custom exporting to HTML of a report on the web. 

Custom Exporting with PDF

Custom Web Exporting Walkthroughs
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Describes how to set up custom exporting to PDF of a report on the web. 

Custom Exporting with Excel
Describes how to set up custom exporting to Excel of a report on the web. 

Custom Exporting with TIFF
Describes how to set up custom exporting to TIFF of a report on the web. 

Custom Exporting with RTF
Describes how to set up custom exporting to RTF of a report on the web. 

Custom Exporting with Plain Text
Describes how to set up custom exporting to Text of a report on the web.

ActiveReports provides custom components for several formats, including PDF, HTML, RTF, Excel, TIFF and 
plain text. Ultimate customizability is available by using any ASP.NET language. 

This walkthrough illustrates how to create a simple Web application and set up custom exporting in HTML 
format.

This walkthrough is split up into the following activities: 

l Adding an ActiveReport to an ASP.NET Web application 

l Connecting the report to a data source 

l Adding controls to the report to contain data 

l Adding the Html export control to the Web Form  

l Creating a public class for the HTML outputter 

l Adding code to the Web Form to export to HTML 

l Adding a folder to the project for report output 

To complete the walkthrough, you must have access to the Northwind database. For your convenience, a 
copy is included with ActiveReports at the following default location: C:\Program Files\Data 
Dynamics\ActiveReports for .NET 3.0\Data\NWIND.MDB. 

You must also have access to Internet Information Services either from your computer or from the server. 
You must also run the "Configure Web Sample" option from the Data Dynamics ActiveReports for .NET 3.0 
program menu from your Windows Start button.

When you have completed this walkthrough, you will have a report that looks similar to the following.

Walkthrough: Custom Exporting with HTML
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Adding an ActiveReport to an ASP.NET Web application

To add an ActiveReport to your project using Visual Studio 2003

1. Create a new ASP.NET Web application.  

2. From the Project menu, select Add New Item.  

3. Select ActiveReports 3.0 File and rename the file rptCustHTML. 

4. Click Open. 

To add an ActiveReport to your project using Visual Studio 2005

1. Create a new ASP.NET Web site.  

2. From the Website menu, select Add New Item. 

3. Select ActiveReports 3.0 File and rename the file rptCustHTML. 

4. Click Add.

5. Click Yes when a message box asks whether you would like to place the class in the 'App_Code' folder.

Note: To see the design view of your report in Visual Studio 2005, right-click the report in the Solution 
Explorer and select View Designer.

Connecting the report to a data source

To connect the report to a data source

1. Click on the gray report DataSource icon in the Detail section to open the report Datasource dialog. 

2. Click on Build.

3. Select Microsoft Jet 4.0 OLE DB Provider and click Next.

4. Click the ellipsis button to browse for the access path to the Northwind database. Click Open once you 
have selected the appropriate access path. 

5. Click OK to continue. 

6. In the Query field, type "Select * from customers order by country". 

7. Click OK to return to the report design surface. 

Adding controls to the report to contain data

To add controls to the report

1. Add a GroupHeader/Footer section to rptCustHTML. 

2. Make the following changes to the group header: 

¡ Change the Name property to ghCountries

¡ Change the BackColor property to Silver

¡ Change the DataField property to Country

3. Add labels with the following properties to ghCountries: 

4. Make the following changes to the detail section: 

Name Text Location Formatting

lblCustomerID Customer ID 0, 0 Bold

lblCompanyName Company Name 0.88, 0 Bold

lblContactName Contact Name 2.13, 0 Bold

lblAddress Address 3.19, 0 Bold

lblCity City 4.31, 0 Bold

lblPhone Phone 5.44, 0 Bold
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¡ Change the BackColor property to WhiteSmoke

¡ Change the CanShrink property to True

5. In the Report Explorer, expand the Fields node, then the Bound node. Drag the following fields onto 
the detail section and set the properties of each textbox as indicated. 

Adding the Html Export control to the Web Form

To add the Html Export control is Visual Studio 2003

1. Click on the Html Export control in the appropriate toolbox to select it. (See Adding ActiveReports 
controls for help on adding it to the toolbox.) 

2. Drag the control onto the Web Form. 

3. The control appears in the tray beneath the WebForm. 

To add the Html Export control is Visual Studio 2005

1. From the View menu, select Component Designer to go to the design view of the aspx file. 

2. Click on the Html Export control in the appropriate toolbox to select it. (See Adding ActiveReports 
controls for help on adding it to the toolbox.) 

3. Drag the control onto the aspx design view. 

Creating a public class for the HTML outputter

To create a public class

1. In the Solution Explorer window, right-click on your project name and select Add New Item. 

2. In the Templates window of the Add New Item dialog, select Class. 

3. Change the name of the file to "MyCustomHtmlOutputter" and click the Open button. (In Visual Studio 
2005, click the Add button and then select Yes to place the class in the 'App_Code' folder.) 

4. This opens the code view of the class file where you can add the code needed to create the public class. 

To write the code in Visual Basic

l Add the following code between "Public Class MyCustomHtmlOutputter" and "End Class". 

To write the code in C#

l Add the following code under "public class MyCustomHtmlOutputter". 

The following example shows what the complete code for the method looks like.

' Visual Basic
Imports System
Imports System.IO
Imports System.Web
Imports System.Text
Imports DataDynamics.ActiveReports
Imports DataDynamics.ActiveReports.Export.Html
Public Class MyCustomHtmlOutputter

Implements IOutputHtml
' The http context of the request.
Private context As System.Web.HttpContext = Nothing

Field Text Location

CustomerID Customer ID 0, 0

CompanyName Company Name 0.88, 0

ContactName Contact Name 2.13, 0

Address Address 3.19, 0

City City 4.31, 0

Phone Phone 5.44, 0
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' The directory the filename will be saved in--this will be used to ensure the filename 
' is unique.
Private dirToSave As System.IO.DirectoryInfo = Nothing
Public mainPage As String = ""
Public Sub New(ByVal context As System.Web.HttpContext)

If context Is Nothing Then
Throw New ArgumentNullException("context")

End If
Me.context = context
Dim dirName As String = context.Server.MapPath("ReportOutput")
Me.dirToSave = New DirectoryInfo(dirName)

End Sub
#Region "Implementation of IOutputHtml"
Public Function OutputHtmlData(ByVal info As DataDynamics.ActiveReports.Export.Html _

.HtmlOutputInfoArgs) As  String Implements IOutputHtml.OutputHtmlData
Dim temp As String = ""
Select Case info.OutputKind

Case HtmlOutputKind.BookmarksHtml
Case HtmlOutputKind.FramesetHtml

temp = Me.GenUniqueFileNameWithExtension(".html")
Dim fs As New FileStream(temp, FileMode.CreateNew)
Me.WriteStreamToStream(info.OutputStream, fs)
fs.Close()
Return temp

Case HtmlOutputKind.HtmlPage
' We want to hold on to the name of the main page so we can redirect the 

 ' browser to it
Me.mainPage = Me.GenUniqueFileNameWithExtension(".html")
Dim fs As New FileStream(Me.mainPage, FileMode.CreateNew)
Me.WriteStreamToStream(info.OutputStream, fs)
fs.Close()
Return Me.mainPage

Case HtmlOutputKind.ImageJpg
' should be a file with a .jpg extension:
temp = Me.GenUniqueFileNameWithExtension(".jpg")
Dim fs As New FileStream(temp, FileMode.CreateNew)
fs = File.Create(temp)
Me.WriteStreamToStream(info.OutputStream, fs)
fs.Close()
Return temp

Case HtmlOutputKind.ImagePng
' should be a file witha .png extension:
temp = Me.GenUniqueFileNameWithExtension(".png")
Dim fs As New FileStream(temp, FileMode.CreateNew)
Me.WriteStreamToStream(info.OutputStream, fs)
fs.Close()
Return temp

Case Else
' This case shouldn't really happen, but we'll default to html.
temp = Me.GenUniqueFileNameWithExtension(".html")
Dim fs As New FileStream(temp, FileMode.CreateNew)
Me.WriteStreamToStream(info.OutputStream, fs)
fs.Close()
Return temp

End Select
End Function
Public Sub Finish()
Implements IOutputHtml.Finish
End Sub
#End Region
Private Sub WriteStreamToStream(ByVal sourceStream As Stream, ByVal targetStream As Stream)

' What's the size of the source stream:
Dim size As Integer = CType(sourceStream.Length, Integer)
' Create a buffer that same size:
Dim buffer(size) As Byte
' Move the source stream to the beginning:
sourceStream.Seek(0, SeekOrigin.Begin)
'copy the whole sourceStream into our buffer:
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sourceStream.Read(buffer, 0, size)
'Write out buffer to the target stream:
targetStream.Write(buffer, 0, size)

End Sub
Private Function GenUniqueFileNameWithExtension(ByVal extensionWithDot As String) As String

Dim r As New System.Random()
Dim unique As Boolean = False
Dim filePath As String = ""
Dim iRandom As Integer = 0
' Generate a random name until it's unique:
While Not unique

iRandom = r.Next()
' Buld the full filename
Dim sb = New StringBuilder()
sb.Append(Me.dirToSave.FullName)
sb.Append(Path.DirectorySeparatorChar)
sb.Append(iRandom.ToString())
sb.Append(extensionWithDot)
filePath = sb.ToString()
If File.Exists(filePath) = False Then

unique = True
Else

unique = False
End If

End While
Return filePath

End Function
End Class
//C#
using System;
using System.IO;
using System.Web;
using System.Text;
using DataDynamics.ActiveReports;
using DataDynamics.ActiveReports.Export.Html;
public class MyCustomHtmlOutputter:DataDynamics.ActiveReports.Export.Html.IOutputHtml
{

// The http context of the request.
private System.Web.HttpContext context = null;
// The directory the filename will be saved in--this will be used to ensure the 

 // filename is unique.
private System.IO.DirectoryInfo dirToSave = null;
public string mainPage = "";
public MyCustomHtmlOutputter(System.Web.HttpContext context)

{
if (context == null)

throw new ArgumentNullException("context");
this.context = context;
string dirName = context.Server.MapPath("ReportOutput");
this.dirToSave = new DirectoryInfo(dirName);

}
#region Implementation of IOutputHtml
public string OutputHtmlData(DataDynamics.ActiveReports.Export.Html.HtmlOutputInfoArgs info)
{

string temp = "";
switch (info.OutputKind)
{

case HtmlOutputKind.BookmarksHtml:
case HtmlOutputKind.FramesetHtml:
{

temp = this.GenUniqueFileNameWithExtension(".html");
FileStream fs = File.Create(temp);
this.WriteStreamToStream(info.OutputStream, fs);
fs.Close();
return temp;

}
case HtmlOutputKind.HtmlPage:
{
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// We want to hold on to the name of the main page so we can
 // redirect the browser to it:

this.mainPage = this.GenUniqueFileNameWithExtension(".html");
FileStream fs = File.Create(this.mainPage);
this.WriteStreamToStream(info.OutputStream, fs);
fs.Close();
return this.mainPage;

}
case HtmlOutputKind.ImageJpg:
{

// should be a file with a .jpg extension:
temp = this.GenUniqueFileNameWithExtension(".jpg");
FileStream fs = File.Create(temp);
this.WriteStreamToStream(info.OutputStream, fs);
fs.Close();
return temp;

}
case HtmlOutputKind.ImagePng:
{

// should be a file witha .png extension:
temp = this.GenUniqueFileNameWithExtension(".png");
FileStream fs = File.Create(temp);
this.WriteStreamToStream(info.OutputStream, fs);
fs.Close();
return temp;

}
default:
{

// This case shouldn't really happen, but we'll default to html.
temp = this.GenUniqueFileNameWithExtension(".html");
FileStream fs = File.Create(temp);
this.WriteStreamToStream(info.OutputStream, fs);
fs.Close();
return temp;

}
}

}
public void Finish()
{
}
#endregion

private void WriteStreamToStream(Stream sourceStream, Stream targetStream)
{

// Whats the size of the source stream:
int size = (int)sourceStream.Length;
 
// Create a buffer that same size:
byte[] buffer = new byte[size];

// Move the source stream to the begining:
sourceStream.Seek(0, SeekOrigin.Begin);

// copy the whole sourceStream in to our buffer:
sourceStream.Read(buffer, 0, size);

// Write out buffer to the target stream:
targetStream.Write(buffer, 0, size);
}

/// <summary>
/// Generates a unqiue file name with the specified extension.
/// </summary>
/// <param name="extensionWithDot">
/// The file extension begining with a dot such as ".jpg".
/// </param>
/// <returns></returns>
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private string GenUniqueFileNameWithExtension(string extensionWithDot)
{
System.Random r = new Random();

bool unique = false;

string filePath = "";
int iRandom = 0;
// Generate a random name until it's unique:
while (!unique)
{
iRandom = r.Next();

 
// Buld the full filename
System.Text.StringBuilder sb = new System.Text.StringBuilder();
sb.Append(this.dirToSave.FullName);
sb.Append(Path.DirectorySeparatorChar);
sb.Append(iRandom.ToString());
sb.Append(extensionWithDot);

filePath =   sb.ToString();

 

unique = !File.Exists(filePath);
}

return filePath;

}
 

}

}

Adding code to the Web Form to export to HTML

To write the code in Visual Basic

l Double-click on the Web Form. This creates an event-handling method for the Web Form's Page Load 
event. Add the following code to the Page Load event. 

To write the code in C#

l Double-click on the Web Form. This creates an event-handling method for the Web Form's Page_Load 
event. Add the following code to the Page_Load event. 

The following example shows what the code for the method looks like.

' Visual Basic
Private Sub Page_Load(ByVal sender As System.Object, ByVal e As System.EventArgs) Handles  _

Dim rpt As New rptCustHTML()
Try

rpt.Run(False)
Catch eRunReport As Exception

' Failure running report, just report the error to the user:
Response.Clear()
Response.Write("<h1>Error running report:</h1>")
Response.Write(eRunReport.ToString())
Return

End Try
' Buffer this page's output until the report output is ready.
Response.Buffer = True
' Clear any part of this page that might have already been buffered for output.
Response.ClearContent()
' Clear any headers that might have already been buffered (such as the content type 
' for an HTML page)
Response.ClearHeaders()
' Tell the browser and the "network" that this resulting data of this page should be 
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' cached since this could be a dynamic report that changes upon each request.
Response.Cache.SetCacheability(HttpCacheability.NoCache)
' Tell the browser this is an Html document so it will use an appropriate viewer.
Response.ContentType = "text/HTML"
' Create the Html export object
Dim HtmlExport1 As New DataDynamics.ActiveReports.Export.Html.HtmlExport()
Dim outputter As New MyCustomHtmlOutputter(Me.Context)
HtmlExport1.Export(rpt.Document, outputter, "")
Response.Redirect("ReportOutput" + "/" + System.IO.Path.GetFileName _

 (outputter.mainPage))
End Sub
//C#
private void Page_Load(object sender, System.EventArgs e)
{

rptCustHTML rpt = new rptCustHTML();
try
{

rpt.Run(false);
}
catch (Exception eRunReport)
{

// Failure running report, just report the error to the user:
Response.Clear();
Response.Write("<h1>Error running report:</h1>");
Response.Write(eRunReport.ToString());
return;

}
// Buffer this page's output until the report output is ready.
Response.Buffer = true;
// Clear any part of this page that might have already been buffered for output.
Response.ClearContent();
// Clear any headers that might have already been buffered (such as the content 

 // type for an HTML page)
Response.ClearHeaders();
// Tell the browser and the "network" that this resulting data of this page should 

 // be cached since this could be a dynamic report that changes upon each request.
Response.Cache.SetCacheability(HttpCacheability.NoCache);
// Tell the browser this is an Html document so it will use an appropriate viewer.
Response.ContentType = "text/html";
// Create the HTML export object
DataDynamics.ActiveReports.Export.Html.HtmlExport html = new DataDynamics

 .ActiveReports.Export.Html.HtmlExport();
// Export the report to HTML in this session's webcache:
//this.htmlExport1.Export(rpt.Document, DataDynamics.ActiveReports.Web
MyCustomHtmlOutputter outputter = new MyCustomHtmlOutputter(this.Context);
this.htmlExport1.Export(rpt.Document, outputter, "");
Response.Redirect("ReportOutput" + "/" + System.IO.Path.GetFileName

 (outputter.mainPage));
}

Adding a folder to the project for report output

To add a folder to the project

1. Open Windows Explorer and browse to the folder in which your project is contained. 

2. On the File menu, click New > Folder. 

3. Name the folder "ReportOutput". 

4. Make sure that you have write permissions for this folder. 

ActiveReports provides custom components for several formats, including PDF, HTML, RTF, Excel, TIFF and 
plain text. Ultimate customizability is available by using any ASP.NET language. 

Walkthrough: Custom Exporting with PDF
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This walkthrough illustrates how to create a simple Web application and set up custom exporting in PDF 
format.

This walkthrough is split up into the following activities: 

l Adding an ActiveReport to an ASP.NET Web application 

l Connecting the report to a data source 

l Adding controls to the report to contain data 

l Adding the PDF Export control to the Web Form  

l Adding code to the Web Form to export to PDF 

To complete the walkthrough, you must have access to the Northwind database. For your convenience, a 
copy is included with ActiveReports at the following default location: C:\Program Files\Data 
Dynamics\ActiveReports for .NET 3.0\Data\NWIND.MDB. 

You must also have access to Internet Information Services either from your computer or from the server 
and run the "Configure Web Sample" option from the Data Dynamics ActiveReports for .NET 3.0 program 
menu from your Windows Start button.

When you have completed this walkthrough, you will have a report in PDF format that looks similar to the 
following.

Adding an ActiveReport to an ASP.NET Web application

To add an ActiveReport to your project using Visual Studio 2003

1. Create a new ASP.NET Web application.  

2. From the Project menu, select Add New Item.  

3. Select ActiveReports 3.0 File and rename the file rptCustomPDF. 

4. Click Open. 

To add an ActiveReport to your project using Visual Studio 2005
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1. Create a new ASP.NET Web site.  

2. From the Website menu, select Add New Item. 

3. Select ActiveReports 3.0 File and rename the file rptCustomPDF. 

4. Click Add.

5. Click Yes when a message box asks whether you would like to place the class in the 'App_Code' folder.

Note: To see the design view of your report in Visual Studio 2005, right-click the report in the Solution 
Explorer and select View Designer.

Connecting the report to a data source

To connect the report to a data source

1. Click the gray report DataSource icon in the Detail section to open the report DataSource dialog. 

2. Click on Build.

3. Select Microsoft Jet 4.0 OLE DB Provider and click Next.

4. Click the ellipsis button to browse for the access path to the Northwind database. Click Open once you 
have selected the appropriate access path. 

5. Click OK to continue. 

6. In the Query field, type "Select * from products order by categoryID". 

7. Click OK to return to the report design surface. 

Adding controls to the report to contain data

To add controls to the report

1. Add a GroupHeader/Footer section to rptCustomPDF. 

2. Make the following changes to the group header: 

¡ Change the Name property to ghProducts

¡ Change the BackColor property to MediumSlateBlue

¡ Change the DataField property to CategoryID

3. Add labels with the following properties to ghProducts: 

4. Make the following changes to the detail section: 

¡ Change the BackColor property to LightGray

¡ Change the CanShrink property to True

5. In the Report Explorer, expand the Fields node, then the Bound node. Drag the following fields onto 
the detail section and set the following properties of each textbox as indicated. 

Formatting Name Text Location

Bold lblProductID Product ID 0, 0 

Bold lblProductName Product Name 1, 0 

Bold lblUnitsInStock Units in Stock 2.69, 0 

Bold lblUnitsOnOrder Units on Order 3.81, 0 

Bold lblUnitPrice Unit Price 5, 0 

Field Text Location Output Format

ProductID Product ID 0, 0 NA

ProductName Product Name 1, 0 NA

UnitsInStock Units in Stock 2.69, 0 NA

UnitsOnOrder Units on Order 3.81, 0 NA
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Adding the PDF Export control to the Web Form

To add the PDF Export control using Visual Studio 2003

1. Click on the PDF Export control in the appropriate toolbox to select it. (See Adding ActiveReports 
controls for help on adding it to the toolbox.) 

2. Drag the control onto the Web Form. 

3. The control appears in the tray beneath the WebForm.

To add the PDF Export control using Visual Studio 2005

1. From the View menu, select Component Designer to go to the design view of the aspx file. 

2. Click on the PDF Export control in the appropriate toolbox to select it. (See Adding ActiveReports 
controls for help on adding it to the toolbox.) 

3. Drag the control onto the aspx design view. 

Adding code to the Web Form to export to PDF

To write the code in Visual Basic

l Double-click on WebForm1. This creates an event-handling method for WebForm1's Page_Load event. 
Add the following code to the Page_Load event. 

To write the code in C#

l Double-click on WebForm1. This creates an event-handling method for WebForm1's Page_Load event. 
Add the following code to the Page_Load event. 

The following example shows what the code for the method looks like.

' Visual Basic
Private Sub Page_Load(ByVal sender As Object, ByVal e As System.EventArgs) Handles _

MyBase.Load
Dim m_stream As New System.IO.MemoryStream()
Dim rpt As New rptCustomPDF()
rpt.Run()
If Me.pdfExport1 Is Nothing Then

Me.pdfExport1 = New DataDynamics.ActiveReports.Export.Pdf.PdfExport
End If
Me.PdfExport1.Export(rpt.Document, m_stream)
m_stream.Position = 0
Response.ContentType = "application/pdf"

Response.AddHeader("content-disposition","inline; filename=MyExport.pdf")
Response.BinaryWrite(m_stream.ToArray())
Response.End()

End Sub
//C#
private void Page_Load(object sender, System.EventArgs e)
{

System.IO.MemoryStream m_stream = new System.IO.MemoryStream();
rptCustomPDF rpt = new rptCustomPDF();
rpt.Run();
if (this.pdfExport1 == null)
{

this.pdfExport1 = new DataDynamics.ActiveReports.Export.Pdf.PdfExport();
}
this.pdfExport1.Export(rpt.Document, m_stream);
m_stream.Position = 0;
Response.ContentType = "application/pdf";
Response.AddHeader("content-disposition","inline; filename=MyExport.pdf");
Response.BinaryWrite(m_stream.ToArray());
Response.End();

}

UnitPrice Unit Price 5, 0 Currency
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Run the project to see the report displayed in a PDF viewer within your internet browser.

ActiveReports provides custom components for several formats, including PDF, HTML, RTF, Excel, TIFF and 
plain text. Ultimate customizability is available by using any ASP.NET language. 

This walkthrough illustrates how to create a simple Web application and set up custom exporting in Excel 
format.

This walkthrough is split up into the following activities: 

l Adding an ActiveReport to an ASP.NET Web application 

l Connecting the report to a data source 

l Adding controls to the report to contain data 

l Adding the Excel export control to the Web Form 

l Adding code to the Web Form to export to Excel 

To complete the walkthrough, you must have access to the Northwind database. For your convenience, a 
copy is included with ActiveReports at the following default location: C:\Program Files\Data 
Dynamics\ActiveReports for .NET 3.0\Data\NWIND.MDB. 

You must also have access to Internet Information Services either from your computer or from the server 
and run the "Configure Web Sample" option from the Data Dynamics ActiveReports for .NET 3.0 program 
menu from your Windows Start button.

When you have completed this walkthrough, you will have a report in Excel format that looks similar to the 
following.

Adding an ActiveReport to an ASP.NET Web application

Walkthrough: Custom Exporting with Excel
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To add an ActiveReport to your project using Visual Studio 2003

1. Create a new ASP.NET Web application.  

2. From the Project menu, select Add New Item.  

3. Select ActiveReports 3.0 File and rename the file rptCustomExcel. 

4. Click Open. 

To add an ActiveReport to your project using Visual Studio 2005

1. Create a new ASP.NET Web site.  

2. From the Website menu, select Add New Item. 

3. Select ActiveReports 3.0 File and rename the file rptCustomExcel. 

4. Click Add.

5. Click Yes when a message box asks whether you would like to place the class in the 'App_Code' folder.

Note: To see the design view of your report in Visual Studio 2005, right-click the report in the Solution 
Explorer and select View Designer.

Connecting the report to a data source

To connect the report to a data source

1. Click the gray report DataSource icon in the Detail section to open the report DataSource dialog. 

2. Click the Build button. 

3. Select Microsoft Jet 4.0 OLE DB Provider and click Next.

4. Click the ellipsis button to browse for the access path to the Northwind database. 

5. Click Open once you have selected the appropriate access path. 

6. Click OK to continue. 

7. In the Query field, type "Select * from products order by categoryID". 

8. Click OK to return to the report design surface. 

Adding controls to the report to contain data

To add controls to the report

1. Add a GroupHeader/Footer section to rptExcel. 

2. Make the following changes to the group header: 

¡ Change the Name property to ghProducts 

¡ Change the BackColor property to MediumPurple

¡ Change the DataField property to CategoryID

3. Add labels with the following properties to ghProducts: 

4. Make the following changes to the detail section: 

¡ Change the BackColor property to Lavender

¡ Change the CanShrink property to True

5. In the Report Explorer, expand the Fields node, then the Bound node. Drag the following fields onto 

Formatting Name Text Location

Bold lblProductID Product ID 0, 0 

Bold lblProductName Product Name 1.06, 0 

Bold lblUnitsInStock Units In Stock 3.5, 0 

Bold lblUnitsOnOrder Units On Order 4.56, 0 

Bold lblUnitPrice Unit Price 5.7, 0 
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the detail section and set the following properties of each textbox as indicated. 

Adding the Excel Export control to the Web Form

To add the Excel Export control using Visual Studio 2003

1. Click on the XlsExport control in the appropriate toolbox to select it. (See Adding ActiveReports 
controls for help on adding it to the toolbox.) 

2. Drag the control onto the Web Form. 

3. The control appears in the tray beneath the WebForm.

To add the Excel Export control using Visual Studio 2005

1. From the View menu, select Component Designer to go to the design view of the aspx file. 

2. Click on the XlsExport control in the appropriate toolbox to select it. (See Adding ActiveReports 
controls for help on adding it to the toolbox.) 

3. Drag the control onto the aspx design view. 

Adding code to the Web Form to export to Excel

To write the code in Visual Basic

l Double-click on the Web Form. This creates an event-handling method for the Web Form's Page_Load 
event. Add the following code to the Page_Load event. 

To write the code in C#

l Double-click on the Web Form. This creates an event-handling method for the Web Form's Page_Load 
event. Add the following code to the Page_Load event. 

The following example shows what the code for the method looks like.

' Visual Basic
Protected Sub Page_Load(ByVal sender As Object, ByVal e As System.EventArgs) Handles Me.Load

Dim m_stream As New System.IO.MemoryStream()
Dim rpt As New rptCustomExcel()
rpt.Run()
If Me.xlsExport1 Is Nothing Then

Me.xlsExport1 = New DataDynamics.ActiveReports.Export.Xls.XlsExport
End If
Me.xlsExport1.MinColumnWidth = 0.5
Me.xlsExport1.Export(rpt.Document, m_stream)
m_stream.Position = 0
Response.ContentType = "application/vnd.ms-excel"
Response.AddHeader("content-disposition", "inline; filename=MyExport.xls")
Response.BinaryWrite(m_stream.ToArray())
Response.End()

End Sub
//C#
private void Page_Load(object sender, System.EventArgs e)
{

System.IO.MemoryStream m_stream = new System.IO.MemoryStream();
rptCustomExcel rpt = new rptCustomExcel();
rpt.Run();
if (this.xlsExport1 == null) 
{ 

DataField Text Location Output Format

ProductID Product ID 0, 0 NA

ProductName Product Name 1.06, 0 NA

UnitsInStock Units In Stock 3.5, 0 NA

UnitsOnOrder Units On Order 4.56, 0 NA

UnitPrice Unit Price 5.7, 0 Currency
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this.xlsExport1 = new DataDynamics.ActiveReports.Export.Xls.XlsExport(); 
} 
this.xlsExport1.MinColumnWidth = 0.5;
this.xlsExport1.Export(rpt.Document, m_stream);
m_stream.Position = 0;
Response.ContentType = "application/vnd.ms-excel";
Response.AddHeader("content-disposition","inline; filename=MyExport.xls");
Response.BinaryWrite(m_stream.ToArray());
Response.End();

}
To view the results in your Web browser, run the project and click the Open button when prompted.

ActiveReports provides custom components for several formats, including PDF, HTML, RTF, TIFF, Excel and 
plain text. Ultimate customizability is available by using any ASP.NET language. 

This walkthrough illustrates how to create a simple Web application and set up custom exporting in TIFF 
format.

This walkthrough is split up into the following activities: 

l Adding an ActiveReport to an ASP.NET Web application 

l Connecting the report to a data source 

l Adding controls to the report to contain data 

l Adding the TIFF export control to the Web Form 

l Adding code to the Web Form to export to a TIFF image 

To complete the walkthrough, you must have access to the Northwind database. For your convenience, a 
copy is included with ActiveReports at the following default location: C:\Program Files\Data 
Dynamics\ActiveReports for .NET 3.0\Data\NWIND.MDB. 

You must also have access to Internet Information Services either from your computer or from the server 
and run the "Configure Web Sample" option from the Data Dynamics ActiveReports for .NET 3.0 program 
menu from your Windows Start button.

When you have completed this walkthrough, you will have a TIFF image that looks similar to the following.

Walkthrough: Custom Exporting with TIFF
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Adding an ActiveReport to an ASP.NET Web application

To add an ActiveReport to your project using Visual Studio 2003

1. Create a new ASP.NET Web application.  

2. From the Project menu, select Add New Item.  

3. Select ActiveReports 3.0 File and rename the file rptCustomTiff. 

4. Click Open. 

To add an ActiveReport to your project using Visual Studio 2005

1. Create a new ASP.NET Web site.  

2. From the Website menu, select Add New Item. 

3. Select ActiveReports 3.0 File and rename the file rptCustomTiff. 

4. Click Add.

5. Click Yes when a message box asks whether you would like to place the class in the 'App_Code' folder.

Note: To see the design view of your report in Visual Studio 2005, right-click the report in the Solution 
Explorer and select View Designer.

Connecting the report to a data source

To connect the report to a data source

1. Click on the gray report DataSource icon in the Detail section to open the report DataSource dialog. 

2. Click on Build.
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3. Select Microsoft Jet 4.0 OLE DB Provider and click Next.

4. Click the ellipsis button to browse for the access path to the Northwind database. Click Open once you 
have selected the appropriate access path. 

5. Click OK to continue. 

6. In the Query field, type "Select * from products order by categoryID". 

7. Click OK to return to the report design surface. 

Adding controls to the report to contain data

To add controls to the report

1. Add a GroupHeader/Footer section to rptCustomTiff. 

2. Make the following changes to the group header: 

¡ Change the Name property to ghProducts 

¡ Change the BackColor property to MediumPurple

¡ Change the DataField property to CategoryID

3. Add labels with the following properties to ghProducts: 

4. Make the following changes to the detail section: 

¡ Change the BackColor property to Lavender

¡ Change the CanShrink property to True

5. In the Report Explorer, expand the Fields node, then the Bound node. Drag the following fields onto 
the detail section and set the following properties of each textbox as indicated. 

Adding the TIFF Export control to the Web Form

To add the TIFF Export control using Visual Studio 2003

1. Click on the TiffExport control in the appropriate toolbox to select it. (See Adding ActiveReports 
controls for help on adding it to the toolbox.) 

2. Drag the control onto the Web Form. 

3. The control appears in the tray beneath the WebForm.

To add the TIFF Export control using Visual Studio 2005

1. From the View menu, select Component Designer to go to the design view of the aspx file. 

2. Click on the TiffExport control in the appropriate toolbox to select it. (See Adding ActiveReports 
controls for help on adding it to the toolbox.) 

Formatting Name Text Location

Bold lblProductID Product ID 0, 0 

Bold lblProductName Product Name 1.06, 0 

Bold lblUnitsInStock Units In Stock 3.5, 0 

Bold lblUnitsOnOrder Units On Order 4.56, 0 

Bold lblUnitPrice Unit Price 5.7, 0 

DataField Text Location Output Format

ProductID Product ID 0, 0 NA

ProductName Product Name 1.06, 0 NA

UnitsInStock Units In Stock 3.5, 0 NA

UnitsOnOrder Units On Order 4.56, 0 NA

UnitPrice Unit Price 5.7, 0 Currency
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3. Drag the control onto the aspx design view. 

Adding code to the Web Form to export to TIFF

To write the code in Visual Basic

l Double-click on the Web Form. This creates an event-handling method for the Web Form's Page_Load 
event. Add the following code to the Page_Load event. 

To write the code in C#

l Double-click on theWeb Form. This creates an event-handling method for the Web Form's Page_Load 
event. Add the following code to the Page_Load event. 

The following example shows what the code for the method looks like.

' Visual Basic
Protected Sub Page_Load(ByVal sender As Object, ByVal e As System.EventArgs) Handles Me.Load

Dim m_stream As New System.IO.MemoryStream()
Dim rpt As New rptCustomTiff()
rpt.Run()
If Me.tiffExport1 Is Nothing Then

Me.tiffExport1 = New DataDynamics.ActiveReports.Export.Tiff.TiffExport
End If
Me.tiffExport1.CompressionScheme = DataDynamics.ActiveReports.Export.Tiff.CompressionScheme.None
Me.tiffExport1.Export(rpt.Document, m_stream)
m_stream.Position = 0
Response.ContentType = "image/tiff"
Response.AddHeader("content-disposition", "inline; filename=MyExport.tiff")
Response.BinaryWrite(m_stream.ToArray())
Response.End()

End Sub
//C#
private void Page_Load(object sender, System.EventArgs e)
{

System.IO.MemoryStream m_stream = new System.IO.MemoryStream();
rptCustomTiff rpt = new rptCustomTiff();
rpt.Run();
if (this.tiffExport1 == null) 
{ 

this.tiffExport1 = new DataDynamics.ActiveReports.Export.Tiff.TiffExport(); 
} 
this.tiffExport1.CompressionScheme = DataDynamics.ActiveReports.Export.Tiff.CompressionScheme.None;
this.tiffExport1.Export(rpt.Document, m_stream);
m_stream.Position = 0;
Response.ContentType = "image/tiff";
Response.AddHeader("content-disposition","inline; filename=MyExport.tiff");
Response.BinaryWrite(m_stream.ToArray());
Response.End();

}
To view the results in your Web browser, run the project and click the Open button when prompted.

ActiveReports provides custom components for several formats, including PDF, HTML, RTF, TIFF, Excel and 
plain text. Ultimate customizability is available by using any ASP.NET language. 

This walkthrough illustrates how to create a simple Web application and set up custom exporting in RTF 
format.

This walkthrough is split up into the following activities: 

l Adding an ActiveReport to an ASP.NET Web application 

l Connecting the report to a data source 

l Adding controls to the report to contain data 

l Adding the RTF export control to the Web Form 

Walkthrough: Custom Exporting with RTF
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l Adding code to the Web Form to export to RTF 

To complete the walkthrough, you must have access to the Northwind database. For your convenience, a 
copy is included with ActiveReports at the following default location: C:\Program Files\Data 
Dynamics\ActiveReports for .NET 3.0\Data\NWIND.MDB. 

You must also have access to Internet Information Services either from your computer or from the server 
and run the "Configure Web Sample" option from the Data Dynamics ActiveReports for .NET 3.0 program 
menu from your Windows Start button.

When you have completed this walkthrough, you will have a report in RTF format that looks similar to the 
following.

Adding an ActiveReport to an ASP.NET Web application

To add an ActiveReport to your project using Visual Studio 2003

1. Create a new ASP.NET Web application.  

2. From the Project menu, select Add New Item.  

3. Select ActiveReports 3.0 File and rename the file rptCustomRtf. 

4. Click Open. 

To add an ActiveReport to your project using Visual Studio 2005

1. Create a new ASP.NET Web site.  

2. From the Website menu, select Add New Item. 

3. Select ActiveReports 3.0 File and rename the file rptCustomRtf. 

4. Click Add.
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5. Click Yes when a message box asks whether you would like to place the class in the 'App_Code' folder.

Note: To see the design view of your report in Visual Studio 2005, right-click the report in the Solution 
Explorer and select View Designer.

Connecting the report to a data source

To connect the report to a data source

1. Click the gray report DataSource icon in the Detail section to open the report DataSource dialog. 

2. Click the Build button. 

3. Select Microsoft Jet 4.0 OLE DB Provider and click Next.

4. Click the ellipsis (...) button to browse for the access path to the Northwind database. Click Open once 
you have selected the appropriate access path. 

5. Click OK to continue. 

6. In the Query field, type "Select * from products order by categoryID". 

7. Click OK to return to the report design surface. 

Adding controls to the report to contain data

To add controls to the report

1. Add a GroupHeader/Footer section to rptCustomRtf. 

2. Make the following changes to the group header: 

¡ Change the Name property to ghProducts 

¡ Change the DataField property to CategoryID

3. Add labels with the following properties to ghProducts: 

4. Make the following change to the detail section: 

¡ Change the CanShrink property to True

5. In the Report Explorer, expand the Fields node, then the Bound node. Drag the following fields onto 
the detail section and set the following properties of each textbox as indicated. 

Adding the RTF Export control to the Web Form

To add the Excel Export control using Visual Studio 2003

1. Click on the XlsExport control in the appropriate toolbox to select it. (See Adding ActiveReports 
controls for help on adding it to the toolbox.) 

Formatting Name Text Location

Bold lblProductID Product ID 0, 0 

Bold lblProductName Product Name 1.06, 0 

Bold lblUnitsInStock Units In Stock 3.5, 0 

Bold lblUnitsOnOrder Units On Order 4.56, 0 

Bold lblUnitPrice Unit Price 5.7, 0 

DataField Text Location Output Format

ProductID Product ID 0, 0 NA

ProductName Product Name 1.06, 0 NA

UnitsInStock Units In Stock 3.5, 0 NA

UnitsOnOrder Units On Order 4.56, 0 NA

UnitPrice Unit Price 5.7, 0 Currency
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2. Drag the control onto the Web Form. 

3. The control appears in the tray beneath the WebForm.

To add the Excel Export control using Visual Studio 2005

1. From the View menu, select Component Designer to go to the design view of the aspx file. 

2. Click on the XlsExport control in the appropriate toolbox to select it. (See Adding ActiveReports 
controls for help on adding it to the toolbox.) 

3. Drag the control onto the aspx design view. 

Adding code to the Web Form to export to RTF

To write the code in Visual Basic

l Double-click on the Web Form. This creates an event-handling method for the Web Form's Page_Load 
event. Add the following code to the Page_Load event. 

To write the code in C#

l Double-click on the Web Form. This creates an event-handling method for the Web Form's Page_Load 
event. Add the following code to the Page_Load event. 

The following example shows what the code for the method looks like.

' Visual Basic
Protected Sub Page_Load(ByVal sender As Object, ByVal e As System.EventArgs) Handles Me.Load

Dim m_stream As New System.IO.MemoryStream()
Dim rpt As New rptCustomRtf()
rpt.Run()
If Me.rtfExport1 Is Nothing Then

Me.rtfExport1 = New DataDynamics.ActiveReports.Export.Rtf.RtfExport
End If
Me.rtfExport1.Export(rpt.Document, m_stream)
m_stream.Position = 0
Response.ContentType = "application/msword"
Response.AddHeader("content-disposition", "inline; filename=MyExport.rtf")
Response.BinaryWrite(m_stream.ToArray())
Response.End()

End Sub
//C#
private void Page_Load(object sender, System.EventArgs e)
{

System.IO.MemoryStream m_stream = new System.IO.MemoryStream();
rptCustomRtf rpt = new rptCustomRtf();
rpt.Run();
if (this.rtfExport1 == null) 
{ 

this.rtfExport1 = new DataDynamics.ActiveReports.Export.Rtf.RtfExport(); 
} 
this.rtfExport1.Export(rpt.Document, m_stream);
m_stream.Position = 0;
Response.ContentType = "application/msword";
Response.AddHeader("content-disposition","inline; filename=MyExport.rtf");
Response.BinaryWrite(m_stream.ToArray());
Response.End();

}
To view the results in your Web browser, run the project and click the Open button when prompted.

ActiveReports provides custom components for several formats, including PDF, HTML, RTF, TIFF, Excel and 
plain text. Ultimate customizability is available by using any ASP.NET language. 

This walkthrough illustrates how to create a simple Web application and set up custom exporting in plain text 
format.

Custom Exporting with Plain Text
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This walkthrough is split up into the following activities: 

l Adding an ActiveReport to an ASP.NET Web application 

l Connecting the report to a data source 

l Adding controls to the report to contain data 

l Adding the Text export control to the Web Form 

l Adding code to the Web Form to export to Text 

To complete the walkthrough, you must have access to the Northwind database. For your convenience, a 
copy is included with ActiveReports at the following default location: C:\Program Files\Data 
Dynamics\ActiveReports for .NET 3.0\Data\NWIND.MDB. 

You must also have access to Internet Information Services either from your computer or from the server 
and run the "Configure Web Sample" option from the Data Dynamics ActiveReports for .NET 3.0 program 
menu from your Windows Start button.

When you have completed this walkthrough, you will have a report in comma-delimited text format that looks 
similar to the following.

Adding an ActiveReport to an ASP.NET Web application

To add an ActiveReport to your project using Visual Studio 2003

1. Create a new ASP.NET Web application.  

2. From the Project menu, select Add New Item.  

3. Select ActiveReports 3.0 File and rename the file rptCustomText. 

4. Click Open. 

To add an ActiveReport to your project using Visual Studio 2005

1. Create a new ASP.NET Web site.  

2. From the Website menu, select Add New Item. 
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3. Select ActiveReports 3.0 File and rename the file rptCustomText. 

4. Click Add.

5. Click Yes when a message box asks whether you would like to place the class in the 'App_Code' folder.

Note: To see the design view of your report in Visual Studio 2005, right-click the report in the Solution 
Explorer and select View Designer.

Connecting the report to a data source

To connect the report to a data source

1. Click on the gray report DataSource icon in the Detail section to open the report DataSource dialog. 

2. Click on Build.

3. Select Microsoft Jet 4.0 OLE DB Provider and click Next.

4. Click the ellipsis button to browse for the access path to the Northwind database. Click Open once you 
have selected the appropriate access path. 

5. Click OK to continue. 

6. In the Query field, type "Select * from products order by categoryID". 

7. Click OK to return to the report design surface. 

Adding controls to the report to contain data

To add controls to the report

1. Add a GroupHeader/Footer section to rptExcel. 

2. Make the following changes to the group header: 

¡ Change the Name property to ghProducts 

¡ Change the DataField property to CategoryID

3. Add labels with the following properties to ghProducts: 

4. Make the following changes to the detail section: 

¡ Change the CanShrink property to True

5. In the Report Explorer, expand the Fields node, then the Bound node. Drag the following fields onto 
the detail section and set the following properties of each textbox as indicated. 

Adding the Text Export control to the Web Form

To add the Text Export control using Visual Studio 2003

Name Text Location

lblProductID Product ID 0, 0 

lblProductName Product Name 1.06, 0 

lblUnitsInStock Units In Stock 3.5, 0 

lblUnitsOnOrder Units On Order 4.56, 0 

lblUnitPrice Unit Price 5.7, 0 

DataField Text Location Output Format

ProductID Product ID 0, 0 NA

ProductName Product Name 1.06, 0 NA

UnitsInStock Units In Stock 3.5, 0 NA

UnitsOnOrder Units On Order 4.56, 0 NA

UnitPrice Unit Price 5.7, 0 Currency
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1. Click on the TextExport control in the appropriate toolbox to select it. (See Adding ActiveReports 
controls for help on adding it to the toolbox.) 

2. Drag the control onto the Web Form. 

3. The control appears in the tray beneath the WebForm.

To add the Text Export control using Visual Studio 2005

1. From the View menu, select Component Designer to go to the design view of the aspx file. 

2. Click on the TextExport control in the appropriate toolbox to select it. (See Adding ActiveReports 
controls for help on adding it to the toolbox.) 

3. Drag the control onto the aspx design view. 

Adding code to the Web Form to export to Text

To write the code in Visual Basic

l Double-click on the Web Form. This creates an event-handling method for the Web Form's Page_Load 
event. Add the following code to the Page_Load event. 

To write the code in C#

l Double-click on the Web Form. This creates an event-handling method for Web Form's Page_Load event. 
Add the following code to the Page_Load event. 

The following example shows what the code for the method looks like.

' Visual Basic
Protected Sub Page_Load(ByVal sender As Object, ByVal e As System.EventArgs) Handles Me.Load

Dim m_stream As New System.IO.MemoryStream()
Dim rpt As New rptCustomText()
rpt.Run()
If Me.textExport1 Is Nothing Then

Me.textExport1 = New DataDynamics.ActiveReports.Export.Text.TextExport
End If
Me.textExport1.Export(rpt.Document, m_stream)
m_stream.Position = 0
Response.ContentType = "text/plain"
Response.BinaryWrite(m_stream.ToArray())
Response.End()

End Sub
//C#
private void Page_Load(object sender, System.EventArgs e)
{

System.IO.MemoryStream m_stream = new System.IO.MemoryStream();
rptCustomText rpt = new rptCustomText();
rpt.Run();
if (this.textExport1 == null) 
{ 

this.textExport1 = new DataDynamics.ActiveReports.Export.Text.TextExport(); 
} 
this.textExport1.Export(rpt.Document, m_stream);
m_stream.Position = 0;
Response.ContentType = "text/plain";
Response.BinaryWrite(m_stream.ToArray());
Response.End();

}
To view the results in your Web browser, run the project.

Follow this guide to deploy ActiveReports Web projects to your Web server. 

This walkthrough is split up into the following activities: 

l Adding referenced DLLs to your project 

Web Deployment
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l Installing prerequisites on the server 

l Copying your project to the server 

l Setting permissions on the server

To complete this walkthrough, you must have access to the Microsoft .NET Framework version 1.1 SP 1, or 
2.0 and the coordinating version of ASP.NET. You must also have access to Internet Information Services 
version 5.1 or 6.0, and you need administrative access to the server. For examples of how to create 
ActiveReports Web projects, see the walkthroughs linked at the bottom of this topic. 

Adding referenced DLLs to your project

To add referenced DLLs to your Visual Studio 2003 project

1. Open an ActiveReports Web application in Visual Studio. 

2. In the Solution Explorer, expand the References and select the ActiveReports reference. 

3. In the Properties grid, change the Copy Local property to True. (This ensures that the copy of the dll you 
are referencing stays with the project.) 

4. Repeat steps 2 and 3 for each ActiveReports reference. 

5. From the Build menu, select Build Solution or Rebuild Solution. (If you leave out this step, the DLLs are 
not added to your bin folder.)

To add referenced DLLs to your Visual Studio 2005 project

1. In Windows Explorer, navigate to the ActiveReports DLLs. By default, these are installed in C:\Program 
Files\Common Files\Data Dynamics\ActiveReports for .NET 3.0.  

2. Copy any DLLs used by your project. (If you are unsure which are necessary, open the project and look 
in the Class View under the References node.) 

3. Paste the DLLs into the Bin folder of your project. 

4. From the Build menu, select Build Solution or Rebuild Solution. 

Installing prerequisites on the server

To install prerequisites on the server

Follow Microsoft's instructions to install each of the following on your Web server: 

1. The Microsoft .NET Framework version 1.1 SP1 or 2.0 

2. Internet Information Services (IIS) version 5.1 or 6.0 

3. ASP.NET version 1.1 SP1, or 2.0 (must be the same version as the Framework)

Copying your project to the server

To copy your project to the server

1. Copy the entire directory containing your project to the server. 

2. If your project is in a virtual directory on your local machine (i.e. C:\Inetpub\wwwroot\YourProject), you 
must set up a virtual directory in IIS in the server as well.

Setting permissions on the server
Depending on your project, you may need to set permissions to allow ActiveReports access to data or folders.

Some examples of required permissions on the server

1. If you are saving files (i.e. PDF or RDF) to a folder on Windows XP or 2000 machines, the ASPNET user ID 
needs Write access to that folder. For Windows 2003, it's user configurable, so you need to find the name 
assigned to the ASPNET user. 

2. If you are reading anything from any folder, you need to assign Read access to it. 

3. If your reports run on any networked data source (i.e. SQL, Access, etc.) you need to assign Read access 
to it.
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ActiveReports provides support for web services to be used to return a dataset as a data source for a report 
or to return an ActiveReport document to show in a Windows Forms viewer. The following walkthroughs show 
how to create a simple web service for each scenario and how to create a Windows client application for each 
web service.

 

dataset Web Service
Describes how to set up a simple web service that returns a dataset. 

dataset Windows Application
Describes how to set up a Windows client application for the dataset Web Service. 

 

ActiveReports Document Web Service
Describes how to set up a simple web service that returns an ActiveReports document. 

ActiveReports Document Windows Application
Describes how to set up a Windows client application for the ActiveReports Document Web Service. 

With ASP.NET, it is easy to set up a Web Service that returns a dataset which you can use as a data source 
for an ActiveReport. 

This walkthrough illustrates how to create a simple Web Service that returns a dataset.

This walkthrough is split up into the following activities: 

l Creating an ASP.NET Web Service project 

l Adding code to create the Web Method 

l Testing the Web Service 

l Publishing the Web Service

To complete the walkthrough, you must have access to the Northwind database. For your convenience, a 
copy is included with ActiveReports at the following default location: C:\Program Files\Data 
Dynamics\ActiveReports for .NET 3.0\Data\NWIND.MDB. 

When you have completed this walkthrough, you will have created a Web Service that returns a dataset 
which can be used as a data source for an ActiveReport.

Creating an ASP.NET Web Service project

To create an ASP.NET Web Service project in Visual Studio 2003

1. From the File menu, select New > Project.

2. In the Templates window of the New Project dialog, select ASP.NET Web Service. 

3. Change the name of the project from WebService1 to DataSetWS. 

4. Click OK to open the new project in Visual Studio.  

To create an ASP.NET Web Service project in Visual Studio 2005

1. From the File menu, select New > Web Site.

2. In the Templates window of the New Web Site dialog, select ASP.NET Web Service. 

3. Change the name of the project from WebService1 to DataSetWS. 

4. Click OK to open the new project in Visual Studio. 

Adding code to create the Web Method

Web Services Walkthroughs

DataSet Web Service
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To write the code to create the Web Method

l Right-click on the Service1.asmx page and select View Code to display the code view for the page. (In 
Visual Studio 2005, the code view displays by default.) 

l Add the following code under the Web Services Designer Generated Code section to create the Web 
Service. (In Visual Studio 2005, just replace the existing WebMethod and function with this code.)

'Visual Basic
Private connString As String
'Change your data source path as needed
<WebMethod(Description:="Returns a DataSet containing all Products")> _
Public Function GetProduct() As Data.DataSet

connString = "Provider=Microsoft.Jet.OLEDB.4.0;Data Source=C:/Northwind.mdb; _
Persist Security Info=False"

Dim adapter As New Data.OleDb.OleDbDataAdapter("select * from products", connString)
Dim ds As New Data.DataSet()
adapter.Fill(ds, "Products")
Return ds

End Function

//C#
//Change your data source path as needed
private static string connString = "Provider=Microsoft.Jet.OLEDB.4.0;Data Source= 

C:/Northwind.mdb;Persist Security Info=False";
[WebMethod(Description="Returns a DataSet containing all Products")]
public Data.DataSet GetProduct()
{

Data.OleDb.OleDbDataAdapter adapter;
Data.DataSet ds;
adapter = new Data.OleDb.OleDbDataAdapter("select * from products", connString);
ds = new Data.DataSet();
adapter.Fill(ds, "Products");
return ds;

}

Testing the Web Service

To test the Web Service

1. Press F5 to run the project.  

2. Click "GetProduct" in the list of supported operations. 

3. Click the Invoke button to test the Web Service operation. 

4. If the test is successful, you will see a valid XML schema of the Northwind products table. 

Publishing the Web Service

To publish the Web Service

1. In the Solution Explorer, right-click the project name and select Publish Web Site.  

2. Click the OK button. 

3. This makes the Web Service available for consumption by other projects. 

In ActiveReports for .NET 3.0, you can use a Web Service that returns a dataset as the data source for your 
reports. 

This walkthrough illustrates how to create a Windows client application that uses the dataset Web Service as 
the data source for an ActiveReport.

This walkthrough builds on the dataset Web Service walkthrough and is split up into the following activities: 

l Adding an ActiveReport to a Visual Studio project 

DataSet Windows Application
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l Adding controls to each report to display the data 

l Adding a web reference to the project  

l Adding the code needed to set the report dataset and data member to the dataset and data member 
returned by the Web Service 

l Viewing the report  

To complete the walkthrough, you must have access to the Northwind database. For your convenience, a 
copy is included with ActiveReports at the following default location: C:\Program Files\Data 
Dynamics\ActiveReports for .NET 3.0\Data\NWIND.MDB.

When you have finished this walkthrough, you will have a report that looks similar to the following.

Adding an ActiveReport to a Visual Studio project

To add an ActiveReport to a Visual Studio project

1. Open a new project in Visual Studio. 

2. From the Project menu, select Add New Item. 

3. Select ActiveReports 3.0 File and rename the file rptProducts. 

4. Click Open (or Add in Visual Studio 2005). 

Adding controls to display the data

To add controls to the reports

1. Add the following controls to the Detail section of rptProducts, setting their properties as indicated: 
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2. Set the CanShrink property of the Detail section to True. 

Adding a web reference to the project

To add a web reference

1. From the Project menu, select Add Web Reference. 

2. Type in the address of the .asmx file for the dataset Web Service you created in the previous 
walkthrough. You can get the address by running the project from the previous walkthrough and copying 
the url from the address in the browser. (It will look something like 
http://localhost:####/DataSetWS/Service.asmx (http://localhost:/) where #### is the port 
number.)  

3. Click the Go button, and then click the Add Reference button when the Web Service is recognized. 

Adding the code needed to set the report's data source control equal to the 
dataset returned by DataSetWS

To write the code in Visual Studio 2003

l Double-click the gray area below rptProducts. This creates an event-handling method for 
rptProducts' ReportStart event. 

l The following example shows what the code for the method looks like. 
'Visual Basic
Private Sub rptProducts_ReportStart(ByVal sender As Object, ByVal e As System.EventArgs) _

Handles MyBase.ReportStart
Dim rpt As New rptProducts()
Dim ws As New localhost.DataSetWS()
Dim ds As New DataSet()
ds = ws.GetProduct()
Me.DataSource = ds
Me.DataMember = "Products"

End Sub
 

//C#
private void rptProducts_ReportStart(object sender, System.EventArgs eArgs)
{

rptProducts rpt = new rptProducts();
localhost.DataSetWS ws = new localhost.DataSetWS();
DataSet ds = ws.GetProduct(); 
this.DataSource = ds;
this.DataMember = "Products";

}

To write the code in Visual Studio 2005

l Double-click the gray area below rptProducts. This creates an event-handling method for 
rptProducts' ReportStart event. 

l The following example shows what the code for the method looks like.
'Visual Basic
Private Sub rptProducts_ReportStart(ByVal sender As Object, ByVal e As System.EventArgs) _

Handles MyBase.ReportStart
Dim rpt As New rptProducts()
Dim ws As New localhost.Service
Dim ds As New DataSet()
ds = ws.GetProduct()
Me.DataSource = ds

Control DataField Name Text Miscellaneous Location

Textbox ProductName txtProductName Product 
Name 

Size = 2.9, 0.19 0, 0 

Textbox UnitPrice txtUnitPrice Unit Price OutputFormat = 
Currency 

3, 0 
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Me.DataMember = "Products"
End Sub
 

//C#
private void rptProducts_ReportStart(object sender, System.EventArgs eArgs)
{

rptProducts rpt = new rptProducts();
localhost.DataSetWS ws = new localhost.Service;
DataSet ds = ws.GetProduct(); 
this.DataSource = ds;
this.DataMember = "Products";

}

Viewing the report

To view the report

1. Add the ActiveReports viewer control to a Windows Form. 

2. Add the code needed to set the viewer document equal to the report document. See Using the 
ActiveReports WinForm Viewer for help. 

Note: You can quickly view your report at design time by clicking the Preview tab at the bottom of the 
designer.

With ASP.NET and ActiveReports, you can set up a Web Service that returns a report document which can 
be shown in a report viewer control. 

This walkthrough illustrates how to create a Web Service that returns the contents of an ActiveReport as a 
byte array.

This walkthrough is split up into the following activities: 

l Creating an ASP.NET Web Service project 

l Adding an ActiveReport to the project 

l Connecting the data source to a database 

l Adding controls to contain the data 

l Adding code to create the Web Method 

l Testing the Web Service 

l Publishing the Web Service

To complete the walkthrough, you must have access to the Northwind database. For your convenience, a 
copy is included with ActiveReports at the following default location: C:\Program Files\Data 
Dynamics\ActiveReports for .NET 3.0\Data\NWIND.MDB. 

You will also need to add a reference to your project to the System.Data.OleDb namespace.

When you have completed this walkthrough, you will have created a Web Service that returns the contents of 
an ActiveReport as a byte array.

Creating an ASP.NET Web Service project

To create an ASP.NET Web Service project in Visual Studio 2003

1. From the File menu, select New > Project.

2. In the Templates window of the New Project dialog, select ASP.NET Web Service. 

3. Change the name of the project from WebService1 to ARDocumentWS. 

4. Click OK to open the new project in Visual Studio.  

To create an ASP.NET Web Service project in Visual Studio 2005

ActiveReports Document Web Service
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1. From the File menu, select New > Web Site.

2. In the Templates window of the New Web Site dialog, select ASP.NET Web Service. 

3. Change the name of the project from WebService1 to ARDocumentWS. 

4. Click OK to open the new project in Visual Studio. 

Adding an ActiveReport to the Visual Studio project

To add an ActiveReport to your project

1. From the Project menu (or Website menu in Visual Studio 2005), select Add New Item.

2. Select ActiveReports 3.0 File and rename the file rptProducts. 

3. Click Open (or Add in Visual Studio 2005).

Note: To see the report design surface in Visual Studio 2005, right-click the report in the Solution 
Explorer and select View Designer.

Connecting the data source to a database

To connect the data source to a database

1. Click the gray report DataSource icon in the Detail section to open the report DataSource dialog. 

2. Click Build.

3. Select "Microsoft Jet 4.0 OLE DB Provider" and click Next .

4. Click the ellipsis button to browse for the access path to the Northwind database. Click Open once you 
have selected the appropriate access path. 

5. Click OK to continue. 

6. In the Query field, type "Select * from products inner join categories on products.categoryid = 
categories.categoryid order by categoryname". 

7. Click OK to return to the report design surface. 

Adding controls to the report to contain data

To add controls to the report

1. Add a GroupHeader/Footer section to rptProducts. 

2. Make the following changes to the group header: 

¡ Change the Name property to ghCategories

¡ Change the DataField property to CategoryName

¡ Change the BackColor property to LightGray

3. In the Report Explorer, expand the Fields node, then the Bound node. Drag the following fields onto 
ghCategories and set the properties as indicated.  

4. Add a second GroupHeader/Footer section to rptProducts to contain labels. 

5. Make the following changes to the group header: 

¡ Change the Name property to ghProducts 

¡ Change the BackColor property to WhiteSmoke  

6. Add labels with the following properties to ghProducts: 

Field Text Location Miscellaneous

CategoryName CategoryName 1.75, 0  Font size = 14; ForeColor = DarkGreen

Name Text Location

lblProductName  Product Name 0, 0  

lblUnitPrice Unit Price 2.38, 0 
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7. Set the CanShrink property of the detail section to True. 

8. In the Report Explorer, expand the Fields node, then the Bound node. Drag the following fields onto the 
detail section and set the properties as indicated.  

Adding code to create the Web Method

To write the code to create the Web Method

l Right-click on the Service1.asmx page and select View Code to display the code view for the page 
(displayed by default in Visual Studio 2005). 

l Add the following code under the Web Services Designer Generated Code section to create the Web 
Service. (In Visual Studio 2005, replace the existing WebMethod and function with this code.)

' Visual Basic

<WebMethod( _
Description:="Returns a products report grouped by category")> _
Public Function GetProductsReport() As Byte()
Dim rpt As New rptProducts()
rpt.Run()
Return rpt.Document.Content

End Function
//C#

[WebMethod(Description="Returns a products report grouped by category")]
public Byte[] GetProductsReport()
{

rptProducts rpt = new rptProducts();
rpt.Run();
return rpt.Document.Content;

}

Testing the Web Service

To test the Web Service

1. Press F5 to run the project.  

2. Click "GetProductsReport" in the list of supported operations. 

3. Click the Invoke button to test the Web Service operation. 

4. If the test is successful, you will see the binary version of the contents of rptProducts. 

Publishing the Web Service

To publish the Web Service

1. In the Solution Explorer, right-click the project name and select Publish Web Site.  

2. Click the OK button. 

3. This makes the Web Service available for consumption by other projects. 

lblUnitsInStock Units in Stock 3.94, 0 

lblUnitsOnOrder Units on Order 5.13, 0 

Field Text Miscellaneous Location

ProductName Product Name Size = 2.25, 0,19 0, 0

UnitPrice Unit Price OutputFormat = Currency 2.38, 0

UnitsInStock Units In Stock Alignment = Right 3.94, 0

UnitsOnOrder Units On Order Alignment = Right 5.13, 0
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In ActiveReports for .NET 3.0, you can use a Web Service that returns the content of an ActiveReport to show 
in the Windows Forms viewer control. 

This walkthrough illustrates how to create a Windows client application that returns the content of an 
ActiveReport in the Windows Forms viewer.

This walkthrough builds on the ActiveReports Document Web Service walkthrough and is split up into the 
following activities: 

l Creating a Visual Studio project 

l Adding the ActiveReports Windows Forms viewer control to the project 

l Adding a web reference to the project  

l Adding the code to set the viewer's document property to the content returned by the ActiveReports 
Document Web Service 

l Running the project 

To complete the walkthrough, you must have access to the Northwind database. For your convenience, a 
copy is included with ActiveReports at the following default location: C:\Program Files\Data 
Dynamics\ActiveReports for .NET 3.0\Data\NWIND.MDB.

When you have finished this walkthrough, you will have a report that looks similar to the following.

Creating a Visual Studio project

ActiveReports Document Windows Application
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To create a Visual Studio project

1. From the File menu, select New > Project.

2. Select Windows Application in the Templates window of the New Project dialog. 

3. Change the name of the application to ARDocumentClient. 

4. Click OK to open the project. 

Adding the ActiveReports viewer control to the Windows Form

To add the ActiveReports viewer control

1. Drag and drop the ActiveReports viewer control from the appropriate toolbox to the Windows Form. 

2. Change the Dock property for the viewer control to Fill. 

Adding a web reference to the project

To add a web reference

1. From the Project menu, select Add Web Reference. 

2. Type in the address of the .asmx file for the ActiveReports Document Web Service you created in the 
previous walkthrough. The address should be similar to http://localhost/ARDocumentWS/Service1.asmx. 

3. Click the Add Reference button when the Web Service is recognized. 

Adding the code needed to set the viewer's document property to the content 
returned by the ActiveReports Document Web Service 

To write the code in Visual Studio 2003

l Double-click on Form1 to create an event-handling method for the Form1_Load event. 

l The following example shows what the code for the method looks like.

'Visual Basic
Private Sub Form1_Load(ByVal sender As System.Object, ByVal e As System.EventArgs) _

Handles MyBase.Load
Dim ws As New localhost.ARDocumentWS()
Me.Viewer1.Document.Content = ws.GetProductsReport()

End Sub
 

//C#
private void Form1_Load(object sender, System.EventArgs e)
{

localhost.ARDocumentWSvb ws = new localhost.ARDocumentWSvb();
this.viewer1.Document.Content = ws.GetProductsReport();

}

To write the code in Visual Studio 2005

l Double-click on Form1 to create an event-handling method for the Form1_Load event. 

l The following example shows what the code for the method looks like.

'Visual Basic
Private Sub Form1_Load(ByVal sender As System.Object, ByVal e As System.EventArgs) _

Handles MyBase.Load
Dim ws As New localhost.Service
Me.Viewer1.Document.Content = ws.GetProductsReport()

End Sub
 

//C#
private void Form1_Load(object sender, System.EventArgs e)
{

localhost.Service ws = new localhost.Service();
this.viewer1.Document.Content = ws.GetProductsReport();
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}

Running the project

To run the project

¡ Press F5 to run the project. 

ActiveReports for .NET 3.0 Professional Edition allows developers to create and deploy custom report 
designers and controls on the web. The following walkthroughs demonstrate how effectively to use specific 
features of the Professional Edition.

In this section

Creating an End-User Report Designer
Describes how to create an End-User Report Designer. 

Deploying ActiveReports Web Applications
Describes how to deploy ActiveReports web applications. 

Configuring the HTTP Handlers
Describes how to configure the HTTP Handlers. 

HTTP Handlers
Describes how to use ActiveReports HTTP Handlers. 

Parameters and HTTP Handlers
Describes how to use parameters with HTTP Handlers. 

Pro Edition Localization Walkthroughs
Describes how to localize the designer and web viewer controls. 

Web Viewer Control
Describes how to use the ActiveReports web viewer control. 

ActiveReports allows you to host the ActiveReports End-User Report Designer control in your application and 
provide end-user report editing capabilities. The control's methods and properties provide easy access to 
save and load report layouts, monitor and control the design environment, and customize the look and feel to 
satisfy the needs of your end users.

 

Creating the Basic Layout for an End-User Report Designer
Demonstrates how to set up a basic layout for the end-user report designer. 

Adding Code for the End-User Report Designer
Demonstrates how to add code to create a working end-user report designer. 

This walkthrough illustrates how to set up a basic layout of an End-User Report Designer on a Windows Form.

This walkthrough is split up into the following activities: 

l Adding a Windows Form to a Visual Studio project 

l Adding a status bar, panels, and splitters to the form 

Professional Edition Walkthroughs

Creating an End-User Report Designer Walkthroughs

Walkthrough: Creating the Basic Layout for an End-User Report 
Designer
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l Adding the Report Explorer to the form 

l Adding the Property Grid to the form 

l Adding the ActiveReports end-user report designer control to the form 

l Adding the ActiveReports Toolbox component to the form 

 

When you have completed this walkthrough, you will have a basic layout that looks similar to the following.

Adding a Windows Form to a Visual Studio project

To add a Windows Form to a Visual Studio project

1. Open a Visual Studio project. 

2. Click on Project > Add Windows Form. 

3. Name the form formDesigner and click Open. 

4. Resize formDesigner to the desired height and width. 

5. Change the text for formDesigner to "ActiveReports for .NET 3.0 End-User Report Designer." 

Adding a status bar, panels, and splitters to the form

To add a status bar, panels, and splitters to the form

1. Add a status bar to the form, rename it arStatus and set the Text property to an empty string.  

2. Add a panel to the form, rename it pnlToolbox and set the Dock property to Left. 

3. Add a second panel to the form, rename it pnlProperties and set the Dock property to Right.  

¡ Add a panel to pnlProperties, rename it pnlExplorer and set the Dock property to Top . 
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¡ Add a second panel to pnlProperties, rename it pnlPropertyGrid and set the Dock property to Fill. 

4. Add a splitter to the form, rename it splitterToolbox, set the BorderStyle property to 
Fixed3D, and the Dock property to Left. 

5. Add a second splitter to the form, rename it to splitterProperties, set the BorderStyle property to 
Fixed3D, and the Dock property to Right.

Adding the Report Explorer to the form

To add the Report Explorer

1. Select the ReportExplorer control from the ActiveReports toolbox tab and drag it onto pnlExplorer. 

2. Change the Name property to arReportExplorer. 

3. Set the Dock property to Fill.  

Adding the Property Grid to the form

To add the Property Grid

1. Right-click on the toolbox where you wish to add the Property Grid control. 

2. Click on Add/Remove Items. In Visual Studio 2005 click on Choose Items . 

3. Select the PropertyGrid control from the .NET Framework Components tab and click OK . 

4. Drag the PropertyGrid control from the toolbox onto pnlPropertyGrid. 

5. Change the Name property to arPropertyGrid. 

6. Set the Dock property to Fill. 

Adding the ActiveReports end-user report designer control to the form

To add the control

1. Select the Designer control from the ActiveReports toolbox tab and drag it onto formDesigner. 

2. Change the Name property to arDesigner. 

3. Set the Dock property to Fill. 

4. Set the PropertyGrid property to arPropertyGrid. 

5. Click on arReportExplorer to select it. Set the ReportDesigner property to arDesigner.

Adding the ActiveReports toolbox component to the form

To add the toolbox component

1. Right-click on the ActiveReports tab in the toolbox. 

2. Click on Add/Remove Items. In Visual Studio 2005 click on Choose Items . 

3. Select the Toolbox component control from the .NET Framework Components tab and click OK. 

4. Drag the Toolbox component from the ActiveReports toolbox tab and drag it onto pnlToolbox. 

5. Change the Name property to arToolbox. 

6. Set the Dock property to Fill. 

ActiveReports for .NET 3 User Guide | 411



To continue creating the End-User Report Designer, please see the next walkthrough, Adding Code for the 
End-User Report Designer.

This walkthrough builds on the steps completed in the previous walkthrough, Creating the Basic Layout 
for an End-User Report Designer, and is split up into the following activities: 

l Adding Imports/using statements 

l Adding code to the formDesigner_Load event to set the designer's toolbox, set the designer's 
CommandBarManager, add an Exit command to the CommandBarManager, and set up the status bar.  

l Adding code to enable shortcut keys to work with the CommandBarManager  

l Adding code to create the arDesigner_SelectionChanged event to display the current object selection in 
the status bar 

l Adding code to create a data toolbox category 

l Adding code to close the End-User Report Designer when the Exit command is clicked on the File menu

When you have finished this walkthrough, you will have a working end-user report designer that looks like 
the following.

Walkthrough: Adding Code for the End-User Report Designer
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Adding Imports/using statements 

To write the code in Visual Basic

l Right-click in any section of formDesigner, and click on View Code to display the code view for the 
Windows Form. Add the following Imports statements. 

To write the code in C#

l Right-click in any section of formDesigner, and click on View Code to display the code view for the 
Windows Form. Add the following using statements. 

The following example shows what the code looks like.

'Visual Basic
'Add the following Imports statements
Imports DataDynamics.ActiveReports
Imports DataDynamics.ActiveReports.Design
Imports DataDynamics.ActiveReports.Design.Toolbox

//C#
//Add the following using statements 
using DataDynamics.ActiveReports;
using DataDynamics.ActiveReports.Design;
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using DataDynamics.ActiveReports.Design.Toolbox;

Adding code to the formDesigner_Load event 

To write the code in Visual Basic

l Double-click the title bar of the formDesigner. This creates an event-handling method for the 
formDesigner_Load event. Add code to the handler to:  

l Set the designer's toolbox 

l Set the designer's CommandBarManager 

l Add an Exit command to the CommandBarManager 

l Set up the designer's status bar

To write the code in C#

l Double-click the title bar of the formDesigner. This creates an event-handling method for the 
formDesigner_Load event. Add code to the handler to:  

l Set the designer's toolbox 

l Set the designer's CommandBarManager 

l Add an Exit command to the CommandBarManager 

l Set up the designer's status bar

The following example shows what the code for the method looks like.

'Visual Basic
Private commandBarManager As CommandBarManager
Private Sub formDesigner_Load(ByVal sender As Object, ByVal e As System.EventArgs)

'Set the designer's toolbox to arDesigner
Me.arDesigner.Toolbox = Me.arToolbox

 
'Set the CommandBarManager of arDesigner to commandBarManager
commandBarManager = Me.arDesigner.CommandBarManager
Me.Controls.Add(commandBarManager) 

'Add an Exit command to the File menu of the first command bar of the CommandBarManager
Dim menu As CommandBarMenu = CType(Me.commandBarManager.CommandBars(0).Items(0), CommandBarMenu)
menu.Items.AddButton("Exit", New EventHandler(AddressOf OnExit)

'Set up the status bar
Me.arStatus.Panels.Add(New StatusBarPanel)
Me.arStatus.Panels.Add(New StatusBarPanel)
Me.arStatus.Panels(0).AutoSize = StatusBarPanelAutoSize.Spring
Me.arStatus.Panels(1).AutoSize = StatusBarPanelAutoSize.Spring
Me.arStatus.ShowPanels = True

End Sub 

//C#
private CommandBarManager commandBarManager;
private void formDesigner_Load(object sender, System.EventArgs e)
{

//Set the designer's toolbox to arToolbox
this.arDesigner.Toolbox = this.arToolbox;

//Set the CommandBarManager of arDesigner to commandBarManager
commandBarManager = this.arDesigner.CommandBarManager;
this.Controls.Add(commandBarManager);

// Add an exit command to the File menu of the first command bar of the CommandBarManager
CommandBarMenu menu = this.commandBarManager.CommandBars[0].Items[0] as CommandBarMenu;
menu.Items.AddButton("Exit", new EventHandler(OnExit), 0);

//Set up the Status Bar
this.arStatus.Panels.Add(new StatusBarPanel());
this.arStatus.Panels.Add(new StatusBarPanel());
this.arStatus.Panels[0].AutoSize = StatusBarPanelAutoSize.Spring;
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this.arStatus.Panels[1].AutoSize = StatusBarPanelAutoSize.Spring;
this.arStatus.ShowPanels = true;

}

Adding code to enable shortcut keys to work with the CommandBarManager

To write the code in Visual Basic

l Right-click in any section of formDesigner, and click on View Code to display the code view for 
formDesigner. Add the following code. 

To write the code in C#

l Right-click in any section of formDesigner, and click on View Code to display the code view for 
formDesigner. Add the following code. 

The following example shows what the code looks like.

'Visual Basic
Protected Overrides Function ProcessCmdKey(ByRef msg As Message, ByVal keyData As Keys) As Boolean

If Me.arDesigner.Focused Then 
If Me.arDesigner.CommandBarManager.PreProcessMessage(msg) Then

Return True
End If

End If
Return MyBase.ProcessCmdKey(msg, keyData)

End Function

//C#
protected override bool ProcessCmdKey(ref Message msg, Keys keyData)
{

if(this.arDesigner.CommandBarManager.PreProcessMessage(ref msg));
return true;

return base.ProcessCmdKey(ref msg, keyData);
}

Adding code to the Designer1_SelectionChanged event

To write the code in Visual Basic

l Right-click in any section of formDesigner, and click on View Code to display the code view for the 
Windows Form. At the top left of the code view for formDesigner, click the drop-down arrow and select 
arDesigner. At the top right of the code window, click the drop-down arrow and select SelectionChanged. 
This creates an event-handling method for the arDesigner_SelectionChanged event. 

To write the code in C#

l Click in the designer window of formDesigner to select arDesigner. Click on the events icon in the 
Properties window to display available events for the section. Double-click SelectionChanged. This 
creates an event-handling method for the arDesigner_SelectionChanged event. 

The following example shows what the code for the method looks like.

'Visual Basic
'This will display the current selection in the designer's status bar
Private Sub arDesigner_SelectionChanged() Handles arDesigner.SelectionChanged

Dim curSelection As String = ""
Dim selectionEnum As IEnumerator = Nothing
If Not (arDesigner.Selection Is Nothing) Then

selectionEnum = arDesigner.Selection.GetEnumerator()
End If
While Not (selectionEnum Is Nothing) AndAlso selectionEnum.MoveNext()

If TypeOf selectionEnum.Current Is Section Then
curSelection = curSelection + (CType(selectionEnum.Current, Section)).Name + ", "

End If
If TypeOf selectionEnum.Current Is ARControl Then

curSelection = curSelection + (CType(selectionEnum.Current, ARControl)).Name + ", "
End If
If TypeOf selectionEnum.Current Is Field Then

curSelection = curSelection + (CType(selectionEnum.Current, Field)).Name + ", "
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End If
If TypeOf selectionEnum.Current Is Parameter Then

curSelection = curSelection + (CType(selectionEnum.Current, Parameter)).Key + ", "
End If
If TypeOf selectionEnum.Current Is ActiveReport3 Then

curSelection = curSelection + (CType(selectionEnum.Current, ActiveReport3)).Document.Name + ", "
End If

End While
If Me.arStatus.Created AndAlso Not (Me.arStatus.Panels(1) Is Nothing) Then

If Not (curSelection = "") Then
Me.arStatus.Panels(1).Text = "Current Selection: " + curSelection.Substring(0, curSelection.Length 

Else
Me.arStatus.Panels(1).Text = "No Selection"

End If
End If

End Sub
 

//C#
//This will display the current selection in the designer's status bar
private void arDesigner_SelectionChanged()
{

string curSelection = "";
IEnumerator selectionEnum = null;
if(arDesigner.Selection != null)

selectionEnum = arDesigner.Selection.GetEnumerator();
while(selectionEnum != null && selectionEnum.MoveNext())
{

if(selectionEnum.Current is Section)
curSelection = curSelection + (selectionEnum.Current as Section).Name + ", ";

if(selectionEnum.Current is ARControl)
curSelection = curSelection + (selectionEnum.Current as ARControl).Name + ", ";

if(selectionEnum.Current is Field)
curSelection = curSelection + (selectionEnum.Current as Field).Name + ", ";

if(selectionEnum.Current is Parameter)
curSelection = curSelection + (selectionEnum.Current as Parameter).Key + ", ";

if(selectionEnum.Current is ActiveReport3)
curSelection = curSelection + (selectionEnum.Current as ActiveReport3).Document.Name + ", ";

}
if(this.arStatus.Created && this.arStatus.Panels[1] != null)
{

if(curSelection != "")
this.arStatus.Panels[1].Text = "Current Selection: " + curSelection.Substring(0, curSelection.Length 

else
this.arStatus.Panels[1].Text = "No Selection";

}
}

Adding code to create a data toolbox category

To write the code in Visual Basic

l Double-click the title bar of formDesigner to go to the load event of the form. Add the following code. 

To write the code in C#

l Double-click the title bar of formDesigner to go to the load event of the form. Add the following code. 

The following example shows what the code looks like.

'Visual Basic
Private Sub formDesigner_Load(ByVal sender As Object, ByVal e As System.EventArgs)

Me.Close()
End Sub

//C#
private void formDesigner_Load(object sender, System.EventArgs e)
{

System.Drawing.Design.ToolboxItem tbItemDS = new System.Drawing.Design.ToolboxItem(typeof(System.Data.DataSet));
System.Drawing.Design.ToolboxItem tbItemDA = new System.Drawing.Design.ToolboxItem(typeof(System.Data.OleDb.OleDbDataReader));
this.arToolbox.AddToolboxItem(tbItemDS, "Data");
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this.arToolbox.AddToolboxItem(tbItemDA, "Data");
}

Adding code to close the End-User Report Designer when the Exit command is 
clicked on the File menu  

To write the code in Visual Basic

l Right-click in any section of formDesigner, and click on View Code to display the code view for the 
Windows Form. Add the following code. 

To write the code in C#

l Right-click in any section of formDesigner, and click on View Code to display the code view for the 
Windows Form. Add the following code. 

The following example shows what the code looks like.

'Visual Basic
Private Sub OnExit(ByVal sender As Object, ByVal e As System.EventArgs)

Me.Close()
End Sub

//C#
private void OnExit(object sender, System.EventArgs e)
{

this.Close();
}

With ActiveReports for .NET 3.0 Professional Edition, Web applications can be set up for deployment by 
including the ActiveReports deployment .msm file in your Visual Studio deployment project. 

This walkthrough illustrates how to create a deployment project in ActiveReports for a Web application. 

This walkthrough is split up into the following activities: 

l Adding an installer project to an existing ActiveReports web solution 

l Adding the ActiveReports .msm file 

l Adding the ActiveReports application to the installer 

l Deploying the installer application to a Web server  

Note: In order to successfully deploy an ActiveReports Web project, the server must have the following 
installed.

l Microsoft .NET Framework Version 1.1 SP1, or 2.0 

l IIS (Internet Information Services) Version 5.1 or 6.0 

l ASP.NET Version 1.1 SP1, or 2.0 (must be the same version as the Framework)

Adding an installer project to an existing ActiveReports project

To add the installer project

1. Open an existing ActiveReports Web project or create a new one. 

2. From the Build menu, select Build Solution to build your report project. 

3. From the File menu, select Add > New Project.

4. Under Project Types in the Add New Project dialog, expand Other Project Types and select Setup 
and Deployment Projects. 

5. In the Templates window, select Web Setup Project, rename the file and click OK. 

6. From the Solution Explorer, select the Installer project. In the Properties window, select the 
ProductName property and type in the name of your file. 

Note: The ProductName property determines the name that is displayed for the application in 

Walkthrough: Deploying ActiveReports Web Applications
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folder names and in the Add/Remove Programs dialog box.

Adding the ActiveReports .msm file

To add the ActiveReports .msm file

1. Right-click on the Installer project in Solution Explorer. 

2. Click on Add and then click Merge Module.

3. Open the Deployment folder where ActiveReports for .NET 3.0 is installed (e.g. C:\\Program Files\Data 
Dynamics\ActiveReports for .NET 3.0\Deployment). 

4. Click on "ActiveReportsDistrib.msm" to select it and click Open. 

5. This adds all of the ActiveReports distributed assemblies to your web project. 

Note: Since the Setup and Deployment project will automatically detect and add any assembly 
dependencies to your project and the .msm file adds all ActiveReports assemblies, in Visual Studio 
2003 you must exclude any duplicate ActiveReports DLLs from the "Detected Dependencies" folder in 
the Solution Explorer window.

Adding the ActiveReports application to the installer

To add the ActiveReports application

1. Select the Installer project in Solution Explorer. 

2. In the File System Editor, choose the Web Application Folder. 

3. From the Action menu, select Add > Project Output.

4. In the Add Project Output Group dialog, choose your ActiveReports project name from the drop-down 
list. 

5. Select Primary Output and Content Files from the list and click OK . (In Visual Studio 2005, there is no 
Primary Output.) 

6. In the File System Editor, select the Web Application Folder. In the Properties window, set the 
VirtualDirectory property to "xyz". 

7. In the Properties window, set the DefaultDocument property to "WebForm1.aspx".  (This step is 
unnecessary in Visual Studio 2005 as default.aspx is already set as the default document.) 

8. On the Build menu, click "Build [your Installer project name]" to build your Installer project. 

Deploying the installer application to a Web server

To deploy the installer application

1. In Solution Explorer, select the Web Installer project. 

2. From the Project menu, select Install and follow the wizard's steps to install it. 

3. To access the Web application that was deployed, start Internet Explorer and enter the URL: 
http://localhost/ (http://localhost/xyz)xyz. (In Visual Studio 2005, the URL is 
http://localhost:####/xyz (http://localhost:/) where #### is the port number.)  

Note: If you are using the WebViewer control in your application, you must also set up the HTTP 
Handlers.

This topic will take you through the steps of configuring the ActiveReports HTTPHandlers for use on the Web 
with ASP.NET.

Configuring the ActiveReports HTTPHandlers

To configure the HTTPHandler  

1. In the Control Panel, double-click "Administrative Tools." Double-click "Internet Information Services" to 

Configuring the HTTP Handlers
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open its dialog window. 

2. Right-click on the Web site that you need to configure the HTTPHandlers for, then click Properties. 

3. Click on the "Home Directory" tab of the "Default Web Site Properties" dialog. 

4. Click on the Configuration button. 

5. In the "Application Mappings" window of the Application Configuration dialog, select the list item 
with .aspx in the extension column and click Edit. Note that if your machine does not have the ASP.NET 
server components installed, the .aspx handler will not show up in the Application Mappings list. 
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6. Select and copy all of the text in the "Executable" field. Click Cancel to return to the Application 
Configuration dialog. 

7. Click Add in the Application Configuration dialog to add a new Application Mapping. 

8. In the Executable field, paste the value copied from Step 6 and enter ".rpx"in the Extension field. 

9. Click OK to add the mapping and return to the Application Configuration dialog. 

 

To configure the compiled report handler (continuing from Step 9 in "To Configure the HTTPHandler) 

1. In the Application Configuration dialog, click Add to add a new Application Mapping. 
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2. In the Executable field, paste the value copied from Step 6 above. 

3. Enter .ActiveReport in the Extension field. 

4. Make sure the "Check that file exists" permission is unchecked. 

5. Click OK to add the mapping and return to the Application Configuration dialog. 

 

To configure the WebCacheAccessHandler (continuing from Step 9 in "To Configure the HTTPHandler)   

1. In the Application Configuration dialog, click Add to add a new Application Mapping. 

2. In the Executable field, paste the value copied from Step 6 above. 

3. Enter .ArCacheItem in the Extension field. 

4. Make sure the "Check that file exists" permission is unchecked. 

5. Click OK to add the mapping and return to the Application Configuration dialog. 

6. Click OK on the remaining open dialogs to exit the IIS Administrative tool. 

ActiveReports provides HTTPHandler components that, upon configuration, allow ASP.NET to automatically 
process reports that have been placed into an ASP.NET web site folder. ActiveReports HTTPHandler 
components enable reports to be easily deployed in both HTML and PDF. ActiveReports includes a simple 
configuration utility to properly register the HTTPHandler components with IIS and ASP.NET. 

This walkthrough illustrates how to create a simple Web application and set the HTTPHandler to output report 
information in PDF format.

This walkthrough is split up into the following activities: 

l Adding an ActiveReport to an ASP.NET Web application 

l Connecting the report to a data source 

l Adding controls to the report to contain data 

l Saving the report layout to rpx format 

l Adding code to the Web.config file to enable HTTP Handlers

l Adding a link to the Web Form to enable viewing in PDF format 

To complete the walkthrough, you must have access to the Northwind database. You must also have access 
to Internet Information Services either from your computer or from the server. You must also run the 
"Configure Web Sample" option from the Data Dynamics ActiveReports for .NET 3.0 program menu from your 
Windows Start button.

When you have completed this walkthrough, you will have a report that looks similar to the following.

Walkthrough: HTTP Handlers
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Adding an ActiveReport to an ASP.NET Web application

To add an ActiveReport to your project using Visual Studio 2003

1. Create a new ASP.NET Web application.  

2. From the Project menu, select Add New Item.  

3. Select ActiveReports 3.0 File and rename the file rptHttpHandlers. 

4. Click Open. 

To add an ActiveReport to your project using Visual Studio 2005

1. Create a new ASP.NET Web site.  

2. From the Website menu, select Add New Item. 

3. Select ActiveReports 3.0 File and rename the file rptHttpHandlers. 

4. Click Add.

5. Click Yes when a message box asks whether you would like to place the class in the 'App_Code' folder.

Connecting the report to a data source

To connect the report to a data source

1. Click the gray report DataSource icon in the Detail section to open the report DataSource dialog. 

2. Click the Build button. 

3. Select Microsoft Jet 4.0 OLE DB Provider and click Next.
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4. Click the ellipsis button to browse for the access path to the Northwind database. Click Open once you 
have selected the appropriate access path. 

5. Click OK to continue. 

6. In the Query field, type "Select * from products ORDER BY categoryID, productname". 

7. Click OK to return to the report design surface. 

Adding controls to the report to contain data

To add controls to the report

1. Add a GroupHeader/Footer section to rptHTTPHandlers. 

2. Make the following changes to the group header: 

¡ Change the name to ghProducts

¡ Change the DataField property to CategoryID

¡ Change the GroupKeepTogether property to FirstDetail

¡ Change the KeepTogether property to True

3. Add labels to ghProducts, setting the properties as indicated in the table below: 

4. Drag the following fields from the Report Explorer onto the detail section, setting the properties as 
indicated in the table below.  

5. Change the CanShrink property of the detail section to True.

Saving the report layout to rpx format

To save the report layou to rpx format

1. From the Report menu, select Save Layout. 

2. Navigate to the project's main folder, name the file rptHTTPHandlers and save it as type Runtime 
Format (*rpx).

Adding code to the Web.config file to enable HTTPHandler

To add code to the Web.config file

1. Double-click the Web.config file in the Solution Explorer window. 

2. In the XML view, add the following code immediately before the closing system.web tag near the bottom 
of the page.

<httpHandlers>
 <!--
 ********** ActiveReports HttpHandler Configuration **********
 -->
 <add verb="*" path="*.rpx" type="DataDynamics.ActiveReports.Web.Handlers.RpxHandler, ActiveReports.Web,
 Version=5.0.0.101, Culture=neutral, PublicKeyToken=cc4967777c49a3ff" />
 <add verb="*" path="*.ActiveReport" type="DataDynamics.ActiveReports.Web.Handlers.CompiledReportHandler,
 ActiveReports.Web, Version=5.0.0.101, Culture=neutral, PublicKeyToken=cc4967777c49a3ff" />
 <add verb="*" path="*.ArCacheItem" type="DataDynamics.ActiveReports.Web.Handlers.WebCacheAccessHandler,

Name Text Location

lblProductName Product Name 0, 0 

lblQuantityPerUnit Quantity Per Unit 1.19, 0 

lblInStock In Stock 2.5, 0 

lblUnitPrice Unit Price 4, 0 

Field Text Location OutputFormat
ProductName Product Name 0, 0 NA
QuantityPerUnit Quantity Per Unit 1.19, 0 NA
UnitsInStock Units In Stock 2.5, 0 NA 
UnitPrice Unit Price 4, 0 Currency
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 ActiveReports.Web, Version=5.0.0.101, Culture=neutral, PublicKeyToken=cc4967777c49a3ff" />
</httpHandlers>

3. Remove line breaks from the verbs if you copy and paste them so that each of the three is completed on 
a single line.

Note: The version number must be updated to reflect the information for the current version of 
ActiveReports installed on your computer. 

Adding a link to the Web Form

To add a link to the Web Form and enable viewing in PDF format

1. In the HTML view of the Web Form (.aspx), add the following HTML code. 
<a href="rptHTTPHandlers.rpx?OutputFormat=pdf">WebApp.rpx/OutputFormat=pdf</a>

2. Press F5 to run the program. 

3. Click the link on the web form to convert the report preview to PDF. 

ActiveReports provides HTTPHandler components that, upon configuration, allow ASP.NET to automatically 
process reports that have been placed into an ASP.NET web site folder. ActiveReports HTTPHandler 
components enable reports to be easily deployed in both HTML and PDF. ActiveReports includes a simple 
configuration utility to properly register the HTTPHandler components with IIS and ASP.NET. 

This walkthrough illustrates how to create a simple Web application and set the HTTPHandler to output report 
information in HTML format.

This walkthrough is split up into the following activities: 

l Adding an ActiveReport to an ASP.NET Web application 

l Connecting the report to a data source 

l Adding parameters to the report's Parameters collection 

l Adding controls to the report to contain data 

l Adding code to the Web.config file to enable HTTP handlers 

l Adding a link to the Web Form to enable viewing in HTML format 

To complete the walkthrough, you must have access to the Northwind database. For your convenience, a 
copy is included with ActiveReports at the following default location: C:\Program Files\Data 
Dynamics\ActiveReports for .NET 3.0\Data\NWIND.MDB. 

You must also have access to Internet Information Services either from your computer or from the server. 
You must also run the "Configure Web Sample" option from the Data Dynamics ActiveReports for .NET 3.0 
program menu from your Windows Start button.

When you have completed this walkthrough, you will have a report that looks similar to the following.

Parameters And HTTP Handlers
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Adding an ActiveReport to an ASP.NET Web application

To add an ActiveReport to your project

1. Open a new ASP.NET Web application in Visual Studio. 

2. From the Project menu, select Add New Item. 

3. Select ActiveReports 3.0 File and rename the file rptCustomers. 

4. Click Open. 

Connecting the report to a data source

To connect the report to a data source and add a parameter to the report's Parameters collection:

1. Click on the gray report DataSource icon in the Detail section to open the report DataSource dialog.  

2. Click on Build.

3. Select Microsoft Jet 4.0 OLE DB Provider and click Next.

4. Click the ellipsis button to browse for the access path to the NorthWind database. Click Open once you 
have selected the appropriate access path. 

5. Click OK to continue. 

6. In the Query field, type "Select * from Customers WHERE Country = <%Country%> ". 

7. Click OK to return to the report design surface. 

8. In the Visual Studio property grid, select ActiveReport from the combo box. 

9. Change the value of the ShowParameterUI property from its default value of True to False to turn off 
the parameter dialog. 

Adding controls to the report to contain data
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To add controls to the report

1. Add a GroupHeader/Footer section to rptCustomers by right-clicking the report and choosing Insert. 

2. Make the following changes to the group header: 

¡ Change the name to ghCountry 

¡ Change the DataField property to Country

¡ Change the GroupKeepTogether property to All

¡ Change the KeepTogether property to True 

3. From the populated Fields list, drag the Country field onto the GroupHeader section, and set its font size 
to 14. 

4. In the Report Explorer, expand the Fields node, then the Bound node. Drag the following fields onto the 
detail section and set the following properties of each textbox as indicated. 

Adding code to the Web.config file to enable HTTPHandler

To add code to the Web.config file

1. Double-click the Web.config file in the Solution Explorer window. 

2. In the XML view, add the following code in the Globalization section at the end. 
<httpHandlers>

 <!--
 ********** ActiveReports HttpHandler Configuration **********
 -->
 <add verb="*" path="*.rpx" type="DataDynamics.ActiveReports.Web.Handlers.RpxHandler, ActiveReports.Web,
 Version=3.0.0.1592, Culture=neutral, PublicKeyToken=cc4967777c49a3ff" />
 <add verb="*" path="*.ActiveReport" type="DataDynamics.ActiveReports.Web.Handlers.CompiledReportHandler,
 ActiveReports.Web, Version=3.0.0.1592, Culture=neutral, PublicKeyToken=cc4967777c49a3ff" />
 <add verb="*" path="*.ArCacheItem" type="DataDynamics.ActiveReports.Web.Handlers.WebCacheAccessHandler,
 ActiveReports.Web, Version=3.0.0.1592, Culture=neutral, PublicKeyToken=cc4967777c49a3ff" />
</httpHandlers>

Note The version number and PublicKeyToken will need to be updated to reflect the information for 
the current version of ActiveReports installed on your computer. 

Adding a link to the Web Form

To add a link to the Web Form

1. In the HTML view of the Web Form, add the following HTML code. 
<a href="rptCustomers.rpx?Country=USA">Customer Phone List for USA</a>

 
2. Press F5 to run the program. 

3. Click the link on the web form to show the report in its default HTML format. 

ActiveReports provides support for the ActiveReports run time dialogs to be localized. The following 
walkthroughs explain how to localize the ActiveReports WebViewer control and End User Designer control.

 

Localizing the WebViewer Control
Describes how to set up localization for the ActiveReports WebViewer control. 

Field Text Location

CompanyName Customer Name 0, 0

ContactName Contact Name 3, 0

Phone Phone 5, 0

Pro Edition Localization Walkthroughs
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Localizing the Designer
Describes how to set up localization for the ActiveReports report Designer control. 

 

In ActiveReports, the report designer control and associated dialogs can be localized.

This walkthrough illustrates the basics of setting up localized strings for the ActiveReports report designer 
control.

The walkthrough is split up into the following activities: 

l Creating a new Visual Studio project 

l Creating a directory 

l Using the Windows Resource Localization Editor for the resource files 

l Running the Satellite Assembly Utility to create a satellite assembly 

l Adding the ActiveReports Report Designer control to the project 

l Adding code to change the culture information for the project (optional step) 

l Running the project

To complete the walkthrough, you must have the following files:

You can find these files in your Program Files/Data Dynamics/ActiveReports for .NET 
3.0/Localization folder (most are in the Designer folder). You can find the current 
ActiveReports.Design3.dll installed on your machine in the Program Files/Common Files/Data 
Dynamics/ActiveReports for .NET 3.0 folder.

This walkthrough should be completed in conjunction with the Localizing the ActiveReports Report 
Engine walkthrough.

When you have finished this walkthrough, you will have a localized ActiveReports designer that looks similar 
to the following. For purposes of this screen shot, Japanese was used to localize the designer.

Localizing the ActiveReports Designer

l DataSourceForm.resx 

l DDColorDropDown.resx 

l DDColorPopup.resx 

l DDColorWell.resx 

l Descriptions.txt 

l DesignerTabArea.resx 

l FindReplace.resx 

l FormatBorderDialog.resx

l GoToLine.resx 

l GridSettingsSheet.resx 

l NewStyleDialog.resx 

l OutputFormatDialog.resx 

l PageSettingSheet.resx 

l PrinterSettingsSheet.resx 

l ReportSettingsDlg.resx 

l RichEditInsertFieldDlg.resx 

l ScriptEditor.resx 

l Strings.txt 

l StyleSettingsSheet.resx 

l PublicKey.snk 

l SatelliteAssembly.exe 

l ActiveReports.Design3.dll
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Creating a new Visual Studio project

To create a new Visual Studio project

1. Open Visual Studio. 

2. From the File menu, select New > Project.

3. Select the project type and click on Windows Application. 

4. Change the name of your project and click OK.

Creating a Directory

To create a directory

1. Open Windows Explorer and browse to the folder in which your project's EXE file will be contained when 
the report is run. For Visual Basic .NET, this will be the bin folder. For C#, this will be the bin/Debug
folder. 

2. From the File menu, select New > Project.. 

3. Name the folder according to the CultureInfo that you will use to localize your project. For example, you 
would use "ja" for Japanese. 

Note: Be sure to be consistent with this name. Localization will not work if you name the folder "ja" but 
create a localization file based on "Japanese (Japan)" rather than "Japanese" because it will be looking for 
a folder named "ja-ja-JP."

4. Copy the required files to this new folder.  

l DataSourceForm.resx 

l DDColorDropDown.resx 

l DDColorPopup.resx 

l DDColorWell.resx 

l Descriptions.txt 

l DesignerTabArea.resx 

l GoToLine.resx 

l GridSettingsSheet.resx 

l NewStyleDialog.resx 

l OutputFormatDialog.resx 

l PageSettingSheet.resx 

l PrinterSettingsSheet.resx 

l ScriptEditor.resx 

l Strings.txt 

l StyleSettingsSheet.resx 

l PublicKey.snk 

l SatelliteAssembly.exe 
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Using the Windows Resource Localization Editor

To use the Windows Resource Localization Editor

1. Open a Visual Studio .NET 2003 or 2005 command prompt. 

2. Run the Windows Resource Localization Editor by typing "winres" and hitting Enter. This editor allows 
you to edit dialog .resx files for a certain locale. The utility is included as part of the .NET framework. 

3. Click on File > Open on the Localization Editor's menu bar. 

4. Change the file type to "ResX File(*.resx)". 

5. Navigate to the directory that you created and copied the required files into, choose the 
DataSourceForm.resx file, and click Open to open the file in the Editor. 

6. On the menu bar, click File > Save, select your localization culture from the list, and then press OK . 

7. Repeat Steps 3-6 for the rest of the .resx files in the directory you created. 

8. Close the Windows Resource Localization Editor. 

9. Close the Visual Studio .NET command prompt window. 

10. In Windows Explorer, browse to the folder containing the required files and rename the .txt files 
(Strings.txt and Descriptions.txt) according to the culture you have chosen. For example, you 
would change "Strings.txt" to "Strings.ja.txt" for Japanese.

Note: If any .resx files contain combo box items then the .resx files need to be modified after they are 
saved. 

Running the Satellite Assembly Utility

To run the Satellite Assembly Utility

1. Double-click the SatelliteAssembly.exe file to run the utility. 

2. On the menu bar, select File > New. This creates a project window for the Satellite assembly. 

3. On the menu bar, select Edit > Properties.

4. On the Build tab of the Properties dialog: 

¡ Select the correct localization culture. 

¡ Set the input and output directories to the directory you created that contains the .resx and .txt files. 

¡ Set the output file name to "ActiveReports.Design3.resources.dll". 

¡ Select or type in the proper Framework Version.

5. On the Assembly tab of the Properties dialog: 

¡ In the Assembly Attributes section, set the Version number to match the version of the 
ActiveReports.Design2.dll file located in the directory you created. 

¡ In the Delayed Signing section, set the Strong Name KeyFile to the publickey.snk key file in the 
directory you created. 

¡ In the Use Template File section, browse to the ActiveReports.Design3.dll file located in the directory 
you created. Click OK to continue.

6. Right-click on the Resource file list view and select Add. 

7. With the File Type set to "Resx", add the .resx files that have the culture information added to the file 
names. For example, for Japanese, you would choose "DataSourceForm.ja.resx", 
"RichEditInsertFieldDlg.ja.resx", etc. Click Open to add the files to the list. 

8. Right-click on the list view and select Add again. Change the File Type to "Strings File" and select the 
two .txt files that you renamed according to the culture you have chosen. Click Open to add the files to 
the list. 

9. Select all of the files in the list view, then right-click and select Edit to open the Edit dialog for each file. 

10. Change the namespace for each culture-localized file according to the list below. Click OK after each 

l FindReplace.resx 

l FormatBorderDialog.resx

l ReportSettingsDlg.resx 

l RichEditInsertFieldDlg.resx 

l ActiveReports.Design3.dll
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change to save the namespace changes. 

11. Select Save As. from the File menu. Click the Save button. This will create a .loc file for the culture you 
have chosen which contains all of the project-related information. 

12. Double-click on each item in the list view, select Editor., and edit each file for the language you have 
chosen to localize. Below is an image of part of the "Strings.ja.txt" file used for this project. 

Resource file Resource file namespace

DataSourceForm.ja.resx DataDynamics.ActiveReports

DDColorDropDown.ja.resx DataDynamics.ActiveReports.Design.Dialogs

DDColorPopup.ja.resx DataDynamics.ActiveReports.Design.Dialogs

DDColorWell.ja.resx DataDynamics.ActiveReports.Design.Dialogs

DesignerTabArea.ja.resx DataDynamics.ActiveReports.Design

FindReplace.ja.resx Compona.Windows.Forms.SyntaxBox.FindReplaceForm

FormatBorderDialog.ja.resx DataDynamics.ActiveReports.Design.Dialogs

GoToLine.ja.resx Compona.Windows.Forms.SyntaxBox.GotoLineForm

GridSettingsSheet.ja.resx DataDynamics.ActiveReports.Design.Dialogs

NewStyleDialog.ja.resx DataDynamics.ActiveReports.Design.Dialogs

OutputFormatDialog.ja.resx DataDynamics.ActiveReports.Design.Dialogs

PageSettingSheet DataDynamics.ActiveReports.Design.Dialogs

PrinterSettingsSheet.ja.resx DataDynamics.ActiveReports.Design.Dialogs

ReportSettingsDlg.ja.resx DataDynamics.ActiveReports.Design.Dialogs

RichEditInsertFieldDlg.ja.resx DataDynamics.ActiveReports.Design

ScriptEditor.ja.resx DataDynamics.ActiveReports.Design.InternalC

StyleSettingsSheet.ja.resx DataDynamics.ActiveReports.Design.Dialogs

Strings.ja.txt DataDynamics.ActiveReports.Design.Res

Descriptions.ja.txt DataDynamics.ActiveReports.Design.Res
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13. When all of the resources have been localized, you can build the Satellite assembly 
(ActiveReports.Design3.resources.dll) by selecting Build Assembly from the Build menu.

Note: If you are unable to edit the .txt files using the Satellite Assembly utility, you can open the files 
using Notepad and save them with Unicode encoding instead of ANSI. 

Adding the ActiveReports Designer control

To add the designer control

1. Drag the ActiveReports Designer control from the appropriate toolbox onto the Windows Form. 

2. Set the Dock property for the Designer to Fill.

Adding code to Change the Culture Information (Optional Step)
Note: This step is only necessary if you are developing on a machine with culture information different 
from that in the project you are localizing.

To add code to change the culture information

l Add the following code in the form's constructor just before the InitializeComponent method is called. 
Make sure you replace the "ja" shown in the example code with the appropriate culture information for 
your project.  
' Visual Basic
System.Threading.Thread.CurrentThread.CurrentUICulture = New System.Globalization.CultureInfo("ja")
//C#
System.Threading.Thread.CurrentThread.CurrentUICulture = new System.Globalization.CultureInfo("ja");

Running the Project

To run the project
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1. Press F5 to run the application. 

2. If the satellite assembly in the directory you created has only been signed with the Data Dynamics public 
key, you will need to turn off sn security for the assembly. You can do this by going to the Visual 
Studio .NET 2003 or 2005 command prompt, browsing to the directory in which the file is located and 
typing in the following line: "sn -Vr ActiveReports.Design3.resources.dll".

Note: Prior to deploying the project, you can send the ActiveReports.Design3.resources.dll file to 
ActiveReports.Support@DataDynamics.com to have it signed. When you deploy the project, if your other 
DLLs are being sent to the Global Assembly Cache, this file will also need to be sent there.

In ActiveReports, the WebViewer control's labels and tool tip text can be localized for the HtmlViewer 
ViewerType. 

This walkthrough illustrates the basics of setting up localized strings for the ActiveReports WebViewer control.

The walkthrough is split up into the following activities: 

l Creating a new Visual Studio project 

l Creating a directory 

l Localizing the resource files  

l Compiling the ActiveReports.Web.resources.dll satellite assembly using the BuildSatelliteAssembly.bat file 

l Adding the ActiveReports WebViewer control to the project  

l Adding code to change the culture information for testing the project (optional step) 

l Running the project 

To complete the walkthrough, you must have the following files: strings.en.resx, 
BuildSatelliteAssembly.bat, and DataDynamicsPublicKey.snk. You can find these files in your Program 
Files\Data Dynamics\ActiveReports for .NET 3.0\Localization\Web Viewer folder. You will also need access to 
the current activereports.web.dll installed on your machine which you can find in the Program Files\Common 
Files\Data Dynamics\ActiveReports for .NET 3.0 folder.

When you have finished this walkthrough, you will have a localized ActiveReports WebViewer control that 
looks similar to the following. For purposes of this screenshot, French was used to localize the WebViewer 
control.

Localizing the Active Reports Web Viewer Control
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Creating a new Visual Studio project

To create a new Visual Studio project

1. Open Visual Studio. 

2. From the File menu, select New > Project. 

3. Select the project type and click on ASP.NET Web Application. 

4. Change the name of your project and click OK. 

Creating a Directory

To create a directory

1. Open Windows Explorer and browse to the folder in which your project's DLL file will be contained when 
the report is run. For Visual Basic .NET, this will be the "bin" folder. For C#, this will be the "bin/Debug" 
folder. 

2. On the File menu, click New > Folder. 

3. Name the folder according to the CultureInfo that you will use to localize your project. For example, you 
would use "ja" for Japanese. 

4. Copy the required files (strings.en.resx, BuildSatelliteAssembly.bat, and DataDynamicsPublicKey.snk) to 
this new folder. 

Localizing the Strings in Visual Studio .NET

To localize the strings in Visual Studio .NET

1. Double-click strings.en.resx to open it in Visual Studio .NET.  

2. The .resx file contains three relevant columns: 

¡ Name - It is important that the name column does not change; this is how the WebViewer control 
finds the localized resources. 

¡ Value - To localize the strings, change the string in the Value column for each item you wish to 
localize. 

¡ Comment - The comment column describes exactly what each string is used for, helping you to 
determine how to set the value column. 

3. From the File menu, choose Save strings.en.resx As, set your localization culture, and then press OK.  
To set your localization culture: 

¡ Change the en portion of the strings.en.resx file to the culture name for which you are creating the 
localized resources (for French, this is fr). 

¡ A list of the valid culture names can be found in the .NET Framework Class Library documentation 
under the "about CultureInfo class (http://msdn.microsoft.com/library/default.asp?
url=/library/en-us/cpref/html/frlrfsystemglobalizationcultureinfoclasstopic.asp)" topic. 

¡ The culture name can be neutral or specific. For example, "en" is a neutral culture name, whereas 
"en-US" is a specific culture name. 

4. Close the Visual Studio .NET IDE. 

Compiling the ActiveReports.Web.resources.dll satellite assembly using the 
BuildSatelliteAssembly.bat file

To compile the Satellite Assembly

1. Open a command prompt, and in DOS, navigate to your localization folder,  i.e. cd 
C:\Inetpub\wwwroot\MyWebViewerProject\bin\fr. 

2. You will then need to run the .bat file and pass it your CultureName and the Version of your 
ActiveReports build.  i.e. BuildSatelliteAssembly.bat es-mx 4.0.0.1009 (The Version of your ActiveReports 
build can be found by right-clicking the ActiveReports.dll found in C:\Program Files\Common Files\Data 
Dynamics\ActiveReports for .NET 3.0 and choosing Properties.  The File Version is on the Version tab.) 
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3. You should see a Success! message when it has finished, and two new files will be created.  One is 
DataDynamics.ActiveReports.Web.strings.fr.resources, and the other is ActiveReports.Web.resources.dll. 

4. Send the compiled ActiveReports.Web.resources.dll satellite assembly you just created to the 
ActiveReports support staff (mailto:activereports.support@datadynamics.com) and they will get 
it signed for you so that the signing key for the satellite .dll matches the key used to sign the 
ActiveReports.Web.dll assembly. (If the signing key does not match, the localization will be ignored.) 

Adding the ActiveReports WebViewer control

To add the WebViewer control

1. Drag and drop the ActiveReports WebViewer control from the appropriate toolbox to WebForm1. 

2. Localization will only affect the WebViewer with the default value of the ViewerType property, which is 
the HtmlViewer. 

Adding Code to Change the Culture Information (Optional Step)
Note: This step is only necessary if you are developing on a machine with culture information different 
from that in the project you are localizing. 

To add code to change the culture information

l To test your localization, add the following code in the webform's constructor just before the 
InitializeComponent method is called.  This is in the "Web Form Designer Generated Code" region.  Make 
sure you replace the "fr" shown in the example code with the appropriate culture information for your 
project.  
' Visual Basic
System.Threading.Thread.CurrentThread.CurrentUICulture = New System.Globalization.CultureInfo("fr")
//C#
System.Threading.Thread.CurrentThread.CurrentUICulture = new System.Globalization.CultureInfo("fr");

Running the Project

To run the project

1. Press F5 to run the application. 

2. If the satellite assembly in the directory you created has not been signed by Data Dynamics' development 
staff, the localization will be ignored.  

Note: We have plans to simplify this process in a future version of ActiveReports for .NET.

The ActiveReports WebViewer control allows you to easily publish simple reports to the web for viewing in the 
browser. The client machine will not require ActiveReports or ASP.NET to be installed. The WebViewer also 
takes advantage of a report queueing technology to ensure the reports are executed and outputted 
efficiently. To use the WebViewer you will select an ActiveReport using the Report property of the WebViewer 
in the property list and set the ViewerType property to the viewer of your choice. Alternatively, you can set 
the Report property programmatically to a new instance of an ActiveReport class. 

This walkthrough is split up into the following activities: 

l Adding an ActiveReport to an ASP.NET Web application 

l Connecting the report to a data source 

l Adding controls to the report to contain data 

l Adding the ActiveReports WebViewer control to the Web Form 

To complete the walkthrough, you must have access to the Northwind database. For your convenience, a 
copy is included with ActiveReports at the following default location: C:\Program Files\Data 
Dynamics\ActiveReports for .NET 3.0\Data\NWIND.MDB. 

You must also have access to Internet Information Services either from your computer or from the server. 
You must also run the "Configure Web Sample" option from the Data Dynamics ActiveReports for .NET 

Walkthrough: Web Viewer Control
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3.0 program menu from your Windows Start button.

When you have completed this walkthrough, you will have a report that looks similar to the following.

Adding an ActiveReport to an ASP.NET Web application

To add an ActiveReport to your project

1. Open a new ASP.NET Web application in Visual Studio. 

2. From the Project menu, select Add New Item. 

3. Select ActiveReports 3.0 File and rename the file rptWebView. 

4. Click Open. 

Connecting the report to a data source

To connect the report to a data source

1. Click on the gray report DataSource icon in the Detail section to open the report DataSource dialog. 

2. Click on Build.

3. Select Microsoft Jet 4.0 OLE DB Provider and click Next .

4. Click the ellipsis button to browse for the access path to the NorthWind database. Click Open once you 
have selected the appropriate access path. 

5. Click OK to continue. 

6. In the Query field, type "Select * from products ORDER BY categoryID, productname". 

7. Click OK to return to the report design surface. 

Adding controls to the report to contain data
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To add controls to the report

1. Add a GroupHeader/Footer section to rptWebView. 

2. Make the following changes to the group header: 

¡ Change the name to ghProducts 

¡ Change the DataField property to CategoryID 

¡ Change the GroupKeepTogether property to FirstDetail

¡ Change the KeepTogether property to True

3. Add the following controls to the GroupHeader section: 

4. In the Report Explorer, expand the Fields node, then the Bound node. Drag the following fields onto the 
detail section and set the following properties of each textbox as indicated.  

Adding the ActiveReports WebViewer control to the Web Form
1. Click on the ActiveReport WebViewer control in the appropriate toolbox and drag it onto the Web Form. 

2. Adjust the size according to your needs. 

3. Change the Report property to rptWebView. 

4. Make sure the ViewerType property is set to HtmlViewer. 

Note: To view the report in PDF format, change the ViewerType property to AcrobatReader. To use the 
ActiveX Viewer, change the ViewerType property to ActiveXViewer and paste the ActiveX viewer .cab 
file in your project folder (for help with this, see " Using ActiveX Viewer Control on the Web"). 

l The ActiveReports icon is not showing up in the Visual Studio.NET IDE

l The Copy icon is missing from the Viewer

l The evaluation message is showing that ActiveReports is not licensed

l Exported reports are not showing up correctly

l Memory issues appear when using ActiveReports

l Parameters are not working correctly

l Reports are not printing correctly, or are printing slowly

l Reports are not showing up in the WebViewer

l When converting Web projects to Visual Studio 2005, the ReportAssembly project does not 
convert

Control Name Text Location

Label lblProductName Product Name 0, 0 

Label lblQuantityPerUnit Quantity Per Unit 1.1875, 0 

Label lblInStock In Stock 2.5625, 0 

Label lblUnitPrice Unit Price 4, 0 

4, 0

Field Text Location OutputFormat

ProductName Product Name 0, 0 NA

QuantityPerUnit Quantity Per Unit 1.1875, 0 NA

UnitsInStock Units In Stock 2.5625, 0 NA

UnitPrice Unit Price Currency

Troubleshooting
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l Reports copied from one project to another display with all controls stacked at 0, 0

l Errors and warnings show up in old projects after installing a new build

l Controls are not showing up at run time in nested subreports

Symptoms: You recently upgraded or reinstalled ActiveReports on your machine and your reports are now 
showing up as XML instead of showing properly in the designer, and the ActiveReports icon is not showing 
when you open Visual Studio.NET. 

Cause: ActiveReports is not registered on your machine. The most common reason for this is AntiVirus 
software which stops the the installation scripts from running. 

Solution: Uninstall ActiveReports, temporarily turn off script blocking and re-install ActiveReports for .NET 
3.0. 

If the symptoms persist: You can manually register ActiveReports for .NET 3.0 by entering the following 
commands at the command prompt: 

l C:\WINDOWS\system32\regsvr32.exe /u C:\ProgramFiles\Common Files\DataDynamics\ActiveReports 
for .NET 3.0\ARVSPackage.dll 

l Run Visual Studio.NET and then close it. 

l C:\WINDOWS\system32\regsvr32.exe /v C:\ProgramFiles\Common Files\DataDynamics\ActiveReports 
for .NET 3.0\ARVSPackage.dll 

l Run Visual Studio. You should now be able to access RPX files. 

Symptoms: The copy icon is not showing in the viewer.

Cause: The ActiveReports RTF and Text export filters are not referenced in the project. The viewer has 
intentionally been designed not to require the export filters so no extra files are required in distribution. 

Solution:

1. In the Solution Explorer, right click References and choose Add Reference. 

2. Select Data Dynamics ActiveReports Rich Text Format (RTF) Export Component and Data Dynamics 
ActiveReports Text Export Component and click OK. 

Symptoms: The evaluation banner still appears after running the Standard Edition LicenseStd3.exe or 
UpgradeStd3.exe (or Professional Edition LicensePro3.exe or UpgradePro3.exe) file and following the steps 
to license applications.

Causes: 

l Running the .exe will license your machine for new Windows Forms projects only. Additional steps are 
required for ASP.NET projects and for existing Windows Forms projects. 

l All licensing in .NET is done at the root EXE level. For example, if you have a report that needs to be 
licensed within a DLL, the calling EXE to that DLL needs to be licensed. 

l The name of your executable has been changed without changing the assembly name in the project's 
references. 

l No licenses.licx file was generated in the project. 

l You have LicenseStd3.exe or UpgradeStd3.exe (Standard Edition) rather than LicensPro3.exe or 
UpgradePro3.exe (Professional Edition) and are using Professional Edition features such as the Http 
Handlers, the WebViewer control, or the End User Designer control. Although Standard Edition users are 
welcome to try out the Professional Edition features, the only way to remove the evaluation banner from 

ActiveReports Icon not Showing

Copy Icon Missing from the Viewer

Evaluation Message Showing
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them is to upgrade to the Professional Edition. 

Solutions: 

l For existing Windows Forms projects: After licensing the machine, reopen the project, open the Build 
menu, and choose Rebuild Solution. In most cases, this will update the license information. 

l For ASP.NET projects:

1. Go to the Start menu, select All Programs, Data Dynamics, ActiveReports for .NET 3.0, and click 
Create Web.Config key. 

2. Enter the same information you used in license.exe and click the Create Web.Config button. (If your 
machine has been properly licensed, the first two fields should already be filled in by default.) 

3. Copy the generated XML string and paste it in your ASP.NET project's web.config file. If your 
web.config file already has <configuration> tags, place the XML string inside these tags, and delete 
the extra <configuration> tags in the XML string. 

4. Caution: Do not place the XML string inside the <system.web> tags, or the project will error out 
when you attempt to run it. 

5. Open the Build menu, and choose Rebuild Solution. 

l For End User Report Designer projects:

1. Add a new End User Report Designer to your solution. This is temporary, so anywhere on the main 
form will do. 

2. From the Build menu, choose Rebuild Solution. 

3. Open the project's licenses.licx file and verify that it contains the line 
"DataDynamics.ActiveReports.Designer.Designer, ActiverReports.Design." 

4. Delete the temporary End User Report Designer. 

l For reports contained in a DLL rather than an EXE: After licensing the machine, the root level calling 
EXE will need to have ActiveReports licensing embedded.  To do this, add a temporary ActiveReport to 
the startup EXE project, open the Build menu, and choose Rebuild Solution. After verifying that licensing 
has been added in the licenses.licx file, the temporary report may be deleted. 

l For run-time licensing:

1. Create a Web.Config key as directed in the ASP.NET solution above. 

2. In the application class, create a report instance and call the SetLicense() method with the key you 
created above as the parameters. The string value for the generated key should be "[Name], 
[Company Name], [Serial Number], [Hash Code]." 

3. Use the Run method to generate the report object. 

l For reports in an executable for which the name has been changed: Change the assembly name in 
the project's references to match the new name of the executable.

If the symptoms persist:  

l For existing Windows Forms projects: If simply rebuilding the project doesn't work, you can manually 
set up the application for licensing. 

1. In the Solution Explorer for the project, right-click the StartUp project, and choose Set As StartUp 
Project 

2. From the Project menu, choose Add New Item. 

3. In the Templates pane, choose Text File, and name it "licenses.licx" 

4. Double-click the licenses.licx file to open it 

5. Add "DataDynamics.ActiveReports.ActiveReport3, ActiveReports" to the text file 

6. From the Build menu, choose Rebuild Solution 

l For ASP.NET projects: Since the web key is comma delimited, there can be no commas in the 
username or company name fields. If there are any commas in the fields, rerun the license.exe or 
licensepro.exe on your CD or original download without using any commas. Then rerun the web config 
key generator. 

l For End User Report Designer projects:

1. Add the line "DataDynamics.ActiveReports.Designer.Designer, ActiverReports.Design" to the 
licenses.licx file manually. 
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2. From the Build menu, choose Rebuild Solution. 

l For reports contained in a DLL rather than an EXE: Another way to embed licensing in the EXE is to 
copy the licenses.licx file from the DLL into the startup project. 

1. Copy the file into the project folder. 

2. Open the project and choose to view all files in the Solution Explorer. 

3. Right click the file, and choose to include it in the project. 

4. In the Properties window for the file, set the Build Action to Embedded Resource. 

5. From the Build menu, choose Rebuild Solution. 

The following topics explain causes and solutions for incorrectly exported reports:

l Excel Export Troubleshooting

l HTML Export Troubleshooting

l PDF Export Troubleshooting  

l RTF Export Troubleshooting  

l Text Export Troubleshooting

l TIFF Export Troubleshooting

Symptoms: The "Specified Cast Is Not Valid" exception fires.

Cause: There is a mix of old and new dlls in the references.

Solution:

1. Remove all ActiveReports for .NET 3.0 references from the project. 

2. Add the ActiveReports for .NET 3.0 references necessary to your project, making sure to use only 
references to assemblies from the latest build installed on your machine. 

Symptoms: Extra columns are showing up in the Excel export.

Cause: Controls don't have the same Top and Height properties. When the Excel export runs, it divides the 
report into rows and columns based on the borders of the controls, much like a grid. Controls that are not 
aligned across the report cause the Excel export to produce more columns to accommodate them. 

Solution: To remedy the situation, set as many controls with the same Left property values and the same 
Top property values as you can, aligning them as if they were in a grid. This reduces the number of columns 
exported. Also, setting the RemoveVerticalSpace or UseCellMerging property to True, or setting the 
MinColumnWidth property equal to the width of the narrowest cell may help.

Symptoms: Extremely long reports don't export to Excel.

Cause: The maximum number of rows which can be exported to MS Excel version 8.0 or 9.0 is 65,536, while 
older versions of Excel (4.0, 5.0 and 7.0) had a limit of 16,384 rows. 

Here are other specifications for Excel version 9.0 which may affect your export: 

l Maximum worksheet size: 65,536 rows by 256 columns  

l Maximum column width: 255 characters 

l Maximum row height: 409 points 

l Maximum length of cell contents (text): 32,767 characters. Only 1,024 display in a cell; all 32,767 
display in the formula bar.  

Solution: Use the Export(document,filePath,pageRange) or Export

Troubleshooting Exports

Excel Export Troubleshooting
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(document,outputStream,pageRange) method to export ranges of pages into separate Excel documents.

Symptoms: When using a memory stream, the Excel export sporadically fails.

Cause: Internet Explorer requires a "content-disposition" header in the response.

Solution: Use code like the following before creating the export.

Response.ContentType = "application/x-msexcel";
Response.AddHeader("content-disposition","attachment; filename=MyXLS.XLS");
Response.AddHeader("content-disposition","inline; filename=MyXLS.xls");

Symptoms: The exported Excel file does not look exactly like the original report.

Cause: The Excel export is not WYSIWYG. It does not support the following items:

l Line control 

l Borders on controls with angled text 

l Shapes (other than filled rects) 

l Overlapping controls 

Solution: Try to avoid using the above items in reports which will be exported to HTML.

Symptoms: The "Specified Cast Is Not Valid" exception fires.

Cause: There is a mix of old and new dlls in the references.

Solution:

1. Remove all ActiveReports for .NET 3.0 references from the project. 

2. Add the ActiveReports for .NET 3.0 references necessary to your project, making sure to use only 
references to assemblies from the latest build installed on your machine. 

Symptoms: The exported HTML file does not look exactly like the original report.

Cause: The HTML export is not WYSIWYG. It does not support the following items:

l Line control 

l Control borders 

l Shapes (other than filled rects) 

l Overlapping controls 

Solution: Try to avoid using the above items in reports which will be exported to HTML.

Symptoms: Internet Explorer displays "Invalid syntax error" on the title bar, "The page cannot be displayed" 
in the body and the url is prepended with "mhtml:" in the address bar. 

Cause: This is caused by Microsoft Hotfix Q330994 (http://support.microsoft.com/default.aspx?
kbid=330994). Microsoft addressed an Outlook security flaw that used the MHT extension and broke the 
streaming HTML functionality. 

Solution: Append the 'mht' extension to the file when you link to it. For example,

SortSample.aspx?RunReport=true
Would be changed to the following.

SortSample.aspx?RunReport=true f=temp.mht

HTML Export Troubleshooting

PDF Export Troubleshooting
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Symptoms: The "Specified Cast Is Not Valid" exception fires.

Cause: There is a mix of old and new dlls in the references.

Solution:

1. Remove all ActiveReports for .NET 3.0 references from the project. 

2. Add the ActiveReports for .NET 3.0 references necessary to your project, making sure to use only 
references to assemblies from the latest build installed on your machine. 

Symptoms: Barcodes in printed PDF exports do not scan and the page margins appear larger than the ones 
in the original report.

Cause: The Adobe Acrobat reader has a default setting in the Print dialog which tells it to scale down large 
pages.  The reader views ActiveReports margins as part of the document, and renders them inside the new 
margins it creates. This is normally not noticeable unless barcodes are used or the PDF printout is held up 
next to a printout of the original report.

Solution:  

For Acrobat 6, change the following options in the Print dialog under Page Handling:

1. Set Page scaling to None (the default is Shrink large pages). 

2. Uncheck Auto-Rotate and Center. 

For Acrobat 5, uncheck the following options in the Print dialog:

1. Shrink oversized pages to paper size 

2. Expand small pages to paper size 

3. Auto-rotate and center pages 

Symptoms: In the WebViewer, reports render correctly with the HTML viewer type but they show up blank 
with the AcrobatReader viewer type on the production web server.

Cause: .ArCacheItem is not set up in your IIS extension mappings. 

Solution:

1. From the Start menu, choose All Programs, Administrative Tools, Internet Information Services. 

2. Right-click your Default Web Site and choose Properties. 

3. On the Home Directory tab, click the Configuration. button. 

4. On the Mapping tab, check the Extension column to see whether .ArCacheItem appears there. 

5. If .ArCacheItem does not appear click the Add button. 

6. Browse to C:\WINDOWS\Microsoft.NET\Framework\v1.1.4322 or 
C:\WINNT\Microsoft.NET\Framework\v1.1.4322. 

7. Change Files of type: to Dynamic Link libraries (*.dll). 

8. Choose the aspnet_isapi.dll and click Open. 

9. In the Extension textbox type ".ArCacheItem". 

10. Click the Limit to: radio button and type "GET,HEAD,POST,DEBUG". 

11. Make sure that the "Script engine" checkbox is checked and the "Check that file exists" checkbox is not 
checked. 

12. Click OK. 

 

Symptoms: The "Specified Cast Is Not Valid" exception fires.

Cause: There is a mix of old and new dlls in the references.

RTF Export Troubleshooting
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Solution:

1. Remove all ActiveReports for .NET 3.0 references from the project. 

2. Add the ActiveReports for .NET 3.0 references necessary to your project, making sure to use only 
references to assemblies from the latest build installed on your machine. 

Symptoms: The exported RTF file does not look exactly like the original report.

Cause: The RTF export is not WYSIWYG, and is based on WordPad rather than Word, so there are a number 
of limitations.  The following items are not supported in the RTF export.

l Line controls 

l Backcolor 

l Shape controls 

l Overlapping controls 

l Control borders (except for borders on the RichTextBox control, which are supported) 

l Angled text 

Solution: Try to avoid using the above items in reports which will be exported to RTF.

Symptoms: The "Specified Cast Is Not Valid" exception fires.

Cause: There is a mix of old and new dlls in the references.

Solution:

1. Remove all ActiveReports for .NET 3.0 references from the project. 

2. Add the ActiveReports for .NET 3.0 references necessary to your project, making sure to use only 
references to assemblies from the latest build installed on your machine. 

Symptoms: The exported text file does not look exactly like the original report.

Cause: The text export is not WYSIWYG. It is limited to plain text, or plain text with encoding for foreign 
language support. 

Solution: Only use the Text export when the output should be plain text.

Symptoms: The "Specified Cast Is Not Valid" exception fires.

Cause: There is a mix of old and new dlls in the references.

Solution:

1. Remove all ActiveReports for .NET 3.0 references from the project. 

2. Add the ActiveReports for .NET 3.0 references necessary to your project, making sure to use only 
references to assemblies from the latest build installed on your machine. 

Symptoms: Reports exported to TIFF format with the RLE or CCITT3 compression scheme are rendering 
black.

Cause: The sections in the reports have a BackColor and are not being dithered.

Solution: Set the Dither property for the export object to True, or set the BackColor property of each section 
to Transparent.

Text Export Troubleshooting

TIFF Export Troubleshooting
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Symptoms: Some reports are exported to TIFF with extra white space at the bottom of the page.

Cause: The default value for CompressionScheme is CCITT3.  According to CCITT3 standards, the page size 
is 1728 x 2376 pixels and the resolution is 200 x 196 DPI, as required by some fax machines. If the page is 
smaller than this standard, then it is scaled up to CCITT3 standards, which can cause extra white space at 
the bottom.

Solution: To get an accurate page size set the CompressionScheme to CompressionScheme.Rle (Run length 
encoding).

Symptoms: ActiveReports is consuming too much memory and the CPU usage is at 100%.

NOTE: The CPU usage will always go to 100% when using ActiveReports.

There are several reasons why too much memory may be consumed:

Cause: The report is not being disposed of properly. The incorrect syntax is as follows. 

[Visual Basic.NET]
rpt.Dispose()
rpt=Nothing
[C#]
rpt.Dispose();
rpt=null;
Solution: The correct syntax for disposing of a report properly is as follows. 

[Visual Basic.NET]
rpt.Document.Dispose()
rpt.Dispose()
rpt=Nothing
[C#]
rpt.Document.Dispose();
rpt.Dispose();
rpt=null;

Cause: Large reports in an ASP.NET application can easily use up the 60% of memory allocated to the 
ASP.NET worker process by default, which produces an error. In Machine.Config, MemoryLimit specifies the 
maximum allowed memory size, as a percentage of total system memory, that the worker process can 
consume before ASP.NET launches a new process and reassigns existing requests. 

Solution: Set the CacheToDisk property of the document to True.  This will cache the report to disk instead 
of holding it in memory. This setting is also detected by the PDF Export, which will follow suit, but any other 
exports will still consume memory. Although it is not advised, the ASP.NET worker process memory allocation 
can also be changed in your Machine.Config file, which is located in a path like: 
C:\WINDOWS\Microsoft.NET\Framework\v1.1.4322\CONFIG\.  Search the Machine.Config file 
for memoryLimit which is located in the processModel. 

Cause: In some cases, very large reports can consume so much memory that the report never finishes 
processing. Some of the things that can cause this include: 

1. The use of many non-repeating images, or a high resolution repeating image 

2. Instantiating a new instance of a subreport each time the format event of a section fires 

3. Using a lot of subreports instead of grouping by doing joins in the SQL query 

4. Pulling in all of the data when only a few fields are needed, i.e. Select * from db instead of Select First, 
Last, Address from db 

Solution: In cases where the report is too large to run any other way, the CacheToDisk property may be set 
to True. This property should only be used when there is no other way to run the report to completion. Before 
resorting to this method, please see the Optimizing ActiveReports topic. 

Troubleshooting Memory Issues

 

ActiveReports for .NET 3 User Guide | 443



Cause: If inflated memory usage is seen in the Task Manager it is not necessarily in use by the code. Task 
manager indicates the current "working set" of the process and, upon request, other processes can gain 
access to that memory. It is managed by the OS. 

Solution: For an example of some working set behavior anomalies (which are considered normal), create a 
WinForms application and run it. Look in Task Manager at the working set for that process (it should be 
several megabytes), then minimize and maximize the form and notice that the working set reclaims to <1MB. 
Obviously, the code was not using all that memory even though Task Manager showed that it was allocated 
to that process. Similarly, you'll see ASP.NET and other managed service processes continue to gradually 
grow their working set even though the managed code in that process is not using all of it. To see whether 
this is the case, try using the two lines of code below under a button after running the project.

System.Diagnostics.Process pc = System.Diagnostics.Process.GetCurrentProcess();
pc.MaxWorkingSet = pc.MinWorkingSet;
If that reclaims the memory then the OS trimmed the working set down to the minimum amount necessary 
and this indicates that the extra memory was not actually in use.

Note: According to Microsoft it is not necessary to call GC.Collect and it should be avoided. However, if 
calling GC.Collect reduces the memory leak, then this indicates that it is not a leak after all. A leak in 
managed code is caused by holding a reference to an object indefinitely. If ActiveReports is holding a 
reference to an object, then the object cannot be collected by the garbage collector. 

Symptoms: An error message is displayed in the Fields list in the Report Explorer instead of the fields. 

Cause: This is an expected error if no default value is given. If the field is a data type other than text, 
memo, or date/time in Access, the report will run normally. 

Solution: To display the fields in the Fields list in the Report Explorer, supply a default value for the 
parameter, i.e. 

<%FieldName | PromptString | DefaultValue | Type%>

Symptoms: When the report is run, an exception like the following occurs: "An unhandled exception of type 
'System.Data.OleDb.OleDbException' occurred in system.data.dll" 

Cause: If the field is a text, memo, or date/time data type in Access, the parameter syntax requires single 
quotes for text or memo fields, or pound signs for date/time fields. Please note that for different data 
sources, these requirements may differ. 

Solution: To avoid the exception when the report is run against an Access database, use pound signs for 
date/time values, or single quotes for string values, i.e. 

#<%InvoiceDate | Choose invoice date: | 11/2/04 | D%>#
or 

'<%Country | Country: | Germany | S%>' 

Symptoms: The parameter user interface pops up at run time asking for a value even though the main 
report is supplying the parameter values for the subreports. 

Cause: The default value of the ShowParameterUI property of the report is True. 

Solution: Set the ShowParameterUI property of the report to False. This can be done in the property grid or 
in code in the ReportStart event. 

Symptoms: In the viewer, the report is rendering to a different paper size than the one specified. 

Troubleshooting Parameters

Troubleshooting Printing
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Cause: ActiveReports polls the printer driver assigned to the report to check for clipping, margins, and paper 
sizes supported by the printer.  If the paper size specified for the report is not supported by the printer, 
ActiveReports will use the printer's default paper size to render the report. 

Solution: If the report is to be printed, the printer assigned to the report must support the paper size and 
margins. Please note that any changes to the print settings in code must be made in or before the 
ReportStart event. To use custom paper sizes not supported by the driver, set the PrinterName to an empty 
string to use the ActiveReports virtual print driver. This will not allow printing, but is recommended for 
reports that are only exported or viewed. This will prevent Activereports from making a call to the default 
printer driver. Use the following code in the ReportStart event, or just before .Run is called. 

Me.Document.Printer.PrinterName = "" 
The PaperHeight and PaperWidth properties, which take a float value defined in inches, will have no effect 
unless you set the PaperKind property to Custom. Here is some sample code which can be placed in the 
ReportStart event, or just before .Run.

Me.PageSettings.PaperKind = Drawing.Printing.PaperKind.Custom
Me.PageSettings.PaperHeight = 2
'sets the height to two inches
Me.PageSettings.PaperWidth = 4
'sets the width to four inches

Symptoms: Custom paper sizes do not work. 

Cause: There can be several custom paper sizes, so setting only the PaperKind property is not enough 
to create a custom paper size. 

Solution: In addition to setting the PaperKind property to Custom, you must also set the PaperName 
property to a unique string.

Symptoms: Blank pages are printed between pages of the report. 

Cause: This problem occurs when the PrintWidth plus the left and right margins exceeds the paper width. For 
example, if the paper size were set to A4, the PrintWidth plus the left and right margins should not exceed 
8.27"; otherwise blank pages will be printed. At run time, ActiveReports marks a page overflow by displaying 
a red line in the viewer at the position in which the breach has occurred. 

Solution: The PrintWidth can be adjusted in the report designer using either the property grid or by dragging 
the right edge of the report. Page margins, height, and width can be adjusted either through the print 
properties dialog box in the Report menu under Settings. or programmatically in the Report_Start event.

Symptoms: The WebViewer will not automatically print a report without displaying it. 

Cause: The WebViewer provides convenience in automating many of the steps involved in providing a 
reporting solution, but the cost of this automation is a loss of control of these steps. 

Solution: In order to provide no touch printing in ASP.NET, stream the file to the ActiveX viewer control and 
then print using vbscript in the HTML view of the ASP rather than the ASP code behind. 

1. Place the ActiveX Control on the page as an object. Setting the version to -1,-1,-1,-1 forces Internet 
Explorer to check for updates each time the page is rendered. Setting the height and width to 0 allows 
you to print the report without displaying it. Here is the code that goes in the HTML view of the ASPX 
page.

<OBJECT id=arv codeBase=bin/arview2.cab#version=-1,-1,-1,-1 
height=0 
width=0 
classid=CLSID:8569d715-ff88-44ba-8d1d-ad3e59543dde>

2. Load the data into the report. Set the DataPath of the viewer object. This can be anything from a byte 
array to a hard coded path. 

<script language=vbscript>
<!--
sub window_onload()

arv.datapath = "Default.aspx?ReturnReport=1"
end sub

3. Print the report. This is done by syncing the LoadCompleted event of the viewer. Inside a call is made to 
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the Viewer's PrintReport method with False indicating that no UI is to be displayed. 

sub arv_loadcompleted()
arv.PrintReport False

end sub
-->
</script>
 

Symptoms: In the WebViewer, reports render correctly with the HTML viewer type but they show up blank 
with the AcrobatReader viewer type on the production web server.

Cause: .ArCacheItem is not set up in your IIS extension mappings. 

Solution:

1. From the Start menu, choose Control Panel> Administrative Tools> Internet Information 
Services. 

2. Right-click your Default Web Site and choose Properties. 

3. On the Home Directory tab, click the Configuration button. 

4. On the Mapping tab, check the Extension column to see whether .ArCacheItem appears. 

5. If .ArCacheItem does not appear click the Add button. 

6. Browse to <Windows>\Microsoft.NET\Framework\v1.1.4322 or v2.0.50727. 

7. Change Files of type: to Dynamic Link libraries (*.dll). 

8. Choose the aspnet_isapi.dll and click Open . 

9. In the Extension textbox type ".ArCacheItem". 

10. Click the Limit to: radio button and type "GET,HEAD,POST,DEBUG". 

11. Make sure that the "Script engine" check box is selected and the "Check that file exists" check box is not. 

12. Click OK. 

Symptoms: "Error Creating Control - Webviewer" appears on the WebForm in place of the WebViewer 
control.

Cause: There is a version conflict within the project.

Solution: 

1. Open the WebForm and look in the HTML view for a line that looks similar to the following and remove it. 

<%@ Register TagPrefix="activereportsweb" Namespace="DataDynamics.ActiveReports.Web" 
Assembly="ActiveReports.Web, Version=5.0.0.84, Culture=neutral, 
PublicKeyToken=cc4967777c49a3ff"%>

2. Go to the code behind the WebForm and remove the following line from the Web Form Designer 
Generated Code. 

Protected WithEvents WebViewer1 As DataDynamics.ActiveReports.Web.WebViewer 
3. In the Solution Explorer, under References, right click and Remove the ActiveReports.Viewer and 

ActiveReports.Web references. 

4. Delete the control from the WebForm. 

5. Add back the references for ActiveReports.Viewer and ActiveReports.Web, making certain that the 
Version number is the same as the currently installed version. 

6. Add the WebViewer back to the WebForm. 

7. Open the Web.config file in the solution, and scroll down to the httpHandlers tag near the bottom. There 
are three add verb tags on that line which indicate the Version. These need to be updated with the 
version number of the currently installed version. 

Troubleshooting the WebViewer
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Symptoms:

l The icons are missing on my WebViewer control. 

l Using the ActiveX ViewerType, this error occurs: "Error 5013 : Invalid DataPath. Cannot load data." 

Cause: The httpHandlers in the Web.config file are missing or referencing the wrong version.

Solution: Make sure that the following HTTP Handler code is in the Web.config file and that the version is 
current. 

<httpHandlers><add verb="*" path="*.ArCacheItem" 
type="DataDynamics.ActiveReports.Web.Handlers.WebCacheAccessHandler, ActiveReports.Web, 
Version=5.0.0.84, Culture=neutral, PublicKeyToken=cc4967777c49a3ff" /><add verb="*" 
path="*.Rpx" type="DataDynamics.ActiveReports.Web.Handlers.RpxHandler, ActiveReports.Web, 
Version=5.0.0.84, Culture=neutral, PublicKeyToken=cc4967777c49a3ff" /><add verb="*" 
path="*.ActiveReport" type="DataDynamics.ActiveReports.Web.Handlers.CompiledReportHandler, 
ActiveReports.Web, Version=5.0.0.84, Culture=neutral, 
PublicKeyToken=cc4967777c49a3ff" /></httpHandlers>

Symptoms: The report in the HTML viewer type does not look exactly like the other viewer types.

Cause: The HTML format is not WYSIWYG. It does not support the following items:

l Line control 

l Control borders 

l Shapes (other than filled rects) 

l Overlapping controls 

Solution: Try to avoid using the above items in reports which will be shown in HTML format.

Symptoms:

l The WebViewer stays on the page number last viewed in the previous report when a user selects a new 
report or refreshes the current report.  

l The report is not getting updated with new data. 

Cause: If the control is being loaded in response to a client postback, the Report property will not run the 
specified report. Instead it uses a previously cached copy of the report's Document in the WebCache service 
to supply speedy responses to clients.  

Solution: To force the client to use a new instance, call the ClearCachedReport method before setting the 
Report property.

Symptoms: The WebViewer will not automatically print a report without displaying it. 

Cause: The WebViewer provides convenience in automating many of the steps involved in providing a 
reporting solution, but the cost of this automation is a loss of control of these steps. 

Solution: In order to provide no touch printing in ASP.NET, stream the file to the ActiveX viewer control and 
then print using vbscript in the ASP code (not the ASP code behind). 

1. Place the ActiveX Control on the page as an object. Setting the version to -1,-1,-1,-1 forces Internet 
Explorer to check for updates each time the page is rendered. Setting the height and width to 0 allows 
you to print the report without displaying it. Here is the code that goes in the ASPX page. 

<OBJECT id=arv codeBase=bin/arview2.cab#version=-1,-1,-1,-1 
height=0 
width=0 
classid=CLSID:8569d715-ff88-44ba-8d1d-ad3e59543dde>

2. Load the data into the report. Set the DataPath of the viewer object. This can be anything from a byte 
array to a hard coded path. 

<script language=vbscript>
<!--
sub window_onload()

arv.datapath = "Default.aspx?ReturnReport=1"
end sub
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3. Print the report. This is done by syncing the LoadCompleted event of the viewer. Inside a call is made to 
the Viewer's PrintReport method with False indicating that no UI is to be displayed. 

sub arv_loadcompleted()
arv.PrintReport False

end sub
-->
</script>

Symptoms: The ReportAssembly project does not convert to Visual Studio 2005.

Cause: The *.cs or *.vb file name is not correct in the CodeFile attribute in the *.rpx file.

Solution: Ensure that the CodeFile attribute of the ActiveReportsLayout is the same as the actual file 
containing code for the report. 

<ActiveReportsLayout Version="3" PrintWidth="9360" DocumentName="ActiveReports Document" 
ScriptLang="C#" CodeFile="rptMyReport.cs">

Symptoms: A report file copied into a new project has all of its controls piled up at location 0, 0. 

Cause: The report has become disconnected from its resource file. 

Solution: When you copy a report's *.vb file from one project's App_Code folder into the App_Code folder of 
a new project, you need to also copy its *.resx file from the original project's App_GlobalResources folder 
into the new project's App_GlobalResources folder.

Symptoms: When you open a project created with a previous build of ActiveReports after installing a new 
build, there are errors related to being unable to find the previous build. 

Cause: Visual Studio 2005 has a new property on references called Specific Version. If this property is set to 
True, the project lookos for the specific version and throws errors when it cannot find it. 

Solution: Delete the ActiveReports references and re-add them. (In Web projects, do this from the Website 
menu, Start Options, References tab.  In WinForms projects, do this from the Project menu, ProjectName
Properties, References tab.)

Symptoms: When you run a project with nested subreports, some of the controls do not display. 

Cause: Controls could be overlapping or the section following a header with the UnderlayNext property set to 
True might have a non-transparent BackColor. 

Solution: Temporarily use the BackColor properties of sections or controls to more easily spot their locations 
at run time, then rearrange them as needed. Take care to leave the BackColor property Transparent for any 
section following a header with the UnderlayNext property set to True.

Visual Studio 2005 Web Project Conversion

Copying Reports Results in Stacked Controls

Troubleshooting Errors After New Build Installation

Troubleshooting Controls in Subreports
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